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DÉBUTER AVEC GIMP 2.6

PRÉSENTATION

Débuter avec Gimp 2.6   est une petite documentation (Licence   CC By-Nc) destinée aux nouveaux 
utilisateurs de GIMP. Elle illustre sommairement le fonctionnement de Gimp dans la version que nous 
proposons en téléchargement à la page http://www.aljacom.com/~gimp/download.html .
Cette documentation est aussi utile pour les autres versions de Gimp, il suffit d'adapter les noms des 

répertoires et/ou les spécificités des systèmes d'exploitation.

GIMP (GNU Image Manipulation Program où GNU est l'acronyme récursif de « GNU's Not Unix ») est un 
logiciel libre et gratuit, pour la création et la manipulation d'images « bitmap » . 

Gimp permet :

● Ouvrir différents types de fichiers d'images.

● Modifier ces images (Créer des effets, dimensionner, corriger, encadrer, éclairer, etc.).

● Assembler plusieurs images.

● Ajouter des textes aux images.

● Réaliser des textures, des dégradés, des icônes.

● Dessiner.

● Convertir les types de fichiers d'images.

● Créer, modifier des animations.

● Exécuter des scripts.

● Accéder à un historique d'annulation.  

● Traiter de nombreux fichiers en une commande (Traitement par lot).                         

● Illustrer, améliorer, truquer, s'amuser, etc.        

                                                                           

Initialement prévu pour fonctionner sous des systèmes compatibles Unix (Linux par exemple) GIMP a été 
adapté pour fonctionner sous Mac et Windows.

Le site de Gimp est  http://www.gimp.org/  et le portail francophone http://www.gimpfr.org/ 

Les nouveautés de Gimp 2.6 en français : http://gimp-fr.org/presentation_gimp26.php,
 en anglais : http://gimp.org/release-notes/gimp-2.6.html 

Merci aux auteurs, traducteurs, rédacteurs et graphistes de ce logiciel  :o)

http://creativecommons.org/licenses/by-nc/3.0/deed.fr_CA
http://gimp.org/release-notes/gimp-2.6.html
http://gimp-fr.org/presentation_gimp26.php
http://www.gimpfr.org/
http://www.gimp.org/
http://www.aljacom.com/~gimp/download.html
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INSTALLATION

TÉLÉCHARGEMENT  POUR W INDOW S

Le plus simple est de télécharger des versions compilées (temps de compilation long, dépendances 
nombreuses).

Pour Windows, Jernej Simoncic réalise cette compilation et propose les différents paquets sur  Sourceforge 
(http://gimp-win.sourceforge.net/stable.html). 

À partir des paquets compilés par Jernej Simoncic  nous proposons une archive qui contient un 
environnement pré-installé pour améliorer le fonctionnement de Gimp :
– Permet d'avoir Gimp sur le disque dur de son ordinateur, sur une clef USB (Gimp portable) ou sur CD

– Avec le programme utilitaire Maringouin, il est possible d'avoir nos préférences sur un support USB 
nomade (Gimp portable) , de lancer Gimp en six langues, d'avoir la fenêtre des outils au 1er plan, de  bien 
positionner automatiquement les variables d'environnement, etc.

– Accès à deux types d'aides   ; l'aide en français au format CHM que nous compilons ainsi que l'aide via 
Internet.

– Une meilleure gestion de l'impression   via le greffon Gutenprint & CUPS for Windows 
(http://webblog.ru/Dickobraz)

– Ouverture des fichiers RAW   via la greffon UFRaw (http://ufraw.sourceforge.net/).

– Éliminer le bruit des images   via le greffon GreyCStoration (http://cimg.sourceforge.net/).

– Ouverture des fichiers   EPS (Encapsulated PostScript) et PS (PostScript.) via Ghostscript 
(http://www.ghostscript.com/awki).

– Création d'animations   via le greffon GAP (Gimp Animation Package).

– Détection de   Python, etc.

Vous pouvez télécharger Gimp à partir de http://www.aljacom.com/~gimp/download.html

INSTALLATION DE L 'ARCHIVE ET DÉMARRAGE  DE G IMP

Il suffit de démarrer l'archive téléchargée depuis la page http://www.aljacom.com/~gimp/download.html par 
un double clic (L'archive a pour nom gimp_2_6_9.exe ).

Choisir un répertoire ou dossier pour la 
décompression en appuyant sur le bouton « ... » . 
Choisir un répertoire sans espaces et sans accents, 
nous conseillons C:\ ou la racine de la clef USB.

Appuyer sur le bouton « Extract » et attendre la 
fin de la décompression. L'attente peut être longue 
et dépend de la rapidité du micro-ordinateur.

http://www.aljacom.com/~gimp/download.html
http://www.aljacom.com/~gimp/download.html
http://www.python.org/
http://www.ghostscript.com/awki
http://www.adobe.com/products/postscript/resources.htm
http://partners.adobe.com/public/developer/en/ps/5002.EPSF_Spec.pdf
http://cimg.sourceforge.net/
http://ufraw.sourceforge.net/
http://webblog.ru/Dickobraz
http://en.wikipedia.org/wiki/Microsoft_Compiled_HTML_Help
http://gimp-win.sourceforge.net/stable.html
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Pour démarrer Gimp il suffit d'aller dans le répertoire créé lors de la décompression ..\gimp_2_6_9  et de 
faire un double clic sur :
– gimp_en_francais_disque_dur.bat

– ou sur gimp_en_francais_nomades_1.bat

– ou sur maringouin.exe > Activer l'icône  dans la barre d'outils > Démarrer Gimp (Le choix de la langue 
se fait dans Outils autour de Gimp > Choix de la langue de Gimp).

Le premier démarrage de Gimp dure beaucoup plus longtemps (création de répertoires et de fichiers) et nous 
risquons d'avoir un message d'erreur mais Gimp sera fonctionnel.

ASSOCIER DES TYPES D ' IMAGES À G IMP , ACTIVER G IMP  VIA UN MENU 
CONTEXTUEL

Pour associer des types d'images à Gimp (fichiers .xcf , etc. ) et/ou pour activer Gimp via un menu 
contextuel nous trouverons les indications dans la notice maringouin.pdf fournie dans l'archive au chapitre 
OUVRIR DES IMAGES DANS GIMP VIA MARINGOUIN.

INSTALLATION DE PYTHON SOUS W INDOW S

Python est très utile pour faire fonctionner des greffons (plug-in) de Gimp.

Si Python n'est pas installé sur notre ordinateur, selon les configurations, nous pourrons avoir une fenêtre 
d'erreur donnée par le lanceur maringouin, par exemple :
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Voici les liens pour télécharger quelques paquets Python (pour gimp) et les installer :

Python

http://www.python.org

http://www.python.org/download/

PyGTK

http://www.pygtk.org

http://www.pygtk.org/downloads.html

Pour installer Python :
– Démarrer maringouin, valider     Comment installer Python 2.6 pour Gimp

– Suivre les instructions.  

Par défaut Python version 2.6.x s'installe dans C:\Python26.

Nota : 

Si vous ne souhaitez pas installer Python, pour ne pas avoir de message d'erreur vous devez éditer 
maringouin_ahk.ini et mettre la clef python_affichage_autorise = 0  

ou 

démarrer Maringouin et faire : Outils autour de Gimp > Affichage message avertissement Python au 
lancement de Gimp > Interdire l'affichage.

Maringouin détecte si Python est installé, et paramètre Gimp pour qu'il puisse utiliser Python.

LOCALISATION DE L ' ICÔNE MARINGOUIN DANS  W INDOW S 7
Il faut démarrer maringouin et paramétrer l'icône via Personnaliser …

file:///C:/Python26
http://www.pygtk.org/downloads.html
http://www.pygtk.org/
http://www.python.org/download/
http://www.python.org/
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AVANT D'UTILISER G IMP, QUELQUES NOTIONS FONDAMENTALES

L' IMAGE EN INFORMATIQUE  OU EN ÉLECTRONIQUE

Cette image est obtenue par des scanners, des appareils photographiques, des cameras, des cartes 
d'acquisition, des logiciels (dessins, 3D, etc.) puis elle est stockée dans l'ordinateur.

C'est cette image qui sera traitée ou créée dans Gimp.

L'image est caractérisée pas ses dimensions, son nombre de couleurs et son type de codage (bitmap ou 
vectoriel).

LES DIMENSIONS DE L ' IMAGE

LES  PIXELS

Le terme pixel est le diminutif de l'expression anglaise « picture element ».

L'image est caractérisée par une hauteur et une largeur exprimée généralement en pixels ou points. Par 
exemple, un écran d'ordinateur 1280*1024 affiche des images de 1280 pixels en largeur sur 1024 pixels en 
hauteur.

LA  RÉSOLUTION

La résolution est le nombre de pixels ou points par unité de longueur. L'unité de longueur est souvent 
exprimée en pouces (1 pouce = 2,54 cm).

Quelques résolutions souvent utilisées :

– Écrans d'ordinateurs => 96 pixels par pouce (ppp).

– Images Web => 72 ppp.

– Télécopies => 200 ppp

– Images à imprimer => 300ppp et +.

LES COULEURS DE L ' IMAGE DANS  G IMP

Gimp gère bien ces modes de couleurs pour ouvrir et traiter les images :

– RVB   (Rouge, Vert, Bleu) et TSV (Teinte, Saturation, Valeur).

– Niveaux de Gris.

– Couleurs indexées.

– CMJN   (Cyan, Magenta, Jaune, Noir), utilisé dans l'imprimerie, où chaque canal est codé de 0 à 100.

LES  CODAGES  RVB
Le codage RVB est très utilisé dans l'électronique des écrans. Dans Gimp 

chaque canal de couleur est codée sur 8 bits soit 256 valeurs (0 à 255 en décimal 
ou 00 à FF en hexadécimal).

Le noir correspond à 0,0,0 en décimal ou 000000 en hexadécimal et le blanc à 
255,255,255 en décimal ou ffffff en hexadécimal.

Dans d'autres logiciels le codage RVB peut être différent. Un bleu codé 
74,204,211 en décimal (4accd3 en hexa.) sera codée 4902099 ce qui correspond 
à la valeur décimale pure de 4accd3 en hexa ou à [{74*256*256} + {204*256} 
+ 211].

Pour améliorer le rendu des images le codage des couleurs peut se faire sur un plus grand nombre de bits.

http://fr.wikipedia.org/wiki/Quadrichromie
http://fr.wikipedia.org/wiki/Teinte_Saturation_Valeur
http://fr.wikipedia.org/wiki/Rouge_vert_bleu
http://fr.wikipedia.org/wiki/Picture_Element
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Imagemagick traite des images codées sur 16 bits.

Le nombre maximum de couleurs avec le codage sur 8 bits est 16 777 216 d’où le terme 16 millions de 
couleurs.

Dans le codage RVBA, un canal « Alpha » est ajoutée au codage RVB. Il définit le niveau de la 
transparence. Le codage de ce canal est sur 256 valeurs de 0 à 255. La valeur 255 correspond à la 
transparence totale.

Exemple : Dans Gimp, nous pouvons ajouter un canal alpha à un calque : Sur la fenêtre de l'image RVB 
faire : Calque > Transparence > Ajouter un canal alpha .

N IVEAU  DE  GRIS

Dans Gimp, une image en niveau de gris, a un canal de 256 niveaux de gris (max.).

COULEURS  INDEXÉES

Une image à couleurs indexées utilise une palette de couleurs.

Elle peut aussi avoir de la transparence.

L'indexation des couleurs permet de diminuer le volume des fichiers gif 
(256 couleurs max.), png.

PASSAGE  D 'UN  MODE  À UN  AUTRE

Dans Gimp, nous pouvons changer le mode d'une image (RVB, niveaux de gris, couleurs indexées) : Sur la 
fenêtre de l'image faire : Image > Mode > Choisir le mode.

CMJN
Voici quelques informations pour obtenir des images CMJN (réalisation de 

travaux d'imprimerie).

Le greffon Separate+ permet de décomposer une image en mode CMJN et 
d'appliquer un profil ICC (testé avec la version de développement gimp 2.5.4).

1/ Télécharger le greffon créé par Alastair M. Robinson et amélioré par 
Yoshinori Yamakawa  à partir de la page 
http://cue.yellowmagic.info/softwares/separate.html . Télécharger liblcms-
1.dll.zip et separate+-0.5.2.zip au bas de la page. Décompresser et installer 
separate.exe , separate_import.exe , icc_colorspace.exe et liblcms-1.dll dans le 

répertoire des plug-ins (...\lib\gimp\2.0\plug-ins). Installer les deux script-fu quickproof.scm et quicksave.scm (du 
répertoire separate+-0.5.2\sample-scripts\for_GIMP2.3+) dans le répertoire des scripts-fu de gimp ().

2/ Télécharger des profils ICC offerts par la société Adobe 
(http://www.adobe.com/support/downloads/product.jsp?product=62&platform=Windows) et décompresser 
dans un répertoire. Noter l'emplacement des profils ICC.

3/ Dans Gimp, à partir de l'image, faire : Image > Separate et choisir une des options Duotone, Separate. 
Dans la petite fenêtre de sélection des profils : Source Profile = un chemin vers un profil RGB , Destination 
Profile = un chemin vers un profil CMJN (CMYK). Pour visualiser la nouvelle image  à l'écran utiliser 
l'option Proof qui donne de bons résultats.

http://www.adobe.com/support/downloads/product.jsp?product=62&platform=Windows
http://cue.yellowmagic.info/softwares/separate.html
http://www.imagemagick.org/
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La sélection des profils ICC utilisés lors de la conversion est très importante car elle agit sur les couleurs.  
Une image CMJN est imprimable et différente d'une image RVB où les couleurs ne sont pas toutes 
imprimables. Pour échanger des images TIFF CMJN codées avec le greffon Separate, nous pouvons indiquer 
les profils ICC utilisés. 

Pour créer une image TIFF CMJN :

– 1) Sur l'image à convertir : Image > Separate > Separate (choisir les 2 profils RVB et CMJN).

– 2) Sur la nouvelle image où les calques sont les négatifs des canaux CMJN : Image, Separate, Save (.tif).

– 3) Fermer et Enregistrer sous .xcf ou .xcf.bz2 pour ne pas écraser l'image TIFF.

LES MOTS POUR DÉSIGNER LES COULEURS

Des tests de perception ont montré que l'homme pouvait distinguer deux millions de couleurs  
différenciées par leur teinte, leur pureté et leur brillance. La plupart des langues ne disposent  
toutefois que d'une palette de mots très réduite pour les désigner, même si, en recourant à des  
métaphores ou à des mots composés, la langue française, par exemple, permet de nommer  
environ 3 000 coloris. Le bleu se décline ainsi en aigue-marine, azur, céruléen, lapis-lazuli,  
outremer, pensée ou pervenche... tandis que le rose se conjugue en aurore, rose chair,  
incarnadin, cuisse-de-nymphe, rose bonbon, guimauve ou crevette... (Dictionnaire des mots et 
expressions de couleur du XXe siècle, par Annie Mollard-Desfour, CNRS Editions).

Les Esquimaux, dont la langue est agglutinante, usent de plusieurs dizaines de locutions pour  
désigner différentes tonalités de blanc. Une richesse lexicale adaptée aux exigences de la vie et  
de la vue dans un univers glacé (Extrait d'un article paru dans l'édition Web le 29 septembre 2004 du 
journal Le Monde).

Voici quelques correspondances « mot/codage RVB sur 8 bits » utilisées en photographie numérique :

– Blanc (255,255,255 - hexa ffffff) et son complémentaire le noir (0,0,0 – hexa 000000).

– Gris (128, 128, 128 - hexa 808080).

– Rouge (255,0,0 - hexa ff0000) et son complémentaire le cyan (0,255,255 – hexa 00ffff).

– Vert (0,255,0 – 00ff00) et son complémentaire le magenta (255,0,255 – hexa ff00ff).

– Bleu (0,0,255 – hexa 0000ff) et son complémentaire le jaune (255,255,0 – hexa ffff00).

Quelques documentations accessibles via Internet:

http://pourpre.com/ : Ce site propose des articles consacrés à la couleur: le phénomène physique, la 
perception des couleurs, la langue française et la couleur, des questions-réponses, un glossaire, une 
présentation des principaux modèles et nuanciers de couleurs, quelques jeux, une sélection de liens...

http://www.linuxgraphic.org/section2d/articles/couleurs/couleurs.pdf : De Toutes Les Couleurs par André 
Pascual

http://www.arnaudfrichphoto.com/gestion-des-couleurs/gestion-de-la-couleur.htm : Arnaud Frich 
Photographie. La Gestion des Couleurs.

http://www.tsi.enst.fr/tsi/enseignement/ressources/mti/RVB_ou_LAB/html/colorspace.html : Les espaces de 
couleur RVB et Lab.

http://www.poynton.com/PDFs/coloureq.pdf : Colour Space Conversions.

http://www.poynton.com/PDFs/coloureq.pdf
http://www.tsi.enst.fr/tsi/enseignement/ressources/mti/RVB_ou_LAB/html/colorspace.html
http://www.arnaudfrichphoto.com/gestion-des-couleurs/gestion-de-la-couleur.htm
http://www.linuxgraphic.org/section2d/articles/couleurs/couleurs.pdf%20
http://pourpre.com/
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ILLUSIONS DANS  LA PERCEPTION DES COULEURS

Edward H. Adelson du M.I.T. propose d'illustrer le fonctionnement de notre système visuel qui n'est pas 
aussi sensible que la pipette des couleurs de Gimp .

Dans cet exemple 
les carrés A et B 
ont la même 
couleur (gris 120, 
120, 120) !

D'autres tests sont accessibles via http://web.mit.edu/persci/ du Massachusetts Institute of Technology.

LES TYPES ET  LES FORMATS D ' IMAGE

Les logiciels, les fichiers, etc. utilisent deux grands types d'images ou une combinaison des deux :

– Les images bitmap ou images en mode point. Dans cette catégorie on retrouve les images JPG, PNG, 
GIF utilisées sur le Web.

– Les images vectorielles souvent utilisées dans les « clipart », les polices de caractères.

– La combinaison des deux dans des fichiers PDF, EPS, etc.

XCF
XCF [.xcf] est le format de Gimp. Ce format conserve les calques, les chemins, etc. et permet de 

s'échanger les travaux (.xcf.gz et .xcf.bz2 sont des fichiers XCF compressés).
Nota : Gimp utilise d'autres formats spécifiques pour son fonctionnement : GBR et GPB (brosses au format  

Gimp), GIH (brosses animées), GGR (dégradés), GPL (palettes), PAT (motifs).

http://web.mit.edu/persci/
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LES  FORMATS  POUR  LE WEB
Gimp est très adapté à la gestion de ces formats : 

– JPEG [.jpg] Joint Photographic Experts Group (http://www.w3.org/Graphics/JPEG/).

– PNG [.png] Portable Network Graphics (http://www.w3.org/TR/PNG/).

– GIF [.gif] Graphics Interchange Format (http://www.w3.org/Graphics/GIF/spec-gif89a.txt).

Gimp importe les chemins (path) et les dégradés (gradient) des fichiers SVG Scalable Vector Graphics 
(http://www.w3.org/TR/SVG/ ).

TIFF
Le format TIFF [.tif] Tagged Image File Format offre de très nombreuses possibilités de codages : 

Résolution, couleurs, multipages, fax, etc. C'est un bon format d'échange. Il est très pratique pour réaliser des 
images facilement importables dans les traitements de texte, P.A.O., etc.

Remarque : Dans Gimp, les pages d'un fichier TIF multipages sont considérées comme des calques. Pour 
voir chaque page il faut agir sur la visibilité des calques.

LES  FORMATS  D 'ADOBE

Gimp ouvre uniquement les formats documentés par la société Adobe en association avec Ghostscript 
(PS et EPS) et Poppler (PDF) : 

– PSD [.psd] Photoshop

– PS * [.ps] Postscript pour imprimantes.

– EPS * [.eps] Encapsulated PostScript pour échange entre applications.

– PDF * [.pdf] Portable Document Format pour publication électronique.

LES  IMAGES  ANIMÉES

Gimp permet de créer ou d'importer des animations GIF, MPEG et AVI via le greffon GAP (Gimp 
Animation Package) fourni dans l'archive que nous produisons.

LA GESTION DE LA COULEUR

L' International Color Consortium a été crée en 1993 par huit sociétés dans le but de créer, de promouvoir, et  
d'encourager la standardisation et le développement d'une architecture dédiée à la gestion de la couleur qui 
soit ouverte et indépendante des constructeurs et des plates-formes. Le résultat de cette coopération fut la 
création des spécifications du profil ICC. (extrait http://www.color.org)

Les profils ICC et ICM sont des fichiers contenant des données colorimétriques qui permettent à tous les 
matériels d'imagerie de pouvoir fonctionner harmonieusement, indépendamment des plates-formes :

– Écran.

– Imprimante, papier.

– Scanner.

– Appareil photo numérique, etc.

Ressource WEB : http://www.freecolormanagement.com/color/links.html  (Ressources libres).

Gimp 2.6.x exploite ces profils ICC.

http://www.freecolormanagement.com/color/links.html
http://www.color.org/
http://poppler.freedesktop.org/
http://www.ghostscript.com/
http://www.w3.org/TR/SVG/
http://www.w3.org/Graphics/GIF/spec-gif89a.txt
http://www.w3.org/TR/PNG/
http://www.w3.org/Graphics/JPEG/
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RÉGLAGES DE L 'ÉCRAN

Tous les écrans ne se ressemblent pas. Et le rendu des couleurs est rarement le même. La  
solution ? Calibrer votre moniteur, c'est-à-dire corriger le rendu des couleurs, au moyen des  
réglages intégrés ou d'un logiciel, de façon à ce que les documents à l'écran soient aussi fidèles  
que possible aux originaux...
Suite à la page http://pourpre.com/outils/calibration.php 

M IRES

http://www.inkjetart.com/custom/  Mires pour imprimantes.

http://www.digitaldog.net/files/Printer%20Test%20file.jpg  Mire Printer Test file.jpg (1)

http://www.galerie-photo.com/images/mire-16cm-RVB.jpg  La mire de galerie-photo.com (2)

http://www.qdigital-imaging.com/tutorials/pages/fuji_calibration_s.htm  Mire FujiFilm (3)

http://www.physics.ohio-state.edu/~kagan/new_toys/Test-Images/ Mire tss_printer_test.tif (4)

http://www.normankoren.com/printer_calibration.html Mire. PDI-Target.jpg (5)

http://www-2.cs.cmu.edu/~chuck/lennapg/lena_std.tif  Mire. Photo de Lena pour test de compression (6)

1 2 3 4 5 6

LES CALQUES

Dans les logiciels de création graphique, les calques sont des couches transparentes superposées où sur 
chaque couche est déposée une image.

Dans Gimp le calque de fond s'appelle Arrière-plan. Selon le mode, l'opacité, la visibilité le résultat de 
l'image visible variera. 

Voici deux exemples d'une image à 3 calques où le calque de fond est gris très foncé [ 25, 25, 25 ] , le calque 
du milieu est transparent avec un carré gris [ 100, 100, 100 ] et le calque du dessus est transparent avec un 

http://www-2.cs.cmu.edu/~chuck/lennapg/lena_std.tif
http://www.normankoren.com/printer_calibration.html
http://www.physics.ohio-state.edu/~kagan/new_toys/Test-Images/
http://www.qdigital-imaging.com/tutorials/pages/fuji_calibration_s.htm
http://www.galerie-photo.com/images/mire-16cm-RVB.jpg
http://www.digitaldog.net/files/Printer%20Test%20file.jpg
http://www.inkjetart.com/custom/
http://pourpre.com/outils/calibration.php
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cercle brun [ 100, 50, 25 ].

Résultat avec mode = normal , opacité = 100, tous les calques sont 
visibles.
Les 3 couleurs sont (R, V, B décimal) :

Fond = [ 25 , 25, 25 ]

Carré = [ 100, 100, 100 ]

Cercle = [ 100, 50, 25 ]

Résultat avec mode = normal pour le fond / mode = addition pour le 
carré et le cercle, opacité = 100, tous les calques sont visibles :

Les 4 couleurs sont (R, V, B décimal) :

Fond = [ 25 , 25, 25 ]

Carré = [ 125, 125, 125 ] = [ 25, 25, 25 ] + [ 100, 100, 100 ]

Cercle = [ 125, 75, 50 ] = [ 25, 25, 25 ] + [ 100, 50, 25 ]

Intersection cercle/carré = [ 225, 175, 150 ] = [ 25, 25, 25 ] + [ 100, 100, 
100 ] + [ 100, 50, 25 ]

La fenêtre des calques de l'exemple 2.
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L'AIDE DE G IMP

L'aide en français que nous fournissons avec notre archive est celle du site http://docs.gimp.org/ (GNU Free 
Documentation licence, version 1.2).

Cette aide est compilée au format CHM pour avoir de meilleures options de recherche. 
Elle est directement accessible à partir de Gimp par le menu d'aide, les boutons d'aide, la touche de fonction 
F1 et par la combinaison Shift+F1 pour l'aide contextuelle. 

L'aide au format CHM est expérimentale.

Le fichier d'aide en français gimp_2_6_fr.chm est dans le répertoire gimp_2_6_9\bin.

L'archive que nous proposons est aussi prête pour recevoir l'aide en anglais au format CHM. Il suffit  
d'installer le fichier gimp_2_6_en.chm dans le répertoire gimp_2_6_9\bin (Où se trouve l'aide en français). 
Cette aide sera compilée est disponible en téléchargement, à la page : 

 http://www.aljacom.com/~gimp/doc_gimp.html

PRINCIPE DE L 'ACCÈS À L 'AIDE INTERNET ET  CHM
La configuration sur Gimp de l'accès à l'aide se fait via la fenêtre « Éditeur d'images Gimp » ou la fenêtre de 

l'image par Édition > Préférences et par la sélection de l'onglet Système d'aide sur la fenêtre « Préférences ». 
Paramétrer comme indiqué dans la copie d'écran pour l'accès à l'aide CHM et valider :

L'accès à l'aide via Internet se fait de deux façons :

– En paramétrant Manuel de l'utilisateur = Utiliser la version en ligne.

– Sur notre archive, si les fichiers gimp_2_6_fr.chm ou gimp_2_6_en.chm ne sont pas trouvés dans le 
répertoire gimp_2_6_9\bin avec l'option « Utiliser une copie locale » validée, l'aide via Internet sera 
automatiquement activée.

http://www.aljacom.com/~gimp/doc_gimp.html
http://www.gnu.org/copyleft/fdl.html
http://www.gnu.org/copyleft/fdl.html
http://docs.gimp.org/
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LES « GLISSER-DÉPOSER »  DANS G IMP

FONCTIONNEMENT  DU  « GLISSER-DÉPOSER   » OU « DRAG  AND DROP »
Pour glisser un objet sur un autre :

– Clic sur un objet.

– Maintient du bouton de la souris enfoncé.

– Déplacement avec la souris vers l'objet cible.

– Relâchement du bouton de la souris.

EXEMPLES

EXPLORATEUR  W INDOW S VERS  G IMP

Glisser le fichier image lu ou vu dans l'explorateur Windows vers la fenêtre « Boîte à outils » ou la fenêtre 
« Éditeur d'images Gimp »  sur la tête de la mascotte pour ouvrir ce fichier dans Gimp.

Glisser le fichier image lu ou vu dans l'explorateur Windows vers la « fenêtre d'une image » de Gimp pour 
mettre ce fichier comme calque(s) supplémentaire(s).

MOTIF ,COULEUR

Remplir une image, une sélection : Glisser-déposer le motif ou la couleur dans l'image ou la sélection.

CALQUE

Ajouter un calque sur une autre image : Sélectionner le calque dans la fenêtre « Calques », Glisser-déposer 
ce calque sur l'autre image.

Créer une nouvelle image à partir d'un calque : Sélectionner le calque dans la fenêtre « Calques », Glisser-
déposer ce calque sur les outils de la « Boîte à outils » .

CHEMIN

Ajouter un chemin sur une autre image : Sélectionner le chemin dans la fenêtre « Chemins », Glisser-
déposer ce chemin sur l'autre image.

NOM  DE  FICHIER

Ajouter une image à partir du nom d'un fichier de la « fenêtre Ouvrir une image » sur une autre image : 
Sélectionner le nom du fichier dans la fenêtre « Ouvrir une image », Glisser-déposer ce nom de fichier sur 
l'autre image.

LES  FENÊTRES  DE  G IMP

Dans Gimp nous pouvons créer une (ou des) fenêtre(s) dans laquelle nous regroupons des fonctions.

Exemple : Ajouter la « console d'erreurs » dans l'ensemble 
« Calques, Canaux, Chemins... »

Sur la fenêtre « Éditeur d'images Gimp » ou sur la fenêtre de 
l'image faire :  Fenêtres > Fenêtres ancrables > Console d'erreurs. 

Glisser la fenêtre « Erreurs » sur « Calques, Canaux, 
Chemins... »
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FENÊTRES DE G IMP

Voici les fenêtres de GIMP lors de la première ouverture du programme.

Pour obtenir l'aide  au format CHM (fournie dans notre archive), selon les fenêtres actives, appuyer sur le 
bouton Aide, sur la touche de fonction F1. 

L'aide contextuelle s'obtient par la combinaison de touches Shift+F1 puis un clic sur un outil.
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LA FENÊTRE « BOÎTE À OUTILS »
Sur cette fenêtre nous retrouvons une grande partie des outils ainsi que leur paramétrages, les couleurs de 

premier plan et d'arrière plan, le motif actif, le dégradé actif, la brosse active, l'image active, la gestion des 
options tout en bas.

RÉDUIRE LA TAILLE DE  CETTE  FENÊTRE  EN  MODIFIANT  LE  THÈME

Pour réduire la taille de la fenêtre « Boite à outils »,  à partir de la fenêtre « Éditeur d'images Gimp » ou de 
la fenêtre de l'image faire : Édition > Préférences et sur la fenêtre « Préférences » activer l'onglet « Thème ». 
Valider Small et appuyer sur le bouton « Valider »

Avant (Default)                                           Après (small)

Des thèmes supplémentaires sont fournis avec notre archive, par exemple le thème Tango permet de réduire 
beaucoup les dimensions.

Voir chapitre « Thèmes pour Gimp à télécharger » page 349

LA FENÊTRE « CALQUES, CANAUX , CHEMINS, ANNULER  ... »
Si cet ensemble n'est pas visible, à partir de la fenêtre « Boîte à outils » , faire : Fenêtres > Fenêtres 

ancrables récemment fermées > Calques, Canaux , Chemins ...

Nota : Les petits boutons au bas de ces fenêtres peuvent avoir plusieurs fonctions en les combinant avec les 
touches Maj, Shift, Ctrl, etc. (appui sur la touche + clic sur le bouton). Les fonctions sont indiquées lorsque le 
curseur de la souris passe sur le bouton.
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LA FENÊTRE « ÉDITEUR  D ' IMAGE  G IMP » OU FENÊTRE DE L ' IMAGE

C'est à partir de cette fenêtre que nous retrouvons les menus pour accéder aux différentes fonctions de Gimp. 

Il y aura autant de fenêtres que d'images ouvertes. Pour faciliter la sélection entre les images nous pouvons 
changer l'image active par Fenêtres > Nom de l'image et/ou activer la fenêtre Images par Fenêtres > Fenêtres 
ancrables > Images

DÉPLACER  UNE  IMAGE  DANS LE CADRE

Si l'image ouverte est plus grande que le cadre, pour déplacer cette image nous pouvons :

– Utiliser les ascenseurs horizontaux et verticaux.

– Sur l'image, appuyer sur la molette de la souris et en même temps déplacer le curseur en forme de croix.

– Faire un clic sur la petite croix dans le coin en bas à droite de la fenêtre et déplacer le curseur en forme 
de croix dans la miniature.

ZOOM

Pour utiliser le zoom :

– Entrer une valeur numérique.

– Utiliser les touches + ou – du pavé numérique.



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 17 / 391
 Fenêtres de Gimp 

METTRE LA FENÊTRE « BOÎTE À OUTILS » TOUJOURS AU 1ER PLAN

Maringouin permet de placer la fenêtre « Boîte à outils » toujours au premier plan.

Nous pouvons démarrer maringouin.exe , valider l'option « Outils autour de Gimp > Fenêtre Boîte à outils de 
Gimp au 1er plan » et démarrer Gimp par Démarrer Gimp . Nous pouvons activer ou désactiver cette fonction 
ainsi que modifier le niveau de transparence sans fermer Gimp dans Outils autour de Gimp.

Nous pouvons aussi éditer maringouin_ahk.ini , mettre la clef fenetre_gimp_premier_plan_defaut = 1 ainsi que 
la clef pourcentage_transparence_fenetre_principale =0 et démarrer Gimp en utilisant un des fichiers .bat 
(gimp_en_francais_disque_dur.bat par exemple).

Nota : Une fonction différente existe dans Gimp (Préférences > Gestion des fenêtres > Garder au dessus).
 Lorsque nous utilisons cette possibilité, il faut appuyer sur la touche   Tab   pour activer ou désactiver  
 la fenêtre des outils, la fenêtre des calques, canaux...

UNE OU DES FENÊTRES  SELON NOS GOÛTS

PERSONNALISER  LA FENÊTRE  « BOÎTE  À OUTILS  »
Dans Gimp nous pouvons modifier, créer une (ou des) fenêtre dans laquelle nous regroupons des fonctions.

Exemple : Glisser et déposer (définition page 13  )   la fenêtre « Images » dans la fenêtre « Boîte à outils » .

– Activer la fenêtre « Images » par Fenêtres > Fenêtres ancrables > Images

– Clisser et déposer cette fenêtre « Images » à cet endroit :
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– Résultat : 

Le même principe (glisser-déposer d'une fenêtre de Gimp) s'applique à beaucoup de fenêtres (sauf à la 
fenêtre de l'image). 

PERSONNALISER  LES INFORMATI ONS  APPARAISSANT DANS LA FENÊTRE  DE  L ' IMAGE

Pour modifier les informations apparaissant dans la fenêtre de l'image (titre, barre d'état), à partir de la 
fenêtre « Éditeur d'images Gimp » ou de la fenêtre de l'image faire : Édition > Préférences et sur la fenêtre 
« Préférences » activer l'onglet « Fenêtres d'images » / « Titre et état ». Modifier les valeurs et appuyer sur le 
bouton « Valider ».

Les valeurs par défaut sont :

– Format du titre de l'image = %D*%f-%p.%i (%t, %L) %wx%h  (Ajoute une * si l'image est modifiée, le 
nom du fichier, un tiret, identifiant de l'image, point, numéro de la vue, espace, parenthèse ouverture, type 
d'image, virgule, nombre de calques,  parenthèse fermeture, espace, largeur en pixels , x, hauteur en 
pixels).

– Format de la barre d'état de l'image =  %n (%m)  (Nom du calque, espace, parenthèse ouverture, mémoire 
utilisée par l'image, parenthèse fermeture).  

Variable Signification
%f Nom du fichier contenant l'image ou "Sans titre"

%F Chemin complet du fichier ou "Sans titre"

%p Identifiant de l'image (ce nombre est unique)

%i Numéro de la vue pour une image qui possède plusieurs vues

%t Type d'image (RVB, niveaux de gris, indexée)

%z Facteur de zoom en pourcentage

%s Facteur d'agrandissement de la source (niveau de zoom = %d/%s)

%d Facteur d'agrandissement de la destination (niveau de zoom = %d/%s)

%D* Affiche * si l'image a été modifiée, rien sinon
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%C* Affiche * si l'image n'a pas été modifiée, rien sinon

%l Le nombre de calques

%L Le nombre de calques (chaîne complète)

%m Mémoire utilisée par l'image

%n Nom du calque ou du canal actif

%P Identifiant du calque ou du canal actif

%w Largeur de l'image en pixels

%W Largeur de l'image en unités réelles

%h Hauteur de l'image en pixels

%H Hauteur de l'image en unités réelles

%u Symbole de l'unité (par exemple px pour Pixel)

%U Abréviation de l'unité

%% Le symbole "%"

Exemple de modification :

Format du titre de l'image =  
%f-%p.%i - mode %t - zoom %d:%s

Format de la barre d'état de l'image =
 %f-%p.%i (%t) (%wx%h) mem:%m
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AJOUTER UNE FENÊTRE DE FOND VIA MARINGOUIN

Pour faire des copies d'écran il est utile de disposer d'un fond uni, blanc par exemple.
Démarrer Gimp via l'icône de maringouin : Démarrage Gimp > Démarrer en français. Attendre que Gimp soit 

démarré. 

Via l'icône de maringouin faire : Outils > Afficher fenêtre de fond. 

Pour modifier le couleur de cette fenêtre via l'icône de maringouin faire : Outils > Couleur de la fenêtre de 
fond. Pour obtenir de blanc paramétrer en RVB 255, 255, 255 et valider par le bouton OK.

Pour naviguer entre les fenêtres, appuyer sur la touche de clavier alt en la maintenant appuyée et faire défiler 
les fenêtres en appuyant sur la touche Tab. Relâcher les touches sur maringouin_fenetre_fond_xxxxxxxxx pour 
afficher la fenêtre de fond.

Toujours avec les touches alt et Tab activer la bonne fenêtre, PDF par exemple, et faire la copie d'écran. 

La fenêtre de fond se ferme via l'icône de maringouin faire : Outils > Afficher fenêtre de fond ou 
automatiquement à la fermeture de Gimp. 

Pour avoir une fenêtre de fond en blanc par défaut, modifier la clef couleur_fenetre_fond = ffffff dans 
maringouin_ahk.ini
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RACCOURCIS CLAVIER

La liste des raccourcis clavier est accessible à partir de la fenêtre « Éditeur d'images Gimp » ou de la fenêtre 
de l'image par : Édition > Raccourcis Clavier
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MENUS DE L' IMAGE (RÉSUMÉ)
Nous trouvons la description exhaustive des menus dans l'aide de Gimp au format CHM fournie avec 

l'archive (touche de fonction F1) ou disponible via Internet. Ce résumé regroupe les points importants.

MENU FICHIER

Le menu « Fichier » comporte toutes les options d'ouverture d'images, d'enregistrement, d'impression et 
de fermeture.

MENU ÉDITION

Le menu « Édition » comporte toutes les options de Copier-Coller, l'accès aux préférences, etc.

MENU SÉLECTION

Le menu « Sélection » comporte toutes les options des sélections, l'activation et la désactivation du 
masque rapide pour le détourage, etc.

MENU AFFICHAGE

Le menu « Affichage » comporte toutes les options pour personnaliser l'affichage.

MENU IMAGE

Le menu « Image » comporte des options de traitement de l'image. Ce menu est un peu un fourre-tout  où 
nous trouvons :

– Les modes RVB, Niveau de gris, Couleurs indexées.

– La partie visible de l'image, le canevas (taille, ajustement aux calques).

– Échelle et taille de l'image.

– Les options de découpage (automatique et futé).

– La fusion des calques visibles (Ctrl+M) pour obtenir un unique calque visible.

– Aplatir l'image qui est une fusion « extrême » des calques visibles pour obtenir une image avec un seul 
calque où les calques invisibles seront supprimés et les zones transparentes transformées dans la couleur 
d'arrière-plan.

– Aligner les calque visibles.

– Les propriétés de l'image.

– Les guides, les options du greffon CMJN Separate.

MENU CALQUE

Le menu « Calque » comporte toutes les opérations réalisables sur les calques.

MENU COULEURS

Le menu « Couleurs » comporte toutes les modifications des couleurs des images.

MENU OUTILS

Contient les outils de la fenêtre « Boite à outils ».

MENU F ILTRES

Le menu « Filtres »  contient des filtres de modification et de création d'images (greffons et scripts). Les 
filtres sont organisés par fonction.

http://fr.wikipedia.org/wiki/D%C3%A9tourage
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MENU V IDEO

Ce menu est créé lors de l'installation du greffon Gimp Animation Package G.A.P.

MENU FENÊTRES

Le menu  « Fenêtres » donne accès à la gestion des fenêtres.

MENU A IDE

Le menu « Aide » donne accès à l'aide, aux conseils du jour, à la fenêtre « À propos », aux navigateurs de 
greffons et  procédures, aux sites de Gimp par Internet.

MENUS SCRIPT-FU , PYTHON-FU ET MENUS  EXOTIQUES.
Ces menus ne devraient plus apparaître. Les accès aux fonctions devraient être répartis dans les menus 

précédents pour améliorer l'ergonomie du logiciel. Ce sont souvent des scripts anciens dont nous pouvons 
modifier l'accès via un éditeur de texte (Notepad++ par exemple).

http://notepad-plus.sourceforge.net/fr/site.htm
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RÉCUPÉRER UNE IMAGE

OUVRIR UN FICHIER CONTENANT  UNE IMAGE

V IA  LE  SÉLECTEUR  DE  FICHIER  DE  G IMP

Le sélecteur de fichiers de Gimp est un peu spécial pour les utilisateurs de Windows car il utilise GTK.

Pour ouvrir un fichier, à partir de la fenêtre « Éditeur d'image GIMP » ou de la fenêtre de l'image faire :

– Fichier > Ouvrir ou utiliser le raccourci Ctrl+O

– Sélectionner le répertoire (ici C:\images_gimp), le fichier contenant une image (ici 
image_a_3_calques.xcf.gz) et appuyer sur le bouton Ouvrir. Avec certains types de fichiers (PDF, EPS, 
PS, SVG, etc.) il faut configurer des options dans des fenêtres, lors de l'ouverture.

PAR  GLISSER-DÉPOSER

Voir « Explorateur Windows vers Gimp » page 13.

PAR  UN  CLIC  SUR  UN  FICHIER  IMAGE  OU  PAR  MENU  CONTEXTUEL

Voir « Associer des types d'images à Gimp, activer Gimp via un menu contextuel » page 3.

http://www.gtk.org/
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OUVRIR  UNE  IMAGE  QUI  CONTIENT  UN  PROFIL  ICC
Certaines images JPEG, TIFF, etc. contiennent des profils ICC qui modifient le rendu des couleurs.

Lors de l'ouverture de ce type d'image, Gimp avertit l'utilisateur par un message :

Pour obtenir l'image avec la correction apportée par le profil ICC il faut appuyer sur   Convertir  .  

Exemple : Résultat de la différence entre Convertir et Conserver sur l'image 2925887624_76f4fe031a.jpg 
disponible sur  http://flickr.com/photos/vancouverflavour/2925887624/ par vancouverflavour (CC)

http://flickr.com/photos/vancouverflavour/2925887624/
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À PARTIR D 'UN SCANNEUR, D 'UNE CAMÉRA , ETC.
– Démarrer le scanner.

– À partir de la fenêtre « Éditeur d'image GIMP » ou de la fenêtre de l'image faire : Fichier > Créer > 
Scanneur/Appareil photo... 

– Une fenêtre « Sélectionner une source » s'ouvre où nous devons sélectionner le bon périphérique selon la 
configuration de l'ordinateur.

– Dans la fenêtre du Scanner (peut varier suivant le type de scanner) : 
1 - Faire une pré-visualisation, appuyer sur le bouton Aperçu.
2 - Cadrer l’image.
3 - Définir le mode Couleur, Gris, N&B, Paramètres personnalisés.
4 - Ajuster la résolution, par exemple : 72 dpi pour le Web, 100 dpi, 150 dpi pour de la qualité
moyenne, 200 dpi pour créer un document de type fax., 300 dpi ou + pour de la bonne
qualité.
Régler les balances de noir et blanc, l’indice gamma, la luminosité.
Pour « scanner » une image tramée (journal par exemple) nous pouvons utiliser un filtre pour 
supprimer la trame (descreen en anglais) si disponible.

– Démarrer l’acquisition en appuyant sur le bouton Numériser.

– Attendre la numérisation, l'image se trouve dans Gimp.

      3 

2 

4 

  1  
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À PARTIR DE PRESSE-PAPIERS (COPIER-COLLER)
Nous pouvons visualiser le contenu du Presse-Papiers de Windows en utilisant clipbrd.exe (Depuis la barre 

d'outils de Windows faire : démarrer, Exécuter, clipbrd.exe, appuyer sur le bouton OK.

Copier une image ou une portion d'image dans le presse-papiers à partir d'une application (OpenOffice.org, 
Paint, Firefox, etc.). Exemple, à partir de Firefox, avec la bannière du site http://gimp.org/  (clic droit sur la 
bannière > Copier l'image).

Contenu du Presse-papiers :

Coller cette image dans Gimp à partir  de la fenêtre « Éditeur d'image GIMP » ou de la fenêtre de l'image 
faire : 

– Fichier > Créer > Depuis le presse-papiers (ou en utilisant le raccourci Shift+Ctrl+V)

– ou par  Édition > Coller comme > Nouvelle image

Nota : Dans le menu Édition > Coller comme nous avons plusieurs options permettant de coller cette image 
comme un nouveau calque, un nouveau motif ou une nouvelle brosse.

http://gimp.org/


www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 28 / 391
 Récupérer une image 

À PARTIR D 'UNE ADRESSE DE SITE WEB

Il suffit de trouver l'adresse d'une image dans son navigateur, de copier cette adresse et , sur Gimp, faire :
Fichier > Ouvrir suivant l'emplacement

Exemple : À Partir du site de Gimp (gimp.org). 

L'image s'ouvre dans Gimp
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COPIE D 'ÉCRAN

Pour améliorer les copies d'écran nous pouvons ajouter une fenêtre de fond via maringouin (page 20).

V IA  G IMP

– À partir de la fenêtre « Éditeur d'image GIMP » ou de la fenêtre de l'image faire : Fichier > Créer > 
Capture d'écran...

– Avec l'option « Capturer une fenêtre seule », après l'appui sur le bouton « Capturer »  une nouvelle 
fenêtre s'ouvre puis nous devons faire glisser la petite croix avec la souris sur le fenêtre que nous désirons 
capturer.

–  Avec l'option « Capturer l'écran entièrement » nous pouvons paramétrer un temps de pause. Après 
l'appui sur le bouton « Capturer »  plus le temps de pose, l'écran sera capturé.

V IA  LA  TOUCHE  IMP  ÉCR  OU  LA COMBINAISON  ALT  GR+ IMP  ÉCR

La touche du clavier imp écr permet de copier l'écran dans le presse papiers et la combinaison alt gr+imp écr 
permet de copier la fenêtre active  dans le presse papiers. Pour récupérer ces images dans Gimp voir « À 
partir de presse-papiers (copier-coller) » page 27.

V IA  MARINGOUIN

Si cette fonction est activée, c'est la touche  imp écr  du clavier qui réalisera la capture de l'écran et/ou de la 
fenêtre active. La capture est enregistrée dans un fichier qui peut s'ouvrir automatiquement dans Gimp.

Avec l'option Copie d'écran > Capturer l'écran avec le curseur, la capture de l'écran avec le curseur se fera 
en appuyant sur la touche «     Imp écr     » après avoir activé   Copie d'écran > Autoriser capture d'écran avec la 
touche Imp Écr.
Voir le chapitre « COPIE D'ÉCRAN » dans la notice maringouin.pdf.
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IMPRIMER UNE IMAGE

V IA G IMP

MÉTHODE  1 (CLASSIQUE  ET DÉCONSEILLÉE)
La méthode classique pour imprimer une image est de faire Fichier > Imprimer ou d'utiliser le raccourci Ctrl+P. 
Cette méthode donne de mauvais résultats sous Windows. Pour avoir une bonne qualité d'impression il faut 
utiliser une des 2 méthodes suivantes.

MÉTHODE  2 (VIA LE GREFFON  GUTENPRINT)
Le greffon Gutenprint est fourni dans l'archive que nous proposons en téléchargement. L'utilisation est  

décrite à la page 181  .  

V IA LE GESTIONNAIRE  D ' IMPRESSION DE W INDOW S

Le gestionnaire d'impression de Windows imprime sans problème des images BMP, JPG, PNG, etc.

Si l'image utilisée dans Gimp est sous un autre format nous pouvons enregistrer une version au format PNG 
par Fichier > Enregistrer sous ou utiliser le raccourci Shift+Ctrl+S.

À partir de l'explorateur Windows sélectionner la ou les images à imprimer, faire un clic droit sur la sélection 
> Imprimer. La fenêtre « Assistant Impression de photographies » s'ouvre. Il suffit de suivre les indications 
pour imprimer. 
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ENREGISTRER UNE IMAGE

Pour enregistrer l’image, à partir de la fenêtre de l'image, faire : Fichier > Enregistrer (raccourci Ctrl+S).

La fenêtre « Enregistrer l'image » s'affiche.

Donner un nom avec l’extension .xcf qui est le format de GIMP (ou d’autres formats PNG, JPEG, BMP, 
TIF, etc.), sélectionner un répertoire ou dossier et enregistrer. Dans l'exemple le nom de l'image est « 
mon_image.xcf », elle est enregistrée dans le répertoire C:\images_gimp.

Nous pouvons aussi:

– Enregistrer une copie   du fichier par Fichier > Enregistrer une copie. Le nom du fichier sera modifié. 
Dans Gimp l'image conservera l'ancien nom.

– Enregistrer sous   par : Fichier > Enregistrer sous (raccourci Shift+Ctrl+S). Le nom du fichier sera modifié. 
Dans Gimp l'image prendra le nouveau nom.

– Enregistrer comme modèle    par Fichier > Enregistrer comme modèle. Les   caractéristiques   de l'image   
seront mémorisées et disponibles lors de la création d'une nouvelle image avec le nom donné au 
modèle. Les données sont mémorisées dans le fichier templaterc du répertoire des préférences.
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PROPRIÉTÉS D'UNE IMAGE

Nous allons déterminer quelques propriétés de deux images en utilisant Gimp et maringouin :

– Dimensions avec Gimp.

– Profil ICC (page 9) ou pas avec Gimp.

– Nombre de couleurs avec Gimp.

– Données Exif, IPTC, informations de localisation GPS, etc. avec maringouin.

PROPRIÉTÉS D 'UNE IMAGE À PARTIR DE G IMP

Dans la fenêtre de l'image faire Image > Propriétés de l'image ou le raccourci alt + entrée qui affichera une 
fenêtre à 3 onglets (Propriétés , Profil de couleurs, Commentaires).

Dimensions                                Profil ICC

http://fr.wikipedia.org/wiki/Global_Positioning_System
http://en.wikipedia.org/wiki/IPTC_Information_Interchange_Model
http://fr.wikipedia.org/wiki/Exif
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Pour déterminer le nombre de couleurs dans la fenêtre de l'image faire Couleurs > Information > Analyse 
colorimétrique... 

DONNÉES  EXIF AVEC MARINGOUIN

Maringouin utilise les programmes utilitaires :

– ExifTool créé par Phil Harvey http://www.sno.phy.queensu.ca/~phil/exiftool/ 

– ExifTool Gui créé par Bogdan Hradtnik http://freeweb.siol.net/hrastni3/    

– Jhead http://www.sentex.net/~mwandel/jhead/ créé par Matthias Wandel (The software is public domain).

– Jpegtran   http://sylvana.net/jpegcrop/jpegtran/ 

À partir d'un clic sur l'icône de maringouin faire ExifTool Gui > Lancer ExifTool Gui , attendre le lancement de 
l'interface et sélectionner les images pour visualiser, modifier les données Exif, etc. contenues dans les 
images.

http://sylvana.net/jpegcrop/jpegtran/
http://www.sentex.net/~mwandel/jhead/
http://freeweb.siol.net/hrastni3/
http://www.sno.phy.queensu.ca/~phil/exiftool/
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DÉPLACER, ALIGNER

Nous aurons souvent besoin de déplacer ou d'aligner des objets sur les images. Deux outils sont utilisés pour 
réaliser ces opérations, l'outil de déplacement et l'outil d'alignement.

OUTIL DE DÉPLACEMENT

L'outil de déplacement est activé par le raccourci M ou par un clic sur sa représentation dans la boite à 
outils.

Cet outil permet de déplacer une sélection en cours, un texte, un chemin, un calque. Lors de son utilisation 
un petit symbole apparaît automatiquement lorsque nous passons la souris sur un objet ou lors de l'activation 
par le raccourci M.

 

Pour déplacer l'objet, lorsque le symbole est présent, il suffit de faire un clic, de maintenir ce clic et de 
déplacer la souris et de relâcher le clic.

Les options de l'outil de déplacement :

UTILISATION DE LA BARRE D 'ESPACEMENT  POUR LE DESSIN

Le déplacement de l'image dans la fenêtre de l'image peut être activé lord de l'utilisation des outils de dessin 
en appuyant sur la barre d'espacement sans perdre la dernière position du curseur de la souris pour pouvoir 
dessiner en continu sur des grandes images.
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OUTIL D 'ALIGNEMENT

L'outil d'alignement est activé par le raccourci Q ou par un clic sur sa représentation dans la boite à 
outils.

C'est un outil de déplacement automatique qui agit sur un ou plusieurs 
calques d'une image.

Les possibilités de déplacement sont dans les options de l'outil (À gauche, 
à droite, vers le bas, avec un décalage, etc.).

Voici un exemple sur une image à trois calques où 
nous souhaitons aligner les calques sur la gauche 
du calque rouge. Chaque calque correspond à une 
couleur.

Nous activons la calque rouge qui 
deviendra la référence dans la fenêtre des 
calques puis, sur l'image, l'outil d'alignement 
par le raccourci Q. Nous faisons un clic et les 
coins du calque sont matérialisés par des 
carrés verts. 

Nous appuyons sur la touche Shift, sélectionnons le calque jaune et, sur l'image, nous faisons un clic sur le 
jaune. Les coins sont matérialisés par des carrés verts. Il faut répéter la même opération pour le calque bleu.

Il suffit d'aller dans les options de l'outil d'alignement et d'appuyer sur le bouton « alignement gauche ».

                                                                   =
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METTRE UN TEXTE SUR UNE IMAGE

Gimp permet de mettre des petits textes sur des images, et de créer des effets à partir de textes. 
Pour avoir de meilleurs résultats il est préférable d'utiliser un logiciel de PAO comme Scribus ou un 
traitement de texte comme OO.o.
Le logiciel de dessin vectoriel Inkscape permet aussi de créer des textes en SVG (vectoriel) qui peuvent être 
importés dans Scribus.

LES POLICES DE CARACTÈRES

Par défaut, Gimp utilise les polices de caractères de Windows. Il va les chercher dans [répertoire de 
Windows]\Fonts. Pour ajouter des polices de caractères nous pouvons les installer dans ce répertoire et elles 
seront disponibles pour toutes les applications de notre ordinateur. Nous pouvons aussi avoir une version 
nomade de Gimp et les installer dans un répertoire spécifique reconnu par Gimp ou par d'autres applications. 

Exemple : Installation de polices dans le répertoire « Préférences nomades (1) » utilisé par maringouin.

– Nous devons avoir démarré Gimp au moins une fois   par gimp_en_francais_nomades_1.bat ou par un 
clic sur l'icône de maringouin en validant Préférences utilisées par Gimp > Préférences nomades (1) puis en 
démarrant Gimp par Démarrage Gimp > Démarrer en français.

– Dans ce cas, le répertoire utilisé par Gimp pour ajouter des polices sera [Unité du disque 
nomade]:\gimp_2_6_9\pref_1\fonts. Nous pouvons vérifier ce répertoire via la fenêtre « Éditeur d'image 
GIMP » ou la fenêtre de l'image par Édition > Préférences, dans la fenêtre « Préférences » par Dossiers > 
Polices.

– Il suffit d'installer la ou les polices choisies, ici la police Ubuntu-Title créée par Andrew  Fitzsimon. 
Télécharger la version TTF à partir de ce lien http://www.volvoguy.net/ubuntu/Ubuntu-Title.ttf.bz2. 
Décompresser avec  7Zip (par exemple) et placer le fichier Ubuntu-Title.ttf directement dans le répertoire 
[Unité du disque nomade]:\gimp_2_6_9\pref_1\fonts. 

– Démarrer Gimp en utilisant le répertoire « Préférences nomades (1) » , par :
      gimp_en_francais_nomades_1.bat.

– La police est disponible dans Gimp :

Nota : Pour pouvoir modifier les textes des images au format Gimp (XCF, XCF.GZ, XCF.BZ2) sur un 
autre ordinateur,  il est nécessaire d'avoir la police de caractères utilisée lors de la création.

http://www.7-zip.org/
http://www.volvoguy.net/ubuntu/Ubuntu-Title.ttf.bz2
http://www.w3.org/Graphics/SVG/
http://inkscape.org/
http://fr.openoffice.org/
http://www.scribus.fr/
http://fr.wikipedia.org/wiki/Publication_assist%C3%A9e_par_ordinateur
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L'OUTIL TEXTE ET  SES OPTIONS

Pour faire apparaître les options de l'outil texte il suffit de faire un clic sur le A de la « Boîte à outils ».

Les paramètres associée à l'outil texte sont :

– La police (Sélection en appuyant sur le bouton).

– Le nom de la police.

– La taille des caractères et l'unité correspondante.

– Amélioration de la netteté pour les petits caractères.

– Ajuste l'espacement.

– Évite le crénelage sur les images RVB et niveau de 
gris (effet très limité sur les images à couleurs 
indexées).

– Couleur du texte.

– Alignement du texte (gauche, droite, centré, justifié).

– Retrait début de paragraphe.

– Espacement entre les lignes.

– Espacement entre les mots et les lettres.

– Mettre un texte le long d'un chemin.

– Créer un chemin à partir de texte pour modifier l'aspect 
des lettres par exemple.

Si un texte est présent, des options sont aussi accessibles 
via le menu «     Calque     » de la fenêtre de l'image  .

UN TEXTE SIMPLE  SUR UNE IMAGE

Exemple : Ajouter le mot GIMP sur la bannière du site http://gimp.org/ .

– Sur l'image utiliser le raccourci T.

– Avec le curseur tracer un rectangle approximatif qui contiendra le texte. Un texte long s'ajustera aux 
modifications des dimensions du rectangle (Largeur).

http://gimp.org/
http://fr.wikipedia.org/wiki/Cr%C3%A8nelage
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– Dans la fenêtre  « Éditeur de texte Gimp » taper GIMP et valider « Police sélectionnée ».

– Activer la fenêtre « Boîte à outils » et aller dans les options de l'outil texte.

– Choisir une police, par exemple Arial Black, avec le bouton « Aa » et le menu déroulant.

– Une taille, 120px.

– Valider « Indice d'ajustement » et « lissage ».

– Une couleur : Gris foncé 2f2f2f (RVB notation HTML).

– Un écart entre les lettres de 20.

– Résultat
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Pour « mélanger » le texte à l'image nous pouvons aller sur la fenêtre « Calques, Canaux... », sélectionner le 
calque de notre texte et modifier le mode et l'opacité. Exemple avec le mode « Extraction de grain » et une 
opacité de 60.

MODIFIER UN TEXTE

Lorsque nous créons un texte avec Gimp, celui-ci est contenu dans un calque. Pour modifier ce texte il suffit  
de sélectionner le calque correspondant dans la fenêtre « Calques, Canaux, Chemins... » et :

– faire un double clic sur la miniature du texte sur le calque ou,

– aller sur l'image, sélectionner l'outil texte (raccourci T), faire deux clics sur le texte. 

La fenêtre d'édition « Éditeur de texte Gimp » apparaît. Il suffit de modifier le texte à l'intérieur de cette 
fenêtre.

Pour les polices de caractères voir nota page 36.

DÉPLACER  UN TEXTE

Pour déplacer un texte il suffit de sélectionner le calque correspondant dans la fenêtre « Calques, Canaux, 
Chemins... ». Faire un double clic sur la miniature du calque ou aller sur l'image, sélectionner l'outil texte 
(raccourci T), faire un clic sur le texte. Il faut se déplacer dans le rectangle du texte pour voir la petite 
croix de déplacement. Faire un clic et maintenir la touche enfoncée, déplacer le rectangle. 
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UN TEXTE QUI  SUIT UN CHEMIN

– Dans un premier temps nous devons créer un texte comme indiqué à la page 37.
Exemple : Image à fond blanc de 600*150 pixels, police = Arial / Taille = 36

– Ensuite, nous devons créer un chemin. Nous pouvons transformer une sélection en chemin (sur l'image 
faire Sélection > Vers chemin) ou utiliser l'outil chemin (raccourci B page 78). Nous utilisons la deuxième 
méthode pour tracer des dents de scie. Le chemin « Sans nom » s'affiche dans l'onglet « Chemins ».

– Nous sélectionnons l'onglet « Calques » de la fenêtre « Calques, Canaux, Chemins.. ». 

– Nous sélectionnons le calque du texte et nous faisons un double clic sur la miniature du texte (la fenêtre  
« Éditeur de texte GIMP » s'affiche ».

– Sur la boîte à outils dans option de l'outil texte appuyer sur le bouton « Texte le long d'un chemin ». 
Cette action va créer un nouveau chemin (Q W E R T Y 0 1 2 3 4 5 6 7 8...).

– Par la suite il suffit d'appliquer des transformations à ce nouveau chemin : Chemin vers sélection, 
Peindre le long d'un chemin. 
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MODIFIER UNE LETTRE

– Dans un premier temps nous devons créer la lettre K comme indiqué à la page 37  .  
Exemple : Image à fond blanc de 120*120 pixels, police = Arial Black / Taille = 112

– Sur la boîte à outils dans option de l'outil texte appuyer sur le bouton « Créer un chemin depuis le 
texte ». Cette action va créer un nouveau chemin (K).

– Rendre invisible le calque du texte en supprimant l'oeil (clic).

– Aller sur l'onglet chemins et rendre le chemin K visible.

– Sur l'image sélectionner l'outil Chemin par le raccourci B et faire un clic 
sur le centre de la lettre K pour visualiser les 12 points de la lettre.

– Sélectionner un point, faire apparaître les poignées pour les pivoter 
et les tirer afin d'obtenir une courbe. Par la suite il suffit d'appliquer 
des transformations à ce chemin modifié : Chemin vers sélection, Peindre le long d'un chemin. 

Exemple d'un effet « Peindre le 
long d'un chemin » qui peut être 
utilisé comme lettrine : 
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HALO AUTOUR  D 'UN TEXTE

Exemple : Mettre un halo blanc sur un texte en noir sur un fond noir.

Le halo est un « Flou mosaïque » que nous ajouterons autour des lettres.

– Créer une image à fond transparent (250*100 pixels).

– Créer un texte en blanc (Police =Arial black , taille = 60pixels). Le blanc deviendra la couleur du halo.

– Dupliquer le calque de texte par le raccourci Shift+Ctrl+D, le calque GIMP#1 est créé.

– Aller sur la fenêtre « Calques, Canaux, Chemins... » dans l'onglet « Calque ». Sélectionner le calque 
« GIMP » .

– Sur l'image faire : Calque > Fusionner vers le bas .

– Pour ajouter un halo, sur l'image faire Filtres > Flou > Flou mosaïque... Dans la fenêtre « Script-Fu : Flou 
mosaïque » paramétrer Rayon = 40, valider verticalement et horizontalement, type de flou = IIR.

– Aller sur la fenêtre « Calques, Canaux, Chemins... » , sélectionner le calque  GIMP#1, faire un double 
clic sur la miniature du texte. Dans la fenêtre « Boite à outils » modifier la couleur en noir (000000 en 
notation HTML) qui deviendra la couleur du texte.

– Sur l'image, créer un nouveau calque par le raccourci Shift+Ctrl+N, dans la fenêtre « Nouveau calque » 
valider « Couleur de premier plan »  qui deviendra la couleur du fond.

– Aller sur la fenêtre « Calques, Canaux, Chemins... » , sélectionner le calque « Nouveau calque » tout 
noir et le descendre au bas de la pile.



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 43 / 391
 Mettre un texte sur une image 

Résultat :

REMPLIR  UN TEXTE AVEC  UNE IMAGE

Exemple : Remplir un texte (LÉOPARD) avec un motif (leopard.pat fourni avec Gimp) sur un fond noir.

Notas : Pour faire apparaître l'image d'un motif au 
format .pat, activer l'onglet motif dans la partie basse 
de la fenêtre « Calques, Canaux, Chemins... ». Faire 
un clic droit sur le motif choisi > Ouvrir le motif en tant 
qu'image. 

 Nous pouvons aussi créer des motifs à partir 
d'images, de contenu de presse-papiers, de copier 
visible. 

– Créer une image à fond noir (400*150 pixels).

– Créer un texte en blanc (Police =Arial black , taille = 60pixels). 

– Sur la boîte à outils appuyer sur le bouton « Créer un chemin depuis le texte ».
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– Aller sur la fenêtre « Calques, Canaux, Chemins... ».

– Dans l'onglet « Calques », rendre invisible le calque du texte en supprimant l'œil.

– Dans l'onglet « Chemins », clic droit sur le chemin >  Chemin vers sélection, Le contour des lettres 
devient la sélection active.

– Dans l'onglet « Calques », activer le calque « Arrière plan ».

– Sur la boîte à outils activer le motif « leopard » par : clic sur le motif actif > clic sur le motif « leopard ».

– Depuis la boîte à outils, glisser-déposer le motif actif vers la sélection active de l'image.
Remarque : Il est possible de glisser-déposer une couleur dans la sélection active.

– Le texte seul obtenu par : Édition > Copier ou Ctrl+C puis Édition > Coller comme > Nouvelle image ou 
Shift+Crtl+V. Aplatir la nouvelle image par Image > Aplatir l'image (Définition page 22) .
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F ILTRES « ALPHA  VERS LOGO »
Ces exemples sont réalisés à partir d'une image transparente sue laquelle un texte en noir est ajouté. Pour 

trouver ces filtres à partir le l'image il suffit de faire Filtres > Alpha vers logo > nom du filtre. Les réglages sont 
ceux proposés par défaut. Pour améliorer il peut être utile d'ajouter un ou des espaces au début du texte.

BASIQUE  I

BASIQUE  II

B ISEAU  GRADUEL

BOVINATION

CHAUD  ROUGEOYANT

CHROME
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CONTOUR  3D

ÉCLATÉ

G IVRÉ

GLACÉ

LUEUR  EXTÉRIEURE
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MÉLANGÉ

NÉON  EXTÉRIEUR

NÉON

TEXTURÉ

TRACÉ DE  PARTICULES

SCRIPTS ACCESSIBLES  PAR LE MENU CRÉER

Les mêmes scripts décrits dans le paragraphe précédent (Filtres « Alpha Vers Logo ») sont aussi accessibles 
sur la fenêtre « Éditeur d'image GIMP » ou la fenêtre de l'image par Fichier > Créer > Logos  
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MODIFIER LES DIMENSIONS

MODIFIER LES DIMENSIONS D 'UNE IMAGE

Avec Gimp et maringouin/Freeimage nous disposons de 10 filtres d'interpolation.

Voici des comparaisons en agrandissant une image de 40*40 pixels à 311*311 pixels. Origine = 

Gimp Interpolation = Aucune                                           Gimp Interpolation = Linéaire  

Gimp Interpolation = Cubique                                    Gimp Interpolation = Sinc (Lanczos 3)  
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maringouin Interpolation = Box                                   maringouin Interpolation = Bicubic

maringouin Interpolation = Bilinear                           maringouin Interpolation = Bspline
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maringouin Interpolation = Catmull Rom                maringouin Interpolation = Lanczos 3

AVEC  G IMP

Méthode 1 : Pour modifier les dimensions, sur l'image faire : Image > Échelle et taille de l'image.

Pour garder un résultat proportionnel à l'origine il suffit de modifier la largeur ou la hauteur. 
Si le résultat n'est pas proportionnel à l'origine il faut faire un clic sur le symbole du lien et paramétrer les 
deux dimensions.

Choisir le type d'interpolation selon le résultat souhaité puis appuyer sur le bouton Échelle.
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Méthode 2 : Utiliser l'outil d'étirement ou de rétrécissement (raccourci Shift+T). 

Les options de cet outil doivent être paramétrées. 

L'effet de cet outil agit sur le calque, la sélection en cours, le chemin actif. Lorsque l'outil est activé, une 
fenêtre et un rectangle de sélection apparaissent. Nous pouvons modifier le rectangle de sélection et le 
déplacer selon les cas.

Pour valider la transformation appuyer sur le bouton « Échelle ».

Après un agrandissement nous devrons peut-être ajuster le canevas au calque par Image > Ajuster le canevas 
aux calques.

AVEC  MARINGOUIN

Maringouin utilise Freeimage ( http://freeimage.sourceforge.net/) pour dimensionner les images via deux 
options :

– Échelle, taille images en utilisant plusieurs filtres (Box, Bicubic, Bilinear, Bspline, Catmull Rom et 
Lanczos 3).

– Vignettes pour créer des miniatures.

Ces deux options sont accessibles via le menu ou en ligne de commande.

Le traitement par lot est possible.

L'utilisation est dans la documentation maringouin.pdf aux chapitres « ÉCHELLE DES IMAGES » et 
« VIGNETTE ("THUMBNAIL") ».

http://freeimage.sourceforge.net/
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MODIFIER LES DIMENSIONS D 'UN CALQUE

Les principes sont les mêmes que pour l'image, l'effet est applicable sur le calque actif.

Mise à l'échelle 2 du calque « Cercle_leopard » sur l'image par Calques > Échelle et taille du calque. Modifier 
la largeur, choisir un mode d'interpolation et valider par le bouton « Échelle ».

Résultat :
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LES COULEURS

COULEUR  D 'UN PIXEL OU D 'UNE AIRE

L'outil « pipette » accessible sur la fenêtre « Boite à outils » ou par le raccourci P permet de déterminer la 
couleur d'un pixel ou d'une aire sur l'image. Le curseur change suivant les options du « Mode de 
prélèvement ».

L'aire est définie dans les options de l'outil en validant l'option « Moyenne de voisinage » et le « rayon ».

L'option « Utiliser la fenêtre d'informations (maj) » donne une information directe sur la couleur ou la 
moyenne des couleurs captée par la pipette en plusieurs modes.

Les autres options de l'outil sont explicites.
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LE SÉLECTEUR DE COULEURS

Pour activer le sélecteur de couleurs faire un double clic sur la couleur de premier plan ou sur la couleur 
d'arrière plan.

Choisir une couleur en agissant sur les curseurs, les valeurs, etc.

PALETTE DE COULEURS

Les palettes de couleurs sont des fichiers avec l'extension .gpl .Elles comportent un nombre variable de 
couleurs.

Pour activer la fenêtre des palettes sur la fenêtre « Éditeur d'image GIMP » ou de la fenêtre de l'image faire 
Fenêtres > Fenêtres ancrables > Palettes.

Les couleurs de la palette active sont représentées dans le  le sélecteur de couleurs à partir de cet onglet.

Nous pouvons créer nos palettes à partir de ce bouton.
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LE NOMBRE DE COULEURS D 'UNE IMAGE

Pour déterminer le nombre de couleurs d'une image voir l'exemple page 33.

DÉGRADÉS  DE COULEURS

Les dégradés sont des variations de couleurs que nous pouvons appliquer sur les images, des sélections, des 
outils de peinture, etc.

Les dégradés de couleurs sont des fichiers avec l'extension .ggr

Pour afficher la fenêtre « Dégradés » faire un double clic sur le 
symbole des dégradés (au dessous des symboles brosse et motif) 
dans la fenêtre « Boîte à outils » ou utiliser le raccourci Ctrl+G.

Nous pouvons créer nos dégradés à partir de ce bouton.

Pour appliquer un dégradé sur une image utiliser l'outil de dégradé ou le raccourci L. Le rendu variera selon 
les options de l'outil dégradé.

Quelques formes :

Répétition dents de scie :
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LE MENU COULEURS FENÊTRE « ÉDITEUR D ' IMAGE GIMP » OU IMAGE

Outils de couleurs qui peuvent avoir des options dans la partie
basse de la « Boîte à outils »..

Filtres et informations.

Pour avoir une description exhaustive consulter l'aide contextuelle ou 
utiliser les boutons d'aide.

AJUSTER  LA  RÉPARTIT ION  DES COULEURS

Sur l'image faire Couleurs > Balance des couleurs.

Les tonalités de couleurs varieront suivant les réglages. Nous 
pouvons sauvegarder et importer ces réglages dans un fichier. 
Exemple :
# GIMP color-balance tool settings

(range shadows)
(cyan-red 0.000000)
(magenta-green 0.000000)
(yellow-blue 0.000000)
(range midtones)
(cyan-red 0.200000)
(magenta-green -0.150000)
(yellow-blue -0.300000)
(range highlights)
(cyan-red 0.000000)
(magenta-green 0.000000)
(yellow-blue 0.000000)
(preserve-luminosity yes)
# end of color-balance tool settings
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AJUSTER  LA  TEINTE , LA SATURATION  ET LA LUMINOSITÉ

Sur l'image faire Couleurs > Teinte-Saturation.

Les tonalités de couleurs varieront suivant les ajustements. Nous pouvons sauvegarder et importer ces 
réglages dans un fichier. Exemple :
# GIMP hue-saturation tool settings

(range all-hues)
(hue 0.111111)
(saturation 0.253731)
(lightness -0.200000)
(range red-hues)
(hue 0.000000)
(saturation 0.000000)
(lightness 0.000000)
(range yellow-hues)
(hue 0.000000)
(saturation 0.000000)
(lightness 0.000000)
(range green-hues)
(hue 0.000000)
(saturation 0.000000)
(lightness 0.000000)
(range cyan-hues)
(hue 0.000000)
(saturation 0.000000)
(lightness 0.000000)
(range blue-hues)
(hue 0.000000)
(saturation 0.000000)
(lightness 0.000000)
(range magenta-hues)
(hue 0.000000)
(saturation 0.000000)
(lightness 0.000000)
(overlap 0.766169)
# end of hue-saturation tool settings

COLORIER  L ' IMAGE

Sur l'image faire Couleurs > Colorier.

Les tonalités de couleurs varieront suivant les réglages. Nous 
pouvons sauvegarder et importer ces réglages dans un fichier. 
Exemple :
# GIMP colorize tool settings

(time 0)
(hue 0.333333)
(saturation 0.400000)
(lightness 0.600000)
# end of colorize tool settings
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AJUSTER  LA  LUMINOSITÉ  ET LE  CONTRASTE

Sur l'image faire Couleurs > Luminosité-Contraste.

Les tonalités de couleurs varieront suivant les deux réglages. 
Nous pouvons sauvegarder et importer ces réglages dans un 
fichier. Exemple :
# GIMP brightness-contrast tool settings

(time 0)
(brightness -0.078947)
(contrast 0.118110)
# end of brightness-contrast tool settings

RÉDUIRE EN  NOIR  ET BLANC EN  UTIL ISANT  UN  SEUIL

Sur l'image faire Couleurs > Seuil.

Cet outil a des options d'affichage de l'échelle.

La transformation variera suivant les réglages. Nous pouvons 
sauvegarder et importer ces réglages dans un fichier. Exemple :
# GIMP threshold tool settings

(time 0)
(low 0.360784)
(high 1.000000)
# end of threshold tool settings
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AJUSTER  LES  NIVEAUX  DE  COULEURS

Sur l'image faire Couleurs > Niveaux.

Cet outil a des options.

Les tonalités de couleurs varieront suivant les réglages. Nous 
pouvons sauvegarder et importer ces réglages dans un fichier. 
Exemple :
# GIMP Levels File
14 176 0 255 1.200000
0 255 0 255 1.000000
0 255 0 255 1.000000
0 255 0 255 1.000000
0 255 0 255 1.000000

Exemple : Ajuster les couleurs d'une photographie trop foncée (bebe.jpg) en utilisant l'outil Niveaux..

– Ouvrir la photographie bebe.jpg et la dupliquer pour ne pas travailler sur l'original en utilisant le 
raccourci Ctrl+D.

– Sur la nouvelle image faire : Couleurs > Niveaux (la courbe noire représente la répartition des couleurs).

– Placer le curseur noir sur l'extrémité gauche de la courbe noire.

– Placer le curseur blanc sur l'extrémité droite de la courbe noire.

– Déplacer le curseur gris du milieu (gamma) pour obtenir une bonne harmonie des couleurs, Valider.
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AJUSTER  LES  COURBES  DES  COULEURS

Sur l'image faire Couleurs > Courbes.

Cet outil a des options.

Modeler la courbe avec le curseur de la souris.

Les tonalités de couleurs varieront suivant les réglages. Nous pouvons sauvegarder et importer ces réglages en 
activant Présélections. 
Ces réglages sont mémorisés dans le fichier C:\Users\[utilisateur].gimp-2.6\tool-options\gimp-curves-tool.settings . 

L'outil « Courbes » est un des moyens les plus sophistiqués pour corriger, ajuster, créer des effets de couleurs 
selon le « modelage » d'une courbe. L'utilisation demande une certaine habitude. La modification de la courbe 
s'applique à chaque canal R,V,B individuellement ou aux 3 canaux simultanément.
Principe du changement des couleurs : L'échelle du bas représente les niveaux d'un (ou des) canal (x = 110 par 
exemple). L'intersection avec la courbe renvoie la nouvelle valeur (y = 172 dans l'exemple).
  Le début de la courbe est en 10 0 , le point d'arrondi en 91 142 et la fin de la courbe en 176 255.

Exemple de cette courbe
sur une copie de bebe.jpg
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RÉDUIRE LE NOMBRE  DE  COULEURS

Sur l'image faire Couleurs > Postériser.

La diminution de couleurs variera suivant le réglage. 

Exemples : 

– image d'origine = 165812 couleurs.

– Niveau de postérisation = 3, nombre de couleurs = 17

– Niveau de postérisation = 100, nombre de couleurs = 62218

Nota : Nous pouvons aussi réduire le nombre de couleurs par Image > Mode > Couleurs indexées, choisir le 
nombre de couleurs et revenir au mode d'origine.

TRANSFORMER  EN  NIVEAUX  DE  GRIS

Sur l'image faire Couleurs > Désaturer.

Le rendu en gris variera selon les 3 options.

OBTENIR UN  NÉGATIF

Sur l'image faire Couleurs > Inverser.

Résultat sur une image RVB 8bits en décimal, chaque pixel = [ 255 , 255 , 255 ] - [ R origine , V origine , B 
origine ].

INVERSION  DE  VALEUR  (MODE  TSV)
Sur l'image faire Couleurs > Inversion de valeur.

Résultat sur une image TSV, chaque pixel = [ T origine , S origine , 100 ] - [ 0 , 0 , V origine ].

DÉCOMPOSER  EN  CANAUX  DE  COULEURS

Sur l'image faire Couleurs > Composants > Décomposer.

Une ou des nouvelles images seront crées avec les canaux.
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REMPLACER UNE  COULEUR  PAR  DE  LA TRANSPARENCE

Sur l'image faire Couleurs > Couleur vers alpha.

Choisir la couleur qui deviendra transparente avec le bouton et la 
pipette disponible sur le sélecteur de couleurs.

APPLIQUER  LES  COULEURS  D 'UNE  IMAGE  À  UNE  AUTRE  IMAGE

Ouvrir 2 images dont l'une est l'échantillon de couleurs. Sur une des images faire Couleurs > Mappage > 
Colorier à partir d'un échantillon. Bien paramétrer l'image de Destination et l'Échantillon en haut de la fenêtre du 
filtre. Appuyer sur le bouton « Capturer les couleurs de l'échantillon » puis sur « Appliquer ».
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ENLEVER LE BRUIT D'UNE IMAGE

Avec le greffon GREYCstoration page 182.

Sur l'image faire Filtres > Amélioration > GREYCstoration. Valider si le 
résultat semble bon.

Avant       Après



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 64 / 391
 Augmenter la netteté d'une image 

AUGMENTER LA NETTETÉ D'UNE IMAGE

Sur l'image faire Filtres > Amélioration > Renforcer la netteté. Paramétrer et valider si le résultat semble bon.

Ce filtre peut être utile après l'utilisation de certains filtres comme  GREYCstoration, etc.
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LES SÉLECTIONS

La sélection est une procédure importante dans le travail avec Gimp. Elle définit la zone dans laquelle les 
opérations se dérouleront : Là où les tracés seront effectifs, les zones à couper, les zones à remplir, etc.

Plusieurs outils permettent de réaliser ces sélections, des simples et des plus compliqués :

1    2     3      4      5    6     7      8

1   « Sélection Rectangulaire » sélectionne des rectangles et des carrés (raccourci R).

2   « Sélection Elliptique » sélectionne des ellipses et des cercles (raccourci E).

3   « Sélection à main levée » ou lasso permet des sélections à main levée. (raccourci F).

4   « Sélection contiguë» ou baguette magique permet des sélections de zones contiguës (raccourci U).

5   « Sélection par couleur» permet des sélections de zones de même couleur. (raccourci Shift+O).

6   « Ciseaux Intelligents » permet des sélections complexes avec un automatisme qui détermine les zones de 
pourtour. (raccourci I).

7   « Extraction du premier plan » permet d'isoler un objet contenu dans un image.

8   L'outil Chemin (voir page 78) peut être utilisé pour réaliser des sélections. Il suffit de transformer le 
chemin fermé en sélection. (raccourci B).

Les outils de sélection possèdent une fonction adoucir et de lissage qui permet de «lisser» le contour de la 
sélection ainsi qu’une possibilité de sélectionner le rapport ou la taille de la sélection (à configurer dans les 
options des outils).

Astuces :

– Inverser la sélection par Ctrl+I.

– Pour sélectionner la totalité de l’image Ctrl+A.

– Pour augmenter la sélection maintenir la touche Shift (majuscule) et faire une autre sélection à un autre 
endroit de l’image.

– Pour la diminuer faites la même opération avec Ctrl.

– Pour créer une intersection avec une autre sélection Shift+Ctrl.

– Pour déplacer une sélection faire Ctrl+Alt et glisser la sélection avec la souris.

– Pour tout dé-sélectionner Shift+Ctrl+A.
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AJUSTER UNE SÉLECTION

Augmenter la sélection vers la droite.

Augmenter la sélection vers le bas, vers la gauche (déplacement du coin). 

Déplacer la sélection avec la souris (petite croix présente). 

Lors du déplacement un petit signe + signale le   centre   de la sélection.  

La sélection active est entourée de pointillés.

ADOUCIR LES BORDS ET LISSAGE

Ces 2 options des outils de sélection sont illustrées dans ces 4 exemples (grossissement * 8) :

Sans adoucir, sans lissage. Sans adoucir, avec lissage. 

Avec adoucir (rayon 2), sans lissage. Avec adoucir (rayon 2), avec lissage.



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 67 / 391
 Les sélections 

LES 4 MODES  DES SÉLECTIONS

Les 4 modes sont accessibles par clic sur les options des outils dans la rubrique Mode.

   1    2   3   4  

1  Mode où la nouvelle sélection remplace la sélection en cours.

2  Mode où la nouvelle sélection est ajoutée à la sélection en cours (Ou touche Shift).

3  Mode où la nouvelle sélection est soustraite à la sélection en cours (Ou touche Ctrl).

4  Mode où la nouvelle sélection crée une intersection avec la sélection en cours (Ou raccourci Shift+Ctrl).

Le curseur change suivant le mode :

1  

2  Un petit + est ajouté.

3  Un petit - est ajouté.

4  Un petit U inversé est ajouté.

Effets, selon les modes, d'une sélection à main levée tracée après une sélection elliptique :

2  Origine : Résultat :

3  Origine : Résultat :

4  Origine : Résultat :
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SÉLECTION RECTANGULAIRE  (R)
Exemple : Copier une sélection carrée au coins arrondis d'un crabe à partir de l'image Crustacea.jpg.

– Sélectionner l'outil de sélection par le raccourci R à partir de l'image.

– Configurer les options de l'outil et valider « Coins arrondis » avec Rayon = 40.

– Faire une sélection grossière autour du sujet et ajuster en vérifiant les dimensions sur le bas de l'image ou 
sur la fenêtre des options de l'outil.

– Copier Ctrl+C, coller comme 
nouvelle image par Shift+Ctrl+V. 
Résultat :
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SÉLECTION ELLIPTIQUE (E)
– Sélectionner l'outil de sélection par le raccourci E à partir de l'image Crustacea.jpg.

– Configurer les options de l'outil et valider « Lissage » et  « Adoucir les bords » avec Rayon = 50.

– Ajuster la sélection.

– Copier Ctrl+C, coller comme nouvelle image par Shift+Ctrl+V  puis aplatir l'image par Image > Aplatir 
l'image. Résultat :
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SÉLECTION À MAIN  LEVÉE  (F)
Cet outil permet :

– Tracer des courbes en maintenant le clic de la souris.

– Tracer des segments de droite avec en cliquant successivement sur plusieurs points.

– Déplacer des points.

– Tracer des segments orientés sur des multiples de 15° avec la touche Ctrl enfoncée.

– Pour fermer la sélection rejoindre le début du tracé et faire un clic ou, sans rejoindre le début du tracé, 
faire un double clic.

SÉLECTION CONTIGUË (U)
L'outil « Sélection contiguë » sélectionne, à partir du point de clic, les zones adjacentes de couleurs 
similaires (option seuil de l'outil de 0 à 255) soit la résultante de tous les canaux (composite) ou selon le canal  
(R, V. B, T, S, V). 

SÉLECTION PAR COULEUR (SHIFT+O)
À partir du point du clic, cet outil sélectionne toutes les zones de couleurs similaires (option seuil de 
l'outil de 0 à 255) soit la résultante de tous les canaux (composite) ou selon le canal (R, V. B, T, S, V).
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C ISEAUX  INTELLIGENTS (I)
Cet outil peut être pratique pour faire des « détourages » dans de zones où les contrastes de couleurs sont 
élevés. L'aide contextuelle (Shift+F1) donne le fonctionnement et ses limites. En résumé, nous positionnons 
des points au plus près de la zone à détourer en terminant sur le premier. Ces points « s'ajustent » 
automatiquement et nous pouvons les déplacer. Pour transformer le tracé en sélection, il suffit de faire un clic 
à l'intérieur du tracé.

EXTRACTION DU PREMIER  PLAN

L'utilisation de cet outil se fait en plusieurs étapes. 

Étape 1 : Sélectionner cet outil et faire un clic sur l'image. Faire une sélection grossière à l'intérieur de l'objet 
à récupérer. Les zones non sélectionnées sont bleues.

Étape 2 : Avec le pinceau affiner la sélection. À chaque correction attendre la fin du traitement.

Étape 3 : Appuyer sur Entrée pour valider la sélection.

L'OUTIL CHEMINS (B)
Créer un chemin fermé avec cet outil (Utilisation page 78).

Transformer ce chemin en sélection par le raccourci Shift+V.

SÉLECTION FLOTTANTE

Nous transformons une sélection en sélection flottante par Sélection > Flottante ou le raccourci Shift+Ctrl+L. À 
partir de ce moment, la partie de l'image contenue sous la sélection se déplace avec la sélection. 
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LE MASQUE RAPIDE

Le masque rapide permet de détourer (déterminer les contours) facilement un sujet en créant une sélection. 
Pour l'activer ou le désactiver utiliser le raccourci Shift+Q ou appuyer sur le petit bouton sans le bas à gauche 
de l'image. 

Principe :

– Lorsque le masque rapide est activé l'image est recouverte par un rouge transparent.

– Activer le Pinceau (P) avec une brosse fine

– Il faut ensuite sélectionner le blanc pour débuter et augmenter la sélection en appliquant le pinceau. Le 
rouge transparent disparaît.
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– En cas de débordement appliquer du noir pour faire réapparaître le rouge transparent.

– Lorsque l'objet est complètement isolé, désactiver le masque de sélection (raccourci Shift+Q ou bouton) 
pour faire apparaître la sélection.

PERTURBER UNE SÉLECTION

Pour modifier le contour d'une sélection, sur l'image, faire Sélection > Perturbation, paramétrer et valider. 

Origine Effet (paramètres par défaut)

AGRANDIR OU RÉDUIRE UNE SÉLECTION

Agrandir par Sélection > Agrandir   et réduire par Sélection > Réduire. Paramétrer et valider. 

Agrandir de 20 pixels. 
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GUIDES ET GRILLES

Les guides et les grilles facilitent le repérage, le positionnement et « l'ancrage ».

GUIDES

L'affichage des guides sur l'image est activé ou désactivé par : Affichage > Afficher les guides ou par le 
raccourci Shift+Ctrl+T. 

Pour qu'un guide soit validé, sur l'image, faire : Image > Guides > Nouveau guide ou Nouveau guide (en 
pourcentage).

Pour supprimer le ou les guides, sur l'image, faire : Image > Guides > Enlever tous les guides.

Pour activer des guides autour d'une sélection faire : Image > Guides > Nouveaux guides depuis la sélection.

Pour aligner sur les guides, sur l'image, faire : Affichage > Aligner sur les guides.
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GRILLE

L'affichage de la grille est activé sur l'image par : Affichage > Afficher la grille.

Le positionnement des objets le long de cette grille est activé par : Affichage > Aligner sur la grille. 

Les paramètres de la grille sont définis dans les préférences (Édition > Préférences > Grille par défaut).
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CADRAGE D'UNE IMAGE

L'OUTIL DE DÉCOUPAGE

L'outil de découpage (Raccourci Shift+C) permet le cadrage d'une 
image. Il est préférable de travailler sur une copie de l'image. 

Les options de cet outils permettent d'ajuster le découpage, de 
modifier l'apparence de la fenêtre de sélection sur l'image

Pour activer le découpage, sur l'image faire Shift+C , ajuster la fenêtre, 
faire un clic.

Exemple :    Résultat
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DÉCOUPAGE  AUTOMATIQUE

Le découpage automatique supprime les contours de couleur uniforme de l'image par : Image > Découpage 
automatique de l'image.

Image d'origine Résultat

DÉCOUPAGE  FUTÉ

Le découpage futé est une variante du découpage automatique qui supprime en plus les zones intérieures. 
L'accès se fait par : Image > Découpage futé.

Résultat avec la même image d'origine que l'exemple précédent :
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L'OUTIL CHEMINS (B)
L’outil Chemins (Créer, éditer des Chemins) permet de faire des tracés et des dessins avec des courbures. Le 
chemin ainsi créé peut aussi être utilisé pour appliquer un texte qui suivra le tracé (page 40). Les 
transformations d'un chemin en sélection ou l'application d'un outil de dessin le long de ce chemin sont 
accessibles dans la fenêtre « Calque, Canaux, Chemins... » en activant l'onglet « Chemins ».

Le tracé se fait en cliquant successivement et va créer plusieurs 
points (un point par clic).

Pour fermer le tracé, appuyer sur Ctrl, rejoindre le point de départ 
et faire un clic .

Pour faire un arrondi, lors de la création d'un point, maintenir la 
touche gauche de la souris enfoncée pour voir apparaître une ou 
deux tangentes avec des petites poignées carrées. Déplacer la ou 
les poignées pour créer l'arrondi, pour amplifier la courbure 
s'éloigner du centre de rotation.
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Pour créer un arrondi sur un point existant, le sélectionner, 
appuyer sur la touche Ctrl et faire un clic dessus en maintenant la 
touche gauche enfoncée, s'écarter du point et déplacer la ou les 
petites poignées carrées.

Pour modifier un arrondi, sélectionner un point existant et déplacer 
la ou les petites poignées carrées.

Pour créer un arrondi entre deux points, faire un clic sur le tracé en 
maintenant la touche gauche enfoncée et se déplacer. 

Pour déplacer un point existant, se diriger vers un point, faire un clic en maintenant la touche gauche 
enfoncée et déplacer le point.

Pour supprimer un point, appuyer sur Shift+Ctrl, se diriger vers un point et faire un clic.

Pour déplacer tout un ensemble, appuyer sur Shift+Ctrl+Alt en maintenant la touche gauche enfoncée et 
déplacer.

Pour faire apparaître un tracé, aller sur la fenêtre « Calque, Canaux, Chemins... » , activer l'onglet 
« Chemins », faire un clic pour que l'oeil devienne visible.
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RETOURNEMENT, PIVOTEMENT

L'OUTIL RETOURNEMENT  (SHIFT+F)

Les options de cet outil doivent être paramétrées. L'effet de cet outil agit sur le calque, la sélection en 
cours, le chemin actif. Lorsque l'outil est activé, une fenêtre et un pointeur indiquant le centre de rotation 
apparaissent. 

Pour valider, appuyer sur le bouton « Rotation ».

Après une rotation nous devrons peut-être ajuster le canevas au calque par Image > Ajuster le canevas aux 
calques.

L'OUTIL PIVOTEMENT  (SHIFT+T)

Les options de cet outil doivent être paramétrées. L'effet de cet outil agit sur le calque, la sélection en 
cours, le chemin actif.

Origine               Pivot H              Pivot V          Pivots H et V
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DÉFORMATIONS

L'OUTIL DE CISAILLEMENT  (SHIFT+S)
Les options de cet outil doivent être paramétrées. L'effet de cet outil agit sur le calque, la sélection en 

cours, le chemin actif. Lorsque l'outil est activé, la fenêtre pour le paramétrage apparaît.

Valider par le bouton « Cisailler ».

Après un cisaillement nous devrons peut-être ajuster le canevas au calque par Image > Ajuster le canevas aux 
calques.
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L'OUTIL PERSPECTIVE (SHIFT+P)
Cet outil est souvent utilisé pour « corriger » les perspectives des bâtiments.

Les options de cet outil doivent être paramétrées. L'effet de cet outil agit sur le calque, la sélection en 
cours, le chemin actif. Lorsque l'outil est activé, une fenêtre et une boîte de sélection apparaissent. Ajuster 
cette boîte pour obtenir l'effet désiré.

Valider par le bouton « Transformer ».

Après une perspective nous devrons peut-être 
ajuster le canevas au calque par Image > Ajuster 
le canevas aux calques.

DÉFORMATION INTERACTIVE

Sur l'image faire Filtres > Distorsion >  Déformation interactive. Possibilité de créer une animation.    

– Paramétrer.

– Avec la souris
(clic maintenu)
déformer l'image
dans la fenêtre.

– Valider.
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 Déformations 

COURBER

Sur l'image faire Filtres > Distorsion >  Courber.

Valider.

Après une courbure nous devrons peut-être ajuster le canevas au calque par Image > Ajuster le canevas aux 
calques.
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ONDULER

Sur l'image faire Filtres > Distorsion >  Onduler 

Valider.
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TOURNER ET  ASPIRER

Sur l'image faire Filtres > Distorsion >  Tourner et aspirer         

Valider.

VAGUES CONCENTRIQUES

Sur l'image faire Filtres > Distorsion >  Vagues         

Valider.
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LES CALQUES

DÉFINITION

Voir page 10. 

LA FENÊTRE DES CALQUES

Pour visualiser la pile des calques utiliser le raccourci Ctrl+L sur l'image.

Chaque calque est caractérisé par :

– Un mode et une opacité (définissent le calcul de 
l'effet par rapport aux calques inférieurs), etc.

– Une préservation des zones transparentes.

– Un nom.

– Une image (avec ou sans zones transparentes, 
masque de calque).

– Une fonction de visibilité (oeil).

– Une chaîne indique les calques liés qui bougeront 
ensemble lors des déplacements.

Un menu est accessible par un clic droit sur le calque.

Sur l'image, le menu « Calque » regroupe aussi des 
fonctions agissant sur les calques. Nous pouvons 
considérer un calque comme étant une image sur 
laquelle de nombreux outils et fonctions s'appliquent : 
Couleurs, transparence, échelle, masque de calque, 
fonctions de la fenêtre calques, etc.

Le bas de la fenêtre calque permet :

 

       1      2      3      4      5     6
– 1  Créer un nouveau calque.

– 2  Monter ou  3 descendre dans la pile.

– 4  Dupliquer un calque.

– 5  Ancrer un calque flottant.

– 6  Supprimer un calque.
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EFFETS EN FONCTION DU MODE  ET  DE L 'OPACITÉ

L'image du papillon monarque est issue du site http://pdphoto.org/ (à visiter).

Elle est du domaine public. Voici l'adresse pour l'obtenir : http://pdphoto.org/PictureDetail.php?
mat=pdef&pg=6533 

Pour illustrer le fonctionnement dans les pages suivantes, le calque de fond est le papillon et le calque 
supérieur est une mire avec les caractéristiques suivantes :

  

- Rouge codage RVB 255, 0, 0
- Vert codage RVB 0, 255, 0
- Cyan codage RVB 0, 255, 255
- Gris codage RVB 128, 128, 128
- Blanc codage RVB 255, 255, 255
- Noir codage RVB 0 ,0 ,0
- Le milieu est transparent.

Les modes : Normal, Dissoudre, Multiplier, Diviser, Écran, Superposer, Éclaircir, Assombrir, Lumière dure, 
Lumière douce, Extraction de grain, Fusion de grain, Différence, Addition, Soustrait, Assombrir seulement, 
Éclaircir seulement, Teinte, Saturation, Couleur et Valeur.

L'opacité : 100% et 50% (éventuellement 75%).

Mire Papillon

Normal
  50

Normal
  100

Dissoudre
  50

Dissoudre
  100

http://pdphoto.org/PictureDetail.php?mat=pdef&pg=6533
http://pdphoto.org/PictureDetail.php?mat=pdef&pg=6533
http://pdphoto.org/
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Mire Papillon

Multiplier
  50

Multiplier
  100

Diviser
  50

Diviser
  100

Écran
  50

Écran
  100

Superposer
  50

Superposer

Éclaircir
  50

Éclaircir
  100
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Mire Papillon

Assombrir
  50

Assombrir
  100

Lumière dure
  50

Lumière dure
  100

Lumière douce
  50

Lumière douce
  100

Extraction de grain
  50

Extraction de grain
  100

Fusion de grain
  50

Fusion de grain
  100
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Mire Papillon

Différence
  50

Différence
  100

Addition
  50

Addition
  100

Soustrait
  50

Soustrait
  100

Assombrir seulement
  50

Assombrir seulement
  100

Éclaircir seulement
  50

Éclaircir seulement
  100
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Mire Papillon

Teinte
  50

Teinte
  100

Saturation
  50

Saturation
  100

Couleur
  50

Couleur
  100

Valeur
  50

Valeur
  100
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LE MASQUE DE CALQUE

Voici l'extrait d'une citation d'Yves Ceccone

Gimp peut rivaliser facilement avec les grands noms de la retouche photo, il possède un outil, le masque de  
calque (équivalent au masque de fusion de Photoshop) qui permet de travailler sur un calque avec une  
grande souplesse. Il est possible avec cette méthode de revenir en arrière et d'ajuster très facilement un  
détourage par exemple et cela sans toucher au calque lui même puisqu'on travaille sur un masque que l'on  
peut supprimer si les modifications ne plaisent pas ou appliquer au calque lorsque qu'on est satisfait. Les  
masques de calque permettent aussi de faire des effets de fusion entre des images, de rendre un effet de  
volume ..., il est sans doute plus facile de comprendre son fonctionnement que d'épuiser toutes les possibilités  
qu'il offre.

EXEMPLE, RETOUCHE D 'UN VISAGE AVEC LE MASQUE DE CALQUE

Dans l'exemple nous voulons « gommer » les imperfections de la peau d'un visage. Pour réaliser cette 
opération  nous utilisons le greffon GREYCstoration. Malheureusement lorsque nous appliquons ce filtre les 
détails sont perdus. C'est à ce moment que le masque de calque intervient.

Le principe est simple :

– 1. Ouvrir une photographie avec un visage.

– 2. Dupliquer le calque de fond où il y a un visage.

– 3. Appliquer  GREYCstoration sur ce nouveau calque.

– 4. Ajouter un masque de calque à ce nouveau calque.

– 5. Peindre les contours du visage, des yeux, des lèvres , etc. avec une brosse fine d'une opacité de 0.3 à 1 
pour faire apparaître les détails.

– 6. Peindre les cheveux et le fond avec une brosse fine avec d'une opacité de 30 à 100 pour faire apparaître 
les détails.

Nous utilisons une partie du portrait Laurianne 'tout  
sourire" de Didier-Lg disponible sur le site flickr.com 
à la page http://www.flickr.com/photos/didier-
lg/253555725/ pour illustrer cet exemple. Il est 
évident que cette belle photographie n'a pas besoin de 
retouche  

1 Image d'origine.

http://www.flickr.com/photos/didier-lg/253555725/
http://www.flickr.com/photos/didier-lg/253555725/
http://www.flickr.com/photos/didier-lg/253555725/
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2 et 3 Duplication du calque et filtre GREYCstoration 
( Filtres > Amélioration > GREYCstoration , mettre 2 
itérations)

Le teint est devenu clair avec un aspect « peau de 
pêche » mais les détails fins sont perdus.                        

4 Pour retrouver ces détails nous ajoutons un masque de 
calque sur ce calque par Calque > Masque > Ajouter un 
masque de calque > Bouton « Ajouter ».

Mettre la couleur de premier plan en noir et d'arrière 
plan en blanc.

5 Contours avec une brosse fine d'opacité 70
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6 Utilisation d'une grosse brosse

Aspect du masque de calque 

Résultat

Nous pouvons blanchir les dents avec l'outil Éclaircissement (Shift +D) et une petite brosse avec une opacité 
moyenne passée sur les dents (à faire après avoir appliquer le masque de calque ou sur une copie visible).

Remarque : Il est possible de transformer un masque de calque en sélection en faisant Masque vers sélection.
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LES MOTIFS

Les motifs sont généralement des images qui s'ajustent, bords à bords, horizontalement et verticalement. Ils  
sont utilisés pour remplir des sélections (Exemple : Simuler des textures de bois, de métal, de cailloux, etc.),  
des fonds de page Web, etc.

Les motifs de Gimp sont des fichiers avec l'extension .pat placés dans des répertoires modifiables via les 
préférences.

Nous pouvons modifier l'aperçu via ce bouton (Voir comme 
une liste par exemple).

Le nom et les dimensions du motif sélectionné.

Nous pouvons utiliser le raccourci Shift+Ctrl+P ou faire un 
double clic sur le symbole motif de la « Boîte à outils pour 
obtenir la fenêtre de dialogues « Motifs ».

Le motif actif est avec un contour noir. Pour grossir un 
motif faire un clic.

Pour ouvrir le motif en tant qu'image, copier l'emplacement 
du motif (exemple :  file:///C:/gimp_2_6_0/share/gimp/2.0
/patterns/corkboard.pat) , supprimer le motif, actualiser 
l'affichage de tous les motifs nous pouvons faire un clic droit 
sur le motif ou utiliser les boutons au bas de la fenêtre.

Le motif ouvert en tant qu'image.
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REMPLIR  UNE SÉLECTION D 'UN MOTIF

Il suffit de glisser et déposer (Définition page 13) le motif dans la sélection active de l'image.

CRÉER  UN MOTIF

Exemple : Créer un motif carré à partir de quelques couleurs d'une image.

Nous devons récupérer un échantillon de couleurs puis le transformer en motif. Pour récupérer un 
échantillon il y a de nombreuses méthodes. La plus simple c'est de demander à Gimp d'analyser l'image par 
Couleurs > Informations > Palette de lissage et dans la fenêtre « Palette de lissage » de paramétrer un carré.

Source Résultat (256*256, profondeur 50)

  

 

Nous pouvons faire une sélection de 1 pixel de large à l'endroit voulu puis ajuster cette sélection en carré.

Il suffit de copier cette sélection par Ctrl+C et de la coller comme 
nouvelle image par Shift+Ctrl+V.

Sur la nouvelle image faire : Image > Échelle et taille de l'image > 
briser le lien des dimensions, carré de 256*256, interpolation 
cubique. 

Résultat :  
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Nous pouvons transformer ces motifs en les déformant, en les éclaircissant, en les rendant ajustables 
(haut/bas, gauche/droite).

LES FILTRES POUR CRÉER DES MOTIFS

Ces filtres sont accessibles sur l'image par : Filtres > Rendu > Motif. Voici quelques exemples réalisés à 
partir d'une image blanche de 128*128 pixels. Les paramètres sont ceux proposés par défaut.

DAMIER

EXPLORATEUR  CML

GRILLE

LABYRINTHE
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MOTIFS  DE  DIFFRACTION

PUZZLE

QBISTE

S INUS

RENDRE UNE  IMAGE  « RACCORDABLE  »

Voir exemple page 150  .  
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CRÉATION DE MOTIFS PAR LE MENU  CRÉER

Su la fenêtre « Éditeur d'image GIMP » ou la fenêtre de l'image faire Fichier > Créer > Motifs.

3D TRUCHET

CAMOUFLAGE

CARREAU  TOURBILLONNANT

RENDRE UN  TERRAIN

TERRAIN PLAT
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TERRE

TOURBILLONNÉ

TRUCHET

UTILISER  DES MOTIFS .PAR PRÉVUS  POUR PHOTOSHOP

Eric Lamarque a créé un greffon Photoshop Pattern Loader qui permet d'ouvrir les motifs .pat de Photoshop. 

Ce greffon est présenté à la page 191 ainsi que le Script-Fu Saves_all_layers_to_separate_pat_files.scm qui 
permet de créer des motifs .pat compatibles Gimp à partir du fichier Photoshop.
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CRÉATION D ' IMAGES AJUSTABLES PAR UN POINT DE SYMÉTRIE

Principe :                       Nous utilisons le coin bas à droite de l'image comme point de symétrie.

Il suffit de créer une nouvelle image aux dimensions doubles et de coller 4 fois l'image 
d'origine en effectuant les rotations convenables (Sans, H, V et H+V) et d'ajuster. 

Remplissage d'un cadre avec l'image obtenue utilisée comme motif de fond.
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LES BROSSES

Les brosses sont appliquées avec les outils : Pinceau, crayon, aérographe, chemins, etc... Elles peuvent 
prendre la couleur de premier plan.

Les brosses sont des fichiers avec l'extension .gbr / .gih / .vbr  placés dans des répertoires modifiables via les  
préférences. Gimp peut utiliser les brosses Photoshop au format .abr

Faire un double clic sur la brosse active de la fenêtre « Boîte à outils » ou 
Shift+Ctrl+B pour obtenir la fenêtre de dialogues « Brosses ».

Nous pouvons modifier l'aperçu via ce bouton (Voir comme une liste par 
exemple).

Le nom de la brosse active avec ses dimensions.

Le contenu du presse-papiers de Gimp.

La représentation de la brosse active (contour noir).

Le triangle rouge indique une brosse « animée » qui est composée de 
plusieurs images. Pour voir la séquence de ces images, faire un clic gauche 
maintenu sur la brosse. 

Exemple réalisé avec la brosse animée Pencil Sketch#1

La petite croix indique que la représentation de la brosse est réduite. Pour 
la voir à sa taille, faire un clic gauche maintenu sur la brosse.

L'espacement indique la manière dont la répétition s'effectue en fonction 
de la largeur de la brosse.

La fonction des boutons du bas de la fenêtre de gauche à droite : 
Modifier, créer une nouvelle brosse, créer une copie, supprimer,  rafraîchir 
l'affichage.
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TROUVER DES BROSSES  SUR INTERNET

Voici quelques liens où il est possible de télécharger des brosses :

– http://www.gimp-attitude.org/ressources-brosses.php  

– http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=yes#order=9    

– http://home.tele2.fr/auroreblender/resources_en.html    

Pour obtenir d'autres liens, mettre gimp brushes ou photoshop brushes dans un moteur de recherche.

Exemple avec des brosses .abr (Photoshop) du site http://www.brusheezy.com/brush/897-Horizontal-
Dividers par MouritsaDA-Stock:

CRÉER  UNE BROSSE

À PARTIR D 'UNE  IMAGE

Nous créons une image transparente à quatre calques de 64*64 pixels. Sur chaque calque il y aura un dessin 
ou une image différente.

Exemple : 

Enregistrer l'image dans un répertoire de brosses actif avec l'extension .gih (brosse animée 
exemple_brosse_animee.gih)

http://www.brusheezy.com/brush/897-Horizontal-Dividers
http://www.brusheezy.com/brush/897-Horizontal-Dividers
http://home.tele2.fr/auroreblender/resources_en.html
http://browse.deviantart.com/resources/applications/gimpbrushes/?alltime=yes#order=9
http://www.gimp-attitude.org/ressources-brosses.php
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Paramétrer la fenêtre des options 
(Explications au chapitre « Enregistrement 
de brosse animée » de l'aide).

Actualiser les brosses.

Résultat :

À PARTIR DE  L 'ÉDITEUR  DE  BROSSES

Au bas de le fenêtre des brosses appuyer sur le bouton « Nouvelle 
brosse », paramétrer.

Résultat :

Contenu du fichier : exemple_editeur_brosses.vbr
GIMP-VBR
1.5
exemple_editeur_brosses
diamond
106.000000
42.799999
7
0.783784
4.765766
21.081081
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CRÉER DES BOUTONS

Sur la fenêtre « Éditeur d'image GIMP » ou l'image faire Fichier > Créer > Boutons

BOUTON ARRONDI

S IMPLE BOUTON BISEAUTÉ
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LES OUTILS DE DESSIN

Ces outils de dessin permettent d'appliquer une brosse sur une image :

– 1  Le pinceau (Raccourci P) trace des traits adoucis.

– 2  Le crayon (Raccourci N) trace des traits durs.

– 3  L'aérographe (Raccourci A) peint.

– 4  L'outil calligraphie (Raccourci K) trace des traits de largeur variable.

Les 3 premiers outils ont des options « Dynamique 
  de la brosse » qui augmentent les effets.

Une tablette graphique facilite l'emploi de ces outils.

1

2

3

4
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LA GOMME

  La gomme (Raccourci Shift+E) efface en utilisant une brosse.

Cet outil a des options « Dynamique de la brosse » qui augmentent les effets.
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L'OUTIL ÉCLAIRCIR-ASSOMBRIR

 

   L'outil Éclaircir-Assombrir (Raccourci Shift+D) blanchit 
     ou noircit les zones où il est appliqué en utilisant une brosse.

Cet outil a des options « Dynamique de la brosse » qui 
augmentent les effets.

Choix

Effet Éclaircir
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OUTIL DE BARBOUILLAGE

L'outil de barbouillage (Raccourci S)  étale les couleurs de l'image en utilisant une brosse.

Cet outil a des options « Dynamique de la brosse » qui augmentent les effets.
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L'OUTIL DE CLONAGE

L'outil de clonage (Raccourci C) étale la ou les portions d'une image sur la même image ou sur une autre 
image en utilisant une brosse.

Cet outil a des options « Dynamique de la brosse » qui augmentent les effets.

Les principes d'utilisation de cet outil sont nombreux et décrits dans l'aide.

Principe

– Étape 1 : Nous devons récupérer avec une brosse la partie d'une image que nous souhaitons appliquer sur 
une autre image.
Choisir une brosse, par exemple la brosse « Pepper » pour illustrer le contour de la brosse.
Aller sur l'image où nous souhaitons récupérer les échantillons.
Sélectionner l'outil de clonage (Raccourci C).
Appuyer sur la touche Ctrl et en maintenant la touche Ctrl enfoncée faire un clic avec la souris.

Relâcher la touche Ctrl et le clic.

– Étape 2 : Appliquer le clonage sur une nouvelle image.
Créer une nouvelle image à fond blanc (raccourci Ctrl+N).
Appliquer l'outil clonage avec la souris.
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L'OUTIL CLONER EN PERSPECTIVE

L'outil de clonage en perspective (Sans raccourci) étale la ou les portions d'une image sur la même image 
ou sur une autre image en utilisant une brosse et en appliquant une perspective.

Cet outil a des options « Dynamique de la brosse » qui augmentent les effets.

Dans un premier temps, nous devons définir un plan de perspective en validant l'option de l'outil « Modifie le 
plan de perspective » sur la source.

Dans un deuxième temps nous devons valider l'option « Clonage en perspective » de l'outil et procéder 
comme le clonage de la page précédente (Ctrl+Clic sur la source > Étaler à l'endroit choisi avec la brosse).

Exemple de vidéo qui montre la différence entre l'outil clonage et l'outil clonage en perspective :
http://video.google.com/videoplay?docid=-3077868802879051003 

http://video.google.com/videoplay?docid=-3077868802879051003
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L'OUTIL FLOU-NETTETÉ

L'outil  Flou-Netteté (Raccourci Shift+U)  augmente le flou ou la netteté sur la portion d'image où il est 
appliqué en utilisant une brosse.

Cet outil a des options « Dynamique de la brosse » qui augmentent 
les effets.

Choix
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SUPPRIMER DES PETITS DÉFAUTS AVEC L'OUTIL CORRECTEUR

L'outil  Correcteur (Raccourci H)  permet d'effacer des petits défauts en « appliquant » un échantillon pris 
à côté du défaut en fonction d'une brosse (Paramètres de l'outil).

Exemple d'utilisation :

L'image d'origine, Zoom à 200%

Sélectionner l'outil de clonage (Raccourci H).

Appuyer sur la touche Ctrl et en maintenant la touche Ctrl 
enfoncée faire un clic avec la souris.

Relâcher la touche Ctrl et le clic, aller vers le défaut à 
supprimer, faire un clic. 

Résultat :

Nota : Il est possible de prendre un échantillon sur une image et de l'appliquer sur une autre image.
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ENLEVER UN OBJET SUR UNE IMAGE

EN UTILISANT  L 'OUTIL « PINCEAU  »
Principe avec une brosse utilisant le presse papiers de Gimp :

– Avec un outil de sélection (Raccourci F par exemple) sélectionner et copier (Raccourci Ctrl+C) une 
petite partie du fond au plus près de l'objet. La partie copiée sera utilisée comme brosse (faire un double 
clic sur la brosse active et sélectionner la copie réalisée). 

– Sur l'image annuler la sélection par Sélection > Aucune (Raccourci Shift+Ctrl+A).

– Sélectionner le pinceau (Raccourci P) et appliquer.

– Renouveler l'opération à chaque variation de ton du contour de l'objet.

EN UTILISANT  LE GREFFON RESYNTHESIZER

Le téléchargement et l'installation  de ce greffon sont décrits page 215.

– Sélectionner l'objet à supprimer (Raccourci F par exemple).

– Activer le script-fu par Filtres > Amélioration > Smart remove selection.

– Activer la fenêtre « Script-Fu : Smart remove selection » à partir de la barre d'outils, appuyer sur le 
bouton « Valider », attendre.

Résultat :
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LES ANIMATIONS

CRÉER  UN GIF ANIMÉ

Les images du type GIF animé produites par Gimp permettent d'obtenir un image animée avec les 
caractéristiques suivantes :

– 256 couleurs au maximum.

– Transparence.

– Paramétrage du temps d'affichage de chaque séquence en ms dans l'attribut du calque.

– Effacement de l'image précédente par l'option « replace » dans l'attribut du calque.

– Ajout à l'image précédente par l'option « combine » dans l'attribut du calque.

– Optimisation des fichiers par Filtres > Animation > Optimiser (différence) ou Filtres > Animation > Optimiser 
(pour GIF).

– Boucle infinie ou pas.

– Possibilité de visualiser une animation par Filtres > Animation > Rejouer l'animation.

Dans l'exemple nous allons créer une animation pour une page Web où les 
deux premières séquences afficheront deux petits dessins qui s'ajouteront tout 
en conservant le fond de la page Web, puis la dernière séquence qui affichera 
une nouvelle image.

– Créer une image à fond transparent par : Ctrl+N > 100*100 pixels, Remplir 
avec transparence > Valider.

– Dupliquer 2 fois le calque par Shift+Ctrl+D et Shift+Ctrl+D 
pour avoir une image à 3 calques. Résultat :

– Sur la fenêtre Calques, Canaux, Chemins... dans l'onglet 
Calques sélectionner le calque Arrière-Plan, faire un clic 
droit > Modifier les attributs du calque > inscrire 
sequence_1(500ms)(replace) > Valider.
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– Sur l'image dessiner un petit dessin avec le pinceau : P > faire un dessin.

– Sur la fenêtre Calques, Canaux, Chemins... dans l'onglet Calques sélectionner le calque Copie de Arrière-
Plan, faire un clic droit > Modifier les attributs du calque > inscrire sequence_2(800ms)(combine) > Valider puis, 
sur l'image dessiner un petit dessin avec le pinceau : P > faire un dessin.

– Sur la fenêtre Calques, Canaux, Chemins... dans l'onglet 
Calques sélectionner le calque Copie de Copie de Arrière-Plan, 
faire un clic droit > Modifier les attributs du calque > inscrire 
sequence_3(1000ms)(replace) > Valider puis, sur l'image, 
remplir le calque d'un motif.

– Enregistrer (Ctrl+S) > animation.xcf.bz2 (sauvegarde du 
travail).

– Sur l'image faire Filtres > Animation > Optimiser (pour GIF). Une nouvelle image est créée.

– Sur la nouvelle image, visualiser l'animation par Filtres 
> Animation > Rejouer l'animation > Lecture.

– Sur la nouvelle image, Enregistrer (Ctrl+S) > animation.gif
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– Paramétrer, Enregistrer en tant qu'animation > Exporter.

– Paramétrer , Boucle infinie pour que l'animation ne s'arrête pas > Enregistrer.

Visualiser la page \images_gimp\animation.html qui contient animation.gif.
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V IRTUALDUB-MPEG2 ET  XVID CODEC

Pour réaliser les exemples suivants du chapitre « Les animations » nous utilisons deux logiciels libres 
VirtualDub-MPEG2 et Xvid Codec ainsi que quelques Scripts-Fu et greffons de Reinhard Geisler.
Didacticiel VirtualDub:  http://furyjin.free.fr/tutos/virtualdub.php 

V IRTUALDUB-MPEG2 
VirtualDub-MPEG2 est un éditeur de vidéo proposé par Avery Lee - fccHandler qui permet l'encodage et 

l'inverse, de créer des effets via des filtres, etc. Ce logiciel est une évolution VirtualDub.

Site : http://fcchandler.home.comcast.net/~fcchandler/stable/index.html  

Chargement logiciel : http://fcchandler.home.comcast.net/~fcchandler/stable/VirtualDub-MPEG2.zip  

Sources : http://fcchandler.home.comcast.net/~fcchandler/stable/VirtualDub-MPEG2-source.7z 

Les greffons sont disponibles à partir de la page : 
 http://fcchandler.home.comcast.net/~fcchandler/index.html  

Installation des greffons : lire les fichiers ReadMe.txt

Il y a une version francisée à la page http://www.trad-fr.com/telecharger/details.php?file=2 

Présentation du logiciel sur le site  : « Il permet de quasiment tout faire avec une vidéo: extraire la piste  
sonore, la recompresser, recompresser la piste vidéo au format désiré (DivX, Xvid, etc ...), enlever un  
générique, scinder une film en plusieurs parties, recoller plusieurs fragments de film, resynchroniser l'audio  
et la vidéo, modifier la fréquence d'image, et j'en passe!!!!
VirtualDub permet également de faire de la capture vidéo pour peu que vous disposiez d'un périphérique de  

capture et des pilotes adéquats!
Cette version modifiée (d'où l'extension "MPEG2"), prend également en charge les flux MPEG2. La version  

1.6.11 introduit en plus la prise en charge, pour le moment expérimentale, des fichiers ASF et WMV.  »

Nota : La version francisée USB U3 ne comporte pas tous les fichiers de la version d'origine (Traitement en ligne 
de commande, gestionnaire de setup). 

http://www.trad-fr.com/telecharger/details.php?file=2
http://fcchandler.home.comcast.net/~fcchandler/index.html
http://fcchandler.home.comcast.net/~fcchandler/stable/VirtualDub-MPEG2-source.7z
http://fcchandler.home.comcast.net/~fcchandler/stable/VirtualDub-MPEG2.zip
http://fcchandler.home.comcast.net/~fcchandler/stable/index.html
http://furyjin.free.fr/tutos/virtualdub.php
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XVID  CODEC

Xvid Codec est un codec  libre (Définition et historique page http://fr.wikipedia.org/wiki/Xvid). Il permet 
l'encodage avec un taux de compression variable pour réduire le volume des fichiers ce qui diminue aussi la 
qualité.

Site : http://www.xvid.org/ 

Téléchargement codec : http://www.xvid.org/Downloads.15.0.html 

Sources : http://www.xvid.org/Downloads.43.0.html 

VERSIONS  ET INSTALLATION  DE   V IRTUALDUB-MPEG2 ET XVID  CODEC

Les liens et fichiers proposés sont en date du 29 octobre 2008. Vérifier si de nouvelles versions sont 
disponibles.

Pour installer  VirtualDub-MPEG2 version anglaise il suffit de décompresser le fichier VirtualDub-
MPEG2.zip dans un répertoire de votre choix.

Pour installer  VirtualDub-MPEG2 version française il y a 2 possibilités :

– Sur disque dur lancer le programme d'installation VirtualDub-MPEG2_1.6.19_b24587_Fr.exe et  suivre les 
instructions. Noter le répertoire d'installation pour les greffons.

– USB U3 avec le fichier VirtualDub-MPEG2_Fr.u3p (Si vous n'installez pas le logiciel sur une clef USB U3, 
il suffit de décompresser le fichiers . u3p avec 7Zip dans un répertoire de votre choix).

Pour installer les greffons de  VirtualDub-MPEG2 il suffit de de décompresser les fichiers .zip et de suivre 
les instructions des fichiers ReadMe.txt.

Pour installer Xvid Codec lancer le programme d'installation Xvid-1.1.3-27042008.exe et  suivre les 
instructions.

Après l'installation de Xvid Codec, ce codec sera reconnu dans VirtualDub-MPEG2 :

 

http://www.7-zip.org/
http://www.xvid.org/Downloads.43.0.html
http://www.xvid.org/Downloads.15.0.html
http://www.xvid.org/
http://fr.wikipedia.org/wiki/Xvid
http://fr.wikipedia.org/wiki/Codec
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SCRIPT-FU SAVES_ALL_LAYERS_TO_SEPARATE_TGA_FILES .SCM

Pour que VirtualDub-MPEG2 puisse importer des images (Issues de calques) créées par Gimp, le Script-Fu 
Saves_all_layers_to_separate_tga_files.scm est créé pour l'occasion à partir d'une idée de Niels Giesen (Voir 
page 319).

Ce script est dans l'archive http://www.aljacom.com/~gimp/images_gimp.7z 

Ce Script-Fu sauvegarde tous les calques d'une image au format TGA. Il est accessible sur l'image par : 
Calque > Save all layers to a different tga file

Nota : Les noms de calques ne doivent pas contenir les caractères / \ * ? (Modifier attributs page 129)

 

Code source :
; Saves_all_layers_to_separate_tga_files.scm
;
; origine http://groups.google.ca/group/comp.graphics.apps.gimp/browse_thread/thread/010e01bd0930438a#
; modification pour enregistrer en .tga (compatible VirtualDub)
; fonctionne Gimp 2.6.1 Windows
;
(define (script-fu-save-layers-to-tga-files image dont-ask display-images)
(let ((basename (car (gimp-image-get-filename image))))
(when (string=? basename "")
(set! basename (string-append
(car (gimp-temp-name ""))
(car (gimp-image-get-name image)))))
(let loop ((layers (vector->list (cadr (gimp-image-get-layers image)))))
(unless (null? layers)
(gimp-edit-copy (car layers))

(let ((img (car (gimp-edit-paste-as-new)))
(new-name (string-append
basename
(car (gimp-drawable-get-name (car layers)))
".tga")))
(file-tga-save dont-ask img (aref (cadr (gimp-image-get-layers img)) 0) new-name new-name 1 1)
(if (= FALSE display-images)
;; clean up afterwards if we are not going to

http://www.aljacom.com/~gimp/images_gimp.7z
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;; display the images anyway:
(gimp-image-delete img)
(gimp-display-new img)))
(loop (cdr layers))))))
(script-fu-register "script-fu-save-layers-to-tga-files"
; modif samj _"Save all layers to a different file"
_"Save all layers to a different tga file"
_"Saves all layers to separate .tga files"
"Niels Giesen (niels.gie...@gmail.com) - samj"
"Niels Giesen -samj"
"2008-10-29"
""
SF-IMAGE "Image" 1
SF-TOGGLE _"Don't ask options for each layer" TRUE
SF-TOGGLE _"Display images?" FALSE)
(script-fu-menu-register "script-fu-save-layers-to-tga-files"
; modif samj _"<Image>/Filters/Generic")
_"<Image>/Layer")

LES  GREFFONS  DE  REINHARD GEISLER

Reinhard Geisler propose quatre greffons qui s'ajoutent au menu des animations de Gimp :

– poster   pour réaliser des assemblages en colonnes et rangées
 http://www.macgeisler.de/gimp/the_gimp.html#poster.

– split   pour « désassembler » les montages réaliser avec poster
 http://www.macgeisler.de/gimp/the_gimp.html#split.

– streak   pour simuler les effets d'une caméra  à balayage de fente « Streak camera »
 http://www.macgeisler.de/gimp/the_gimp.html#streak.

– uc-avi   pour importer et enregistrer des vidéos au format AVI non compressé
 http://www.macgeisler.de/gimp/the_gimp.html#uc-avi.

Les fichiers exécutables sont réalisés par Michael Schumacher :

– http://schumaml.gmxhome.de/downloads/gimp/poster.zip  

– http://schumaml.gmxhome.de/downloads/gimp/split.zip  

– http://schumaml.gmxhome.de/downloads/gimp/streak.zip  

– http://schumaml.gmxhome.de/downloads/gimp/uc-avi.zip  

Pour l'installation, décompresser les 4 archives .zip (poster.zip , split. zip , streak. zip , uc-avi.zip ) et installer 
les 4 fichiers exécutables .exe (poster.exe , split.exe , streak.exe , uc-avi.exe) dans le répertoire des greffons 
\gimp_2_6_x\lib\gimp\2.0\plug-ins.

http://schumaml.gmxhome.de/downloads/gimp/uc-avi.zip
http://schumaml.gmxhome.de/downloads/gimp/streak.zip
http://schumaml.gmxhome.de/downloads/gimp/split.zip
http://schumaml.gmxhome.de/downloads/gimp/poster.zip
http://www.macgeisler.de/gimp/the_gimp.html#uc-avi
http://www.macgeisler.de/gimp/the_gimp.html#streak
http://www.optronis.com/streak-kameras/das-streak-prinzip.html
http://www-iness.c-strasbourg.fr/Axe3-ImagRap/cameraBal.htm
http://www.macgeisler.de/gimp/the_gimp.html#split
http://www.macgeisler.de/gimp/the_gimp.html#poster
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Les sources sont disponibles à :

– http://www.macgeisler.de/gimp/v2.0/poster.c  

– http://www.macgeisler.de/gimp/v2.0/split.c  

– http://www.macgeisler.de/gimp/v2.0/streak.c  

– http://www.macgeisler.de/gimp/v2.0/uc-avi.c  

Dans Gimp, les filtres sont accessibles à partir de l'image par : 

– Filtres > Animation > Poster

– Filtres > Animation > Split into layers    

– Filtres > Animation > Streak   

Le filtre uc-avi s'active automatiquement à l'ouverture et à l'enregistrement d'une vidéo .avi . 

SCRIPTS-FU DE  DANIEL BATES

Daniel Bates propose un ensemble de 6 Scripts-Fu qui agissent sur les calques d'une image.

La description est à la page http://insanity-prevails.deviantart.com/art/Multi-Layer-Action-Scripts-72632286 
. Il ne faut pas utiliser les scripts de cette page mais utiliser ceux fournis dans l'archive des images 
http://www.aljacom.com/~gimp/images_gimp.7z .

Pour installer il suffit de copier les 6 fichiers .scm ( bates-layers-attributes.scm , bates-layers-copy-to-new.scm 
, bates-layers-delete.scm , bates-layers-number.scm , bates-layers-scale-crop.scm , bates-layers-transform.scm) 
dans le répertoire des scripts \gimp_2_6_x\share\gimp\2.0\scripts.

Sur l'image les scripts-fu sont accessibles par : Calque > Multi-Layer Options > Nom du filtre

Ces scripts s'appliquent aux fichiers .avi non compressés importés dans Gimp avec uc-avi.

http://www.aljacom.com/~gimp/images_gimp.7z
http://insanity-prevails.deviantart.com/art/Multi-Layer-Action-Scripts-72632286
http://insanity-prevails.deviantart.com/
http://www.macgeisler.de/gimp/v2.0/uc-avi.c
http://www.macgeisler.de/gimp/v2.0/streak.c
http://www.macgeisler.de/gimp/v2.0/split.c
http://www.macgeisler.de/gimp/v2.0/poster.c
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CRÉER  UNE ANIMATION .AVI À PARTIR D 'UN FILTRE DE G IMP

Le but est de produire une séquence d'images numérotées (Exemple : image_000.png, image_001.png, 
image_002.png, … , image_999.png) avec Gimp que nous pourrons importer dans VirtualDub-MPEG2 pour 
créer des fichiers vidéo .avi (haute et basse résolution).

Ouvrir une image.

Appliquer le filtre déformation 
interactive par Filtres > Distorsions > 
Déformation interactive. Appliquer un 
effet de déformation avec le curseur de 
la souris sur la fenêtre, activer l'onglet 
« Animer » et valider « Animer » avec 
un nombre d'images. Valider.

Enregistrer le fichier sous le format xcf.bz2 (Shift+Ctrl+S) , par exemple video.xcf.bz2 

Supprimer le calque placé au dessous du calque Image 0 .

Créer les images .tga en utilisant le Script-Fu « Script-Fu Saves_all_layers_to_separate_tga_files.scm » décrit 
page 120     : Calque > Save all layers to a different tga file > Valider.
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Nous obtenons 30 images TGA :

Fermer Gimp sans enregistrer les modifications.

Ouvrir VirtualDub-MPEG2. 

Dans  VirtualDub-MPEG2 ouvrir un fichier vidée (Ctrl+O) , Fichier de type : Séquences d'images, Nom de 
fichier : L'image avec l'indice de numérotation le plus bas > Ouvrir.

Dans  VirtualDub-MPEG2 valider le codec « Xvid Codec » par Vidéo > Compression > Valider le bon codec 
et appuyer sur le bouton Configurer. C'est ici que nous disposons de la qualité obtenue avec ce curseur :

Paramétrer et valider successivement 2 fois avec le boutons OK.

Faire Fichier > Enregistrer en Avi (raccourci F7). La vidéo est disponible en lecture. 

Faire une autre sauvegarde en modifiant le curseur de qualité.

Fermer VirtualDub-MPEG2. 
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F ILTRE « TRAME  D ' IMPRIMERIE » DE G IMP APPLIQUÉ À UNE SÉQUENCE VIDÉO

Nous allons utiliser le filtre « trame d'imprimerie » de Gimp à une séquence vidéo.

Pour réaliser cet effet nous utilisons le Script-Fu batch-plug-in-newsprint.scm décrit dans le chapitre 
« Traitement par lot 'Batch processing' avec Gimp » à la page 167. 

Ce script est dans l'archive http://www.aljacom.com/~gimp/images_gimp.7z 

Le principe du traitement :

– Obtenir une séquence d'images avec le logiciel  VirtualDub-MPEG2.

– Faire un traitement par lot sur ces images avec Gimp.

– Assembler le résultat dans VirtualDub-MPEG2.

L'exemple est réalisé avec séquence vidéo extraite du film d'animation 3D Big Buck Bunny placé sous 
licence CC http://creativecommons.org/licenses/by/3.0/ 

(c) copyright Blender Foundation | www.bigbuckbunny.org 

Réalisé avec Blender (http://www.blender.org/) 

Site : http://www.bigbuckbunny.org/ 

Liste des images composant l'extrait :

De : http://media.xiph.org/BBB/BBB-360-png/big_buck_bunny_01130.png 

À  :  http://media.xiph.org/BBB/BBB-360-png/big_buck_bunny_01153.png 

– Dans le logiciel  VirtualDub-MPEG2 ouvrir la vidéo (Ctrl+O) BBB_01130_01153.avi contenue dans 
l'archive BBB_01130_01153.avi.7z et créer une séquence d'image par : Fichier > Enregistrer la séquence 
d'images. Paramétrer et appuyer sur OK. Quitter le logiciel.

http://media.xiph.org/BBB/BBB-360-png/big_buck_bunny_01153.png
http://media.xiph.org/BBB/BBB-360-png/big_buck_bunny_01130.png
http://www.bigbuckbunny.org/
http://www.blender.org/
http://www.bigbuckbunny.org/
http://creativecommons.org/licenses/by/3.0/
http://www.aljacom.com/~gimp/images_gimp.7z
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– Nous obtenons 24 images de BBB_00.tga à BBB_23.tga.

– Ouvrir Gimp. Faire : Fichier > Créer > Traitement par lot : Filtre trame d imprimerie

– Paramétrer : 

– Attendre la fin du traitement. Fermer Gimp. Nous obtenons 24 images de BBB_00.tga.tga à 
BBB_23.tga.tga. Résultat sur la première image de la séquence :
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– Dans le logiciel  VirtualDub-MPEG2 ouvrir la nouvelle séquence d'images créée par Gimp (Ctrl+O) 
BBB_00.tga.tga .

– Configurer la compression (Voir exemple précédent). 

– Faire Fichier > Enregistrer en Avi (raccourci F7) BBB_imprimerie.avi . La vidéo est disponible en lecture. 

INCLURE  UN TEXTE, UN LOGO SUR UNE SÉQUENCE

Voir l'utilisation du Script-Fu watermark-batch_samj.scm  à la page 170. et la vidéo BBB_logo.avi. 

La mis en œuvre est identique  à l'exemple précédent.

Pour obtenir des effets différents au niveau de l'image ajoutée nous pouvons modifier le script watermark-it-
f.scm. 

CRÉER  UN FICHIER AVI COMPATIBLE G IMP

Avec le greffon uc-avi (voir page 121) nous pouvons importer et enregistrer des vidéos au format AVI non 
compressé. 

Si lord de l'ouverture du fichier .avi dans Gimp nous 
obtenons un message d'erreur nous pourrons utiliser 
VirtualDub-MPEG2 pour obtenir un fichier compatible.

Pour obtenir ce fichier compatible :

– Ouvrir VirtualDub-MPEG2

– Ouvrir le fichier .avi qui cause l'erreur dans Gimp (Ctrl+O).

– Raccourci Shift+F7 (Enregistrer sous l'ancien format 
AVI) et indiquer un autre nom.

OU

– Ouvrir VirtualDub-MPEG2

– Ouvrir le fichier .avi qui cause l'erreur dans Gimp 
(Ctrl+O).

– Dans le menu Vidéo, activer l'option Compression , 
valider  (même si la conversion semble étrange) et 
appuyer sur OK. 

– Enregistrer sous un autre nom le fichier ( Touche de 
fonction F7).
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– Ouvrir ce nouveau fichier dans Gimp.

– Choisir le début et le fin des « trames ».

– Valider.

Modifier le fichier.

Voici la fenêtre des options d'enregistrement : 

IMPORTER  UNE ANIMATION SOUS LA FORME  D 'UNE IMAGE À PLUSIEURS CALQUES

Voici quelques possibilités pour, dans Gimp, créer une image à plusieurs calques. Il faut faire attention aux 
nombres de calques et aux dimensions afin d'éviter de « saturer » le système.

– Ouvrir une image AVI (voir exemple précédent).

– Ouvrir plusieurs images en même temps comme calques : Ctrl+Alt+O , sélectionner un répertoire, Ctrl+A 
pour tout sélectionner, Bouton Ouvrir (Attention aux noms des calques qui ne correspondront peut-être pas 
à nos désirs).

– Ouvrir la première image d'une série d'images. Utiliser G.A.P. Par : Video > Frames to image , paramétrer 
dans la fenêtre « Frame to images », Valider.
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MODIFIER  LES  ATTRIBUTS  DES CALQUES (LES  NOMS)
Il faut utiliser un des Scripts-Fu de Daniel Daniel Bates (Téléchargement page 122) qui modifie les attributs 
des calques par : Calque > Multi-layer Options > Edit Attributes of Layers, paramétrer et valider.

  Paramètres                                                                     Résultats

Pour connaître le nombre de calques faire :  Calque > Multi-layer Options > Number Layers , Valider
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DÉCOUPAGE , MISE À L 'ÉCHELLE , PIVOTEMENT  DES CALQUES

Utiliser les Scripts-Fu de Daniel Daniel Bates (Téléchargement page 122) pour réaliser les opérations de 
découpage, mise à l'échelle, pivotement de calques.

Découpage, mise à l'échelle par : Calque > 
Multi-layer Options > Scale or Crop Layers

Exemple de découpage des calques 1 à 30 
avec une dimension de 240*180. L'origine 
du découpage est au point x=15  y=25.

Pivotement par :  Calque > Multi-layer 
Options > Transform

Exemple de rotation à 45°.

Faire Image >Ajuster le canevas aux 
calques après la transformation.

Résultat :
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ANIMATION LE LONG D 'UN CHEMIN (FP-SCRIPT-FU-PATH-SUITE.SCM)
Fence-post propose un script-fu qui permet de créer des animations à partir de chemins avec de nombreuses 

options.

Sites : http://www.gimptalk.com/forum/-script-animated-path-stroking-path-suite-t46679.html    
             http://fence-post.deviantart.com/art/Animated-Path-Stroking-Script-152654834   

Téléchargement :  
        http://www.deviantart.com/download/152654834/Animated_Path_Stroking_Script_by_fence_post.zip   

Installation : Décompresser Animated_Path_Stroking_Script_by_fence_post.zip et placer le script-fu 
fp-script-fu-path-suite.scm dans le répertoire des scripts ...\gimp_2_6_x\share\gimp\2.0\scripts

Sur une image, créer un chemin.

Accès : À partir du chemin  > Animated Path Stroking
         //        //          > Path Direction
         //        //          > Show Point
         //        //          > Reverse Path Direction
         //        //          > Path Details
         //        //          > Stroke Delete

Pour avoir l'utilisation en français vous pouvez utiliser l'outil de traduction :

http://fr.babelfish.yahoo.com/translate_url?doit=done&tt=url&intl=1&fr=bf-
home&trurl=http://www.gimptalk.com/forum/-script-animated-path-stroking-path-suite-
t46679.html&lp=en_fr&btnTrUrl=Traduire 

http://fr.babelfish.yahoo.com/translate_url?doit=done&tt=url%E2%88%ABl=1&fr=bf-home&trurl=http://www.gimptalk.com/forum/-script-animated-path-stroking-path-suite-t46679.html&lp=en_fr&btnTrUrl=Traduire
http://fr.babelfish.yahoo.com/translate_url?doit=done&tt=url%E2%88%ABl=1&fr=bf-home&trurl=http://www.gimptalk.com/forum/-script-animated-path-stroking-path-suite-t46679.html&lp=en_fr&btnTrUrl=Traduire
http://fr.babelfish.yahoo.com/translate_url?doit=done&tt=url%E2%88%ABl=1&fr=bf-home&trurl=http://www.gimptalk.com/forum/-script-animated-path-stroking-path-suite-t46679.html&lp=en_fr&btnTrUrl=Traduire
http://www.deviantart.com/download/152654834/Animated_Path_Stroking_Script_by_fence_post.zip
http://fence-post.deviantart.com/art/Animated-Path-Stroking-Script-152654834
http://www.gimptalk.com/forum/-script-animated-path-stroking-path-suite-t46679.html
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Ouvrir la boite de dialogue par « Animated Path Stroking » :

Paramétrer et Valider.

Dans ce cas une animation de 15 séquences sera créée en utilisant un dégradé.
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LE FORMAT APNG (ANIMATION, IMAGE STATIQUE)

Le format d’images numériques libre de droits APNG (Animated Portable Network Graphics) est une 
extension non officielle du format PNG (Portable Network Graphics) qui permet de créer des animations à 
partir d'images PNG. À ce jour (mai 2010) ce format peut être lu par Firefox 3, Opera 9.5 , KSquirrel 0.7.2 et 
XnView 1.92. Si ce format n'est pas reconnu dans votre navigateur, celui-ci devrait afficher la première 
« frame ». L'extension des fichiers APNG est .png
Pour en savoir plus sur le format APNG : http://fr.wikipedia.org/wiki/Apng  

http://animatedpng.com/index.php/about/  

Voici un lien pour comparer apng vs gif animé : http://gimpchat.com/viewtopic.php?p=1385 

Pour réaliser des animations au format il existe 2 moyens :

– Assembler des images PNG via l'utilitaire apngasm.

– Créer des animations via le greffon gimp-apng pour Gimp.

ASSEMBLER DES IMAGES PNG VIA L 'UTILITAIRE  APNGASM

Cet utilitaire permet d'assembler des images PNG pour créer des animations APNG. Il existe une version 
accessible en ligne où il suffit de fournir les images png dans une archive zip et de déclarer la temporisation 
entre chaque « frame » de l'animation : http://animatedpng.com/index.php/assembler/ . Il faut bien respecter 
la recommandation Each frame you give it must have the same metadata (size, colour depth, transparency,  
pallete, etc.).
Cet utilitaire peut être téléchargé sur http://sourceforge.net/projects/apngasm/files/ et il existe une version 

Linux (apngasm-2.0-bin-linux.zip) et Windows (apngasm-2.0-bin-win32.zip). 

Sous Windows il suffit de décompresser apngasm-2.0-bin-win32.zipet d'utiliser l'utilitaire apngasm.exe en 
ligne de commande :

APNG Assembler 2.0
Usage: apngasm.exe output.png frame001.png [1] [10] [/f]
1/10 is the default delay. Use /f to skip the first frame.

UTILISER  LE GREFFON GIMP-APNG  POUR G IMP

Un greffon pour Gimp est disponible à la page http://sourceforge.net/projects/gimp-apng/files/ et a été créé 
par Daisuke Nishikawa.

Sous Windows l'installation est un peu spéciale :

– Dans un premier temps il faut télécharger l'archive gimp-apng-0.1.0.win32.zip et la décompresser.

– Il faut placer les 2 fichiers file-apng.exe et file-apng.ui dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins

– Il faut aussi supprimer le greffon existant   file-png.exe de ce répertoire gimp_2_6_x\lib\gimp\2.0\plug-ins 
car les 2 greffons se nuisent.

– Lorsque l'installation est effectuée il faut démarrer Gimp.

http://sourceforge.net/projects/gimp-apng/files/
http://sourceforge.net/projects/apngasm/files/
http://animatedpng.com/index.php/assembler/
http://gimpchat.com/viewtopic.php?p=1385
http://animatedpng.com/index.php/about/
http://fr.wikipedia.org/wiki/Apng
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Ce greffon permet d'ouvrir et d'enregistrer des animations.

Pour compiler ce greffon sous Linux : http://gimpchat.com/viewtopic.php?p=1385 

OUVERTURE  D 'UNE  ANIMATION

Par exemple nous ouvrons l'animation proposée par à l'adresse http://gimpchat.com/files/2_spinfox.png par 
Fichier > Ouvrir suivant l'emplacement > coller le lien > Appuyer sur le bouton Ouvrir

Voici l'image et quelques calques :

ENREGISTRER  UNE  ANIMATION

Il faut créer une image à plusieurs calques et le nommés à la façon d'un gif animé (voir exemple des calques 
présenté ci-dessus) avec les délais en ms et les possibilités combine et replace.

Faire uns sauvegarde au format xcf.

http://gimpchat.com/files/2_spinfox.png
http://gimpchat.com/viewtopic.php?p=1385
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Lorsque l'animation est sauvegardée faire Fichier > Enregistrer Sous > donner un nom, par exemple 
animation.png > Appuyer sur le bouton Enregistrer > Paramétrer comme indiqué :

Appuyer sur Export.

L'animation sera jouée 3 fois et s'arrêtera sur la dernière image.

Ce greffon a été testé sous Gimp 2.6.8 32 bits / Windows 7 64 bits.
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EFFETS DE QUELQUES FILTRES

LES FILTRES DE FLOU

Les filtres de flou permettent :

– D'adoucir l'image.

– De créer des effets de luminosité ou de correction de luminosité.

– De simuler des mises au point d'objectifs (Profondeur de champ, type d'objectif).

– De masquer des personnes.

– D'estomper les contours d'un objet pour sa mise en valeur.

– Donner du mouvement, etc.

Ces filtres sont accessibles sur l'image par Filtres > Flou > Nom du filtre.

Exemples :  Image d'origine par Vancouverflavour (CC) disponible à
 http://flickr.com/photos/vancouverflavour/2925887624/ 

    Flou Cinétique radial >> 

<< Pixeliser

http://flickr.com/photos/vancouverflavour/2925887624/
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F ILTRES DE DISTORSIONS

Quelques exemples sont disponibles au chapitre « Distorsions » page 81.

Ces filtres sont accessibles sur l'image par Filtres > Distorsions > Nom du filtre.

Exemple : Coin de page 

F ILTRES OMBRES ET  LUMIÈRES

Ces filtres sont accessibles sur l'image par Filtres > Ombres et lumières > Nom du filtre.

ÉBLOUISSEMENT  GRADUEL

Filtres > Ombres et lumières > Éblouissement graduel

Quelques effets sur un fond noir : Paramètres :
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EFFET  D 'ÉBLOUISSEMENT

Filtres > Ombres et lumières > Effet d'éblouissement

EFFETS  D 'ÉCLAIRAGE

Filtres > Ombres et lumières > Effets d'éclairage
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ÉTINCELER

Filtres > Ombres et lumières > Étinceler (Ajoute des éclats sur les 
points clairs)

SUPERNOVA

Filtres > Ombres et lumières > Supernova

EFFET  XACH

Filtres > Ombres et lumières > Effet Xach 
(Ajoute un effet 3D autour d'une sélection)
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OMBRE  PORTÉE

Filtres > Ombres et lumières > Ombre portée 
(Ajoute une ombre autour d'une sélection)

Résultat avec la même sélection que pour le filtre « Effet Xach ».

PERSPECTIVE

Filtres > Ombres et lumières > Perspective 
(Ajoute une ombre en perspective)

Résultat en ajoutant une ombre au rectangle jaune.

CARREAUX  DE  VERRE

Filtres > Ombres et lumières > Carreaux de verre 

LENTILLE  OPTIQUE

Filtres > Ombres et lumières > Lentille optique 

Voir greffon Wideangle page 253.
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F ILTRES BRUIT

Ces filtres sont accessibles sur l'image par Filtres > Bruit > Nom du filtre. Ils ajoutent ou créent du « bruit » 
sur l'image. 

BROUILLAGE  RVB
Voici un exemple appliqué sur une image noire.

Filtres > Bruit > Brouillage RVB 

BROUILLAGE  TSV
Voici un exemple appliqué sur une image noire.

Filtres > Bruit > Brouillage TSV 

ÉPARPILLER

Filtres > Bruit > Éparpiller 
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JETER

Voici un exemple appliqué sur une image noire.

Filtres > Bruit > Jeter 

MÉLANGER

Filtres > Bruit > Mélanger 

P IQUER

Filtres > Bruit > Piquer 



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 143 / 391
 Effets de quelques filtres 

F ILTRES DÉTECTION DE BORD

Ces filtres sont accessibles sur l'image par Filtres > Détection de bord > Nom du filtre.

Les exemples sont appliqués à l'image 2925887624_76f4fe031a.jpg disponible sur
   http://flickr.com/photos/vancouverflavour/2925887624/ par vancouverflavour (CC)

CONTOUR

Filtres > Détection de bord > Contour 

D IFFÉRENCE  GAUSSIENNE

Filtres > Détection de bord > Différence gaussienne 

L'option Inverser donne l'image au dessous

LAPLACE

Filtres > Détection de bord > Laplace 

http://flickr.com/photos/vancouverflavour/2925887624/
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NÉON

Filtres > Détection de bord > Néon 

SOBEL

Filtres > Détection de bord > Sobel 

F ILTRES GÉNÉRIQUES

Ces filtres sont accessibles sur l'image par Filtres > Générique > Nom du filtre.

Ces filtres, en principe, permettent un grand nombre d'effets en utilisant des programmes ou des algorithmes 
spécifiques.

MATRICE  DE  CONVOLUTION

Filtres > Générique > Matrice de convolution

Des exemples d'utilisation de la matrice de convolution sont dans la documentations des Scripts-Fu 
disponible à la page 188 : Voir les scripts invertir-bordes.scm et convolution-presets_1.1.scm.
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D I LATER

*** Sur Gimp 2.6.1, les effets Dilater et Éroder sont inversés.

Filtres > Générique > Dilater

Permet de supprimer des parasites sur un fond uni.

    > Dilater >

ÉRODER

*** Sur Gimp 2.6.1, les effets Dilater et Éroder sont inversés.
Filtres > Générique > Éroder

Permet d'augmenter la taille des objets sur un fond uni.

    > Éroder >

F ILTRES COMBINER

Ces filtres sont accessibles sur l'image par Filtres > Combiner > Nom du filtre.

Ces filtres mélangent, combinent des images

SUPERPOSER  SELON  PROFONDEUR

Filtres > Combiner > Superposer selon profondeur

Exemple :

      +                               =

F I LM

Filtres > Combiner > Film

Exemple :

      +                               =
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F ILTRES ARTISTIQUES

Ces filtres sont accessibles sur l'image par Filtres > Artistiques > Nom du filtre.

Ces filtres créent des effets « artistiques » sur les images. 
Les exemples sont appliqués à l'image 2925887624_76f4fe031a.jpg disponible sur

   http://flickr.com/photos/vancouverflavour/2925887624/ par vancouverflavour (CC)

CUBISME

Filtres > Artistiques > Cubisme

EFFET  DE  TOILE

Filtres > Artistiques > Effet de toile

PEINTURE  À L 'HUILE

Filtres > Artistiques > Peinture à l'huile

PRÉDATEUR

Filtres > Artistiques > Prédateur

http://flickr.com/photos/vancouverflavour/2925887624/
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TRESSER

Ajoute un tressage sur l'image.

Filtres > Artistiques > Tresser

F ILTRES DÉCOR

Ces filtres sont accessibles sur l'image par Filtres > Décor > Nom du filtre.

Ces filtres ajoutent des décorations. Effets sur une image blanche.

AJOUTER  UN  BISEAU

Filtres > Décor > Ajouter un biseau

AJOUTER  UNE  BORDURE

Filtres > Décor > Ajouter une bordure

BORDURE  INÉGALE

Filtres > Décor > Bordure inégale
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PELLICULE  PHOTO

Filtres > Décor > Pellicule photo

TACHE DE  CAFÉ

Filtres > Décor > Tache de café

V IE ILLE  PHOTO

Filtres > Décor > Vieille photo

F ILTRES MAPPAGE

Ces filtres sont accessibles sur l'image par Filtres > Mappage > Nom du filtre.

Les exemples sont appliqués à l'image 2925887624_76f4fe031a.jpg disponible sur
   http://flickr.com/photos/vancouverflavour/2925887624/ par vancouverflavour (CC)

FRACTALISER

Filtres > Mappage > Fractaliser

http://flickr.com/photos/vancouverflavour/2925887624/


www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 149 / 391
 Effets de quelques filtres 

ILLUSION

Filtres > Mappage > Illusion

PETITS  RACCORDS

Filtres > Mappage > Petits raccords

PLAQUER  SUR  UN  OBJET

Filtres > Mappage > Plaquer sur un objet

Exemple sur une sphère
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RENDRE RACCORDABLE

Filtres > Mappage > Rendre raccordable

Modifie les bords pour créer un motif « raccordable ».

REPOUSSAGE  D 'APRÈS  UNE  CARTE

Permet de créer des reliefs à partir d'une image en niveaux de gris (carte)

Filtres > Mappage > Repoussage d'après une carte

Effet de la carte sur une image de couleur unie :
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F ILTRES RENDU

Ces filtres sont accessibles sur l'image par Filtres > Rendu > Nom du filtre.

Ces filtres permettent de créer de images à partir d'une image vide ou dans une sélection.

LAVE

Filtres > Rendu > Lave

F ILTRES WEB

Ces filtres sont accessibles sur l'image par Filtres > Web > Nom du filtre.

IMAGE  CLIQUABLE  WEB

Permet de créer des zones cliquables sur l'image qui sont associées à des liens. Enregistrer le résultat par le 
menu Fichier du filtre. Le résultat peut être placé dans une page Web.

Filtres > Web > Image cliquable Web
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Résultat :
<img src="web.png" width="330" height="178" border="0" usemap="#map" />

<map name="map">
<!-- #$-:Image map file created by GIMP Image Map plug-in -->
<!-- #$-:GIMP Image Map plug-in by Maurits Rijk -->
<!-- #$-:Please do not edit lines starting with "#$" -->
<!-- #$VERSION:2.3 -->
<!-- #$AUTHOR:samj -->
<area shape="rect" coords="168,66,284,111" alt="Site associé à lien" 
href="http://www.aljacom.com/~gimp" />
<area shape="circle" coords="71,90,52" alt="site associé au rond" 
href="http://www.gimp.org" />
</map>
Résultat importé dans Kompozer et visible dans \images_gimp\Image cliquable Web.html

http://kompozer.net/
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TRANCHE

Python doit être installé.
Découpe l'image selon les guides. 

Pour placer des guides faire : Image > Guide > … 

L'image sera découpée en 9 morceaux.

Appel du filtre par : 

Filtres > Web > Tranche

      Paramètres >

Fichiers créés :

Contenu du fichier slice.html :

<!--HTML SNIPPET GENERATED BY GIMP

WARNING!! This is NOT a fully valid HTML document, it is rather a piece of
HTML generated by GIMP's py-slice plugin that should be embedded in an HTML
or XHTML document to be valid.

Replace the href targets in the anchor (<a >) for your URLS to have it working
as a menu.
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 -->
<table cellpadding="0" border="0" cellspacing="0">
  <tr>
    <td><img alt=" " src="slice_0_0.jpg" style="width: 42px;  height: 115px; border-width: 0px;"></td>
    <td><img alt=" " src="slice_0_1.jpg" style="width: 297px;  height: 115px; border-width: 0px;"></td>
    <td><img alt=" " src="slice_0_2.jpg" style="width: 111px;  height: 115px; border-width: 0px;"></td>
</tr>

  <tr>
    <td><img alt=" " src="slice_1_0.jpg" style="width: 42px;  height: 330px; border-width: 0px;"></td>
    <td><a href="#"><img alt=" " src="slice_1_1.jpg"  style="width: 297px; height: 330px; border-width: 

0px;"></a></td>

    <td><img alt=" " src="slice_1_2.jpg" style="width: 111px;  height: 330px; border-width: 0px;"></td>
</tr>

  <tr>
    <td><img alt=" " src="slice_2_0.jpg" style="width: 42px;  height: 277px; border-width: 0px;"></td>
    <td><img alt=" " src="slice_2_1.jpg" style="width: 297px;  height: 277px; border-width: 0px;"></td>
    <td><img alt=" " src="slice_2_2.jpg" style="width: 111px;  height: 277px; border-width: 0px;"></td>
</tr>

</table>
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TRAITEMENT PAR LOT « BATCH PROCESSING » AVEC G IMP

Le traitement « Batch » est possible avec Gimp 2.6.x  en utilisant le petit programme utilitaire sh.exe 
(Console) fourni dans notre archive. Ce programme se trouve dans \gimp_2_6_x\bin.

Nous utilisons l'exemple fourni à la page http://www.gimp.org/tutorials/Basic_Batch/ . À la fin de cette page 
nous utilisons ce petit Script-Fu qui permet d'augmenter la netteté des images :

  (define (batch-unsharp-mask pattern
                              radius
                              amount
                              threshold)
  (let* ((filelist (cadr (file-glob pattern 1))))
    (while (not (null? filelist))
           (let* ((filename (car filelist))
                  (image (car (gimp-file-load RUN-NONINTERACTIVE
                                              filename filename)))
                  (drawable (car (gimp-image-get-active-layer image))))
             (plug-in-unsharp-mask RUN-NONINTERACTIVE
                                   image drawable radius amount threshold)
             (gimp-file-save RUN-NONINTERACTIVE
                             image drawable filename filename)
             (gimp-image-delete image))
           (set! filelist (cdr filelist)))))

REMARQUES AU SUJET DE CE CHAPITRE :

Des parties de ce chapitre ne sont plus à jour. 

Avec les dernières versions de Gimp, il est possible d'utiliser \gimp_2_6_x\bin\gimp-console-2.6.exe à la 
place des programmes utilitaires sh.exe et win-bash.exe en mode non-interactif (voir exemple page 176).

Les exemples proposés doivent tout de même fonctionner.

Pour illustrer le fonctionnement du script proposé sur cette page, placer des copies d'images au format png 
dans le répertoire C:\images, ouvrir la console Windows (cmd.exe) puis taper ou copier cette ligne de 
commande, valider par la touche Entrée :

C:\gimp_2_6_x\bin\gimp-console-2.6.exe -i -b "(batch-unsharp-mask \"C:\\images\\*.png\" 5.0 0.5 0)" -b "(gimp-quit 0)"

http://www.gimp.org/tutorials/Basic_Batch/
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Il faut copier le texte en bleu dans un éditeur de texte et l'enregistrer sous essai_batch1.scm dans le 
répertoire des scripts  gimp_2_6_x\share\gimp\2.0\scripts

Maintenant nous devons placer une copie des images à traiter dans le répertoire C:\images

Il faut activer l'utilitaire sh.exe (double clic), taper cette ligne de commande en rouge dans la fenêtre, 
vérifier, appuyer sur la touche Entrée pour démarrer le traitement :

C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-unsharp-mask "C:\\images\\*.png" 5.0 0.5 0)' -b '(gimp-quit 0)'

Attention au redoublement des signes   //   pour localiser l'exécutable Gimp et   \\   pour localiser le répertoire   
des images et le type d'images. Attention aussi aux guillemets, simples avant et après les parenthèses, 
doubles pour encadrer le répertoire + type d'image. 
  

Si vous ne disposez pas de touche \ sur votre clavier, utilisez "*.png" à la place de "C:\\images\\*.png" et 
placez vos copies d'images dans \gimp_2_6_x\bin.

Attendre la fin du traitement et fermer les fenêtres inutiles.

Nota :  sh.exe était disponible à http://unxutils.sourceforge.net/ (Le site semble arrêté)

http://unxutils.sourceforge.net/
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Explications :

– Gimp démarre par C://gimp_2_6_1//bin//gimp-2.6.exe

–  -i   indique le mode sans interface.

–  -b  indique le mode « batch ». 

– Dans Gimp, l'appel du script se fera par batch-unsharp-mask suivi de 4 paramètres : 
1 - Les images "C:\\images\\*.png"  .

2 - 5.0
3 - 0.5
4 - 0

– Fermer Gimp par  gimp-quit 0

Résultats : Avant Traitement                 Après traitement 
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D IMENSIONNER  DES IMAGES

Voici un Script-Fu utilisable en mode « batch » pour dimensionner les images en choisissant le filtre 
d'interpolation :

;  batch-scale-filter.scm 
;  Adaptation script page http://www.gimp.org/tutorials/Basic_Batch/
;  Pour la documentation  http://www.aljacom.com/~gimp/debuter_avec_gimp_2_6.pdf
;
;  Exemple appel Windows : largeur = 600 / hauteur = 400 / filtre = 2 (interpolation cubic); 
;  C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-scale-filter "C:\\essai\\*.bmp" 600 400 2)' -b '(gimp-quit 0)'
;
;  Filtres : 0=sans 1=linear 2=cubic 3=lanczos
; 
;  Fonctionne aussi avec shell Windows : http://win-bash.sourceforge.net/
;
(define (batch-scale-filter pattern
                              width
                              height
                              filter)
  (let* ((filelist (cadr (file-glob pattern 1))))
    (while (not (null? filelist))
           (let* ((filename (car filelist))
                  (image (car (gimp-file-load RUN-NONINTERACTIVE
                                              filename filename)))
                  (drawable (car (gimp-image-get-active-layer image))))
             (gimp-image-scale-full image width height filter)
             (gimp-file-save RUN-NONINTERACTIVE
                             image drawable filename filename)
             (gimp-image-delete image))
           (set! filelist (cdr filelist)))))

Placer une copie des images dans le répertoire  C:\essai

Exemple d'une ligne de commande pour mettre les images .bmp du répertoire C:\essai à la taille de 
800*600pixels en utilisant l'interpolation « cubic » défini par la valeur 2 :

C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-scale-filter "C:\\essai\\*.bmp" 800 600 2)' -b '(gimp-quit 0)'
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CRÉER  UN CONTOUR FLOU BLANC

Voici un Script-Fu utilisable en mode « batch » qui utilise le Script-Fu « fuzzy-border » (Filtre Bordure 
inégale) pour créer un contour flou en blanc.

;  batch-add-fuzzy-border.scm 
;  Adaptation scripts pages http://www.gimp.org/tutorials/Basic_Batch/
;  http://www.gimp-attitude.org/forum/viewtopic.php?p=23704 par CraZyKing
;  Pour la documentation  http://www.aljacom.com/~gimp/debuter_avec_gimp_2_6.pdf
;
;  Exemple appel Windows : 
;  C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-add-fuzzy-border "C:\\essai\\*.jpg" 20 TRUE 12 TRUE 2)' -b '(gimp-quit 0)'
; 
;  Fonctionne aussi avec shell Windows : http://win-bash.sourceforge.net/
;
(define (batch-add-fuzzy-border pattern

        taille_bord
        bord_flou
        granularite
        ombre
        epaisseur_ombre)

  (let* ((filelist (cadr (file-glob pattern 1))))
    (while (not (null? filelist))
           (let* ((filename (car filelist))
                  (image (car (gimp-file-load RUN-NONINTERACTIVE
                                              filename filename)))
                  (drawable (car (gimp-image-get-active-layer image))))

(script-fu-fuzzy-border image drawable '(255 255 255) taille_bord bord_flou granularite ombre epaisseur_ombre FALSE TRUE)
     (set! drawable (car (gimp-image-get-active-layer image))) 

             (gimp-file-save RUN-NONINTERACTIVE
                             image drawable filename filename)
             (gimp-image-delete image))
           (set! filelist (cdr filelist)))))

Placer une copie des images dans le répertoire  C:\essai

Exemple d'une ligne de commande pour traiter les images .jpg du répertoire C:\essai 

C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-add-fuzzy-border "C:\\essai\\*.jpg" 20 TRUE 12 TRUE 2)' -b '(gimp-quit 0)'
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RÉALISER  UN TRAITEMENT  « BATCH » VIA W IN-BASH  ET UN SCRIPT  AUTOIT

Nous n'utilisons plus sh.exe des exemples précédents mais le programme win-bash.exe version 0.6 
disponible à la page : http://win-bash.sourceforge.net/ .

Le programme win-bash.exe (shell) est associé dans notre utilisation à un script batch.exe créé avec Autoit. 

Il faut placer  win-bash.exe dans le répertoire \gimp_2_6_x\bin (Où se trouve gimp-2.6.exe) puis placer 
batch.exe et le fichier texte batch.txt dans le répertoire \gimp_2_6_x (Où se trouve maringouin.exe).

Le programme batch.exe utilise un fichier texte batch.txt où est placée la ligne de commande. La ligne de 
commande active est sur la première ligne et elle est suivie du mot fin.

Exemple d'un fichier  batch.txt :
C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-add-fuzzy-border "C:\\essai\\*.jpg" 20 TRUE 12 TRUE 2)' -b '(gimp-quit 0)'

fin

C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-scale-filter "C:\\essai\\*.bmp" 600 400 1)' -b '(gimp-quit 0)'

C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-unsharp-mask "C:\\images\\*.png" 5.0 0.5 0)' -b '(gimp-quit 0)'

Ce fichier texte permet de conserver les anciennes commandes après le mot   fin  .  
Ces programmes et les sources sont dans le répertoire batch de l'archive 

http://www.aljacom.com/~gimp/images_gimp.7z 

Utilisation :

– Mettre une ligne de commande valide dans le fichier batch.txt .

– Démarrer batch.exe par un clic.  Ne pas changer de fenêtre active pendant l'inscription des caractères 
qui dure une dizaine de secondes. Attendre le traitement.
.
.
.
.

.

– À la première utilisation un répertoire \gimp_2_6_x\batch va être créé.

– À la fin du traitement cette fenêtre s'affiche :
 :
 :
 :
 :
 :

– Appuyer sur une touche, les fenêtres se ferment, le traitement est terminé.

http://www.aljacom.com/~gimp/images_gimp.7z
http://win-bash.sourceforge.net/
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TRAITEMENT  SÉQUENTIEL

Principe : Chaque tâche du traitement est sur la même ligne de commande :

C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '( Tâche 1 )' -b '(  Tâche 2 )'   …   -b '(  Tâche x )' -b '(gimp-quit 0)'

Dans cet exemple, 2 tâches seront exécutées successivement sur les images .jpg du répertoire C:\essai : 

1. L'ajout d'un contour flou.

2. La mise à l'échelle.
C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-add-fuzzy-border "C:\\essai\\*.jpg" 20 TRUE 12 TRUE 2)' -b '(script-fu-
batch-scale-ratio "C:\\essai\\*.jpg" 0.52 2)' -b '(gimp-quit 0)'

CODE  SOURCE  DU  SCRIPT  AUTOIT

#Region ;**** Directives created by AutoIt3Wrapper_GUI ****
#AutoIt3Wrapper_icon=batch.ico
#AutoIt3Wrapper_Res_Comment=Traitement batch
#AutoIt3Wrapper_Res_Description=Traitement batch
#AutoIt3Wrapper_Res_Fileversion=0.0.0.3
#AutoIt3Wrapper_Res_Fileversion_AutoIncrement=y
#AutoIt3Wrapper_Res_LegalCopyright=samj 2008
#AutoIt3Wrapper_Res_Language=3084
#EndRegion 

;**** Directives created by AutoIt3Wrapper_GUI ****
;;;;; Copyright (C) 2006-2008 SAMJ sylviale@bigfoot.com - www.aljacom.com/~gimp
;;;;; This program is free software; you can redistribute it and/or modify it under the terms 
;;;;; of the GNU General Public License as published by the Free Software Foundation; either version 2 
;;;;; of the License, or (at your option) any later version.
;;;;; This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without
;;;;; even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. 
;;;;; See the GNU General Public License for more details.
;;;;; You should have received a copy of the GNU General Public License along with this program; if not, 
;;;;; see <http://www.gnu.org/licenses>.

$file = ""
$line = ""
$repertoire_bash = "batch"
$fichier_txt_cdes_bash = "batch.txt"
If ProcessExists("win-bash.exe") or ProcessExists("gimp-2.6.exe") Then 
; win-bash.exe ou gimp-2.6.exe est utilisé 
   MsgBox(16,"Fin","win-bash.exe ou gimp-2.6.exe est actif")
   Exit
EndIf
Run( @ScriptDir & "\bin\win-bash.exe" , @ScriptDir & "\bin" ) ; démarrer win-bash.exe
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If WinWait(@ScriptDir & "\bin\win-bash.exe", "", 20) = 1 Then 
; attendre la fenêtre win-bash.exe 20 secondes
   ; la fenêtre est là
   Sleep(1000)
Else
   MsgBox(16,"Fin","Temporisation win-bash.exe trop longue")
   Exit
EndIf
; déterminer USERPROFILE
$userprofile = "export USERPROFILE=" & @ScriptDir & "\" & $repertoire_bash & "\USERPROFILE"
$userprofile = StringReplace($userprofile,"\","\\")
WinActivate(@ScriptDir & "\bin\win-bash.exe", "")
Send($userprofile & @CR , 1)
Sleep(1000)
; déterminer HOMEPATH
$homepath = "export HOMEPATH=" & @ScriptDir & "\" & $repertoire_bash
$homepath = StringReplace($homepath,"\","\\")
WinActivate(@ScriptDir & "\bin\win-bash.exe", "")
Send($homepath & @CR , 1)
Sleep(1000)
; déterminer TEMP
$temp = "export TEMP=" & @ScriptDir & "\" & $repertoire_bash & "\Temp"
$temp = StringReplace($temp,"\","\\")
WinActivate(@ScriptDir & "\bin\win-bash.exe", "")
Send($temp & @CR , 1)
Sleep(1000)
; déterminer TMP
$tmp = "export TMP=" & @ScriptDir & "\" & $repertoire_bash & "\Temp"
$tmp = StringReplace($tmp,"\","\\")
WinActivate(@ScriptDir & "\bin\win-bash.exe", "")
Send($tmp & @CR , 1)
Sleep(1000)
; déterminer GIMP2_DIRECTORY
$rep_pref_temp = "export GIMP2_DIRECTORY=" & @ScriptDir & "\" & $repertoire_bash
$rep_pref_temp = StringReplace($rep_pref_temp,"\","\\")
WinActivate(@ScriptDir & "\bin\win-bash.exe", "")
Send($rep_pref_temp & @CR , 1)
Sleep(1000)
$file = FileOpen(@ScriptDir & "\" & $fichier_txt_cdes_bash, 0)
   If $file = -1 Then
       ; impossible d'ouvrir le fichier
       MsgBox(0,"Fin","impossible d'ouvrir le fichier " & $fichier_txt_cdes_bash )
   Else
       ; lire toutes les lignes
       While 1
           $line = FileReadLine($file)         
           If @error = -1 Then ExitLoop
           If $line = "fin" Then ExitLoop
           ; MsgBox(0,"$line",$line)
           WinActivate(@ScriptDir & "\bin\win-bash.exe", "")
           Send($line & @CR , 1) ; envoyer le contenu de la ligne à win-bash.exe
           sleep (1000) ; 
       Wend        
       FileClose($file)
   EndIf
   
WinActivate(@ScriptDir & "\bin\win-bash.exe", "")
Send("exit" & @CR , 1) ; fermer la fenêtre
Exit
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TRAITEMENT PAR LOT VIA UN MENU DE G IMP

ÉCHELLE  PROPORTIONNELLE

Voici un Script-Fu qui permet de réduire la taille des images contenues dans un répertoire. Le traitement est 
accessible depuis Gimp par : Fichier > Créer > Batch Image Scale By Ratio

; batch_rescale.scm
; origine http://madberry.org/2008/10/using-script-fu-in-gimp/
; modifications samj octobre 2008 pour Gimp 2.6
;
(define (script-fu-batch-scale-ratio globexp ratio interpolation)
  (define (resize-img n f)
   (let* ((fname (car f))
          (img (car (gimp-file-load 1 fname fname))))
       (let* (
             (drawable   (car (gimp-image-active-drawable img)))
             (cur-width  (car (gimp-image-width img)))
             (cur-height (car (gimp-image-height img)))
          (new-width  (* ratio cur-width))
          (new-height (* ratio cur-height))
             (new_ratio      (min (/ new-width cur-width) (/ new-height cur-height)))
             (width      (* new_ratio cur-width))
             (height     (* new_ratio cur-height))
          )

         (gimp-image-undo-disable img)
         (gimp-image-scale-full img width height interpolation)
         (gimp-file-save 1 img (car (gimp-image-get-active-drawable img)) fname fname)
         (gimp-image-delete img)
      )
    )
    (if (= n 1) 1 (resize-img (- n 1) (cdr f)))
  )
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  (let* ((files (file-glob globexp 0)))
     (resize-img (car files) (car (cdr files))))
)

(script-fu-register "script-fu-batch-scale-ratio"
          _"Batch Image Scale By Ratio"
          "Hey!"
          "Nicholas Herring and Richard Hirner"
          "2008, Nicholas Herring based on a script by Richard Hirner"
          "March 26, 2008"
          ""
          SF-STRING "Full path with wildcards" "C:\\essai\\*.jpg"
          SF-VALUE "Scaling ratio (min 0.01, max 1)" "0.50"

  SF-VALUE "Interpolation (0=sans 1=linear 2=cubic 3=lanczos)" "2")
(script-fu-menu-register "script-fu-batch-scale-ratio"
          "<Image>/File/Create")

Ce Script-Fu peut aussi être exécuté via une ligne de commande :
C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(script-fu-batch-scale-ratio "C:\\essai\\*.jpg" 0.52 2)' -b '(gimp-quit 0)'

COLORISATION

Ce Script-Fu permet une colorisation des images contenues dans un répertoire. Le traitement est accessible 
depuis Gimp par : Fichier > Créer > Colorize
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; origine http://archives.free.net.ph/message/20050411.040706.449dec96.en.html
; Adaptation et correction Windows et Gimp 2.6 par samj octobre 2008
;; batch-convert-colorize.scm -- convert a set of files to index
;; call it from the command-line using a line like the following:
;; C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(script-fu-batch-colorize "C:\\essai\\*.jpg" 180 40 10)' -b '(gimp-quit 0)'
;; hue=180 saturation=40 lightness=10
;; or from menu File -> Create -> Colorize
(define (script-fu-batch-colorize pattern hue saturation lightness)
  (let* ((filelist (cadr (file-glob pattern 1))))
    (while (not (null? filelist))
           (let* ((filename (car filelist))
                  (image (car (gimp-file-load RUN-NONINTERACTIVE
                                              filename filename)))
                  (drawable (car (gimp-image-get-active-layer image))))
             (gimp-colorize drawable hue saturation lightness)
             (gimp-file-save RUN-NONINTERACTIVE
                             image drawable filename filename)
             (gimp-image-delete image))
           (set! filelist (cdr filelist)))))
(script-fu-register "script-fu-batch-colorize"

_"_Colorize..."
_"Colorize a set of files"
""
"J.Filby"
"10/04/2005"
""
SF-STRING _"File(s)" "C:\\essai\\*.png"
SF-ADJUSTMENT _"Hue" '(180 0 360 1 10 0 0)
SF-ADJUSTMENT _"Saturation" '(50 0 100 1 10 0 0)
SF-ADJUSTMENT _"Lightness" '(0 -100 100 1 10 0 0)

)
(script-fu-menu-register "script-fu-batch-colorize"
             "<Image>/File/Create") 

Ce Script-Fu peut aussi être exécuté via une ligne de commande :
C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(script-fu-batch-colorize "C:\\essai\\*.jpg" 180 40 10)' -b '(gimp-quit 0)'
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CONVERSION

Ce Script-Fu permet la conversion des 
images contenues dans un répertoire en un 
autre type d'images. 
Le traitement est accessible depuis Gimp par 
: Fichier > Créer > Conversion images

; batch-save-as-image.scm 
; samj octobre 2008
;
; enregistre des images dans un autre type (conversion) en ajoutant l'extension au nom de l'image d'origine
; C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-save-as-image "C:\\essai\\*.xcf" ".png")' -b '(gimp-quit 0)'
;
(define (batch-save-as-image pattern

        nouvelle_extension)
  (let* ((filelist (cadr (file-glob pattern 1))))
    (while (not (null? filelist))

(let* ((filename (car filelist))
(image (car (gimp-file-load RUN-NONINTERACTIVE

                                              filename filename)))
(drawable (car (gimp-image-get-active-layer image)))) 
(gimp-image-flatten image)            
(set! drawable (car (gimp-image-get-active-layer image))) 
(gimp-file-save RUN-NONINTERACTIVE

              image drawable (strcat filename nouvelle_extension) (strcat filename nouvelle_extension) )
(gimp-image-delete image))

           (set! filelist (cdr filelist)))))
(script-fu-register "batch-save-as-image"

_"_Conversion images..."
_"Taitement par lot conversion images"
""
"samj"
"octobre 2008"
""
SF-STRING _"Fichier(s)" "C:\\essai\\*.xcf"
SF-STRING _"Nouvelle extension" ".png"

)
(script-fu-menu-register "batch-save-as-image"
             "<Image>/File/Create")  

Ce Script-Fu peut aussi être exécuté via une ligne de commande :
C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-save-as-image "C:\\essai\\*.xcf" ".bmp")' -b '(gimp-quit 0)'
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APPLIQUER  LE  FILTRE  TRAME  D ' IMPRIMERIE

Le Script-Fu  batch-plug-in-newsprint.scm a été créé pour illustrer un exemple d'application d'un filtre de 
Gimp (Trame d'imprimerie ou plug-in-newsprint) à une séquence vidéo décrit page 125  .  

Le traitement est accessible 
depuis Gimp par : Fichier > 
Créer > Traitement par lot : 
Filtre trame d imprimerie

Ce Script-Fu peut aussi être exécuté via une ligne de commande :
C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-plug-in-newsprint "C:\\essai\\*.tga" ".tga" 15 0 2 45.0 15.0 75.0 5.0)' -b 

'(gimp-quit 0)'

Représentation des correspondances entre les nombreux paramètres du filtre plug-in-newsprint :
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Pour utiliser un autre filtre suivre les indications données dans le code du Script-Fu :
; batch-plug-in-newsprint.scm 
; samj octobre 2008
;
; paramètres du script Roy-Lichtenstein.scm par Cprogrammer
; C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(batch-plug-in-newsprint "C:\\essai\\*.tga" ".tga" 15 0 2

 ; 45.0 15.0 75.0 5.0)' -b '(gimp-quit 0)'
;
; Modifications :
; pour changer de filtre modifier entre les lignes _______ et - - - -
; pour changer le nom du script modifier toutes les lignes contenant le texte : batch-plug-in-newsprint
;

(define ( batch-plug-in-newsprint
pattern

        extension
; ______________________________________________________

        pixelSize
colorspace

        spotFunc
        blackAng
        cyanAng
        magentaAng
        yellowAng

;- - - - - - - - - - - - - - - - - - - - - - - - - - - -
)

  (let* ((filelist (cadr (file-glob pattern 1))))
    (while (not (null? filelist))

(let* ((filename (car filelist))
(image (car (gimp-file-load RUN-NONINTERACTIVE

                                              filename filename)))
(drawable (car (gimp-image-get-active-layer image)))) 
(gimp-image-flatten image)            
(set! drawable (car (gimp-image-get-active-layer image)))

; ______________________________________________________
 (plug-in-newsprint RUN-NONINTERACTIVE
                             image drawable pixelSize colorspace 100 blackAng spotFunc cyanAng spotFunc 

magentaAng spotFunc yellowAng spotFunc 15)
;- - - - - - - - - - - - - - - - - - - - - - - - - - - -

(gimp-file-save RUN-NONINTERACTIVE
                             image drawable (strcat filename extension) (strcat filename extension) )

(gimp-image-delete image))
           (set! filelist (cdr filelist)))))
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; ______________________________________________________
(script-fu-register "batch-plug-in-newsprint"

_"_Traitement par lot : Filtre trame d imprimerie"
_"Batch plug-in-newsprint"

;- - - - - - - - - - - - - - - - - - - - - - - - - - - -
""
"samj"
"octobre 2008"
""
SF-STRING _"Fichier(s)" "C:\\essai\\*.tga"
SF-STRING _"Extension" ".tga"

; ______________________________________________________
SF-ADJUSTMENT "Newsprint Pixel Size" '(3 1 20 1 10 1 1)
SF-OPTION "Colorspace 0:RGB 1:CMYK 2:Luminance" '("0" "1" "2")
SF-OPTION "Spot Function 0:dots 1:lines 2:diamonds 3:euclidean dot 4: PS Diamond" '("0" "1" "2" 

"3" "4")
SF-ADJUSTMENT "Black Angle" '(45 -90 90 1 10 1 1)
SF-ADJUSTMENT "Cyan Angle" '(15 -90 90 1 10 1 1)
SF-ADJUSTMENT "Magenta Angle" '(75 -90 90 1 10 1 1)
SF-ADJUSTMENT "Yellow Angle" '(0 -90 90 1 10 1 1)

;- - - - - - - - - - - - - - - - - - - - - - - - - - - -
)

(script-fu-menu-register "batch-plug-in-newsprint"
             "<Image>/File/Create") 

Avant traitement Après traitement (Paramètres page 167)
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TRAITEMENT  AVEC  LE  SCRIPT-FU W ATERMARK - IT-F.SCM

Le Script-Fu « watermark-it-f.scm » permet d'appliquer une image et/ou un texte sur une image. L'utilisation 
d'origine est prévue pour marquer ses images avec un copyright, un logo. Les qualités de ce script autorisent 
son usage pour modifier des séquences vidéo.

Ce script est disponible à la page http://www.td-e.com/soft/watermark-it.php (Version anglaise) ou http://td-
e.com/soft-fr/watermark-it.php (Version française) ainsi que dans l'archive images_gimp.7z de notre site. Il est 
accompagné d'un script (watermark-batch.scm version 1,02) pour effectuer un traitement par lot qui, 
malheureusement, ne fonctionne pas sous Gimp 2.6.1 Windows XP.

Pour pouvoir utiliser les possibilités de « watermark-it-f.scm » pour un traitement vidéo, le script watermark-
batch_samj.scm a été créé. Comparé à watermark-batch.scm, watermark-batch_samj.scm  a un fonctionnement 
et des caractéristiques un peu différentes au niveau des 2 premiers paramètres : Fichiers(s) – Extension.

Pour activer le traitement par lot, sur 
l'image faire : Fichier > Créer > Traitement 
par lot : Scrip-Fu watermark-it

http://td-e.com/soft-fr/watermark-it.php
http://td-e.com/soft-fr/watermark-it.php
http://www.td-e.com/soft/watermark-it.php
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Résultat : 

Ce Script-Fu peut aussi être exécuté via une ligne de commande :
C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(watermark-batch_samj "C:\\essai\\*.tga" ".tga" "C:\\essai\\image.xcf" 10 10 60 

"Bla Bla" 20 20 90 40 "Arial" 20 "White" 1 1 1 1 1 1 1)' -b '(gimp-quit 0)'

Code du script :
; watermark-batch_samj.scm 
; samj octobre 2008 http://www.aljacom.com/~gimp
;
; C://gimp_2_6_1//bin//gimp-2.6.exe -i -b '(watermark-batch_samj "C:\\essai\\*.tga" ".tga"
; "C:\\essai\\image.xcf" 10 10 60 "Bla Bla" 20 20 90 40 "Arial" 20 "White" 1 1 1 1 1 1 1)' -b '(gimp-quit 0)'
;
; Modifications :
; pour changer de filtre modifier entre les lignes _______ et - - - -
; pour changer le nom du script modifier toutes les lignes contenant le texte : watermark-batch_samj
;
; samj octobre 2008 Adaptation pour fonctionner avec Gimp 2.6.1 + modification interface
; Version française par http://td-e.com/soft-fr/watermark-it.php
; Copyright (c) 2007 Tharsice Demand <www.td-e.com>
;
;This program is free software; you can redistribute it and/or
;modify it under the terms of the GNU General Public License
;as published by the Free Software Foundation; either version 2
;of the License, or (at your option) any later version.
;
;This program is distributed in the hope that it will be useful,
;but WITHOUT ANY WARRANTY; without even the implied warranty of
;MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
;GNU General Public License for more details.
;
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;You should have received a copy of the GNU General Public License
;along with this program; if not, write to the Free Software
;Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA.
;
;Copy of the license at http://td-e.com/site/gpl.php
;

(define ( watermark-batch_samj
pattern

        extension
; ______________________________________________________

        wmfile xmargini ymargini opai wmtext xmargint 
ymargint opat opatb wmfont wmfontsize wmfontcolor wmnocolor
wmemboss toplef toprig botlef botrig centered

;- - - - - - - - - - - - - - - - - - - - - - - - - - - -
)

  (let* ((filelist (cadr (file-glob pattern 1))))
    (while (not (null? filelist))

(let* ((filename (car filelist))
(image (car (gimp-file-load RUN-NONINTERACTIVE

                                              filename filename)))
(drawable (car (gimp-image-get-active-layer image)))) 
(gimp-image-flatten image)            
(set! drawable (car (gimp-image-get-active-layer image))) 

; ______________________________________________________
(script-fu-watermark-it 

             image drawable wmfile xmargini ymargini opai wmtext xmargint 
ymargint opat opatb wmfont wmfontsize wmfontcolor wmnocolor 
wmemboss toplef toprig botlef botrig centered)

(set! drawable (car (gimp-image-get-active-layer image)))
;- - - - - - - - - - - - - - - - - - - - - - - - - - - -

(gimp-file-save RUN-NONINTERACTIVE
                             image drawable (strcat filename extension) (strcat filename extension) )

(gimp-image-delete image))
           (set! filelist (cdr filelist)))))

; ______________________________________________________
(script-fu-register "watermark-batch_samj"

_"_Traitement par lot : Scrip-Fu watermark-it"
_"Batch Scrip-Fu watermark-it"

;- - - - - - - - - - - - - - - - - - - - - - - - - - - -
""
"Copyright (c) 2007 Tharsice Demand <www.td-e.com>"
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"samj octobre 2008"
""
SF-STRING _"Fichier(s)" "C:\\essai\\*.tga"
SF-STRING _"Extension" ".tga"

; ______________________________________________________
SF-STRING "Image filigrane--------------" "C:\\essai\\image.jpg"
SF-ADJUSTMENT "Marge X image" '(10 0 250 1 10 0 1)
SF-ADJUSTMENT "Marge Y image" '(10 0 250 1 10 0 1)
SF-ADJUSTMENT "Opacite image" '(60 1 100 1 10 0 1)
SF-STRING "Texte filigrane------------------" "(c)2007 Nom de l'auteur"
SF-ADJUSTMENT "Marge X texte" '(20 0 250 1 10 0 1)
SF-ADJUSTMENT "Marge Y texte" '(20 0 250 1 10 0 1)
SF-ADJUSTMENT "Opacite texte" '(90 1 100 1 10 0 1)
SF-ADJUSTMENT "Opacite perimetre texte" '(40 0 100 1 10 0 1)
SF-FONT "Police caractere" "Arial Bold"
SF-ADJUSTMENT "Hauteur police (pixels)" '(20 6 1000 1 10 0 1)
SF-COLOR "Couleur police" '(255 208 128)
SF-TOGGLE "Sans couleur c.a.d. eclaircir ou assombrir image" FALSE
SF-TOGGLE "Texte en relief" TRUE
SF-OPTION "EN HAUT A GAUCHE" '("Pas de filigrane" "Filigrane image" "Filigrane texte")
SF-OPTION "EN HAUT A DROITE" '("Pas de filigrane" "Filigrane image" "Filigrane texte")
SF-OPTION "EN BAS A GAUCHE" '("Pas de filigrane" "Filigrane image" "Filigrane texte")
SF-OPTION "EN BAS A DROITE" '("Pas de filigrane" "Filigrane image" "Filigrane texte")
SF-OPTION "AU CENTRE" '("Pas de filigrane" "Filigrane image" "Filigrane texte")

;- - - - - - - - - - - - - - - - - - - - - - - - - - - -
)

(script-fu-menu-register "watermark-batch_samj"
             "<Image>/File/Create") 
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DÉMARRER  UN TRAITEMENT  PAR LOT À PARTIR DE MSYS
MSYS et MinGW sont les outils de développement libres pour Windows.

MSYS est en téléchargement à http://downloads.sourceforge.net/mingw/MSYS-1.0.10.exe 

        Liens pour installer  MSYS et MinGW :
 http://www.mingw.org/wiki/msys et 
 http://www.mingw.org/wiki/HOWTO_Install_the_MinGW_GCC_Compiler_Suite 

Pour cet exemple 

– Nous créons un fichier texte batch_msys_gimp dans C:\gimp_2_6_x dont le contenu est  :
/gimp/bin/gimp-2.6.exe -i -b '(batch-plug-in-newsprint "C:\\essai\\*.tga" ".tga" 15 0 2 45.0 15.0 75.0 5.0)' -b '(gimp-quit 0)'

– Nous créons ou modifions le fichier C:\msys\1.0\etc\fstab avec le contenu de la deuxième ligne :
#Win32_Path Mount_Point
C:/gimp_2_6_2 /gimp

 Ceci permet d'aller directement dans le répertoire où est maringouin par cd /gimp

– Attention aux signes / et \

– Pour démarrer le traitement faire ./ batch_msys_gimp

Ce code d'erreur est normal et connu pour Gimp 2.6.2

http://www.mingw.org/wiki/HOWTO_Install_the_MinGW_GCC_Compiler_Suite
http://www.mingw.org/wiki/msys
http://downloads.sourceforge.net/mingw/MSYS-1.0.10.exe
http://www.mingw.org/
http://fr.wikipedia.org/wiki/MSYS
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DÉMARRER  UN TRAITEMENT  PAR LOT À PARTIR DE LA CONSOLE SCRIPT-FU

Nous pouvons aussi démarrer des traitements à partir de la console des Scripts-Fu. 

Dans un premier temps nous devons ouvrir cette console par : Filtres > Script-Fu > Console

Ensuite, coller une ligne de commande (ici un exemple précédent) et appuyer sur la touche Entrée.

Attendre la fin du traitement ().

Pour sauvegarder le contenu de la console, appuyer sur le bouton « Enregistrer », choisir un nom de fichier. 
Exemple du contenu sauvegardé :
 Bienvenue sur TinyScheme
Copyright (c) Dimitrios Souflis
Console Script-Fu - Développement Scheme interactif

> (script-fu-batch-colorize "C:\\essai\\*.jpg" 180 40 10)
()

GREFFON DBP (DAVID 'S BATCH  PROCESSOR) POUR TRAITEMENTS  PAR LOT

Voir l'utilisation de ce greffon bien pratique à la page 284  .  
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TRAITEMENT PAR LOT AVEC GIMP-CONSOLE-2.6.EXE

Dans cet exemple nous faisons des traitements en ligne de commande ou des traitements par lots en utilisant 
l'exécutable gimp-console-2.6.exe.

Nous utilisons le script-fu créé par odie5533 et disponible à la page http://odie5533.com/gimp-resize-and-
match-dpi-in-scheme-304 . Il suffit de placer ce script-fu dans le répertoire des scripts. 

Voici le code de ce script :
; auteur : odie5533  May 16, 2010
; site   : http://odie5533.com/gimp-resize-and-match-dpi-in-scheme-304
; Released under the GNU GPL 3.0 or later
; Resize-match-dpi is a GIMP Script-Fu script written in Scheme to resize or scale an image along with 
scaling the DPI. 
; Let’s consider an image being scanned which is 4.75" x 4.70". 
; We scan the image at 300 DPI with a pixel resolution of 1425 x 1409 and we want to scale it down to 
1280×1266. 
; Using IrfanView, XNView, GIMP, and other programs will rescale the image, but the DPI will still be 300. 
; This means when the image is viewed on a monitor or printed out it will appear too small (4.27" x 4.22"). 
; This script scales the DPI to match the new pixel resolution so it will still appear as 4.75" x 4.70".
;
(define (resize-match-dpi image drawable newwidth newheight)
  (let* (

 (oldwidth (car (gimp-image-width image)))
 (oldheight (car (gimp-image-height image)))
 (newdpi 0)

        )
    (if (= newheight 0)
        (set! newheight (round (* (/ oldheight oldwidth) newwidth)))

()
    )
    (if (= newwidth 0)

(set! newwidth (round (* (/ oldwidth oldheight) newheight)))
()

    )
    (set! newdpi (/ (* newwidth (car (gimp-image-get-resolution image))) oldwidth))
    (gimp-image-undo-group-start image)
    (gimp-image-scale image newwidth newheight)
    (gimp-image-set-resolution image newdpi newdpi)
    (gimp-image-undo-group-end image)
))

(define (resize_match_dpi filename output newwidth newheight)
  (let* ((image    (car (gimp-file-load RUN-NONINTERACTIVE filename filename)))
         (drawable (car (gimp-image-get-active-layer image)))
        )
    (resize-match-dpi image drawable newwidth newheight)
    (gimp-file-save RUN-NONINTERACTIVE image drawable output output)

http://odie5533.com/gimp-resize-and-match-dpi-in-scheme-304
http://odie5533.com/gimp-resize-and-match-dpi-in-scheme-304
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    (gimp-image-delete image)
))

(define (resize_match_dpi_multi pattern outdir newwidth newheight)
  (let* ((filelist (cadr (file-glob pattern 1))))
    (while (not (null? filelist))

   (let* ((filename (car filelist))
  (image    (car (gimp-file-load RUN-NONINTERACTIVE

 filename filename)))
  (drawable (car (gimp-image-get-active-layer image)))
  (outf (string-append outdir "/" filename)))

     (resize-match-dpi image drawable newwidth newheight)
     (gimp-file-save RUN-NONINTERACTIVE image drawable outf outf)
     (gimp-image-delete image))
   (set! filelist (cdr filelist)))))

(script-fu-register "resize-match-dpi"
  "<Image>/Script-Fu/Resize Match DPI"
  "Resize and match DPI"
  "odie5533"
  "odie5533"
  "2010-05-16"
  "RGB*"
  SF-IMAGE "Image"  0
  SF-DRAWABLE "Drawable" 0

  SF-VALUE  "New width" "1280"
  SF-VALUE  "New height" "0"
)

Ce script est directement accessible depuis Gimp sur l'image par Script-Fu > Resize Match DPI.

Il est aussi possible d'utiliser gimp-console-2.6.exe en lignes de commandes via l'Invite de commandes de 
Windows ou d'utiliser un fichier de commandes .bat

L IGNES  DE COMMANDES

Il suffit d'adapter, de copier ou de taper ces lignes de commandes dans l'Invite de commandes de Windows 
( activé par Démarrer > Tous les programmes > Accessoires > Invite de commandes) : 

PATH C:\gimp_2_6_8\bin;%PATH%

cd C:\gimp_2_6_8\bin

gimp-console-2.6.exe -i -b "(resize_match_dpi \"C:/toto/input.bmp\" \"C:/toto/output.bmp\" 1280 0)" -b "(gimp-quit 0)"

Il faut appuyer sur la touche Entrée à la fin de chaque ligne.

La première ligne de commande ajoute le répertoire à la variable PATH. La deuxième ligne nous place dans 
le répertoire de l'exécutable  gimp-console-2.6.exe . La troisième ligne lance cet exécutable et demande d'agir 
sur le fichier C:\toto\input.bmp\ et de placer le résultat comme C:\toto\output.bmp. La largeur est de 1280 
pixels et la hauteur proportionnelle (0 comme quatrième paramètre du script).
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Il faut noter l'usage particulier des caractères / et \ . L'adressage des fichiers peut être direct ou relatif par 
rapport à l'exécutable.

Les images sont dans le répertoire de l'exécutable (C:\gimp_2_6_8\bin) :
gimp-console-2.6.exe -i -b "(resize_match_dpi \"input.bmp\" \"output.bmp\" 1280 0)" -b "(gimp-quit 0)"

Les images sont au niveau supérieur (C:\gimp_2_6_8) :
gimp-console-2.6.exe -i -b "(resize_match_dpi \"../input.bmp\" \"../output.bmp\" 1280 0)" -b "(gimp-quit 0)"

Les images sont dans un répertoire spécifié (C:\toto) :
gimp-console-2.6.exe -i -b "(resize_match_dpi \"C:/toto/input.bmp\" \"C:/toto/output.bmp\" 1280 0)" -b "(gimp-quit 0)"

TRAITEMENT PAR LOT VIA UN FICHIER .BAT

Dans cet exemple nous traitons les fichiers fichier2.bmp, fichier3.bmp et fichier4.bmp

Contenu du fichier .bat :
; ajouter le répertoire de l'exécutable dans PATH
PATH C:\gimp_2_6_8\bin;%PATH%

; aller dans le répertoire de l'exécutable
cd C:\gimp_2_6_8\bin

; boucle (début=2,pas=1,fin=4) pour mise à l'échelle fichier2.bmp, fichier3.bmp, fichier4.bmp
for /L %%X in (2,1,4) do gimp-console-2.6.exe -i -b "(resize_match_dpi \"C:/toto/fichier%
%X.bmp\" \"C:/toto/echelle%%X.bmp\" 1280 0)" -b "(gimp-quit 0)"

Ce type de traitement est relativement long car il faut faire un démarrage et un arrêt de gimp-console-2.6.exe 
pour chaque image. X est la variable qui prendra successivement, à chaque itération, les valeurs 2, 3 et 4.

Il de copier ces lignes, les coller et les adapter dans un éditeur de texte et enregistrer sous avec l'extension 
.bat . Faire un double clic sur ce fichier pour démarrer le traitement.

Exemple du fichier dans le bloc-notes de Windows :
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COMPRESSER LES FICHIERS IMAGES EN LIGNE DE COMMANDE

Gimp version Windows est fourni avec un programme utilitaire bzip2.exe de compression de données. 
Ce programme est utilisé par Gimp pour obtenir les fichiers avec l'extension .bz2  (.xcf.bz2 par exemple).

Ce programme se trouve dans  C:\gimp_2_6_x\bin\bzip2.exe et peut être utilisé en ligne de commande pour 
compresser le fichiers images en ligne de commande (Traitement par lot).

OPTIONS  DE LA LIGNE DE COMMANDE  DE BZIP2.EXE

bzip2, a block-sorting file compressor.  Version 1.0.3, 15-Feb-2005.
   usage: bzip2.exe [flags and input files in any order]
   -h --help           print this message
   -d --decompress     force decompression
   -z --compress       force compression
   -k --keep           keep (don't delete) input files
   -f --force          overwrite existing output files
   -t --test           test compressed file integrity
   -c --stdout         output to standard out
   -q --quiet          suppress noncritical error messages
   -v --verbose        be verbose (a 2nd -v gives more)
   -L --license        display software version & license
   -V --version        display software version & license
   -s --small          use less memory (at most 2500k)
   -1 .. -9            set block size to 100k .. 900k
   --fast              alias for -1
   --best              alias for -9
   If invoked as `bzip2', default action is to compress.
              as `bunzip2',  default action is to decompress.
              as `bzcat', default action is to decompress to stdout.
   If no file names are given, bzip2 compresses or decompresses
   from standard input to standard output.  You can combine
   short flags, so `-v -4' means the same as -v4 or -4v, &c.

EXEMPLES DE LIGNES  DE COMMANDES

COMPRESSION  (-Z)
C:\gimp_2_6_x\bin\bzip2.exe -z C:\toto\skin_tone.xcf

Compresser le fichier skin_tone.xcf du répertoire C:\toto. Le fichier skin_tone.xcf  deviendra skin_tone.xcf .bz2

C:\gimp_2_6_x\bin\bzip2.exe -z C:\toto\*.xcf

Compresser tous les fichiers .xcf du répertoire C:\toto. Les fichiers .xcf  deviendront .xcf .bz2

http://fr.wikipedia.org/wiki/Compression_de_donn%C3%A9es
http://fr.wikipedia.org/wiki/Bzip2
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C:\gimp_2_6_x\bin\bzip2.exe -z -k -v -v C:\toto\*.xcf

Compresser tous les fichiers .xcf du répertoire C:\toto avec toutes les informations dans la fenêtre de commandes 
(Options -v -v).  Les fichiers .xcf  seront conservés (Option -k), les fichiers compressés seront en .xcf .bz2

C:\gimp_2_6_x\bin\bzip2.exe -z -k -v -v C:\toto\*.bmp

Compresser tous les fichiers .bmp du répertoire C:\toto avec toutes les informations dans la fenêtre de commandes 
(Options -v -v).  Les fichiers .bmp  seront conservés (Option -k), les fichiers compressés seront en .bmp.bz2 . Ces 
fichiers .bmp.bz2  peuvent être ouverts directement dans Gimp. Il est possible de compresser d'autres formats : 
TIFF, PSD, etc.

DÉCOMPRESSION  (-D)
C:\gimp_2_6_x\bin\bzip2.exe -d C:\toto\skin_tone.xcf.bz2

Décompresser le fichier skin_tone.xcf.bz2 du répertoire C:\toto. Le fichier skin_tone.xcf.bz2 deviendra skin_tone.xcf

C:\gimp_2_6_x\bin\bzip2.exe -d C:\toto\*.xcf.bz2

Décompresser tous les fichiers .xcf.bz2 du répertoire C:\toto. Les fichiers .xcf.bz2  deviendront .xcf

C:\gimp_2_6_x\bin\bzip2.exe -d -k -v -v C:\toto\*.xcf.bz2

Décompresser tous les fichiers .xcf.bz2 du répertoire C:\toto avec toutes les informations dans la fenêtre de 
commandes (Options -v -v).  Les fichiers .xcf.bz2  seront conservés (Option -k), les fichiers décompressés seront 
en .xcf

NOTA : Les noms des répertoires, de fichiers ne doivent pas contenir d'espaces.
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LES GREFFONS FOURNIS AVEC NOTRE ARCHIVE

GUTENPRINT  & CUPS FOR W INDOW S

But : Imprimer des images en fonction des réglages et des pilotes d'imprimantes avec un très grand nombre 
d'options.

Site : http://webblog.ru/Dickobraz                                   

Auteur :     

Téléchargement sources :   http://webblog.ru/Dickobraz / (http://gimp-print.sourceforge.net 
http://sourceforge.net/projects/gimp-print/).                

Version :  Gutenprint-5.2.0-rc1             

Testé avec : Gimp 2.6.2

Appel du greffon :   Sur l'image par Fichier > Print with Gutenprint.  

Utilisation :

– Créer le nom d'une imprimante à partir du bouton « New Printer », exemple Imprimante PDF

– Choisir le modèle à partir du bouton « Setup Printer » , exemple Printer make = Adobe Post Script 2 / 
Printer queue = PDF Creator (si installé).

– Valider le format du papier dans la zone  Paper size.

– Positionner l'image dans les zones Image position et Image size.

– Ajuster les couleurs dans l'onglet Output, bouton Adjust output.

– Imprimer avec le bouton Print ou Print and save settings.

http://sourceforge.net/projects/gimp-print/
http://gimp-print.sourceforge.net/
http://webblog.ru/Dickobraz
http://webblog.ru/Dickobraz
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GREYCSTORATION

But : Diminuer le bruit sdes photographies, effets de « dessin ».

Site :  http://cimg.sourceforge.net/greycstoration/                                  

Auteur :  Image Team, GREYC Lab (UMR CNRS 6072)    

Téléchargement sources : http://cimg.sourceforge.net/greycstoration/download.shtml                   

Version :  2.9              

Testé avec : Gimp 2.6.0

Appel du greffon :   Sur l'image par Filtres > Amélioration > GREYCstoration.  

À partir de Gimp 2.6.1 la version de GREYCstoration sera celle proposée par photocomix.

Extraits du fichier README.txt
# Author
  David Tschumperle  ( http://www.greyc.ensicaen.fr/~dtschump/ )
  with the help of
  - David Cortesi (compiled MAC OS X Intel version + TCL script for GUI).
  - Nikita Melnichenko (bugs corrections).
  - Grzegorz Szwoch (source code of the GIMP plugin).
  - Michel Talon (compiled FreeBSD version).
  - Bernard Duhamel (compiled Linux64 plug-in version).
# About the GIMP plug-in :
 The GIMP GREYCstoration plugin has been developed by Grzegorz Szwoch  (greg(at)sound.eti.pg.gda.pl)
 The plugin is accessible from the menu : 'Filters/Enhance/GREYCstoration' 
 Installation : Copy the correct file 'GREYCstoration_gimp_*' from the GREYCstoration archive  into the 

GIMP's plugin directory. That's it !
 Details :
 This is an implementation of GREYCstoration algorithm as a plugin for GIMP  (www.gimp.org). Only 

RESTORE mode is implemented.
 Note that there is an existing GREYCstoration plugin in the GIMP registry  (registry.gimp.org). 

However, that plugin (greycstoration-0.2.0) is OBSOLETE,  based on OLD and SLOW code, and is no longer 
maintained. Please do not use it !
 On the contrary, the plugin provided in this package uses the most recent  GREYCstoration version and 

may be easily updated.
 The denoising process may be still slow with big images.
 If you have any questions or comments regarding the GIMP plugin, please e-mail 

greg(at)sound.eti.pg.gda.pl. Questions related to the algorithm should be sent  to the GREYCstoration 
author (or, even better, use the dedicated forum on sourceforge).
 To compile the plug-in, please type 'make gimp' in the 'src/' directory.

Didacticiels :

http://cimg.sourceforge.net/greycstoration/demonstration.shtml (en anglais)

http://www.commentcamarche.net/faq/sujet-3179-restaurer-une-photo-avec-greycstoration par sebsauvage

http://www.commentcamarche.net/faq/sujet-3179-restaurer-une-photo-avec-greycstoration
http://cimg.sourceforge.net/greycstoration/demonstration.shtml
http://photocomix-resources.deviantart.com/art/Greycstoration2-9pluginWin-94412740
http://cimg.sourceforge.net/greycstoration/download.shtml
http://cimg.sourceforge.net/greycstoration/
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UFRAW

But : Importer des images au format RAW directement dans Gimp (Liste des appareils photographiques 
supportés à la page http://ufraw.sourceforge.net/Cameras.html).

Site :   http://ufraw.sourceforge.net/                                

Auteur :  Udi Fuch    

Téléchargement sources : http://sourceforge.net/project/showfiles.php?group_id=127649                                

Version :  0.14              

Testé avec : Gimp 2.6.2

Appel du greffon :   Automatique lors de l'ouverture d'un fichier RAW.  

Nota : Un document en français réalisé par Vincent Deroo (traduction et adaptation) est disponible à la page 
http://vincent.deroo.free.fr/NikonD40/ufraw-manual.html .   

G IMP  ANIMATION PACKAGE GAP
But : Réaliser des animations.

Site :   http://gimp.org/                                

Auteur :    http://gimp.org/ , compilé par  SAMJ    

Téléchargement sources : ftp://ftp.gimp.org/pub/gimp/plug-ins/v2.6/gap                               

Version :  GAP 2.6.0                   

Testé avec : Gimp 2.6.6

Appel du greffon :   Sur la fenêtre de l'image par le menu Video  

L'aide de GAP en anglais au format texte est dans le répertoire gimp_2_6_x\gap_2_4_0_documentation

Nota : Un document en français réalisé par Bertrand Carette (traduction et adaptation), sur une version 
précédente de GAP, est disponible à la page http://www.framasoft.net/article3374.html 

Conseil : GAP sous Windows à besoin d'encodeurs externes comme, par exemple, Imagemagick 
(http://www.imagemagick.org/) et VirtualDub (http://www.virtualdub.org/).

Didacticiels :

http://www.gimp-fr.org/document/document_8/index.html de Jakub Steiner  traduit par  Raymond Ostertag.

http://www.gimp.org/tutorials/Using_GAP/ (en anglais) par Jakub Steiner.

http://carol.gimp.org/gimp2/animation/gap/ (en anglais) pas Carol Spears.

http://www.gimptalk.com/forum/gap-very-simple-tutorial-t9266.html (en anglais) par ccbarr.

http://www.gimptalk.com/forum/topic/Making-gih-Gimp-Image-Hose-Brushes-in-GAP-21594-1.html 
(en anglais) Créer des brosses rotatives animées avec GAP par ClayOgre.

http://www.gimptalk.com/forum/topic/Making-gih-Gimp-Image-Hose-Brushes-in-GAP-21594-1.html
http://www.gimptalk.com/forum/gap-very-simple-tutorial-t9266.html
http://carol.gimp.org/gimp2/animation/gap/
http://www.gimp.org/tutorials/Using_GAP/
http://www.gimp-fr.org/document/document_8/index.html
http://www.virtualdub.org/
http://www.imagemagick.org/
http://www.framasoft.net/article3374.html
ftp://ftp.gimp.org/pub/gimp/plug-ins/v2.6/gap
http://gimp.org/
http://gimp.org/
http://vincent.deroo.free.fr/NikonD40/ufraw-manual.html
http://sourceforge.net/project/showfiles.php?group_id=127649
http://ufraw.sourceforge.net/
http://ufraw.sourceforge.net/Cameras.html
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DBORDER .PY

But :  Créer une bordure autour de l'image (Tester le fonctionnement de Python).

Auteur :  James Henstridge   

Testé avec : Gimp 2.6.0

Appel du greffon :   Sur la fenêtre de l'image par Python-fu > Decor > Borders 

Code source :
#!/usr/bin/env python

#   Gimp-Python - allows the writing of Gimp plugins in Python.
#   Copyright (C) 1997  James Henstridge <james@daa.com.au>
#
#   This program is free software; you can redistribute it and/or modify
#   it under the terms of the GNU General Public License as published by
#   the Free Software Foundation; either version 2 of the License, or
#   (at your option) any later version.
#
#   This program is distributed in the hope that it will be useful,
#   but WITHOUT ANY WARRANTY; without even the implied warranty of
#   MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the
#   GNU General Public License for more details.
#
#   You should have received a copy of the GNU General Public License
#   along with this program; if not, write to the Free Software
#   Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA.

from gimpfu import *

gettext.install("gimp20-python", gimp.locale_directory, unicode=True)

def dborder(image, layer, out_top, out_side, out_bottom, out_color,\
           in_top, in_side, in_bottom, in_color, blur, flatten):

    image.undo_group_start()

    old_width = pdb.gimp_image_width(image)
    old_height = pdb.gimp_image_height(image)
    out_width = old_width + out_side*2 + in_side*2
    out_height = old_height + out_top + out_bottom + in_top + in_bottom
    in_width = old_width + in_side*2
    in_height = old_height + in_top + in_bottom

    old_x = out_side + in_side
    old_y = out_top + in_top
    out_x = 0
    out_y = 0
    in_x = out_top
    in_y = out_side
    

    pdb.gimp_image_resize(image, out_width, out_height, old_x, old_y)

    in_border = gimp.Layer(image, "Inner Border", out_width, out_height, RGBA_IMAGE,
                       100, NORMAL_MODE)
    pdb.gimp_image_add_layer(image, in_border, 0)
    pdb.gimp_edit_clear(in_border)

    pdb.gimp_rect_select(image, out_x, out_y, out_width, out_height, CHANNEL_OP_REPLACE,  0, 0.0)
    pdb.gimp_rect_select(image, old_x, old_y, old_width, old_height, CHANNEL_OP_SUBTRACT, 0, 0.0)
    pdb.gimp_context_set_foreground(in_color)
    pdb.gimp_edit_fill(in_border, FOREGROUND_FILL)

    
    pdb.gimp_selection_none(image)
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    out_border = gimp.Layer(image, "Outer Border", out_width, out_height, RGBA_IMAGE,
                           100, NORMAL_MODE)
    pdb.gimp_image_add_layer(image, out_border, 0)
    pdb.gimp_edit_clear(out_border)    

    pdb.gimp_rect_select(image, out_x, out_y, out_width, out_height, CHANNEL_OP_REPLACE,  0, 0.0)
    pdb.gimp_rect_select(image, in_x, in_y, in_width, in_height, CHANNEL_OP_SUBTRACT, 0, 0.0)
    if blur > 0:
        pdb.gimp_selection_feather(image, blur)
    pdb.gimp_context_set_foreground(out_color)

    pdb.gimp_edit_fill(out_border, FOREGROUND_FILL)

    pdb.gimp_selection_none(image)

    if flatten:
        pdb.gimp_image_flatten(image)

    image.undo_group_end()

register(
    "dborder",
    N_("Add a double border"),
    "Add a double border",
    "Carlo Pallanti",
    "Carlo Pallanti",
    "2007",
    N_("DBorder"),
    "RGB*",
    [(PF_IMAGE, "image","Input image", None),
        (PF_DRAWABLE, "layer", "Input drawable", None),
        (PF_INT,   "out_top", "Outer Top Border Width",  40),
        (PF_INT,   "out_side", "Outer Side Border Width",  40),
        (PF_INT,   "out_bottom", "Outer Bottom Border Width", 80),
        (PF_COLOR, "out_color", "Outer Border Color", (0,  0,  0)),
        (PF_INT,   "in_top", "Inner Top Border Width",  20),
        (PF_INT,   "in_side", "Inner Side Border Width",  20),
        (PF_INT,   "in_bottom", "Inner Bottom Border Width", 20),
        (PF_COLOR, "in_color", "Inner Border Color", (250,  250,  250)),
        (PF_FLOAT, "blur", "Outer Border Blur radius", 5.0),
        
        (PF_BOOL,  "flatten", "Flatten resulting image", False)],
    [],
    dborder,
    menu="<Image>/Filters/Decor",
    domain=("gimp20-python", gimp.locale_directory))

main()

Exemple : 
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SOURCE DES IMAGES ANALYSÉES DANS CETTE DOCUMENTATION

– tv_baseballscreen_1_1.jpg > http://connectedtv.yahoo.com/newsroom/images

– fujifilm-finepix40i.jpg > http://exif.org/samples.html 

– gimp-2.4polished.xcf.bz2 > http://jimmac.musichall.cz (splash screen de gimp 2.4 par Jakub Steiner)

– papillon_mire.xcf > montage réalisé à partir d'un papillon http://pdphoto.org/PictureDetail.php?
mat=pdef&pg=6533 (par PDPhoto.org).

– tommek_Car.svg > http://openclipart.org/people/tommek/tommek_Car.svg par tommek , licence : CC 
Public Domain Dedication.

– Canon-10D-noise-full-original.jpg > http://www.neatimage.com/examples.html 

– Crustacea.jpg > http://commons.wikimedia.org/wiki/Image:Crustacea.jpg par Hans Hillewaert, licence : 
CC By-Sa

– bobcat.jpg > http://www.pics4learning.com/ 
 (lien direct  http://www.pics4learning.com/catalog/b/bobcat.jpg). Pics4Learning is a copyright-friendly  
image library for teachers and students. The Pics4Learning collection consists of thousands of images  
that have been donated by students, teachers, and amateur photographers.

– 2925887624_76f4fe031a.jpg  >  http://flickr.com/photos/vancouverflavour/2925887624/ par 
vancouverflavour (CC)

http://flickr.com/photos/vancouverflavour/2925887624/
http://www.pics4learning.com/catalog/b/bobcat.jpg
http://www.pics4learning.com/
http://commons.wikimedia.org/wiki/Image:Crustacea.jpg
http://www.neatimage.com/examples.html
http://openclipart.org/people/tommek/tommek_Car.svg
http://pdphoto.org/PictureDetail.php?mat=pdef&pg=6533
http://pdphoto.org/PictureDetail.php?mat=pdef&pg=6533
http://jimmac.musichall.cz/
http://exif.org/samples.html
http://connectedtv.yahoo.com/newsroom/images
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INSTALLATION DES GREFFONS ET SCRIPTS SOUS W INDOWS

Voici les procédures d'installation des greffons pour l'archive GIMP 2.6.x que nous proposons. Des greffons 
sont disponibles en téléchargement sur notre site dans le fichier images_gimp.7z ou en effectuant une 
recherche dans cette documentation PDF avec le terme -i686.zip pour les greffons compilés ici. 

INSTALLATION DES GREFFONS PYTHON (.PY)
Pour faire fonctionner ces greffons Python + PyGTK doivent être présents. Pour l'installation consulter la 

page 4.

Les greffons avec l'extension .py sont des fichiers texte qu'il faut installer dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

INSTALLATION DES GREFFONS COMPILÉS (.EXE / .DLL)
Les greffons avec l'extension .exe, .dll sont des fichiers qu'il faut installer dans le répertoire des greffons 

gimp_2_6_x\lib\gimp\2.0\plug-ins. Certains ont des composants qui s'installent dans gimp_2_6_x\bin.  

INSTALLATION DES SCRIPTS-FU (.SCM)
Les greffons avec l'extension .scm sont des fichiers texte qu'il faut installer dans le répertoire des scripts  

gimp_2_6_x\share\gimp\2.0\scripts.

RÉPERTOIRE DES PRÉFÉRENCES

Ces greffons et scripts peuvent aussi être installés dans le répertoire des préférences :

XP  C:\Document and Settings\[utilisateur]\.gimp-2.6\plug-ins
Vista - W7 C:\Utilisateurs\[utilisateur]\.gimp-2.6\plug-ins

XP  C:\Document and Settings\[utilisateur]\.gimp-2.6\scripts
Vista - W7 C:\Utilisateurs\[utilisateur]\.gimp-2.6\scripts

et/ou Préférences 1 nomades
XP  [unité]:\gimp_2_6_x\pref_1\plug-ins

Vista - W7 [unité]:\gimp_2_6_x\pref_1\plug-ins

XP  [unité]:\gimp_2_6_x\pref_1\scripts
Vista - W7 [unité]:\gimp_2_6_x\pref_1\scripts

et/ou Préférences 2 nomades
XP  [unité]:\gimp_2_6_x\pref_2\plug-ins

Vista - W7 [unité]:\gimp_2_6_x\pref_2\plug-ins

XP  [unité]:\gimp_2_6_x\pref_2\scripts
Vista - W7 [unité]:\gimp_2_6_x\pref_2\scripts
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SCRIPTS-FU EN VRAC

FX-FOUNDRY  (ENSEMBLE  DE SCRIPTS-FU POUR G IMP)
fx-foundry regroupe un ensemble de Script-Fu anciens qui son mis à jour pour la version Gimp 2.6

Site : http://gimpfx-foundry.sourceforge.net/   

Liste des auteurs : http://gimpfx-foundry.sourceforge.net/browse26/index_author_name.html       

Téléchargements :

http://sourceforge.net/projects/gimpfx-foundry/ 

http://sourceforge.net/projects/gimpfx-foundry/files/     

Installation : Télécharger et décompresser gimpfx-foundry-2.6-1.zip dans le répertoire des Scripts-Fu

Accès aux scripts : Sur l'image par FX-Foundry où les scripts sont organisés par Fonctions.

Liste des 117 Scripts-Fu :
alexios-duotone.scm

alexios-photoframe.scm

alfaro-color-temperature.scm

aurore-planet-render.scm

bates-gradient-difference.scm

bates-layers-attributes.scm

bates-layers-copy-to-new.scm

bates-layers-delete.scm

bates-layers-number.scm

bates-layers-scale-crop.scm

bates-layers-transform.scm

bercovich-lomo.scm

conte-draw-tools.scm

cozens-match-colours.scm

cprogrammer-midnight-sepia.scm

cprogrammer-roy-richtenstein.scm

death-cross-processing-effect.scm

death-lomo-effect.scm

death-shape-tools.scm

death-vintage-effect.scm

egger-black-and-white.scm

egger-border.scm

egger-color-saturation.scm

egger-copyright.scm

egger-duotone-simulation.scm

egger-high-pass-sharpen.scm

egger-infrared-simulation.scm

egger-iso-noise-reduction.scm

egger-separate-sharpen.scm

egger-shadow-recovery.scm

egger-smart-redux-sharpen.scm

egger-stair-Interpolation.scm

giancarlo-sepoina.scm

goode-animation-settings.scm

goode-combine-bg.scm

goode-copy-mask.scm

goode-fit-canvas.scm

goode-letter-drop.scm

goode-mirror-duplicates.scm

goode-rgb-swapscale.scm

goode-rule-of-thirds-grid.scm

guldahl-red-eye.scm

gunther-radial-fade-blur.scm

gutteridge-fuzzy-border.scm

gutteridge-old-photo.scm

hall-edge-mask-sharpen.scm

iccii-convolution-presets.scm

iccii-cross-light.scm

iccii-layer-effects.scm

iccii-pastel-image.scm

iccii-soft-focus.scm

iccii-texturizer.scm

iccii-water-paint-effect.scm

iccii-wrap-effect.scm

jacobs-midtone-sharp.scm

jacobs-press-print.scm

jeschke-mats-and-frames.scm

klawiter-sepia-toning.scm

lasm-gm-channel-extract.scm

lasm-gm-invert.scm

lasm-gm-solarize.scm

lasm-gm-ultra-vivid-solarize.scm

lasm-lab-color-punch.scm

lasm-lab-ultra-vivid.scm

lasm-lab-wow.scm

lasm-line-art.scm

likins-glow.scm

lowry-auto-contrast.scm

lowry-bsss-sharpening.scm

lowry-ez-improver.scm

lowry-ez-red-skin-fix.scm

lowry-gothic-glow.scm

lowry-landscape-illustrator.scm

lowry-landscape-painter.scm

lowry-local-contast-
enhancement.scm

http://sourceforge.net/projects/gimpfx-foundry/files/
http://sourceforge.net/projects/gimpfx-foundry/
http://gimpfx-foundry.sourceforge.net/browse26/index_author_name.html
http://gimpfx-foundry.sourceforge.net/
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lowry-paint-with-light.scm

madsen-fire-animator.scm

meddler-underwater-red-
correction.scm

meiklejohn-tonemapping.scm

melcher-aquarel.scm

melcher-colorize.scm

melcher-make-bw.scm

melcher-selective-coloring.scm

neumann-slide.scm

noclayto-fade-animator.scm

noclayto-hue-change-animator.scm

payne-graduated-filter.scm

peck-spread-out-layers.scm

phillips-amazing-circles.scm

phillips-double-border.scm

phillips-film-grain.scm

phillips-orton.scm

phillips-quick-sketch.scm

phillips-split-tone.scm

phillips-stair-resize.scm

phillips-tonemapping.scm

rogge-grey-point.scm

ruhnke-wonderful.scm

salonen-dynamic-range-
extender.scm

salonen-luminocity-sharpening.scm

salonen-vivid-saturation.scm

tankedup-create-contrast-mask.scm

tissier-diffusion-filter.scm

torres-analogize.scm

trefftzs-pencil-sketch.scm

trefftzs-pixel-gradient.scm

wade-powertone.scm

xtns-bodor-chrominium.scm

xtns-demartin-liquid-water.scm

xtns-demartin-shiny-painting.scm

xtns-gutteridge-dracula.scm

xtns-lankinen-fiery-steel.scm

xtns-mosteller-glass-text.scm

xtns-mosteller-lava-logo.scm

xtns-mosteller-multi-effect-text.scm

xtns-pippin-gloss-orbs.scm

xtns-zenkov-shrek-text.scm

ANCIENNE DOCUMENTATION SCRIPT-FU POUR G IMP  2.4

Les scripts décrits danc cette documentation ne sont pas testés sous Gimp 2.6 mais devraient, en 
principe, fonctionner.

Documentation Script-Fu pour Gimp 2.4
(196 scripts pour améliorer l'utilisation de Gimp)

au format CHM (Windows) 
au format HTML (Linux, etc.)

Vous pouvez télécharger la documentation au format CHM compilée le 24 avril 2008 (pour 
Windows  )   à partir de ce lien :

script_fu_documentation.chm

• volume : 23 701 140 octets  
• md5 : 6359dca017f0f508797a090085f56b6b 
• Licence : CC BY-NC 
• Copyright © 2008 SAMJ

http://www.aljacom.com/~gimp/script_fu_documentation.chm
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Vous pouvez télécharger la même documentation au format HTML dans une archive 7-Zip à partir de ce 
lien :

script_fu_documentation.7z

• volume : 22 965 147 octets  
• md5 : 6359dca017f0f508797a090085f56b6b 
• Licence : CC BY-NC 
• Copyright © 2008 SAMJ 
• Pour décompresser sous Linux : http://p7zip.sourceforge.net/ 
• Ouvrir .../script_fu_documentation/index.html

http://www.aljacom.com/~gimp/script_fu_documentation.7z
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GREFFON PHOTOSHOP PATTERN LOADER PAR ERIC LAMARQUE

Ouvrir les motifs .pat multi-calques de Photoshop dans Gimp .

Site :   http://registry.gimp.org/node/10879                                       

Auteur : Eric Lamarque            

Téléchargement sources : http://www.aljacom.com/~gimp/ps-pat-load_1-i686.zip 

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/ps-pat-load_1-i686.zip par SAMJ 

Version :  2008-11-04 / v1.2 / Eric Lamarque                    

Installation :   Décompresser ps-pat-load_1-i686.zip et placer ps-pat-load_1.exe dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.2

Appel du greffon : Automatiquement à l'ouverture des fichiers .pat Photoshop.

Deux liens pour trouver des motifs au format Photoshop :

deviantART
http://browse.deviantart.com/resources/applications/#catpath=resources/applications/patterns&order=9 

Adobe (Utiliser 7Zip pour décompresser les fichiers .rar)
http://www.adobe.com/cfusion/exchange/index.cfm?from=1&o=desc&cat=200&event=productHome&s=3&l=-1&exc=16

Voici un Script-Fu pour exploiter facilement le greffon Photoshop Pattern Loader qui permet de sauvegarder 
chaque calque du motif Photoshop en un fichier .pat compatible Gimp.

Accès sur l'image par Calque > Save all layers to a different pat file (Motifs Gimp)

Placer les fichier produits .pat dans un répertoire de motifs reconnu par Gimp, par exemple : 
\gimp_2_6_x\share\gimp\2.0\patterns . Il ne faut pas mettre le fichier   .pat au format Photoshop   dans ce   
répertoire.

Code du Script-Fu Saves_all_layers_to_separate_pat_files.scm (Fourni dans l'archive images_gimp.7z)

Nota : Les noms de calques ne doivent pas contenir les caractères / \ * ? (Modifier attributs page 129)
; Saves_all_layers_to_separate_pat_files.scm
;
; origine http://groups.google.ca/group/comp.graphics.apps.gimp/browse_thread/thread/010e01bd0930438a#
; modification pour enregistrer en .pat (motifs Gimp)
; fonctionne Gimp 2.6.1 Windows
;
(define (script-fu-save-layers-to-pat-files image dont-ask display-images short-description-of-the-pattern)
(let ((basename (car (gimp-image-get-filename image))))
(when (string=? basename "")
(set! basename (string-append

http://www.adobe.com/cfusion/exchange/index.cfm?from=1&o=desc&cat=200&event=productHome&s=3&l=-1&exc=16
http://www.7-zip.org/
http://browse.deviantart.com/resources/applications/#catpath=resources/applications/patterns&order=9
http://www.aljacom.com/~gimp/ps-pat-load_1-i686.zip
http://www.aljacom.com/~gimp/ps-pat-load_1-i686.zip
http://registry.gimp.org/node/10879
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(car (gimp-temp-name ""))
(car (gimp-image-get-name image)))))
(let loop ((layers (vector->list (cadr (gimp-image-get-layers image)))))
(unless (null? layers)
(gimp-edit-copy (car layers))

(let ((img (car (gimp-edit-paste-as-new)))
(new-name (string-append
basename
(car (gimp-drawable-get-name (car layers)))
".pat")))
(file-pat-save dont-ask img (aref (cadr (gimp-image-get-layers img)) 0) new-name new-name short-description-
of-the-pattern)
(if (= FALSE display-images)
;; clean up afterwards if we are not going to
;; display the images anyway:
(gimp-image-delete img)
(gimp-display-new img)))
(loop (cdr layers))))))

(script-fu-register "script-fu-save-layers-to-pat-files"
; modif samj _"Save all layers to a different file"
_"Save all layers to a different pat file (Motifs Gimp)"
_"Saves all layers to separate .pat files"
"Niels Giesen (niels.gie...@gmail.com) - samj"
"Niels Giesen - samj"
"2008-10-29"
""
SF-IMAGE "Image" 1
SF-TOGGLE _"Don't ask options for each layer" TRUE
SF-TOGGLE _"Display images?" FALSE
SF-STRING "Description sommaire des motifs" "Motifs issus de calques")

(script-fu-menu-register "script-fu-save-layers-to-pat-files"
; modif samj _"<Image>/Filters/Generic")
_"<Image>/Layer")
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GREFFON PSPI « RUNNING PHOTOSHOP PLUG- INS IN GIMP »
Faire fonctionner certains greffons (.8bf) prévus pour Photoshop sous Gimp .

Site :  http://tml.pp.fi/gimp/pspi.html                                    

Auteur : Tor Lillqvist (tml)             

Téléchargement sources : http://tml.pp.fi/gimp/gimp-pspi-1.0.7.tar.gz                                       

Téléchargement binaires compilées : http://tml.pp.fi/gimp/gimp-pspi-1.0.7.win32.zip                  

Sources + binaires compilées :   http://www.aljacom.com/~gimp/pspi-1.0.7.zip  

Version :  1.0.7                    

Installation :   Décompresser gimp-pspi-1.0.7.win32.zip et placer lib\gimp\2.0\plug-ins\pspi.exe dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 
Créer un répertoire pour recevoir les fichiers .8bf (Des greffons fonctionnant sous Photoshop), par exemple : 
gimp_2_6_x\plug-8bf . Placer des greffons Photoshop dans ce répertoire. 

Voici un lien pour trouver ces greffons avec Google : 
http://www.google.com/search?hl=fr&q=8bf&btnG=Recherche+Google&meta=  

Testé avec : Gimp 2.6.1

Appel du greffon pour configurer le répertoire des «     Photoshop plug-ins     » :   Filtres > Photoshop Plug-in 
Settings.   

Nota : Si vous avez des messages d'erreur au lancement de Gimp, essayez de le relancer en activant 
Préférences utilisées par Gimp > Préférences nomades (1) dans maringouin ou par un double clic sur 
gimp_en_francais_nomades_1.bat. Il semble que le greffon ne supporte pas les noms d'utilisateur avec des 
accents sous XP.

Didacticiel : Comme exemple, nous allons installer « Selective Saturation ».

– Télécharger le greffon Photoshop dans un répertoire temporaire à partir de la page Selective Saturation : 
http://www.photo-plugins.com/Plugins/Plugins/Selective-Saturation.html . Lien direct : 
 http://www.photo-plugins.com/index.php?option=com_docman&task=cat_view&gid=68&Itemid=43

– Créer un répertoire pour accueillir ces greffons Photoshop :  gimp_2_6_x\plug-8bf

– Décompresser pphps.zip et placer pphps.8bf dans gimp_2_6_x\plug-8bf    

– Démarrer Gimp par gimp_en_francais_nomades_1.bat pour configurer le répertoire des greffons 
Photoshop.

– Sur la fenêtre « Éditeur d'image GIMP » faire : Filtres > Photoshop Plug-in Settings.   

http://www.photo-plugins.com/index.php?option=com_docman&task=cat_view&gid=68&Itemid=43
http://www.photo-plugins.com/Plugins/Plugins/Selective-Saturation.html
http://www.google.com/search?hl=fr&q=8bf&btnG=Recherche+Google&meta
http://www.aljacom.com/~gimp/pspi-1.0.7.zip
http://tml.pp.fi/gimp/gimp-pspi-1.0.7.win32.zip
http://tml.pp.fi/gimp/gimp-pspi-1.0.7.tar.gz
http://tml.pp.fi/gimp/pspi.html
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–   Sur la fenêtre « Photoshop Plug-in Settings » appuyer sur le bouton dossier, valider le répertoire 
gimp_2_6_x\plug-8bf et appuyer sur OK.

–  Fermer Gimp et démarrer Gimp par gimp_en_francais_nomades_1.bat pour que le répertoire soit validé.

– Pour tester « Selective Saturation » , sur l'image faire Filtres > Photo-Plugins > High Pass Sharpening. 

Paramétrer et appuyer sur OK 
(Image du site http://www.photo-plugins.com/Plugins/Plugins/Selective-Saturation.html ).

http://www.photo-plugins.com/Plugins/Plugins/Selective-Saturation.html
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GREFFON USERF ILTER (CRÉER SES FILTRES)
Ce greffon est un ensemble qui se compose d'un filtre Gimp pour créer et appliquer ses filtres ainsi que 

d'outils (Programmes utilitaires) pour importer des filtres d'autres formats.

Site :   http://gimpuserfilter.sourceforge.net/                                      

Auteurs : Jens Ch. Restemeier, Torsten Neuer           

Téléchargement sources : http://sourceforge.net/project/showfiles.php?group_id=225481 

Téléchargement binaires compilées : 
       http://www.aljacom.com/~gimp/gimp-plugin-userfilter-0.9.7-i686.zip par samj     

Version :  0.9.7                    

Installation :   
Décompresser l'archive gimp-plugin-userfilter-0.9.7-i686.zip. L'installation se décompose en deux étapes. 

Copier le greffon \filter\userfilter.exe dans gimp_2_6_x\lib\gimp\2.0\plug-ins  . 
Copier le répertoire \filter dans C:\              

Testé avec : Gimp 2.6.2

Appel du greffon : Filtres > Générique > User Filter     

Des documents sont fournis dans l'archive gimp-plugin-userfilter-0.9.7-i686.zip pour l'utilisation des ce greffon 
et des utilitaires : lisez_moi.txt , GIMP UserFilter.htm (Utilisation en anglais), \filter\usage.txt (Utilisation des 
programmes de conversion).

Le greffon utilise des fichiers .guf comme filtres. Ces fichiers sont générés automatiquement par le greffon 
ou pas les programmes utilitaires de conversion.

UTILISER  DES FILTRES EXISTANTS, CONVERSION

Nous créons 5 fichiers .guf à partir de afhbevel.zip (fourni avec  gimp-plugin-userfilter-0.9.7-i686.zip) en 
utilisant les 5 fichiers .afs . Placer ces 5 fichiers dans le répertoire C:\filter . 
Copier cette commande C:\filter\bin\afs2guf.exe C:\filter\*.afs , faire démarrer > Exécuter > Coller la ligne de 
commande > Appuyer sur OK.

Après l'exécution de la commande nous disposons des 5 filtres .guf dans C:\filter

http://www.aljacom.com/~gimp/gimp-plugin-userfilter-0.9.7-i686.zip
http://sourceforge.net/project/showfiles.php?group_id=225481
http://gimpuserfilter.sourceforge.net/
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Ouvrir Gimp, et une image. Appeler le greffon par : Filtres > Générique > User Filter

Activer l'onglet Filter Directories pour choisir C:\filter comme répertoire de dépôt des filtres .guf. 
Appuyer sur le bouton a gauche (Dossier) pour activer le curseur de saisie, appuyer sur le bouton sélecteur de 
fichier, sélectionner le répertoire :

Nous retrouvons les 5 filtres dans l'onglet Filter Manager :

Sélectionner un filtre et appuyer sur Open. L'effet d'encadrement apparaît dans le fenêtre Aperçu.

Avant de valider par le bouton OK, nous pouvons ouvrir l'onglet Filter Control pour modifier le cadre :
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Pour visualiser les formules du filtre activer l'onglet Filter Editor (Explications dans GIMP UserFilter.htm):

Valider par le bouton OK. Résultat :

Nota : Les filtres importés sont compatibles Filter Factory / Filter Foundry pour Photoshop



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 198 / 391
 Greffon UserFilter (Créer ses filtres) 

CRÉER  UN FILTRE

Nous créons un filtre (assez inutile) pour éclaircir une image à l'aide de 3 curseurs (Rouge, Vert, Bleu).  
Nous allons ajouter la valeur du curseur au canal.

Les caractéristiques générales du filtre sont définies dans l'onglet Filter Editor, partie Filter Information.

Les 3 curseurs [ ctl(0)  , ctl(1)  , ctl(2)  ] sont définis dans l'onglet Filter Editor, partie Filter Interface avec les 
noms Rouge, Vert, Bleu.

Les formules sont définies dans l'onglet Filter Editor, partie Filter Formulas.

Enregistrer ce filtre en appuyant sur le bouton Save As, lui donner un nom (test.guf par exemple).

Appuyer sur le bouton Refresh de l'onglet Filter Manager pour le voir apparaître.

Pour l'utiliser aller sur l'onglet Filter Control et bouger les curseurs.
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Extraits du fichier  test.guf :
# Created with User Filter v0.9.7.
[GUF]
Protocol=1
[Info]
Category=<Image>/Filters/User Filters
Title=Éclaircir
Author=Test
Copyright=Copyright sans
[Version]
Major=0
Minor=1
Micro=0

Registered=false
Description=Éclaircir en utilisant 3 curseurs
Date=2008-11-12
EdgeMode=2

[Control 0]
Enabled=true
Label=Rouge
Tooltip=Use this slider to change the effects of the filter.
Preset=0
Step=1
[Control 1]
Enabled=true
Label=Vert
Tooltip=Use this slider to change the effects of the filter.
Preset=0
Step=1
[Control 2]
Enabled=true
Label=Bleu
Tooltip=Use this slider to change the effects of the filter.
Preset=0
Step=1

[Code]
R=r+ctl(0)
G=g+ctl(1)
B=b+ctl(2)
A=a



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 200 / 391
 Greffon G'MIC 

GREFFON G'MIC
GMIC is an open-source product distributed under the CeCILL License (GPL-compatible). Copyrights (C) 

From July 2008, David Tschumperlé - GREYC UMR CNRS 6072, Image group.

Site : http://gmic.sourceforge.net/gimp.shtml  , http://registry.gimp.org/node/13469                                 

Auteur : David Tschumperle (main source code), Claude Bulin (packaging), Angelo Lama (testing)            

Téléchargement sources :  http://gmic.sourceforge.net/                               

Téléchargement binaires compilées :  http://downloads.sourceforge.net/gmic/gmic_gimp_win32.zip 

Version :  1.3                   

Installation :   Décompresser le fichier  .zip et placer  les  4 fichiers gmic4gimp.exe , libfftw3-3.dll , 
pthreadGC2.dll , wget.exe dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins             

Testé avec : Gimp 2.6.6

Appel du greffon : Filtres > G'MIC pour Gimp      

Présentation du greffon sur le site   http://gimpfr.org   , posté par Raymond le 19/01/2009 :  

David Tschumperlé présente un nouveau greffon open-source pour GIMP nommé G'MIC, réalisé par  
l'équipe IMAGE du laboratoire CNRS GREYC de Caen/France. 
Ce greffon propose une liste de filtres disponibles que l'on peut appliquer sur des images pour réaliser des  

effets artistiques, de la restauration d'image (débruitage/sharpening), du rendu 3D, etc.. En particulier, il  
contient tous les algorithmes de débruitage /lissage d'images préalablement définis par le plug-in  
GREYCstoration qui avait été réalisé par la même équipe. 
L'idée principale derrière G'MIC est qu'il est basé sur un interpréteur d'un petit langage de programmation  

simple basé sur des macros pour le traitement d'images. Ainsi, il est tout à fait possible à l'utilisateur du  
plug-in de réaliser et d'ajouter ses propres définitions de filtres au plug-in, en les écrivant sous formes de  
macros G'MIC dans un simple fichier texte. 
De la même manière, le plug-in est capable de se mettre à jour via Internet, la liste de ses filtres disponibles  

étant également définie sous forme d'un fichier texte. Pour conclure, G'MIC est un greffon extensible et  
évolutif, contenant des algorithmes non-triviaux pour le traitement d'images. 
Il possède une liste de filtres qui est amenée à s'allonger très rapidement, sans aucune réinstallation  

nécessaire du greffon. On espère avoir réalisé quelque chose d'utile et surtout de collaboratif : pas de  
connaissances poussées en programmation n'est nécessaire pour faire évoluer ou corriger la liste des filtres  
existants.
… Les filtres de base qui sont donc appelés à évoluer sont déjà, nombreux et efficaces. Ils sont rangés dans  

les catégories suivantes :
    -  Mosaïques, motifs et encadrements de photos
    -  Effets artistiques
    -  Dégradations d'images
    -  Améliorations d'images
    -  Divers

http://gimpfr.org/
http://downloads.sourceforge.net/gmic/gmic_gimp_win32.zip
http://gmic.sourceforge.net/
http://registry.gimp.org/node/13469
http://gmic.sourceforge.net/gimp.shtml
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Nota : Les greffons GIMP-PLUGIN-ASTRONOMY et G'MIC utilisent la même DLL libfftw3-3.dll (Site 
FFTW pour transformation de Fourier : http://www.fftw.org/install/windows.html).On peut utiliser la version 
fournie avec G'MIC pour faire fonctionner le greffon Astronomy.

Exemple de fichier texte de programmation : http://gmic.sourceforge.net/.gmic4gimp_def

Documentation : http://gmic.sourceforge.net/documentation.shtml

Groupe de discussion : http://www.flickr.com/groups/gmic/ 

Copie d'écran :

http://www.flickr.com/groups/gmic/
http://gmic.sourceforge.net/documentation.shtml
http://gmic.sourceforge.net/.gmic4gimp_def
http://www.fftw.org/install/windows.html
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G'MIC 0.9 EN LIGNE DE COMMANDE

G'MIC est à l'origine un programme qui fonctionne en ligne de commandes. Il utilise la bibliothèque Cimg 
(http://cimg.sourceforge.net/) et Magick++ (http://www.imagemagick.org/Magick%2B%2B/).

L'installation sous Ubuntu et des exemples sont donnés en français à la page http://doc.ubuntu-fr.org/gmic . 

Pour Windows :

Imagemagick doit être installé http://www.imagemagick.org 

La version 0.9 de G'MIC est disponible en téléchargement sur ce lien : 
http://downloads.sourceforge.net/gmic/gmic-0.9.0_win32.zip?modtime=1226328148&big_mirror=0

Il suffit de décompresser l'archive gmic-0.9.0_win32.zip dans le répertoire d'ImageMagick (où se trouvent 
convert.exe , animate.exe , etc.) et d'utiliser le programme gmic_win32.exe en lignes de commandes 
(http://gmic.sourceforge.net/documentation.shtml).

Exemple, interpolation :
gmic_win32.exe C:\images_gimp\oeil_interpolation.png -resize 777.5%,777.5%,1,3,5 -o C:\test\interpolation_gmic.png

Origine   >>                          interpolation_gmic.png >>
  oeil_interpolation.png

Exemple, cumuler des effets :

gmic_win32.exe C:\images_gimp\tv_baseballscreen_1_1.jpg -resize 25%,25% -warhol3x3 -o C:\test\2effets_gmic.png

http://gmic.sourceforge.net/documentation.shtml
http://downloads.sourceforge.net/gmic/gmic-0.9.0_win32.zip?modtime=1226328148&big_mirror=0
http://www.imagemagick.org/
http://doc.ubuntu-fr.org/gmic
http://www.imagemagick.org/Magick%2B%2B/
http://cimg.sourceforge.net/
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G'MIC 1.3 EN LIGNE DE COMMANDE

La version G'MIC 1.3.0.4 (12 février 2009) est disponible pour Windows en téléchargement à partir de ce lien :

http://sourceforge.net/project/showfiles.php?group_id=234931&package_id=285247 (gmic_win32.zip).

Décompresser gmic_win32.zip. L'utilitaire gmic.exe est livré avec des bibliothèques (fichiers .dll).

Il semble que cette version fonctionne sans Imagemagick.

Les lignes de commandes peuvent être un peu différentes des anciennes versions.

Exemples : 
gmic.exe C:\images_gimp\oeil_interpolation.png -resize 777.5%,777.5%,1,3,5 -o C:\test\interpolation_gmic.png

gmic.exe C:\images_gimp\tv_baseballscreen_1_1.jpg -resize 25%,25% -warhol 3 -o C:\test\2effets_gmic.png

Pour obtenir un fichier texte d'aide (aide_gmic.txt), utiliser cette commande :
gmic.exe --help > aide_gmic.txt

http://sourceforge.net/project/showfiles.php?group_id=234931&package_id=285247
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GREFFON PANORAMAS, ASSEMBLAGE  D' IMAGES (STITCH PANORAMA)
Python doit être installé pour que ce greffon fonctionne.

Site :  http://stitchpanorama.sourceforge.net/                                

Auteur : Thomas R. Metcalf             

Téléchargement sources :  http://sourceforge.net/project/showfiles.php?group_id=138776                             

Téléchargement binaires compilées :  N/A     

Version :  0.9.6                      

Installation :   Placer stitch_0.9.6.py dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins             

Testé avec : Gimp 2.6.0

Appel du greffon : Fichier > Créer > Stitch panorama     

Documentation : stitch_panorama.pdf accessible en téléchargement.

IMPORTANT

Pour utiliser ce greffon il faut modifier le script à l'aide d'un éditeur de texte (Notepad++ par exemple) et 
remplacer  "<Toolbox>/Xtns/Utils/Stitch _panorama",   par   "<Image>/File/Create/Stitch _panorama",

Suite à la modification l'accès se fera, à partir d'une image, par Fichier > Créer > Stitch panorama   

http://notepad-plus.sourceforge.net/fr/site.htm
http://sourceforge.net/project/showfiles.php?group_id=138776
http://stitchpanorama.sourceforge.net/
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Ouvrir deux images et activer le greffon  par  Fichier > 
Créer > Stitch panorama. Appuyer sur le bouton 
« Accept ».

Appuyer sur le bouton « Set/Edit/View Controls Points » pour créer 
des points de référence semblables sur les images.

Sur chaque image, zoomer et  faire une sélection rectangulaire sur les 
points semblables.
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Appuyer sur Add 

Résultat :

Ajouter de nouveaux points en répétant les opérations du dessus (sélections, add).

Sauvegarder les points par le bouton Save (option).

Valider par le bouton Accept.

Appuyer sur le bouton « Stitch Panorama » pour créer le panorama.
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Résultat : Nouvelle image à 2 calques.

Les images proviennent d'un didacticiel d'Hugin (Logiciel libre d'assemblage de panorama) créé par Bruno 
Postle  et disponible à http://hugin.sourceforge.net/tutorials/two-photos/en.shtml    

http://hugin.sourceforge.net/tutorials/two-photos/en.shtml
http://hugin.sourceforge.net/
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GREFFON FELIMAGE-NOISE

– Can generate tileable textures.
– Can generate textures for use in spherical mapping.
– Can use foreground/background colors, gradients, independent R/G/B/A or warp an image.
– Implements several noise functions.
– The way the colors are mapped can be tuned (gradient rotated, reversed, repeated, etc...).
– Fractal Brownian Motion (fBm) or Multifractal textures can be generated.
– A phase can be specified, which results in the gradual change of the noise (useful to generate animation  

frames).
– Can save and load presets.
– and more...

Site : http://fimg-gmplugins.sourceforge.net/                                  

Auteur : drirr             

Téléchargement sources : 
http://prdownloads.sourceforge.net/fimg-gmplugins/felimage-noise-0.1.1.tar.gz?download 

Téléchargement binaires compilées : 
http://prdownloads.sourceforge.net/fimg-gmplugins/felimage-noise-win-bin-0.1.1.zip?download      

Version : 0.1.1                       

Installation :   Décompresser felimage-noise-win-bin-0.1.1.zip et placer felimage-noise.exe dans le répertoire 
des  greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.          

Testé avec : Gimp 2.6.1

Appel du greffon :  Sur l'image par Filtres > Rendu > Felimage > Noise    

Exemple

http://prdownloads.sourceforge.net/fimg-gmplugins/felimage-noise-win-bin-0.1.1.zip?download
http://prdownloads.sourceforge.net/fimg-gmplugins/felimage-noise-0.1.1.tar.gz?download
http://fimg-gmplugins.sourceforge.net/
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GREFFON L IQUID RESCALE GIMP PLUGIN

Le greffon Liquid Rescale permet de changer les dimensions de parties d'images, d'images tout en 
conservant d'autres parties à la taille ou aux proportions d'origines.

Site :  http://liquidrescale.wikidot.com/                                  

Auteurs : http://liquidrescale.wikidot.com/en:contributors              

Téléchargement sources :  
    http://liquidrescale.wikidot.com/local--files/en:download-page/gimp-lqr-plugin-0.6.1.tar.bz2 

Téléchargement binaires compilées :  
    http://www.aljacom.com/~gimp/gimp-lqr-plugin-0.6.1_win32.zip           

Version :  0.6.1                  

Installation :   Décompresser gimp-lqr-plugin-0.6.1_win32.zip directement dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins.  

Testé avec : Gimp 2.6.5

Appel du greffon :  Sur l'image par Calque > Redimensionnement liquide     

Documentations :

– En anglais:  http://liquidrescale.wikidot.com/en:manual 
 http://liquidrescale.wikidot.com/en:tutorial

– En français :  http://www.calcyum.org/liquid-rescale-applications-pratiques/ 

Image d'origine 300*50 pixels : 

Préservation des lettres à l'échelle 1 : 

 Résultat :

Réglages : 

  

http://www.calcyum.org/liquid-rescale-applications-pratiques/
http://liquidrescale.wikidot.com/en:tutorial
http://liquidrescale.wikidot.com/en:manual
http://www.aljacom.com/~gimp/gimp-lqr-plugin-0.6.1_win32.zip
http://liquidrescale.wikidot.com/local--files/en:download-page/gimp-lqr-plugin-0.6.1.tar.bz2
http://liquidrescale.wikidot.com/en:contributors
http://liquidrescale.wikidot.com/
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Le Script-Fu batch-gimp-lqr.scm permet des traitements par lot (non testé). 

Il possède 3 entrées :
(batch-gimp-lqr run-mode string value value string string string)
un-mode string string value value string string value string value value string value value 
toggle toggle toggle toggle value value value toggle value toggle)
(batch-gimp-lqr-full-use-id run-mode string string value value drawable drawable value drawable 
value value drawable value value toggle toggle toggle toggle value value value toggle value 
toggle)

Paramètres de batch-gimp-lqr-full-use-id :
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GREFFON GLUAS

Algorithmes de traitement en langage Lua.

Site :  http://pippin.gimp.org/plug-ins/gluas/index.html 
http://pippin.gimp.org/plug-ins/gluas/index.html   
http://pippin.gimp.org/image_processing/appendix_gluas.html                                 

Auteurs :  Øyvind Kolås, Michael Natterer, Kevin Turner.            

Téléchargement sources :  http://pippin.gimp.org/plug-ins/gluas/files/gluas-0.1.19.tar.gz                              

Téléchargement binaires compilées : http://pippin.gimp.org/plug-ins/gluas/files/gluas-0_1_19.exe        

Version :                        

Installation :  Télécharger directement gluas-0_1_19.exe directement dans le répertoire des greffons
 gimp_2_6_0\lib\gimp\2.0\plug-ins            

Testé avec : Gimp 2.6.0 

Appel du greffon : Filtres > Générique > Gluas.     

Ici, effet « Kuwahara » (valeur moyenne d'une région autour d'un pixel), programme de la page des 
exemples :

– Ouvrir une image et faire Filtres > Générique > Gluas.

– Dans la fenêtre effacer le programme existant et ouvrir le fichier image images_gimp\kuwahara.lua à 
partir de l'onglet « Open... » ou utiliser le raccourci Ctrl+O. Appuyer sur Ouvrir pour charger le fichier.

– Appuyer sur Valider pour activer le filtre. Le temps de traitement peut être long.

Origine Résultat

http://pippin.gimp.org/plug-ins/gluas/files/gluas-0_1_19.exe
http://pippin.gimp.org/plug-ins/gluas/files/gluas-0.1.19.tar.gz
http://pippin.gimp.org/image_processing/appendix_gluas.html
http://pippin.gimp.org/plug-ins/gluas/index.html
http://pippin.gimp.org/plug-ins/gluas/index.html
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Effet « mirrored_frame » par Boris Eyrich pour créer un contour.
– Ouvrir une image et faire Filtres > Générique > Gluas.

– Dans la fenêtre effacer le programme existant et ouvrir le fichier image images_gimp\mirrored_frame.lua 
à partir de l'onglet « Open... » ou utiliser le raccourci Ctrl+O. Appuyer sur Ouvrir pour charger le fichier.

– Appuyer sur Valider pour activer le filtre. Le temps de traitement peut être long.
Origine Résultat
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GREFFON KALEIDOSCOPE

Créer des images avec effet de kaléidoscope.

Site :  http://www.aljacom.com/~gimp/images_gimp.7z (Archive 7Zip)                                

Auteur :  Kelly Martin (version Windows réalisée par Matthew H. Plough).            
Téléchargement sources :  Fichier kaleidoscop.e.c fourni avec les images dans le répertoire

        \images_gimp\greffons_disparus                             

Téléchargement binaires compilées :  
Fourni avec les images dans le répertoire \images_gimp\greffons_disparus      

Version :                        

Installation :  Placer kaleidoscope.exe (23 552 octets) directement dans le répertoire des greffons
 gimp_2_6_x\lib\gimp\2.0\plug-ins            

Testé avec : Gimp 2.6.0

Appel du greffon :   Sur l'image par Filtres > Distorsions > Kaleidoscope  

         Origine                                          Paramètres                                               Résultat

http://www.aljacom.com/~gimp/images_gimp.7z
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GREFFON REFOCUS

Augmente la netteté ou corrige le focus.

Site : http://refocus.sourceforge.net/                                  

Auteur : Ernst Lippe             

Téléchargement sources :  
           http://sourceforge.net/project/showfiles.php?group_id=72588&package_id=72474 

Téléchargement binaires compilées :  
 Sur le site de Jean-Louis Hamel http://jlhamel.club.fr/FILES/index.html  
 Lien direct http://jlhamel.club.fr/FILES/refocus_win_gimp2.zip      

Version : 0.9.0                       

Installation :  Télécharger et décompresser refocus_win_gimp2.zip dans un répertoire temporaire. Placer 
refocus.exe dans le répertoire des greffons             

Testé avec : Gimp 2.6.0

Appel du greffon :  Sur l'image par Filtres > Amélioration > Refocus 

Documentation : http://refocus.sourceforge.net/doc.html 

Origine (image du site http://refocus.sourceforge.net )             Résultat

   

   

    Paramètres :

(les réglages sont délicats)

    

http://refocus.sourceforge.net/
http://refocus.sourceforge.net/doc.html
http://jlhamel.club.fr/FILES/refocus_win_gimp2.zip
http://jlhamel.club.fr/FILES/index.html
http://sourceforge.net/project/showfiles.php?group_id=72588&package_id=72474
http://refocus.sourceforge.net/
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GREFFON RESYNTHESIZER

Ce greffon est un ensemble d'outils pour créer des motifs, enlever une partie de l'image et accentuer l'image.  
Outil complet livré avec 2 scripts-fu, les scripts-fu simplifient l'utilisation. Ce greffon est lent.

Site :  http://www.logarithmic.net/pfh/resynthesizer                                 

Auteur : Greffon Resynthesizer-0.16 créé par Paul Francis Harrison             

Téléchargement sources :  http://www.logarithmic.net/pfh/resynthesizer                                

Téléchargement binaires compilées : http://registry.gimp.org/files/resynthesizer-0.16.zip          

Version : 0.16                       

Installation :  

– Télécharger resynthesizer-0.16.zip et décompresser dans un répertoire temporaire.

– Copier [répertoire temporaire]\plug-ins\resynth.exe dans gimp_2_6_x\lib\gimp\2.0\plug-ins

– Copier [répertoire temporaire]\scripts\smart-enlarge.scm et [répertoire temporaire]\scripts\smart-remove.scm 
dans gimp_2_6_x\share\gimp\2.0\scripts

– Démarrer Gimp             

Testé avec : Gimp 2.6.0

Appel du greffon :  

– Sur l'image par Filtres > Mappage > Resynthesize.

– smart-remove.scm pour enlever une partie d'image. Sur l'image par Filtres >  Amélioration > smart-
remove (voir page 114).

– smart-enlarge.scm pour agrandir des images. Sur l'image par Filtres >  Amélioration > smart-enlarge

– Accentuation. Sur l'image par Filtres > Amélioration > smart-sharpen    

http://registry.gimp.org/files/resynthesizer-0.16.zip
http://www.logarithmic.net/pfh/resynthesizer
http://www.logarithmic.net/pfh/resynthesizer


www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 216 / 391
 Greffon Voronoi 

GREFFON VORONOI

Créer des motifs.

Site :  http://www.aljacom.com/~gimp/images_gimp.7z (Archive 7Zip)                                   

Auteur :  David Nečas (version Windows par Matthew H. Plough).            

Téléchargement sources :  Fichier voronoi-2.2.tar.bz2 fourni avec les images dans le répertoire
        \images_gimp\greffons_disparus                             

Téléchargement binaires compilées :  
Fourni avec les images dans le répertoire \images_gimp\greffons_disparus      

Version : 2.2                       

Installation :  Placer voronoi.exe (55 808 octets) directement dans le répertoire des greffons
 gimp_2_6_x\lib\gimp\2.0\plug-ins            

Testé avec : Gimp 2.6.0

Appel du greffon :   Sur l'image par Filtres > Rendu > Motifs > Voronoi.        

        

http://www.aljacom.com/~gimp/images_gimp.7z
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GREFFON WATER SURFACE

Créer un motif avec des « vagues » en utilisant la couleur de premier plan.

Site : http://www.aljacom.com/~gimp/images_gimp.7z (Archive 7Zip) 

Version d'origine 1.7 : http://sudakyo.hp.infoseek.co.jp/gimp/wsurface/watersurface_e.html 

Auteur :  Kyoichiro Suda, évolution par David Nečas (version Windows par Matthew H. Plough ?).            

Téléchargement sources :  Fichier wsurface-2.1.tar.bz2 fourni avec les images dans le répertoire
        \images_gimp\greffons_disparus                             

Téléchargement binaires compilées :  
Fourni avec les images dans le répertoire \images_gimp\greffons_disparus      

Version : 2.1                       

Installation :  Placer wsurface.exe (65 051 octets) directement dans le répertoire des greffons
 gimp_2_6_x\lib\gimp\2.0\plug-ins                         

        Testé avec : Gimp 2.6.0

Appel du greffon :   Filtres > Rendu > Nature >  Water Surface

  

http://sudakyo.hp.infoseek.co.jp/gimp/wsurface/watersurface_e.html
http://www.aljacom.com/~gimp/images_gimp.7z
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GREFFON MATHMAP

Effectue de nombreux effets.

Site :  http://www.complang.tuwien.ac.at/schani/mathmap/                                 

Auteur : Mark Probst            

Téléchargement sources :  http://www.complang.tuwien.ac.at/schani/mathmap/files/mathmap-1.3.5.tar.gz 

Téléchargement installateur binaires compilées :   
      http://www.complang.tuwien.ac.at/schani/mathmap/files/mathmap-1.3.5-setup.exe         

Version :  1.3.5                      

Installation :  Lancer mathmap-1.3.5-setup.exe qui installera automatiquement le greffon dans le répertoire 
des préférences.  Pour désinstaller, passer par le panneau de configuration.         

Testé avec : Gimp 2.6.7

Appel du greffon :  Sur l'image par Filtres > Générique > Mathmap > Mathmap    

Nota : Dans la version de Gimp de notre CD, ce greffon est installé et fonctionne quelque soit le répertoire 
des préférences utilisé.

Exemple de l'effet « Lomoize » :

http://www.complang.tuwien.ac.at/schani/mathmap/files/mathmap-1.3.5-setup.exe
http://www.complang.tuwien.ac.at/schani/mathmap/files/mathmap-1.3.5.tar.gz
http://www.complang.tuwien.ac.at/schani/mathmap/
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Programme correspondant à l'effet « Lomoize »

Le fichier .mm est ...\mathmap\expressions\Colors\Lomoize.mm

Divers :

Didacticiel sur la programmation : http://www.complang.tuwien.ac.at/schani/mathmap/language.html 

Le langage de programmation : http://www.complang.tuwien.ac.at/schani/mathmap/reference.html

Groupe de discussions : http://groups.google.com/group/mathmap     

http://groups.google.com/group/mathmap
http://www.complang.tuwien.ac.at/schani/mathmap/reference.html
http://www.complang.tuwien.ac.at/schani/mathmap/language.html
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GREFFON COLOR CORRECTION

Site :  http://pippin.gimp.org/plug-ins/color_correct/index.html                                 

Auteur :  Øyvind Kolås             

Téléchargement sources : http://pippin.gimp.org/plug-ins/color_correct/files/color-correct-0.0.3.tar.gz 

Téléchargement binaires compilées :        

Version : 0.0.3                       

Installation :   à éviter           

Testé avec : Gimp 2.6.0 et 2.6.1

Appel du greffon :   Sur l'image par Calques > Colors > Color correction   

IMPORTANT
La version Windows donne une erreur du greffon sans conséquence ou une erreur fatale pour Gimp.

http://pippin.gimp.org/plug-ins/color_correct/files/color-correct-0.0.3.tar.gz
http://pippin.gimp.org/plug-ins/color_correct/index.html
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GREFFON ROTATING BRUSH

Créer des brosses rotatives automatiques.

Site :  http://www.gamalocus.com                                 

Auteur :  Emanuel Greisen, Programmer, Gamalocus Studios            

Téléchargement sources :  http://www.graphie.org/ressources/gimp/plugins/rotating_brush.zip 

Téléchargement binaires compilées :   N/A     

Version : 2005-2010                       

Installation :    Extraire rotating_brush.py de l'archive rotating_brush.zip et le placer dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins            

Testé avec : Gimp 2.6.0

Appel du greffon :   Sur l'image par Brush Tools > Create _Rotating Brush   

Documentation : http://www.gimp-attitude.org/forum/viewtopic.php?t=4867 

Ce greffon copie une image et fait une rotation de cette image pour créer des brosses rotatives. L'image peut 
être ou pas découpée en colonnes. Chaque colonne représentera une image différente de brosse.

   Exemple
pour expliquer
le copier/coller.

Sur l'image par Brush Tools > Create _Rotating Brush. Paramétrer et valider.

http://www.gimp-attitude.org/forum/viewtopic.php?t=4867
http://www.graphie.org/ressources/gimp/plugins/rotating_brush.zip
http://www.gamalocus.com/
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Résulat : 

Pour ne pas déborder d'une rangée sur l'autre, la brosse doit être dans un cercle de diamètre max = 64 
pixels.

Enregistrer le résultat au format .gih 

Résultats (effet, calques)
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GREFFON GIMP DESKEW PLUGIN

Rotation automatique d'une image contenant un texte incliné.

Site : http://www.cubewano.org/gimp-deskew-plugin/                                  

Auteur :  Karl Chen   (Compilation Windows par Marcin Dabrowski)           

Téléchargement sources : 
http://www.cubewano.org/gimp-deskew-plugin/downloads/1.1.0/gimp-deskew-plugin_1.1.tar.gz 

Téléchargement binaires compilées : 
http://mwd.twine.pl/gimp/deskew-win32-1.1.0.zip           

Version : 1.1                       

Installation :  Décompresser deskew-win32-1.1.0.zip et installer deskew.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins.                    

Testé avec : Gimp 2.6.1

Appel du greffon :    Filtres > Misc > Deskew 

Résultat sur l'image en exemple sur le site de GIMP Deskew Plugin après un ajustement de canevas au 
calque.

Origine Effet

http://mwd.twine.pl/gimp/deskew-win32-1.1.0.zip
http://www.cubewano.org/gimp-deskew-plugin/downloads/1.1.0/gimp-deskew-plugin_1.1.tar.gz
http://www.cubewano.org/gimp-deskew-plugin/
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GREFFON TEXTURIZE

Créer des motifs a .

Site :  http://gimp-texturize.sourceforge.net/                                 

Auteur :  Emmanuel Cornet & Jean-Baptiste Rouquier (version Windows par Michael Schumacher).             

Téléchargement sources :  http://gimp-texturize.sourceforge.net/download.html                              

Téléchargement binaires compilées : http://gimp-texturize.sourceforge.net/download.html        

Version :  2.1                      

Installation :  Décompresser texturize-2.1_windows.zip et installer texturize.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.1

Appel du greffon :  Filtres > Mappage > Texturize    

Exemple sur une image d'origine réduite à 80*128 pixels :

Résultat : 

http://gimp-texturize.sourceforge.net/download.html
http://gimp-texturize.sourceforge.net/download.html
http://gimp-texturize.sourceforge.net/
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GREFFON ARCLAYER (COURBER UN CALQUE SELON UN ARC DE CERCLE)
Python doit être installé pour que ce greffon fonctionne.

Site : http://www.shallowsky.com/software/arclayer/                          

Auteure : Akkana Peck  (Auteure du livre Beginning GIMP: From Novice to Professional)         

Téléchargement sources : http://www.shallowsky.com/software/arclayer/arclayer-0.3.py                              

Téléchargement binaires compilées :  N/A     

Version :  0.3                     

Installation :   Placer arclayer-0.3.py dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins             

Testé avec : Gimp 2.6.1

Appel du greffon : Filtres > Distorsions > ArcLayer(py)     

Autre ressources : http://www.shallowsky.com/software/ 

Origine

Effet ArcLayer(py) 

http://www.shallowsky.com/software/
http://www.shallowsky.com/software/arclayer/arclayer-0.3.py
http://gimpbook.com/
http://www.shallowsky.com/software/arclayer/
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GREFFON FOURIER

Un simple plugin pour faire une transformation de Fourier sur une image. L'avantage principal de ce  
plugin est qu'il donne la possibilité de travailler directement dans GIMP dans l'espace de Fourier, en  
utilisant toute la puissante des filtres, des capacités d'éditions,... et en revenant ensuite via une  
transformation inverse pour constater le résultat. (Rémi Peyronnet)

Site :  http://people.via.ecp.fr/~remi/soft/gimp/gimp_plugin_en.php3#fourier                                 

Auteur : Rémi Peyronnet             

Téléchargement sources : http://people.via.ecp.fr/~remi/soft/gimp/fourier-0.4.0.tar.gz                             

Téléchargement binaires compilées : 
 http://people.via.ecp.fr/~remi/soft/gimp/fourier-0.4.0_bin_win32.zip  

et fftw3.dll  http://people.via.ecp.fr/~remi/soft/gimp/fftw3_dll.zip            

Version :  0.4.0                      

Installation :  Décompresser fourier-0.4.0_bin_win32.zip et fftw3_dll.zip dans un répertoire temporaire. Copier 
fourier.exe et fftw3.dll dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins              

Testé avec : Gimp 2.6.7

Appel du greffon :  

Sur l'image par Filtres > Générique > FFT Foward pour la transformation et Filtres > Générique > FFT Inverse 
pour la transformation inverse (Retour à l'image normale).

Informations : http://people.via.ecp.fr/~remi/sitewrapper.php3?src=ecp/tpi/rapport/fourier.html 

http://people.via.ecp.fr/~remi/sitewrapper.php3?src=ecp/tpi/rapport/fourier.html
http://people.via.ecp.fr/~remi/soft/gimp/fftw3_dll.zip
http://people.via.ecp.fr/~remi/soft/gimp/fourier-0.4.0_bin_win32.zip
http://people.via.ecp.fr/~remi/soft/gimp/fourier-0.4.0.tar.gz
http://people.via.ecp.fr/~remi/soft/gimp/gimp_plugin_en.php3#fourier
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GREFFON DDS

Ouvre et sauve des images (textures) au format DirectDraw Surface. 

Site : http://nifelheim.dyndns.org/~cocidius/dds/                                  

Auteur : Shawn Kirst             

Téléchargement sources : http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-dds 

Téléchargement binaires compilées :      
 http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-dds-win32        

Version : 2.0.6 (2008-06-03)                       

Installation :   Décompresser gimp-dds-win32-2.0.6.zip et placer dds.exe dans le répertoire des  greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins                       

Testé avec : Gimp 2.6.0

Appel du greffon :  Automatique lors de l'ouverture ou l'enregistrement d'un fichier .DDS

Documentation : http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-dds-doc-pdf 

Des textures sont disponibles à : http://developer.nvidia.com/object/IO_TTVol_01.html  

Exemple : Ouverture

http://developer.nvidia.com/object/IO_TTVol_01.html
http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-dds-doc-pdf
http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-dds-win32
http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-dds
http://nifelheim.dyndns.org/~cocidius/dds/
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GREFFON GIMP NORMALMAP PLUGIN

Clone du greffon NVIDIA pour Photoshop. Création de textures normal map. 

Site :    http://nifelheim.dyndns.org/~cocidius/normalmap/                              

Auteur :  (C) Copyright 2002-2008 Shawn Kirst            

Téléchargement sources :  
http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-normalmap                             

Téléchargement binaires compilées : 
http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-normalmap-win32       

Version :     1.2.2 (2008-12-12)                   

Installation :    

Décompresser  gimp-normalmap-win32-1.2.2.zip dans un répertoire temporaire.

Installer  normalmap.exe dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins, placer 
libgtkglext-win32-1.0-0.dll et libgdkglext-win32-1.0-0.dll et glew32.dll dans le répertoire gimp_2_6_x\bin (où 
se trouve gimp-2.6.exe).       

Testé avec : Gimp 2.6.4

Appel du greffon :  Sur l'image par Filtres > Mappage > Normalmap

Documentation : http://nifelheim.dyndns.org/~cocidius/normalmap/ 

Didacticiel en français : http://forums.jeuxonline.info/showthread.php?p=13538956#post13538956

Le greffon Photoshop : http://developer.nvidia.com/object/photoshop_dds_plugins.html

Greffon dds page 227.   

http://developer.nvidia.com/object/photoshop_dds_plugins.html
http://forums.jeuxonline.info/showthread.php?p=13538956#post13538956
http://nifelheim.dyndns.org/~cocidius/normalmap/
http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-normalmap-win32
http://nifelheim.dyndns.org/~cocidius/download.php?filename=gimp-normalmap
http://nifelheim.dyndns.org/~cocidius/normalmap/
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GREFFON GIMP PLT-PLUGIN

Ouverture et enregistrement de fichiers de textures .PLT

Site :  http://joco.kicks-ass.net/parser/parser.php?file=/nwn/plt.htm (Problème de fonctionnement) 

Auteur :  Joco            

Téléchargement sources : 
http://joco.kicks-ass.net/nwn/downloads/gimp-plugin-plt--source-0.1.0.zip                              

Téléchargement binaires compilées :  
http://joco.kicks-ass.net/nwn/downloads/gimp-plugin-plt-binary-0.1.0.zip      

Version :  21 juillet 2004, 13:55:00                      

Installation :   Décompresser  gimp-plugin-plt-binary-0.1.0.zip et installer  gimp-plugin-plt.exe  dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins             

Testé avec : Gimp 2.6.1

Appel du greffon :  Automatique à l'ouverture et à l'enregistrement des fichiers .plt

Usage :

The plugin requies a grayscale image with alpha. There must also be exactly 10 layers with the normal PLT  
order i.e. bottom layer being Skin. Even if you are not using a layer it must still be there for the plugin to  
correcty save the file as a PLT.
The plugin is a file plugin and adds the PLT extension to the normal file load/save dialogs within gimp. So  

you use it just like any other file format.
Les fichiers de textures .plt sont incorporés dans les « HAKPACKS »  (Voir http://nwvault.ign.com/)

Pour les récupérer, utiliser  NWN Viewer (http://nwvault.ign.com/View.php?view=Other.Detail&id=340)

Image par jonnyhr téléchargée à  http://nwvault.ign.com/View.php?view=Models.Detail&id=329    

http://nwvault.ign.com/View.php?view=Models.Detail&id=329
http://nwvault.ign.com/View.php?view=Other.Detail&id=340
http://nwvault.ign.com/
http://joco.kicks-ass.net/nwn/downloads/gimp-plugin-plt-binary-0.1.0.zip
http://joco.kicks-ass.net/nwn/downloads/gimp-plugin-plt--source-0.1.0.zip
http://joco.kicks-ass.net/parser/parser.php?file=/nwn/plt.htm
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GREFFON DCAM NOISE

Enlever le bruit d'une image.

Site :  http://home.arcor.de/peter.heckert/ (Semble non actif)                               

Auteur :  Peter Heckert (version Windows proposée par photocomix).           

Téléchargement sources : 
 http://www.aljacom.com/~gimp/images_gimp.7z (Archive 7Zip)                                

Téléchargement binaires compilées :  
 http://photocomix-resources.deviantart.com/art/DCamnoise-2-for-Gimp-windows-81260805         

Version :  2 0.64                     

Installation :   Télécharger DCamnoise_2_for_Gimp__windows_by_photocomix_resources.exe directement 
dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.0

Appel du greffon :  Sur l'image par Filtres > Améliolioration > Dcam Noise 2 0.64

http://photocomix-resources.deviantart.com/art/DCamnoise-2-for-Gimp-windows-81260805
http://www.aljacom.com/~gimp/images_gimp.7z
http://home.arcor.de/peter.heckert/


Cadre rempli motif Plasma-2 de 64*64 pixels de l'exemple
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GREFFON PLASMA-2
Création de motifs, remplir une sélection.

Site :  http://home.arcor.de/peter.heckert/ (Semble non actif)                               

Auteur :  Stephen Norris, David Necas (version Windows proposée par photocomix).           

Téléchargement sources : 
 http://www.aljacom.com/~gimp/images_gimp.7z (Archive 7Zip)                                

Téléchargement binaires compilées :  
 http://photocomix-resources.deviantart.com/art/Plasma2-for-Gimp-windows-81246453       

Version :  2 0.64                     

Installation :   Télécharger Plasma2_for_Gimp__windows_by_photocomix_resources.exe directement dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.0

Appel du greffon :  Sur l'image par Filtres > Rendu > Nuages > Plasma2

http://photocomix-resources.deviantart.com/art/Plasma2-for-Gimp-windows-81246453
http://www.aljacom.com/~gimp/images_gimp.7z
http://home.arcor.de/peter.heckert/
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PANORAMA TOOLS

Ensemble de filtres de traitement d'images dans le but de créer des images panoramiques. Pour assembler 
des panoramas il est préférable d'utiliser le greffon Stitch Panorama décrit page   204   ou   Hugin  .   Ces filtres ont 
des fonctions intéressantes.

Le site d'origine d'Helmut Dersch n'existe plus. Max Lyons propose une évolution à la page 
http://www.tawbaware.com/maxlyons/pano12ml.htm. Nous n'utilisons pas ces évolutions mais les fichiers 
d'origine avec une nouvelle version du greffon de Gimp. Ce greffon est dans l'archive que nous proposons et 
a été trouvé sur SourceForge.

Site :  N'existe plus.                              

Auteur :  Helmut Dersch         

Téléchargement sources :  http://www.aljacom.com/~gimp/PanoTools.7z  (Archive 7Zip) 

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/PanoTools.7z  (Archive 7Zip)  

Version :  pano12.dll version 1.0.0.1 ,  PanTools.exe version 2.6.12.0                   

Installation :   Télécharger l'archive 7Zip PanoTools.7z  et décompresser dans un répertoire temporaire. 
Placer la DLL « pano12.dll »  du répertoire \PanoTools ainsi que le greffon « PanTools.exe » du répertoire 
\PanoTools\Gimp dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins          

Testé avec : Gimp 2.6.1

Appel du greffon :  Sur l'image par Filtres > Panorama Tools > Nom du filtre

Dans les exemples qui suivent nous utilisons une photographie de la cathédrale York Minster faite par Ian 
Britton et disponible à la page http://www.freefoto.com/preview.jsp?id=05-05-8.

Image d'origine à 50% :

http://www.freefoto.com/preview.jsp?id=05-05-8
http://www.aljacom.com/~gimp/PanoTools.7z
http://www.aljacom.com/~gimp/PanoTools.7z
http://www.tawbaware.com/maxlyons/pano12ml.htm
http://hugin.sourceforge.net/
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INTERPOLATION  
Pour valider le type d'interpolation, choisir un filtre : Filtres > Panorama Tools > un filtre. 
Suivre les 3 étapes (Prefs > More > Options)

FONCTION DE PERSPECTIVE

Sur l'image faire : Filtres > PanoramaTools > PTPerspective. Ici HFOV est déterminé de façon empirique et 
dépend de l'objectif utilisé lors de la prise de vue.
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Effet de la correction Fisheye 
(Paramètres identiques sauf Format = Fisheye).                        Rotate = 45°, Format Normal

Vertical = 0 Horizontal = 30° , Format Normal
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FONCTIONS DE CONVERSION  REMAP

Sur l'image faire : Filtres > PanoramaTools > Remap.  HFOV = 90  , VFOV = 0

Normal vers QTVR-Panoramic                                                        Normal vers PSphere

Normal vers Fisheye Hor. (Pour transformer cette image sensiblement à l’origine faire Fisheye Hor vers 
Normal, HFOV = 113).                                                                 
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FONCTIONS DE CORRECTION CORRECT

Sur l'image faire : Filtres > PanoramaTools > Correct. Choisir le type de correction. S’ouvre alors une autre 
fenêtre pour paramétrer. Les options sont cumulatives. 

Nota : Dans l'option Radial Luminance le nom de cette fenêtre n'est pas bon. C'est bien Radial Luminance.

Le filtre de mise à l'échelle Scale possède de bonnes qualités pour réduire les dimensions des images.

Didacticiels en anglais : http://epaperpress.com/pano/ 

   http://home.no.net/dmaurer/~dersch/Index.htm  

http://home.no.net/dmaurer/~dersch/Index.htm
http://epaperpress.com/pano/
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GREFFONS HQ RESCALE

Remarque : Ce greffon a pour successeur  « Upsize »  (Description suivante).

Filtres d'interpolation pour agrandir les images.

Extrait du fichier README des sources :

This is an add-on to http://svenfoo.org/scaletest/133-9.html?  and http://svenfoo.org/scaletest/133-
8.html?  from which the t*.png and 133*.png pictures were taken.

Four proposed plug-ins are included. 
EANBQH.c (Exact Area Natural Biquadratic Histosplines)
EANBQHgamma.c (same with gamma correction)
IBFNBQH.c (Interpolatory Box Filtered Natural BiQuadratic Histosplines)
IBFNBQHgamma.c (same with gamma correction)

Site :  http://web.cs.laurentian.ca/robidoux/misc/                   

Auteur :  Nicolas Robidoux (Compilation Francois Collard, version Windows proposée par photocomix). 

Téléchargement sources : http://web.cs.laurentian.ca/robidoux/misc/gimptests.tgz                               

Téléchargement binaires compilées :    
http://photocomix-resources.deviantart.com/art/HQ-rescale-Plugin-for-Gimp-100248242

Lien direct
http://www.deviantart.com/download/100248242/HQ_rescale_Plugin_for_Gimp_by_photocomix_resources.zip 

Version :  Août 2008                     

Installation :   Télécharger et décompresser HQ_rescale_Plugin_for_Gimp_by_photocomix_resources.zip. 
Placer les 4 fichiers du répertoire \HQ-Upscale\FILES_TO_INSTALL ( EANBQH.exe , EANBQHgamma.exe , 
IBFNBQH.exe , IBFNBQHgamma.exe ) dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.1

Appel du greffon :  Sur l'image par Image > HQ Upscale > EANBQH ou EANBQHgamma ou IBFNBQH ou 
IBFNBQHgamma

Tests page suivante...

http://www.deviantart.com/download/100248242/HQ_rescale_Plugin_for_Gimp_by_photocomix_resources.zip
http://photocomix-resources.deviantart.com/art/HQ-rescale-Plugin-for-Gimp-100248242
http://web.cs.laurentian.ca/robidoux/misc/gimptests.tgz
http://web.cs.laurentian.ca/robidoux/misc/
http://svenfoo.org/scaletest/133-8.html
http://svenfoo.org/scaletest/133-8.html
http://svenfoo.org/scaletest/133-9.html
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Origine

Résultat EANBQH (311*311 pixels) Résultat IBFNBQH (311*311 pixels)
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GREFFON UPSIZE

Remarque : Ce greffon est le successeur de  « HQ rescale »  (Description précédente).

Filtres d'interpolation pour agrandir les images.

Site :     http://registry.gimp.org/node/19582    

Auteurs : Copyright (C) 2009 Nicolas Robidoux and Adam Turcotte (compilation SAMJ).

Licence :    http://creativecommons.org/licenses/by/2.5/ca/

Version : October 20, 2009.

Accès :   Image > Upsize    

Installation : Décompresser et placer upsize.exe dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-
ins.            

Testé avec : Gimp 2.6.7

 * *********************************************************

 * * UPSIZE: An image upsizing plugin featuring two modes. *

 * *****************************************************************************

 * * 1. Smooth (IBFNBQH): Image upsizing with Interpolatory Box Filtered       *

 * *                      Natural BiQuadratic Histosplines.                    *

 * *                      [This is the default option.]                        *

 * *                                                                           *

 * * 2.  Sharp  (EANBQH): Exact Area image upsizing with Natural BiQuadratic   *

 * *                      Histosplines.                                        *

 * *****************************************************************************

 *

 * For more details regarding these methods, see Fast Exact Area Image

 * Upsampling with Natural Biquadratic Histosplines by Nicolas

 * Robidoux, Adam Turcotte, Minglun Gong and Annie Tousignant,

 * pp.85-96 of Image Analysis and Recognition, 5th International

 * Conference, ICIAR 2008, Póvoa de Varzim, Portugal, June 25-27,

 * 2008. Proceedings, Aurelio C. Campilho, Mohamed S. Kamel (Eds.).

 * Lecture Notes in Computer Science 5112, Springer 2008, ISBN

 * 978-3-540-69811-1. Only the "Sharp" version is explicitly

 * discussed; "Smooth" differs in that it is box filtered (and in that

 * this implementation uses a different image size convention than the

 * "Sharp" resampler).

http://creativecommons.org/licenses/by/2.5/ca/
http://registry.gimp.org/node/19582
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GREFFON EXIF BROWSER

Lire les données Exif d'une image JPEG.

Site : http://registry.gimp.org/node/8839                    

Auteur :  William Skaggs (Compilé par Francois Collard, version Windows proposée par photocomix). 

Téléchargement sources : http://registry.gimp.org/node/8839 Lien direct
       http://registry.gimp.org/files/exif-browser.tar.gz                                 

Téléchargement binaires compilées :    
     http://photocomix-resources.deviantart.com/art/Exif-browser-Plugin-Gimp-100256028 

Lien direct
     http://www.deviantart.com/download/100256028/Exif_browser_Plugin__Gimp_by_photocomix_resources.zip 

Version :  Sept 1, 2008: Updated for libexif 0.6.16 and Gimp 2.5                     

Installation :   Télécharger et décompresser Exif_browser_Plugin__Gimp_by_photocomix_resources.zip. Placer 
le fichier exif-browser.exe dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.1

Appel du greffon :  Sur l'image par Fichier > View Exif 

http://www.deviantart.com/download/100256028/Exif_browser_Plugin__Gimp_by_photocomix_resources.zip
http://photocomix-resources.deviantart.com/art/Exif-browser-Plugin-Gimp-100256028
http://registry.gimp.org/files/exif-browser.tar.gz
http://registry.gimp.org/node/8839
http://registry.gimp.org/node/8839
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GREFFON F IX-CA (CHROMATIC ABERRATION)
Corriger les aberrations chromatiques.

Site :  http://kcd.sourceforge.net/fix-ca.php                           

Auteur :   Kriang Lerdsuwanakij

Téléchargement sources :  http://kcd.sourceforge.net/fix-ca.c           

Téléchargement binaires compilées :  Proposées par Photocomix
               http://photocomix-resources.deviantart.com/art/Fix-Cromatic-Aberration-95683614 

Lien direct :
     http://www.deviantart.com/download/95683614/Fix_Cromatic_Aberration__by_photocomix_resources.zip 

Version :  3.0.2                     

Installation :   Décompresser Fix_Cromatic_Aberration__by_photocomix_resources.zip dans un répertoire 
temporaire et placer \fix-ca-gimp-windows\fix-ca.exe directement dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.1

Appel du greffon :  Sur l'image par Filtres > Colors > Chromatic Aberration 

Image du site 
  de l'auteur.

http://www.deviantart.com/download/95683614/Fix_Cromatic_Aberration__by_photocomix_resources.zip
http://photocomix-resources.deviantart.com/art/Fix-Cromatic-Aberration-95683614
http://kcd.sourceforge.net/fix-ca.c
http://kcd.sourceforge.net/fix-ca.php
http://fr.wikipedia.org/wiki/Aberration_chromatique
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GREFFON JPEG 2000
Permet d'ouvrir et d'enregistrer des images au format JPEG 2000. Ce greffon a certaines limites pour ouvrir 

des images aux volumes importants.

Site :  http://registry.gimp.org/node/9899                               

Auteur :  Divyanshu vats 

Téléchargement sources :   http://www.megaupload.com/?d=BANPHKD6         

Téléchargement binaires compilées :  http://www.megaupload.com/?d=BANPHKD6 (Compilation par
 pucelo).   

Version :  2006/2007                    

Installation :   Décompresser PaqueteGIMP.tar.gz (avec 7Zip par exemple). Placer jp2.exe directement dans
 le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Automatique à l'ouverture ou l'enregistrement des images.

Nota : Il y a une autre version de greffon pour le format JPEG 2000 qui ne fonctionne pas encore trop bien à 
la page http://advance-software.com/download/tools/gimp_j2k.zip 

Des exemples d'images pour tester sont disponibles à la page 
 http://www.morgan-multimedia.com/JPEG2000/J2K_samples.htm où il faut modifier 
l'extension des fichier de .j2c en . j2k ou .jp2 pour les importer dans Gimp.

Le JPEG 2000 permet de réduire le volume des images en supprimant les artefacts créés avec le JPEG.

Image de 1920*1080 pixels.

Comparaison EPS (origine)/ JP2 (87 ko) / JPG (93ko )

La qualité du JPEG est nettement moins bonne que le JP2
(compression très visible sur le casque et les genouillères). 

Inclure une image JPEG 2000 dans une page HTML : <embed src="TV%20Baseball%20Screen.jp2" 
height="1080" width="1920"> (Balise non validée par le W3C). QuickTime d'Apple 
(http://www.apple.com/quicktime/) lit bien ce format.

http://www.apple.com/quicktime/
http://www.morgan-multimedia.com/JPEG2000/J2K_samples.htm
http://advance-software.com/download/tools/gimp_j2k.zip
http://www.megaupload.com/?d=BANPHKD6
http://www.megaupload.com/?d=BANPHKD6
http://registry.gimp.org/node/9899
http://fr.wikipedia.org/wiki/JPEG_2000
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GREFFON FREE TYPE

Ce greffon n'est plus développé car les auteurs considèrent que l'outil texte de Gimp est suffisamment 
performant. Sa simplicité d'utilisation peut encore plaire.

Site : http://freetype.gimp.org/                           

Auteurs :   Jens Lautenbacher , Sven Neumann, Michael Natterer, Andy Thomas, Tor Lillqvist

Téléchargement sources : http://freetype.gimp.org/ 

Téléchargement binaires compilées :   http://www.aljacom.com/~gimp/images_gimp.7z  (Archive 7Zip) 
freetype.exe compilé par Jernej Simoncic (freetype.exe) fourni avec les anciennes versions de Gimp sur 
SourceForge.                     

Version :  0.6                     

Installation :   Placer freetype.exe directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-
ins.            

Testé avec : Gimp 2.6.1

Appel du greffon :  Sur l'image par Filtres > Text > Free Type

http://www.aljacom.com/~gimp/images_gimp.7z
http://freetype.gimp.org/
http://freetype.gimp.org/
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GREFFON GIMP-PLUGIN-ASTRONOMY

Faciliter le traitements des images en astronomie..  

Site : http://www.hennigbuam.de/georg/gimp.html                                   

Auteur :   Georg Hennig 

Téléchargement sources :  Clic sur ce lien.         

Téléchargement binaires compilées :  Clic sur ce lien. 

Version :  0.6                     

Installation :   Décompresser l'archive gimp-plugin-astronomy-0.6b.zip et placer
\gimp-plugin-astronomy-0.6\plugins\astronomy-alignment.exe

\gimp-plugin-astronomy-0.6\plugins\astronomy-artificial-galaxy.exe

\gimp-plugin-astronomy-0.6\plugins\astronomy-artificial-stars.exe

\gimp-plugin-astronomy-0.6\plugins\astronomy-background-gradient.exe

\gimp-plugin-astronomy-0.6\plugins\astronomy-merge.exe

\gimp-plugin-astronomy-0.6\plugins\astronomy-star-rounding.exe

\gimp-plugin-astronomy-0.6\plugins\libfftw3-3.dll

\gimp-plugin-astronomy-0.6\plugins\libgsl-0.dll

\gimp-plugin-astronomy-0.6\plugins\libgslcblas-0.dll  directement dans le répertoire
          des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Placer les scripts-fu 
\gimp-plugin-astronomy-0.6\scripts\background_gradient_batch.scm

\gimp-plugin-astronomy-0.6\scripts\border_information.scm

\gimp-plugin-astronomy-0.6\scripts\brightness_contrast_batch.scm

\gimp-plugin-astronomy-0.6\scripts\dark_subtraction.scm

\gimp-plugin-astronomy-0.6\scripts\flat_division.scm

\gimp-plugin-astronomy-0.6\scripts\mode_batch.scm

\gimp-plugin-astronomy-0.6\scripts\normalize_batch.scm  directement dans le
                              répertoire des scripts-fu gimp_2_6_x\share\gimp\2.0\scripts.

Testé avec : Gimp 2.6.2

Appel des greffons et scripts :  

Sur l'image par Filtres > Astronomy >

http://www.cip.physik.uni-muenchen.de/~georg.hennig/counter/dlcount.php?link=http://www.cip.physik.uni-muenchen.de/~georg.hennig/downloads/gimp-plugin-astronomy-0.6b.zip
http://www.cip.physik.uni-muenchen.de/~georg.hennig/counter/dlcount.php?link=http://www.cip.physik.uni-muenchen.de/~georg.hennig/downloads/gimp-plugin-astronomy-0.6.tar.bz2
http://www.hennigbuam.de/georg/gimp.html
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La documentation est dans :  \gimp-plugin-astronomy-0.6\documentation.pdf

Quelques résultats :

Créer une galaxie Créer des étoiles
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GREFFON YUV
Permet de passer de l'espace colorimétrique RVB à YUV et réciproquement.  

Site : http://registry.gimp.org/node/9848                               

Auteur :   Rémi Peyronnet (http://www.via.ecp.fr/~remi)

Téléchargement sources : http://registry.gimp.org/files/yuv-0.1.3.tar.gz           

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/yuv-0.1.3-i686.zip            

Version :  0.1.3                     

Installation :   Décompresser l'archive yuv-0.1.3-i686.zip et placer yuv.exe directement dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.8 (32bits) / Windows 7 (64 bits)

Appel du greffon :  Sur l'image par Image > Mode > RGB -> YUV et  Image > Mode > YUV-> RGB

La luminance se trouve dans le canal rouge et la chrominance dans les canaux verts et bleus.

 RVB YUV

   >>

   < <

http://www.aljacom.com/~gimp/yuv-0.1.3-i686.zip
http://registry.gimp.org/files/yuv-0.1.3.tar.gz
http://www.via.ecp.fr/~remi
http://registry.gimp.org/node/9848
http://fr.wikipedia.org/wiki/YUV
http://fr.wikipedia.org/wiki/Rouge_vert_bleu
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GREFFON FORMULAS

Modifie les 3 couleurs RVB avec des formules mathématiques.

Site :   http://nbenoit.tuxfamily.org/projects/gimp-plugin-formulas/ ou
     http://registry.gimp.org/node/67 

Auteur :  Nicolas BENOIT 

Téléchargement sources : 
   http://nbenoit.tuxfamily.org/projects/gimp-plugin-formulas/gimp-plugin-formulas-0.9.7.tar.gz           

Téléchargement binaires compilées :   
  http://nbenoit.tuxfamily.org/projects/gimp-plugin-formulas/gimp-plugin-formulas-0.9.7-win32.zip 

Version :  0.9.7                 

Installation :   Télécharger gimp-plugin-formulas-0.9.7-win32.zip directement dans gimp_2_6_x   (Où est 
maringouin.exe) et décompresser l'archive.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Rendu > Formulas

Exemples de formules proposées par l'auteur :

  1)  
Red Channel :     ((1+cos(rad(x+y)))*127)+1
Green Channel :  ((1+sin(rad(x+y)))*127)+1
Blue Channel :     y%255

   2)
First Pass:

Red Channel :      0
Green Channel :   (1+cos(rad(x)))*127
Blue Channel :      (1+cos(rad(y)))*127

Second Pass:
Red Channel :       192-((green+blue)/3)
Green Channel :    green
Blue Channel :      blue

   3)
Red Channel :      100
Green Channel :   (1+cos(rad(x*2.21*x/(y+1))))*92
Blue Channel :      (1+sin(rad(x*2.21*x/(y+1))))*127

http://nbenoit.tuxfamily.org/projects/gimp-plugin-formulas/gimp-plugin-formulas-0.9.7-win32.zip
http://nbenoit.tuxfamily.org/projects/gimp-plugin-formulas/gimp-plugin-formulas-0.9.7.tar.gz
http://registry.gimp.org/node/67
http://nbenoit.tuxfamily.org/projects/gimp-plugin-formulas/
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GREFFON F ILM DEGRAIN

Ajuste les 3 couleurs RVB avec des curseurs.

Site :  http://members.ozemail.com.au/~hodsond/degrain.html                                        

Auteurs :  Stefan M Fendt, David Hodsond 

Téléchargement sources :  http://www.aljacom.com/~gimp/degrain-i686.zip          

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/degrain-i686.zip  par samj        

Version :  ?                 

Installation :   Décompresser l'archive degrain-i686.zip et placer degrain.exe directement dans le répertoire 
des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Amélioration > Film Grain Remover

http://www.aljacom.com/~gimp/degrain-i686.zip
http://www.aljacom.com/~gimp/degrain-i686.zip
http://members.ozemail.com.au/~hodsond/degrain.html
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GREFFON L IGHT TO HEIGHT

Expansion sur l'image en fonction de sa luminosité ou de la luminosité d'une autre image.

Site :  http://sudakyo.hp.infoseek.co.jp/gimp/l2height/lighttoheight_e.html                                     

Auteur :   Kyoichiro Suda  

Téléchargement sources :   http://www.aljacom.com/~gimp/l2height-0.7-i686.zi         

Téléchargement binaires compilées :   http://www.aljacom.com/~gimp/l2height-0.7-i686.zip par samj        

Version :  0.7                   

Installation :   Décompresser l'archive l2height-0.7-i686.zip et placer l2height-0.7.exe directement dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Mappage > Light to Height

http://www.aljacom.com/~gimp/l2height-0.7-i686.zip
http://www.aljacom.com/~gimp/l2height-0.7-i686.zip
http://sudakyo.hp.infoseek.co.jp/gimp/l2height/lighttoheight_e.html
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GREFFON G IMP-ACE (AUGMENTER LES CONTRASTES)
Augmente beaucoup les contrastes (Évolution d'Adaptive Contrast).

Site : http://registry.gimp.org/node/20                                        

Auteurs :   * Based on J. Alex Stark's <stark@niss.org> GLACE system.

* GIMP Plug-in by Kevin Turner <kevint@poboxes.com> 

Téléchargement sources :  http://registry.gimp.org/files/gimp-ace-0.6.7.tar.gz                    

Téléchargement binaires compilées :   http://www.aljacom.com/~gimp/gimp-ace-0.6.7-i686.zip  par samj 

Version :  0.6.7                   

Installation :   Décompresser l'archive gimp-ace-0.6.7-i686.zip et placer gimp-ace.exe directement dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Colors > Adaptive Contrast

http://www.aljacom.com/~gimp/gimp-ace-0.6.7-i686.zip
http://registry.gimp.org/files/gimp-ace-0.6.7.tar.gz
http://registry.gimp.org/node/20
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GREFFON CRÉER DES NUAGES, CRAYONNER (PHYMODMEDIA)
Créer des nuages sur une image ou une sélection, crayonner.

Site :  Le site est disparu.                                    

Auteurs :   David A. Bartold 

Téléchargement sources : http://www.aljacom.com/~gimp/phymodmedia-0.5.1-i686.zip           

Téléchargement binaires compilées : http://www.aljacom.com/~gimp/phymodmedia-0.5.1-i686.zip 
 par samj        

Version :  Modifiée pour l'accès (novembre 2008).                 

Installation :   Décompresser l'archive phymodmedia-0.5.1-i686.zip et placer phymodmedia.exe directement 
dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins puis, placer thick-oil-paint.scm dans le 
répertoire des scripts-fu \gimp_2_6_x\share\gimp\2.0\scripts.            

Testé avec : Gimp 2.6.2

Appel du greffon :  

Pour créer des nuages, sur l'image par : Filtres > Rendu > Nuages > Sky

Effet

Pour crayonner par  Filtres > Misc > Media > Color Pencils 
et Filtres > Misc > Media > Texture pour modifier la texture 
sous le crayonnage. 

Pour créer une toile par  Filtres > Artistique> Thick oil Paint

http://www.aljacom.com/~gimp/phymodmedia-0.5.1-i686.zip
http://www.aljacom.com/~gimp/phymodmedia-0.5.1-i686.zip
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GREFFON V IGNETTING (V IGNETAGE)
Créer un effet de vignetage sur une image.

Site :  http://www.linuxgraphic.org/forums/viewtopic.php?t=2642                                      

Auteurs :   Luc Courtrai, David Hodson 

Téléchargement sources : http://www.aljacom.com/~gimp/vignetting-i686.zip             

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/vignetting-i686.zip  par samj        

Version :  Modifiée pour l'accès (novembre 2008).                 

Installation :   Décompresser l'archive vignetting-i686.zip et placer vignetting.exe directement dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Ombres et lumières > Vignetting

http://www.aljacom.com/~gimp/vignetting-i686.zip
http://www.aljacom.com/~gimp/vignetting-i686.zip
http://www.linuxgraphic.org/forums/viewtopic.php?t=2642
http://fr.wikipedia.org/wiki/Vignetage
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GREFFON W IDEANGLE (GRAND ANGLE)
Créer ou rectifier l'effet d'une prise de vue avec un objectif grand angle (Idem filtre distorsion de lentille).

Site : http://members.ozemail.com.au/~hodsond/wideangle.html                                           

Auteur :   David Hodson 

Téléchargement sources :  http://members.ozemail.com.au/~hodsond/wideangle.c                

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/wideangle-i686.zip  par samj        

Version :  1.0.10.                 

Installation :   Décompresser l'archive wideangle-i686.zip et placer wideangle.exe directement dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Distorsions > Wideangle (ou Distorsion de lentille) 

Image d'origine >

http://www.aljacom.com/~gimp/wideangle-i686.zip
http://members.ozemail.com.au/~hodsond/wideangle.c
http://members.ozemail.com.au/~hodsond/wideangle.html
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Les exemples sont appliqués à l'image 2925887624_76f4fe031a.jpg , disponible sur
  http://flickr.com/photos/vancouverflavour/2925887624/ par vancouverflavour (CC), avec l'ajout d'une mire 
pour visualiser les effets.

http://flickr.com/photos/vancouverflavour/2925887624/
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GREFFON INTELLIGUM (GOMME INTELLIGENTE)
Gommer à partir d'une sélection qui est remplacée par un fond interpolé .

Site :  http://www.geocities.com/lode_leroy/gimp/                                            

Auteur :   Lode Leroy

Téléchargement sources : http://www.geocities.com/lode_leroy/gimp/intelligum.zip                  

Téléchargement binaires compilées : http://www.geocities.com/lode_leroy/gimp/intelligum.zip         

Sources + binaires compilées :  http://www.aljacom.com/~gimp/intelligum.zip        

Version :  08/2004            

Installation :   Décompresser l'archive intelligum.zip et placer \intelligum\intelligum.exe directement dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Misc > Intelligum

Nota : À la fin de son utilisation ce greffon produit une erreur sans conséquence.

http://www.aljacom.com/~gimp/intelligum.zip
http://www.geocities.com/lode_leroy/gimp/intelligum.zip
http://www.geocities.com/lode_leroy/gimp/intelligum.zip
http://www.geocities.com/lode_leroy/gimp/
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GREFFON AREA (SURFACE)
Indique la surface, dans le système métrique, d'une sélection rectangulaire sur une carte ou sur un plan 

scanné dont on connaît l'échelle et la résolution, dans le système impérial, appliquée lors du « scan ».

Site : http://atrey.karlin.mff.cuni.cz/~qiq/mff/vazne/area.en.html                                                

Auteur :  Miroslav Spousta (Patch de Hannes Rotzinger) 

Téléchargement sources : http://atrey.karlin.mff.cuni.cz/~qiq/mff/vazne/area-gimp-2.2.tar.gz                 

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/area-gimp-2.2-i686.zip  par samj        

Version :  0.7                   

Installation :   Décompresser l'archive area-gimp-2.2-i686.zip et placer area.exe directement dans le répertoire 
des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Image > Count Area (Recommencer à chaque variation de la sélection).

Précision des résultats du greffon non vérifiée. Le temps de traitement est long sur une grande surface.

http://www.aljacom.com/~gimp/area-gimp-2.2-i686.zip
http://atrey.karlin.mff.cuni.cz/~qiq/mff/vazne/area-gimp-2.2.tar.gz
http://atrey.karlin.mff.cuni.cz/~qiq/mff/vazne/area.en.html
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GREFFON .ANI (CURSEURS ANIMÉS SOURIS W INDOWS)
Ouvrir et enregistrer des fichiers .ani qui représentent les curseurs animés des souris Windows.

Site :  http://www.gimptalk.com/forum/viewtopic.php?f=9&t=27573                              

Auteur :   Christian Kreibich  

Téléchargement sources :   http://www.box.net/shared/jkkq6vsgs0    

Téléchargement binaires compilées :  http://www.box.net/shared/iao5pog84k par JamesH

Version :  2007/12/30                    

Installation :   Décompresser l'archive ani(Win32bin).zip et placer ani.exe directement dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Automatique à l'ouverture et à l'enregistrement des images .ani

CE GREFFON EST INCOMPATIBLE AVEC LES FICHIERS VIDÉO AVI (Page 121)

La présentation par l'auteur en mai 2002:

Dear Gimpies,
I recently encountered the need to edit Windows icons and wanted to use  

the Gimp as usual, when I noticed that apparently Windows icons aren't  
supported by default (that's with 1.2.2, but a look at 1.2.3's sources  
suggests the same). A search one the web brought up half-finished  
plugins at best.
So here's my try, the plugin supports both loading and saving of multiple  

icons in a file at 2/4/8/32 bpp. You can choose each icon's own color  
depth (and thus the color map that's created for it) in a preview dialog  
when saving the icon. I've included a little help page that explains things  
a bit. I've tested it quite a bit and checked that the generated files do in  
fact work with icon editors in windows, but of course I may have missed  
things.  … Cheers, keep it up, Christian.

Exemple >

http://www.box.net/shared/iao5pog84k
http://www.box.net/shared/jkkq6vsgs0
http://www.gimptalk.com/forum/viewtopic.php?f=9&t=27573
http://www.sharpened.net/helpcenter/file_extension.php?ani
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GREFFON GP BOUNDARY SHRINKER

Extrait du site de l'auteur : 

Un greffon pour le Gimp pour nettoyer des images pixels aux couleurs indexées telles que des cartes de  
géographie politique/administrative. 
J'ai écrit ce greffon pour nettoyer les cartes créées pour le logiciel éducatif  KGeography d'Albert Astals. Il  

préfère que les frontières ne mesurent qu'un pixel de large, pixel connectés au suivant par un côté et non  
seulement par un coin.
Site : http://home.gna.org/gp-boundary-shrk/                                                         

Auteur :  Laurent G

Téléchargement sources :  http://download.gna.org/gp-boundary-shrk/                       

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/GP_Boundary_shrinker-i686.zip
   par samj        

Version :  1.1.1                  

Installation :   Décompresser l'archive GP_Boundary_shrinker-i686.zip et placer boundary-shrinker.exe 
directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Misc > Boundary shrinker.

Fonctionne sur une image en mode couleurs indexées et aplatie ( Image > Mode > Couleurs indexées   / 
Image > Aplatir l'image ). Ce greffon peut créer une erreur si l'image n'est pas aplatie.

Voir l'exemple sur le site http://home.gna.org/gp-boundary-shrk/  

Principe :

Origine Paramètres       Résultat

http://home.gna.org/gp-boundary-shrk/
http://www.aljacom.com/~gimp/GP_Boundary_shrinker-i686.zip
http://download.gna.org/gp-boundary-shrk/
http://home.gna.org/gp-boundary-shrk/
http://kgeography.berlios.de/
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 Greffon Image Subtraction (Soustraction de 2 images) 

GREFFON IMAGE SUBTRACTION (SOUSTRACTION DE 2 IMAGES)
Compare les pixels de 2 images et donne le résultat dans une autre image. Si les pixels sont identiques, le  

résultat sera une transparence. Si les pixels sont différents, les pixels de la première image seront reportés sur 
la nouvelle image. Ce greffon permet d'isoler des objets de 2 images semblables. Ce greffon dispose aussi 
d'un réglage du seuil.

Site : http://registry.gimp.org/node/27                                                          

Auteurs :  Alexandre Heitor Schmidt, Daniel Afonso Heisler

Téléchargement sources : http://registry.gimp.org/files/gimp_image_subtraction_plugin-0.1.0.tar.gz 

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/Image_Subtraction-i686.zip 
   par samj        

Version :  1.1.1                  

Installation :   Décompresser l'archive Image_Subtraction-i686.zip et placer Image_Subtraction.exe 
directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Misc > Image Subtraction (Traitement lent).

http://www.aljacom.com/~gimp/Image_Subtraction-i686.zip
http://registry.gimp.org/files/gimp_image_subtraction_plugin-0.1.0.tar.gz
http://registry.gimp.org/node/27
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GREFFON MAGIE (EFFET H IGH DYNAMIC RANGE IMAGE)
Créer un effet HDRI (High Dynamic Range Image).

Site :  http://magie.sourceforge.net/                                                          

Auteur :  Ivan Bezdomniy

Téléchargement sources :  http://sourceforge.net/project/platformdownload.php?group_id=188185 

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/magie-0.3-i686.zip  par samj        

Version :  0.3                 

Installation :   Décompresser l'archive magie-0.3-i686.zip et placer gimp-drt.exe directement dans le répertoire 
des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Amélioration > DR Transformer (L'aperçu ne fonctionne pas).

Effet du Filtre

http://www.aljacom.com/~gimp/magie-0.3-i686.zip
http://sourceforge.net/project/platformdownload.php?group_id=188185
http://magie.sourceforge.net/
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GREFFON BASCII (ART ASCII)
Créer de l'art ASCII lors de l'enregistrement d'une image en niveau de gris.

Site :  http://sourceforge.net/projects/bascii/                                  

Auteur :  Mate Kovacs        

Téléchargement sources :  http://sourceforge.net/projects/bascii/              

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/bascii_pre-alpha-i686.zip   par samj 

Version :  pre-alpha.                 

Installation :   Décompresser l'archive bascii_pre-alpha-i686.zip et placer bascii.exe directement dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Automatique à l'enregistrement.

Mettre l'image en niveau de gris avec beaucoup de contrastes.
Aplatir l'image.
Enregistrer au format bASCII (*.txt  *.asc).
Choisir une police comme Courier New.
Ouvrir avec Wordpad ou Notepad++

                                       
                                              
      Wilber en art ASCII                                                                               
                                                                                     
                                                                                     

                                                                    m                
                                                                   MMp               
                                                                  MMMN               
                                                                _MMMMN               
                   #_                                         _MMMMMMN               
                   MMp                                      _MMMMMMMMM               
                   MMMMp                                 _gMMMMMMMMMMM               
                   MMMMMMm_                         _ggMMMMMMMMMMMMMMM               
                   MMMMMMMMMMm__                 7MMMMMMMMMMMMMMMMMMMM               
                   MMMMMMMMMMMMMMM.               "MMMMMMMMMMMMMMMMMMM               
      ______       MMY       7MN6,`         ~&_    /MMMMMMMMMMMMMMMMMN               
    gMMMMMMMMNp    M       _   ML'.         qMMMp  'MMMMMMMMMMMMMMMMMM               
   MMN     MMMMMp __.     qMMp.3p '     gpqMMMMMM ' #MMMMMMMMMMMMMMMMM               
  qMMp_   ,MMMMMMMMp    MMMMMB #M, `.   MMMMMMMMM` _MMMMMMMMMMMMMMMMM                
  MMMMMMMMMMMMMMMMMMm_  -MMM__MMMM_   `..YMMMMMD  gMMMMMMMMMMMMMMMMMM                
  /MMMMMMMMMMMMMMMMMMMMMmmmMMMMMMMMMm_         _gMMMMMMMMMMMMMMMMMMMt                
   MMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMmmmMMMMMMMMMMMMMMMMMMMMMMMM                 
    MMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMM                  
     UMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMM\                  
       MMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMM7                   
          HMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMM                     
                  MMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMp_WMMMMMM                      
                    /MMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMp_VMq                       
                       `UMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMMp_74_                    
                         '7EMMMMMMMMMMMMMMMMMMMMMMMMMMMM7`7MMMMp_7;                  
                            '"7EMMMMMMMMMMMMMMMMMMMW7"`      UMMM,                   
                                   '^""*****""^`                Vk3+.                
                                                                    *%_.             
                                                                       **MMMMMp      
                                                                        qMMMMMMN     
                                                                        HMMMMMMMp    
                                                                         MMMMMMMN    
                                                                          MMMMMMM    
                                                                            MMMMMp   
                                                                               MMM,

http://www.aljacom.com/~gimp/bascii_pre-alpha-i686.zip
http://sourceforge.net/projects/bascii/
http://sourceforge.net/projects/bascii/


www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 262 / 391
 Greffon PDS (Images .img & .imq) 

GREFFON PDS (IMAGES . IMG & . IMQ)
Ouverture des images NASA/ESA PDS/EDR :

PDS-files usually have the filename-suffix ".img" or ".imq" if compressed. 
Note, that this suffix is also used for other non-PDS file-formats.
The plug-in will install itself as input filter for files with the following suffixes: 
img, imq, qub, pds, edr, bb1, bb2, bb3, bb4, ir1, ir2, ir3, n07, n15, sur, sun, red, grn, blu, sgr, vio 

Site : http://registry.gimp.org/node/1627                                                            

Auteur :  Holger Isenberg

Téléchargement sources :  http://registry.gimp.org/files/pds-2.3.6.tar.gz                         

Téléchargement binaires compilées : http://mars-news.de/gimp/gimp-2.4/pds.exe         

Version :  2.3.6                

Installation :   Placer pds.exe directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.2

Appel du greffon :  Automatique.

Image : http://astrogeology.usgs.gov/Projects/LunarConsortium/data/earthbas/radar_p.imq 

http://astrogeology.usgs.gov/Projects/LunarConsortium/data/earthbas/radar_p.imq
http://mars-news.de/gimp/gimp-2.4/pds.exe
http://registry.gimp.org/files/pds-2.3.6.tar.gz
http://registry.gimp.org/node/1627
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GREFFON SHAPEFS (EFFET 3D SUR LES OMBRES)
Génération d'effet 3D sur des images en niveau de gris à partir des ombres, de l'azimut du soleil, l'angle de la 

caméra et la dimension du pixel. Ce greffon, très complexe, utilise beaucoup de puissance de calcul (Mémoire 
minimale de 512 Mo). Une documentation technique est fournie dans l'archive.

Site : http://registry.gimp.org/node/2944                                                             

Auteur :  Alfred P. Reaud

Téléchargement sources :  http://registry.gimp.org/files/shapefs-1.2.0.0-20051020.tar.gz                         

Téléchargement binaires compilées :  http://registry.gimp.org/files/shapefs-1.2.0.0-20051020.zip         

Version :  1.2.0.0-20051020                 

Installation :   Décompresser l'archive shapefs-1.2.0.0-20051020.zip  et placer ShapeFS\ShapeFS.exe 
directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Mappage > Shape From Shading.

http://registry.gimp.org/files/shapefs-1.2.0.0-20051020.zip
http://registry.gimp.org/files/shapefs-1.2.0.0-20051020.tar.gz
http://registry.gimp.org/node/2944


www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 264 / 391
 Greffons de bruits créés par Lukas Hosek 

GREFFONS DE BRUITS CRÉÉS PAR LUKAS HOSEK

Traitement du bruit sur les « Pixels chauds » (Filtres créés pour soutenir une thèse).

Site :  http://www.ms.mff.cuni.cz/~hosel4am/                                                           

Auteur :  Lukas Hosek

Téléchargement sources :   http://www.ms.mff.cuni.cz/~hosel4am/                         

Téléchargement binaires compilées :  
     http://www.aljacom.com/~gimp/impulse_localmode_gaussnr-i686.zip par samj 

Version :  2007                

Installation :   Décompresser l'archive impulse_localmode_gaussnr-i686.zip et placer gaussnr.exe , 
localmode.exe ,  impulse.exe directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Amélioration > Impulse noise reduction
Filtres > Amélioration > Local mode filter (Très lent)
Filtres > Amélioration > Advanced noise reduction

http://www.aljacom.com/~gimp/impulse_localmode_gaussnr-i686.zip
http://www.ms.mff.cuni.cz/~hosel4am/
http://www.ms.mff.cuni.cz/~hosel4am/
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GREFFON COLOUR2GREY-LOCAL (RVB EN NIVEAUX DE GRIS)
Traitement pour essayer de conserver la luminosité, les bons contrastes lors d'une conversion RVB en 

niveaux de gris.

Site :  http://www.mpi-inf.mpg.de/resources/ApparentGreyscale/                                                             

Auteur :  This program is a modification of Peter Heckert's Unsharp masking plugin.
Téléchargement sources : 

http://www.mpi-inf.mpg.de/resources/ApparentGreyscale/colour2grey-local-0.1.c 

Téléchargement binaires compilées :  
            http://www.aljacom.com/~gimp/colour2grey-local-i686.zip   par samj 

Version :  0.1               

Installation :   Décompresser l'archive colour2grey-local-i686.zip et placer colour2grey-local-0.1.exe 
directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Filtres > Colors > Colour2Grey Local

Original (Getty images)            Niveaux de gris Gimp

http://www.aljacom.com/~gimp/colour2grey-local-i686.zip
http://www.mpi-inf.mpg.de/resources/ApparentGreyscale/colour2grey-local-0.1.c
http://www.mpi-inf.mpg.de/resources/ApparentGreyscale/
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GREFFON WAVELET-DECOMPOSE (DÉCOMPOSER EN ONDELETTES) 
Décomposer une image en ondelettes sur plusieurs calques pour modifier le rendu en utilisant les 

caractéristiques de ces calques.

Site :  http://registry.gimp.org/node/11742  (Traduction automatique en français par Google) 

Auteur : Marco Rossini

Téléchargement sources : http://registry.gimp.org/files/wavelet-decompose-0.1.2.tar.gz                              

Téléchargement binaires compilées :  
http://registry.gimp.org/files/wavelet-decompose-0.1.2_win32.zip           

Version :  0.1.2             

Installation :   Décompresser l'archive wavelet-decompose-0.1.2_win32.zip et placer wavelet-decompose.exe 
directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.4

Appel du greffon :  

Sur l'image par : Filtres > Générique > Wavelet decompose

Pour modifier l'image :

– Modifier les calques « Wavelet ... ».

– Dans l'exemple donné sur le site de l'auteur, il faut utiliser le pinceau 
sur les calques Wavelet scale 1 et  Wavelet scale 2. Nous obtenons de 
bons résultats avec un pinceau de couleur grise (RVB = 
128,128,128) en mode normal.

– Nous pouvons modifier la luminosité en modifiant l'opacité des 
calques.

http://registry.gimp.org/files/wavelet-decompose-0.1.2_win32.zip
http://registry.gimp.org/files/wavelet-decompose-0.1.2.tar.gz
http://translate.google.com/translate?u=http://registry.gimp.org/node/11742&sl=en&tl=fr&hl=fr&ie=UTF-8
http://registry.gimp.org/node/11742
http://fr.wikipedia.org/wiki/Compression_Ondelette_(Images)


www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 267 / 391
 Greffon Annular denoise (Diminuer le bruit) 

GREFFON ANNULAR DENOISE (D IMINUER LE BRUIT)
Diminuer le bruit avec Annular denoise et créer un cadre avec Add Frame.

Site : http://w3.impa.br/~luis/                                                             

Auteur : Luis A.Florit

Téléchargement sources :  http://w3.impa.br/~luis/photos/varios/annulardenoise.c 
http://w3.impa.br/~luis/photos/varios/frame.scm                          

Téléchargement binaires compilées :  
      http://www.aljacom.com/~gimp/frame-scm_annulardenoise-i686.zip  par samj 

Version :  2007             

Installation :   Décompresser l'archive frame-scm_annulardenoise-i686.zip et placer annulardenoise.exe 
directement dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.  Placer frame.scm dans le 
répertoire des scripts \gimp_2_6_x\share\gimp\2.0\scripts.           

Testé avec : Gimp 2.6.2

Appel du greffon et du script-fu :  

Sur l'image par : Filtres > Annular denoise et Script-Fu > Mias > Add Frame

Les réglages sont délicats.

Exemple des pixels modifiés par ce greffon (tout ce qui n'est pas noir).

   Effet du Script-Fu Add Frame

http://www.aljacom.com/~gimp/frame-scm_annulardenoise-i686.zip
http://w3.impa.br/~luis/photos/varios/frame.scm
http://w3.impa.br/~luis/photos/varios/annulardenoise.c
http://w3.impa.br/~luis/
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GREFFON FILESEQ

Choix des images ouvertes, enregistrement par un séquenceur.

Site :  http://members.ozemail.com.au/~hodsond/fileSeq.html                                       

Auteur : David Hodsond     

Téléchargement sources :  http://www.aljacom.com/~gimp/fileSeq-i686.zip                  

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/fileSeq-i686.zip  par samj        

Version :  ?                  

Installation :   Décompresser l'archive fileSeq-i686.zip et placer fileSeq.exe directement dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.2

Appel du greffon :  Sur l'image par : Fichier > File Sequencer 

Ce greffon qui a des bogues connus de l'auteur est présenté comme exemple.

Image suivante

Enregistrer si modification

http://www.aljacom.com/~gimp/fileSeq-i686.zip
http://www.aljacom.com/~gimp/fileSeq-i686.zip
http://members.ozemail.com.au/~hodsond/fileSeq.html
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GREFFON BLEND REMOVAL

Remove alpha blended image : This plug-in removes alpha blended image from current image, like a half  
blended logos or motion blur by frames.
Nous n'avons pas réussi à faire fonctionner ce greffon en fonction de la définition en anglais de l'auteur. Par 

contre ce greffon permet de mélanger deux images avec un résultat différent des possibilités offertes pas les 
modes et opacités des calques.

Site :       http://sudakyo.hp.infoseek.co.jp/gimp/blendremoval/blendremoval.html                                                 

Auteur : Kyoichiro Suda            

Téléchargement sources et binaires compilées :  

Version 0.7   http://www.aljacom.com/~gimp/blendremoval-0.7-i686.zip    

Ancienne version 0.6  http://www.aljacom.com/~gimp/Blend_Removal-i686.zip  par SAMJ        

Version :  0.7                  

Installation :   Décompresser l'archive .zip et placer 
blendremoval.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64 bits).

Appel du greffon : 
Sur l'image par Filtres > Amélioration > Blend Rmoval.

             Résultat du greffon appliqué sur l'image bleue >>

http://www.aljacom.com/~gimp/Blend_Removal-i686.zip
http://www.aljacom.com/~gimp/blendremoval-0.7-i686.zip
http://sudakyo.hp.infoseek.co.jp/gimp/blendremoval/blendremoval.html
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GREFFON WAVELET SHARPEN (NETTETÉ)
Améliore la netteté en augmentant les contrastes dans les hautes fréquences..

Site :  http://registry.gimp.org/node/9836                                     

Auteur : Marco Rossini           

Téléchargement sources :  http://registry.gimp.org/files/wavelet-sharpen-0.1.2.tar.gz                                       

Téléchargement binaires compilées :  
  http://www.aljacom.com/~gimp/wavelet-sharpen-0.1.2-i686.zip   par samj     

Version :  0.1.2                   

Installation :   
Décompresser l'archive wavelet-sharpen-0.1.2-i686.zip. Placer wavelet-sharpen.exe dans le répertoire des 
greffons \lib\gimp\2.0\plug-ins

Testé avec : Gimp 2.6.4

Appel du greffon :  Sur l'image par Filtres > Amélioration > Wavelet Sharpen     

Ce greffon effectue une décomposition en ondelettes et permet d'ajuster le niveau de la netteté. En option, 
nous pouvons ajuster le canal de luminance de l'image convertie en mode YCbCr ce qui permet de réduire le 
bruit des images.

http://fr.wikipedia.org/wiki/YCbCr
http://www.aljacom.com/~gimp/wavelet-sharpen-0.1.2-i686.zip
http://registry.gimp.org/files/wavelet-sharpen-0.1.2.tar.gz
http://registry.gimp.org/node/9836
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GREFFON WAVELET DENOISE (D IMINUER LE BRUIT)
Ce greffon permet de diminuer le bruit d'une image.

Site :  http://registry.gimp.org/node/4235                                           

Auteur : Marco Rossini           

Téléchargement sources : http://registry.gimp.org/files/wavelet-denoise-0.3.1.tar.gz     
Téléchargement binaires compilées : 

      http://www.aljacom.com/~gimp/wavelet-denoise-0.3.1-i686.zip   par samj     

Version :  0.3.1                    

Installation :   
Décompresser l'archive wavelet-denoise-0.3.1-i686.zip. Placer wavelet-denoise.exe dans le répertoire des 
greffons \lib\gimp\2.0\plug-ins            

Testé avec : Gimp 2.6.4

Appel du greffon : Sur l'image par Filtres > Amélioration > Wavelet denoise     

http://www.aljacom.com/~gimp/wavelet-denoise-0.3.1-i686.zip
http://registry.gimp.org/files/wavelet-denoise-0.3.1.tar.gz
http://registry.gimp.org/node/4235
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NOISE GENERATOR (CRÉER DU BRUIT)
Ces deux greffons permettent de créer plusieurs types de bruits.

Site :  http://registry.gimp.org/node/13016                                        

Auteur : Marco Rossini            

Téléchargement sources : http://registry.gimp.org/files/poisson-noise-0.1b.tar.gz  
       http://registry.gimp.org/files/noise-generator-0.2.5.tar.gz 

Téléchargement binaires compilées : 
   http://www.aljacom.com/~gimp/noise_generator-i686.zip   par samj     

Versions :  0.1 et 0.2.5                    

Installation :   
Décompresser l'archive noise_generator-i686.zip.Placer poisson-noise.exe et noise-generator.exe dans le 
répertoire des greffons \lib\gimp\2.0\plug-ins             

Testé avec : Gimp 2.6.4

Appel des greffons : Sur l'image par Filtres > Bruit > Poisson noise et par Filtres > Bruit > Noise generator     

http://www.aljacom.com/~gimp/noise_generator-i686.zip
http://registry.gimp.org/files/noise-generator-0.2.5.tar.gz
http://registry.gimp.org/files/poisson-noise-0.1b.tar.gz
http://registry.gimp.org/node/13016
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GREFFON FOCUS BLUR (BRUIT)
Ajoute du bruit, crée des effets d'ombres et de profondeur de champ.

Site :  http://sudakyo.hp.infoseek.co.jp/gimp/fblur/focusblur_e.html   
           http://registry.gimp.org/node/1444                                        

Auteur :  Kyoichiro Suda 

Téléchargement sources : http://registry.gimp.org/files/focusblur-3.2.3.tar.bz2            

Téléchargement binaires compilées :  http://registry.gimp.org/node/8236         

Version :  3.2.3                 

Installation :   Décompresser l'archive focus-blur-3.2.3.zip  directement dans le répertoire des greffons 
gimp_2_6_x            

Testé avec : Gimp 2.6.4

Appel du greffon :  Sur l'image par : Filtres > Flou > Focus Blur (Greffon très, très lent).

Usage

    Function and dialogue : http://sudakyo.hp.infoseek.co.jp/gimp/fblur/focusblur2e.html 

    Throw a shadow with Focus blur : http://sudakyo.hp.infoseek.co.jp/gimp/fblur/focusblur3e.html 

    Applying depth effect : http://sudakyo.hp.infoseek.co.jp/gimp/fblur/focusblur4e.html 

http://sudakyo.hp.infoseek.co.jp/gimp/fblur/focusblur4e.html
http://sudakyo.hp.infoseek.co.jp/gimp/fblur/focusblur3e.html
http://sudakyo.hp.infoseek.co.jp/gimp/fblur/focusblur2e.html
http://registry.gimp.org/node/8236
http://registry.gimp.org/files/focusblur-3.2.3.tar.bz2
http://registry.gimp.org/node/1444
http://sudakyo.hp.infoseek.co.jp/gimp/fblur/focusblur_e.html
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GREFFON RAWTEX

Sauvegarde de textures RAW.

RAWTex is a save plugin for GIMP 2.2.x, 2.3.x & 2.4.x allowing to create raw textures for the PC, PSP,  
NDS, PS2 or any other architecture handling chunky or compressed dxtc formats.
It can save raw RGBA (5650, 5551, 4444 or 8888) & indexed (T4, T8) textures (with 5650, 5551, 4444 or  

8888 palette modes support) as well as DXTC (DXT1, DXT3, DXT5) compresssed ones, it supports the PSP  
textures swizzle mode and can generate mipmaps, it also have a color key feature to handle transparency and  
can convert grayscale pictures into alpha channel only textures.
Site :  http://pagesperso-orange.fr/franck.charlet/misc.html                                   

Auteur :  Copyright (C) 2006-2008 Franck Charlet.            
Téléchargement sources et binaires compilées :  

http://pagesperso-orange.fr/franck.charlet/RAWTex.zip 

Version :  1.06                      

Installation :  Placer RAWTex.exe directement dans le répertoire des greffons
 gimp_2_6_x\lib\gimp\2.0\plug-ins            

Testé avec : Gimp 2.6.4

Appel du greffon :   Automatique lors de la sauvegarde de l'image au format RAW.  

Lors de la sauvegarde, 2 fichiers sont créés : xxx.raw et xxx.h

http://pagesperso-orange.fr/franck.charlet/RAWTex.zip
http://pagesperso-orange.fr/franck.charlet/misc.html
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GREFFON SAVE FOR WEB

Optimiser la qualité visuelle des images destinées aux sites Web en fonction du volume en octets.

Site :  http://registry.gimp.org/node/33                                      

Auteur :  Aurimas Juška              
Téléchargement sources :     http://registry.gimp.org/files/gimp-save-for-web-0.29.0.tar.bz2                         

Téléchargement binaires compilées :  
    http://www.aljacom.com/~gimp/gimp-save-for-web-0.29.0-i686.zip                   

Version :  0.29.0                      

Installation :  Décompresser l'archive gimp-save-for-web-0.29.0-i686.zip et placer webexport.exe directement 
dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins . Décompresser traductions.zip dans c:\        

Testé avec : Gimp 2.6.8 32 bits / Windows 7 64 bits

Appel du greffon :   Sur l'image à sauvegarder par Fichier > Enregistre pour le Web 

http://www.aljacom.com/~gimp/gimp-save-for-web-0.29.0-i686.zip
http://registry.gimp.org/files/gimp-save-for-web-0.29.0.tar.bz2
http://registry.gimp.org/node/33
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GREFFON TWIST (DÉFORMATIONS)
Créer des déformations géométriques sur une image RVB ou en niveaux de gris.

Site :  http://registry.gimp.org/node/13221                                            

Auteurs :   Peter Uray  

Téléchargement sources :  http://registry.gimp.org/files/twist-2.0.tar.gz                

Téléchargement binaires compilées :  http://registry.gimp.org/files/twist-2.0_1.zip          

Version :  2.0                  

Installation :   Décompresser l'archive twist-2.0_1.zip et placer twist.exe directement dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.4

Appel du greffon :  Sur l'image par : Filtres > Distorsions > Twist

Ce greffon qui a de nombreux paramètres est complexe à utiliser. Une petite documentation, twist_doc.html, 
est dans les sources et les binaires compilées.

http://registry.gimp.org/files/twist-2.0_1.zip
http://registry.gimp.org/files/twist-2.0.tar.gz
http://registry.gimp.org/node/13221
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GREFFON T ILEABLY SHRINK (IMAGES AJUSTABLES)
Permet de rendre les images ajustables pour créer des motifs.

Auteur : Copyright (C) 2002,2004 Yeti (David Necas).            

Téléchargement sources :  http://www.aljacom.com/~gimp/tileably-shrink-1.3-i686.zip 

Téléchargement binaires compilées : 
                                           http://www.aljacom.com/~gimp/tileably-shrink-1.3-i686.zip  par SAMJ        

Version :  1.3                    

Installation :   Décompresser tileably-shrink-1.3-i686.zip et placer tileably-shrink.exe dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.4

Appel du greffon : Sur l'image RVB ou en niveau de gris par Filtres > Mappage > Tileably Shrink.   

Pour les essais rendre l'image « raccordable » en mettant les curseurs au maximum sur une image dont les 
dimensions sont paires (ici 200*300).

<< Image d'origine (Source Wikipédia)

Paramètres                                   Résultat

     Assemblage >>

http://www.aljacom.com/~gimp/tileably-shrink-1.3-i686.zip
http://www.aljacom.com/~gimp/tileably-shrink-1.3-i686.zip
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GREFFON THIN L INE (CRÉER DES CONTOURS)
Permet, par exemple, de créer des contours noirs sur fond blanc (ou l'inverse) avec les options Target Color 

et Thinning.

Auteur : ICII            

Téléchargement sources :  http://www.aljacom.com/~gimp/thin_line-2.0-i686.zip 

Téléchargement binaires compilées :   http://www.aljacom.com/~gimp/thin_line-2.0-i686.zip  par SAMJ 

Version :  2.0                    

Installation :   Décompresser thin_line-2.0-i686.zip et placer thin_line.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.4

Appel du greffon : Sur l'image par Filtres > Détection de bord > Thin Line.    

Exemple sur une photographie de Lena :

http://www.aljacom.com/~gimp/thin_line-2.0-i686.zip
http://www.aljacom.com/~gimp/thin_line-2.0-i686.zip
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GREFFON SELF-SOM (CRÉER DES COULEURS)
Créer un ensemble organisé et harmonieux de couleurs à partir d'une image RVB.

Auteur : Copyright (C) 2004 Yeti (David Necas).           

Téléchargement sources :  http://www.aljacom.com/~gimp/selfsom-1.1-i686.zip 

Téléchargement binaires compilées :    http://www.aljacom.com/~gimp/selfsom-1.1-i686.zip  par SAMJ 

Version :  1.1                    

Installation :   Décompresser selfsom-1.1-i686.zip et placer selfsom.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.4

Appel du greffon : Sur l'image par Filtres > Colors > Self-SOM.   

   Paramètres

Origine

Résultat

http://www.aljacom.com/~gimp/selfsom-1.1-i686.zip
http://www.aljacom.com/~gimp/selfsom-1.1-i686.zip
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GREFFON CAMOTRUCK-NET (CAMOUFLAGE)
Permet de créer des effets de camouflage sur des voitures, camions, etc.

Site et forum :  http://www.camotruck.net/                                     

Auteur :  Copyright (C) 2005 J. Mike Rollins               

Téléchargement sources :   http://www.camotruck.net/gimp/src.php  
                                            http://www.camotruck.net/gimp/CamoTruckNet.tar.gz                                        

Téléchargement binaires compilées :  
           http://www.aljacom.com/~gimp/CamoTruck-Net-i686.zip   par SAMJ

Version :  08/2005                    

Installation :   Décompresser CamoTruck-Net-i686.zip et installer les 4 greffons CamoTruck-Net-Sprawl.exe , 
CamoTruck-Net-Grass.exe , CamoTruck-Net-Colors.exe , CamoTruck-Net-Blob.exe  dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.        

Testé avec : Gimp 2.6.4

Appel du greffon :  Les 4 filtres sont accessibles sur l'image par 
Filtres > CamoTruck-Net > Assign Colors
Filtres > CamoTruck-Net > Blob
Filtres > CamoTruck-Net > Grass
Filtres > CamoTruck-Net > Sprawl    

Assign Colors permet de choisir les 
couleurs du camouflage, les 3 autres filtres 
agissent sur les formes.

                                   Assign Colors >>

http://www.aljacom.com/~gimp/CamoTruck-Net-i686.zip
http://www.camotruck.net/gimp/CamoTruckNet.tar.gz
http://www.camotruck.net/gimp/src.php
http://www.camotruck.net/
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                                                                                                   << Blob

         Grass >>
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        Sprawl >>

Des exemples sont disponibles à http://www.camotruck.net/gimp/ 

http://www.camotruck.net/gimp/
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GREFFON ISLES (SUPPRIMER LES PETITES SÉLECTIONS)
Supprimer les petites et très petites sélections d'une sélection multiple.

Site :  http://registry.gimp.org/node/85                                     

Auteur :  Copyright (C) 2006 Wolfgang Hofer.             
Téléchargement sources :   http://registry.gimp.org/files/isle.c    

        Modification 1.1 avec les binaires compilées                                   

Téléchargement binaires compilées :  
http://www.aljacom.com/~gimp/Isles-1.1-i686.zip   par SAMJ         

Version :  1.1                      

Installation :  Décompresser Isles-1.1-i686.zip et installer isle.exe directement dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins            

Testé avec : Gimp 2.6.4

Appel du greffon :   Sur l'image par Sélection > Subtract Small Selection Isles 

 

<< Sélections d'origine (Zoom à 800%),

     Paramètres

<< Effet du filtre, 5 petites sélections sont supprimées.

http://www.aljacom.com/~gimp/Isles-1.1-i686.zip
http://registry.gimp.org/files/isle.c
http://registry.gimp.org/node/85
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GREFFON DBP DAVID 'S BATCH PROCESSOR (TRAITEMENT PAR LOT)
Permet un traitement par lot des images sélectionnées.

Site :  http://members.ozemail.com.au/~hodsond/dbp.html                                  

Auteur :  Copyright (C) 2001 - 2008 David Hodson.             
Téléchargement sources :   http://www.ozemail.com.au/~hodsond/dbpSrc-1-1-9.tgz                                 

Téléchargement binaires compilées :    http://www.aljacom.com/~gimp/dbp-1.1.9-i686.zip  par SAMJ           

Version :  1.1.9                      

Installation :  Décompresser dbp-1.1.9-i686.zip et installer dbp.exe directement dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins            

Testé avec : Gimp 2.6.4

Appel du greffon :   Sur la fenêtre "Éditeur d'image GIMP" ou sur une image par  Filtres > Batch Process 

Le traitement par lot s'applique sur les images 
sélectionnées dans l'onglet Input par le bouton 
Add files. 

L'onglet Turn permet de faire pivoter les 
images. Valider le choix en cochant Enable.

L'onglet Blur permet d'ajouter du flou aux 
images. Valider le choix en cochant Enable et 
choisir le rayon du flou.

http://www.aljacom.com/~gimp/dbp-1.1.9-i686.zip
http://www.ozemail.com.au/~hodsond/dbpSrc-1-1-9.tgz
http://members.ozemail.com.au/~hodsond/dbp.html
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L'onglet Colour permet d'ajuster les niveaux de 
couleurs des images, de convertir en niveaux de 
gris, d'inverser les couleurs. Valider les choix en 
cochant Enable, choisir les options.

L'onglet Resize permet de modifier les 
dimensions des images. Valider les choix en 
cochant Enable, choisir les options.

L'onglet Crop permet de découper les images. 
Valider les choix en cochant Enable, choisir les 
options.

L'onglet Sharpen permet d'augmenter la netteté 
des images. Valider les choix en cochant Enable, 
choisir les options.
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L'onglet Rename permet d'ajouter des préfixes 
ou des suffixes aux noms des images, d'aplatir, 
de convertir, de créer des images à couleurs 
indexées. Valider les choix en cochant Enable, 
choisir les options.

L'onglet Output permet de choisir le type des 
images sauvegardés et de paramétrer la qualité 
des sauvegardes.
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Appuyer sur le bouton Start pour démarrer les 
modifications. Attendre la fin des modifications 
par done et quitter.

Le bouton test peut, dans certains cas, 
occasionner des petits messages d'erreur dans 
Gimp.

Voici le résultat d'une mise à l'échelle à 30% sur 3 images avec une modification des noms (préfixe = essai)  
et du type de fichier (bmp).
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GREFFON WAVES OF CHAOS (MOTIFS)
Permet des créer des motifs.

Auteur : Copyright (C) 2004 Yeti (David Necas).            

Téléchargement sources :  http://www.aljacom.com/~gimp/waves-of-chaos-1.2-i686.zip 

Téléchargement binaires compilées : 
        http://www.aljacom.com/~gimp/waves-of-chaos-1.2-i686.zip  par SAMJ        

Version :  1.2                    

Installation :   Décompresser waves-of-chaos-1.2-i686.zip et placer waves-of-chaos.exe dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.4

Appel du greffon : Sur l'image par Filtres > Rendu > Waves of Chaos.    

http://www.aljacom.com/~gimp/waves-of-chaos-1.2-i686.zip
http://www.aljacom.com/~gimp/waves-of-chaos-1.2-i686.zip
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GREFFON COLOR SPOTTER

Permet de jouer sur les contrastes via la sélection d'une couleur en noircissant la couleur choisie et 
éclaircissant les autres couleurs.

Auteur :  François Gingras             

Téléchargement sources :   http://registry.gimp.org/node/18633                                                 

Téléchargement binaires compilées : 
     http://www.aljacom.com/~gimp/colorspot-i686.zip   par SAMJ        

Version :   du 17 septembre 2009                   

Installation :   Décompresser colorspot-i686.zip et placer colorspot.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.7

Appel du greffon : Sur l'image par Filtres > Misc > Color spotter.  

http://www.aljacom.com/~gimp/colorspot-i686.zip
http://registry.gimp.org/node/18633
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GREFFON KALÉIDOSCOPE

Permet des créer  un effet kaléidoscope à partir d'une image.

Auteurs : Scott Goehring, Federico Mena Quintero, Kelly Martin, Matthew Plough.            

Téléchargement sources et binaires compilées :   http://www.aljacom.com/~gimp/Kaleidoscope-i686.zip

Version :  1.2                    

Installation :   Décompresser Kaleidoscope-i686.zip et placer Kaleidoscope.exe dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 (32 bits) / Windows 7 (64 bits) 

Appel du greffon : Sur l'image par Filtres > Distorsions > Kaleidoscope.   

Ajout du script-fu fp-kaleidoscope-anim.scm de fence-post pour créer des animations à partir du greffon.

Placer  fp-kaleidoscope-anim.scm dans le répertoire des scripts gimp_2_6_x\share\gimp\2.0\scripts

Appel du script-fu : Sur l'image par Filtres > Animation > Kaleidoscope Animation.   

http://www.aljacom.com/~gimp/Kaleidoscope-i686.zip
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GREFFON SMOOTH-PATH

Permet d'arrondir les angles des chemins.

Auteur : Copyright 2009 Marko Peric.

Site :  http://registry.gimp.org/node/18938                    

Téléchargement sources et binaires compilées :    http://registry.gimp.org/files/smooth-path.zip             

Version :  01/10/2009                    

Installation :   Décompresser smooth-path.zip et placer smooth-path.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.7

Appel du greffon : Dans la fenêtre Chemins, sélectionner un chemin, faire un clic droit et valider Smooth Path. 

             Paramètres

Résultat :

http://registry.gimp.org/files/smooth-path.zip
http://registry.gimp.org/node/18938
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GREFFON ITERATIVE_SAVE

Sauvegarde en .xcf avec numérotation automatique.

Auteur : Mircea Purdea.

Site :  http://registry.gimp.org/node/18873                          

Téléchargement sources et binaires compilées :   http://registry.gimp.org/files/iterative_save_win32.zip 

Version :  0.1   2009/09/25                   

Installation :   Décompresser iterative_save_win32.zip et placer iterative_save.exe dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.7 (Vista et ZenWalk 6.2)

Appel du greffon : Sur l'image par Fichier > Iterative Save.   

Permet de sauvegarder en incrémentant automatiquement les noms, exemple : essai_0000.xcf , 
essai_0001.xcf , essai_0002.xcf ...

Pratique pour animations, changement de versions…

http://registry.gimp.org/files/iterative_save_win32.zip
http://registry.gimp.org/node/18873
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GREFFON « GUILLOTINE INTO LAYERS »
Découpe les contenus visibles définis par des guides en calques dans une nouvelle image.

Auteur : Randall Sawyer.

Site :   http://registry.gimp.org/node/19886                                   

Téléchargement sources et binaires compilées :  
                                                                  http://www.aljacom.com/~gimp/guillotine_into_layers-0.1.zip 

Version :  0.1                  

Installation :   Décompresser guillotine_into_layers-0.1.zip et placer guillotine_into_layers.exe dans le 
répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.7 (Vista )

Appel du greffon : Après avoir créé un ou plusieurs guides sur une image accès par Image > Transformer > 
Guillotine into layers.     

Guillotine-into-Layers est une variation du greffon Guillotine. Ce greffon crée une nouvelle image avec 
calques; un calque pour chaque région rectangulaire définie par les guides sur l'image d'origine. La partie 
visible de chaque région est copiée et passée comme un calque unique sur la nouvelle image. Le nom de la 
nouvelle image provient  de l'image d'origine.  Le suffixe '.xcf' permet de sauvegarder l'image dans un format 
qui préserve les calques.  L'original n'est pas affecté.

Image d'origine : 

Effet : 

http://www.aljacom.com/~gimp/guillotine_into_layers-0.1.zip
http://registry.gimp.org/node/19886
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GREFFON COLOUR MATCH

Modifie les couleurs d'une image en remplaçant une valeur par une autre.

Auteurs : Based on the algorithm from ColorMapRelative plugin by Lars Clausen 
Copyright (C) 2008  Amplex A/S (lars@amplex.dk) which was based on code by Ling Xu
and Emanuele Zattin
Copyright © 2009 Aareus Inc.
Modifications pour Windows par samj 25 novembre 2009

Site :  http://registry.gimp.org/node/20494             

Téléchargement sources et binaires compilées :    
   http://www.aljacom.com/~gimp/colour-match-25novembre2009.zip                   

Version :  25 novembre 2009                  

Installation :   Décompresser colour-match-25novembre2009.zip et placer colour-match.exe dans le répertoire 
des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.7 (Windows 7 et ZenWalk 6.2)

Appel du greffon : Sur l'image par Couleurs > Colour Match.   

Utilisation sur une image RVB ou RVBA :

– Sur l'image Couleurs > Colour Match.

– Désactiver « Aperçu ».

– Avec la pipette « Source Colour » choisir la couleur à modifier.

– Dans « Target colour » choisir la couleur qui remplacera la couleur « Source colour ».

– Activer « Aperçu ».

– Appuyer sur le bouton « Valider ».   

http://www.aljacom.com/~gimp/colour-match-25novembre2009.zip
http://registry.gimp.org/node/20494
mailto:lars@amplex.dk
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GREFFON ELSAMUKO-DEPTHMAP

Ce greffon génère une carte de « mappage » à partir de deux images stéréoscopiques. 

Ensuite, mettre les deux images sous forme de calques dans Gimp et démarrer ce greffon par Filtres > 
Mappage > Depthmap.

Les deux calques doivent être de tailles identiques. L'algorithme prend un pixel de la première couche en 
plus de ses environs et fait des recherches sur la deuxième couche pour la meilleure correspondance. 

Auteur :   Samuel Albrecht-ElSamuko

Sites :   http://sites.google.com/site/elsamuko/   http://registry.gimp.org/node/10217           

Téléchargement sources et binaires compilées :    
          http://www.aljacom.com/~gimp/elsamuko-depthmap-2009-10-26-i686.zip 

Version :  26 octobre 2009                  

Installation :   Décompresser elsamuko-depthmap-2009-10-26-i686.zip et placer elsamuko-depthmap.exe 
dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon : Sur l'image par  Filtres > Mappage > Depthmap.         

http://www.aljacom.com/~gimp/elsamuko-depthmap-2009-10-26-i686.zip
http://registry.gimp.org/node/10217
http://sites.google.com/site/elsamuko/
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GREFFON TURING PATTERN (MOTIFS)
Ce greffon permet de créer des motifs raccordables. 

Auteur :   David Necas

Téléchargement sources : http://schumaml.gmxhome.de/downloads/gimp/sources/turing-pattern-1.1.tar.bz2 

Téléchargement binaires compilées :       
                                         http://www.geocities.jp/gimproject/plug-ins/win32-binary/turing-pattern-1.3.zip   

Version :  1.3                 

Installation :   Décompresser turing-pattern-1.3.zip et placer turing-pattern.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon : Sur l'image par  Filtres >  Rendu > Motifs > Turing Pattern        

Exemple sur une image de 256*256 pixels assemblée dans un cadre :

http://www.geocities.jp/gimproject/plug-ins/win32-binary/turing-pattern-1.3.zip
http://schumaml.gmxhome.de/downloads/gimp/sources/turing-pattern-1.1.tar.bz2
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GREFFON SIMPLE SURFACE BLUR/BILATERAL (FLOU)
Ce greffon permet de créer du flou, pour enlever du bruit par exemple. 

Auteur :   Copyright (C) 2010 David Beynon 

Site :  http://registry.gimp.org/node/24208      

Téléchargement sources : http://registry.gimp.org/files/bilateral.tar_0.gz     

http://www.spectral3d.co.uk/repo/gimp_plugins               

Téléchargement binaires compilées :       
                                    http://registry.gimp.org/files/simple-bilateral_win32.zip      par Francois_C  

Version :  0                

Installation :   Décompresser simple-bilateral_win32.zip et placer simple-bilateral.exe dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon : Sur l'image par  Filtres >  Flou > Simple Bilateral        

Exemple sur l'image de Lena :

Avant     Après

http://registry.gimp.org/files/simple-bilateral_win32.zip
http://www.spectral3d.co.uk/repo/gimp_plugins
http://registry.gimp.org/files/bilateral.tar_0.gz
http://registry.gimp.org/node/24208
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GREFFON BLIZZARD BLP IMPORTER

Ce greffon permet d'importer ou d'ouvrir des images au format .blp (World of Warcraft addon). 

Auteur :   Copyright (C) 2009 Coy Barnes 

Site :   http://registry.gimp.org/node/24218                 

Téléchargement sources : http://registry.gimp.org/files/gimp_blp_plugin-1.0.0.tar.gz                            

Téléchargement binaires compilées :   http://www.aljacom.com/~gimp/gimp_blp_plugin-1.0.0_i686.zip      
                                                                                           

Version :  1.0.0                

Installation :   Décompresser gimp_blp_plugin-1.0.0_i686.zip et placer blp.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon :  Automatique à l'ouverture d'une image .blp      

Remarques :  - Ce greffon ne peut pas sauvegarder au format blp (reste à faire).
- Il existe un outil de conversion écrit en  Java png <-> bmp (BlpToTga.zip) sur le site :

http://wow.jeuxonline.info/fichiers-divers.html   

http://wow.jeuxonline.info/fichiers-divers.html
http://www.aljacom.com/~gimp/gimp_blp_plugin-1.0.0_i686.zip
http://registry.gimp.org/files/gimp_blp_plugin-1.0.0.tar.gz
http://registry.gimp.org/node/24218
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GREFFON ENHANCE DETAILS  (AMÉLIORATION)
Ce greffon permet d'améliorer une image... Les réglages sont délicats.

Auteur :   Copyright (C) 2010 David Beynon 

Site :  http://registry.gimp.org/node/24211      

Téléchargement sources : http://registry.gimp.org/files/detail_enhance_100310.tar.gz                   

Téléchargement binaires compilées :       
                                  http://registry.gimp.org/files/detail_enhance_w32_110310.zip      par Francois_C  

Version :  100310                

Installation :   Décompresser detail_enhance_w32_110310.zip  et placer bilateral-boost.exe et libintl-8.dll 
dans le répertoire des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon : Sur l'image par  Filtres >  Amélioration > Enhance Details        

http://registry.gimp.org/files/detail_enhance_w32_110310.zip
http://registry.gimp.org/files/detail_enhance_100310.tar.gz
http://registry.gimp.org/node/24211
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GREFFON IMAGE REGISTRATION  (ALIGNER 2 IMAGES)

Ce greffon permet d'aligner 2 images suivant une ligne d'horizon par exemple. L'utilisation possible et 
l'alignement de photographier HDR prises sans trépied.

Auteur :   Copyright (C) 2010 Behnam Tabatabai 

Sites :  http://gimp-image-reg.sourceforge.net/   http://registry.gimp.org/node/24248       

Téléchargement sources : 
                        http://sourceforge.net/projects/gimp-image-reg/files/gimp-image-reg-0.5.4.tar.bz2/download 

Téléchargement binaires compilées :   
                   http://sourceforge.net/projects/gimp-image-reg/files/gimp-image-reg-0.5.4-win32.zip/download 

Version :  0.5.4                

Installation :   Décompresser gimp-image-reg-0.5.4-win32.zip et placer gimp-image-reg.exe dans le répertoire 
des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon : Sur l'image par  Outils >  Image Registration   

Nous utilisons 2 images (1.xcf et 2.xcf) pour illustrer le fonctionnement de ce greffon. La première image 
1.xcf servira de référence comme ligne d'horizon pour aligner la seconde image 2.xcf.

Sur l'image 2.xcf nous activons le greffon par Outils >  Image Registration  

http://sourceforge.net/projects/gimp-image-reg/files/gimp-image-reg-0.5.4-win32.zip/download
http://sourceforge.net/projects/gimp-image-reg/files/gimp-image-reg-0.5.4.tar.bz2/download
http://registry.gimp.org/node/24248
http://gimp-image-reg.sourceforge.net/
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La fenêtre de paramétrage s'affiche.

   

Ce paramétrage est celui proposé par défaut. Appuyer sur le bouton OK pour lancer le greffon. Le temps de 
calcul peut être relativement long suivant le nombre d'itérations. Voici le résultat :

Le bus s'est redressé et a pris la même position que l'image 
1.xcf présentée page précédente.
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GREFFON SHAPE IT (TEXTE SELON UN MAPPAGE)
Ce greffon permet de faire suivre un texte selon un calque de mappage en noir et blanc. 

Auteur :   Claes G Lindblad ported to 2.x by Victor Ramirez.

Sites :  http://www.algonet.se/~claesg/shapeit.html   http://registry.gimp.org/node/24236                

Téléchargement sources et binaires compilées : 
   http://registry.gimp.org/files/shapeit_win32.zip  (compilation par François C)  

Installation :   Décompresser shapeit_win32.zip et placer shapeit.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon :  Sur l'image par Filtres > Mappage > Shape It  

L'utilisation est décrite dans le document PDF joint avec l'archive. Pour une utilisation avec Gimp 2.6.x il  
faut faire une petite modification : il faut créer un texte et fusionner ce calque de texte vers le bas.

                 Avant                                                                             Après

    

Résultat

http://registry.gimp.org/files/shapeit_win32.zip
http://registry.gimp.org/node/24236
http://www.algonet.se/~claesg/shapeit.html
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GREFFON EDGE-AVOIDING-WAVELETS (NETTETÉ)
Ce greffon permet d'augmenter la netteté sans créer d'artéfacts. 

Auteur :   Michael Munzert.

Site :  http://www.mm-log.com/blog/2010-04-05/gimp-edge-avoiding-wavelets                 

Téléchargement sources:  http://www.mm-log.com/system/files/eaw-source.7z    

Téléchargement binaires compilées Windows   :    http://www.mm-log.com/system/files/eaw-win32-bin.7z  

Téléchargement pthreadGC2.dll : ftp://sourceware.org/pub/pthreads-win32/dll-latest/lib/pthreadGC2.dll 
(fait partie du projet http://sourceware.org/pthreads-win32/)

Téléchargement binaires compilées Linux :   Deux versions existent sur le site, 32 et 64 bits. 

Installation :   Cette installation est un peu technique. Créer répertoires C:\Tools\EAW . Télécharger  eaw-
win32-bin.7z dans ce répertoire créé et décompresser   eaw-win32-bin.7z   dans ce répertoire   C:\Tools\EAW   en 
utilisant 7-Zip (http://www.7-zip.org/). Placer mm extern eaw.py dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins.  Télécharger  pthreadGC2.dll dans C:\Tools\EAW. 

Remarque : Si vous utilisez un autre répertoire que C:\Tools\EAW  vous devrez modifier la ligne 88 
path = "c:\\Tools\\EAW\\"  de mm extern eaw.py par le nouveau répertoire et doubler le signe \ .  
Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits) avec la version 2010-04-05

Appel du greffon :  Sur l'image par Filtres > MM-Filters > EAW...  

Article technique et vidéo : http://www.cs.huji.ac.il/~raananf/projects/eaw/index.html    
http://tv.adobe.com/watch/cs5-production-premium-feature-tour/boost-detail/ 

  Paramètres                                                    

      <-Avant

        Après →

http://tv.adobe.com/watch/cs5-production-premium-feature-tour/boost-detail/
http://www.cs.huji.ac.il/~raananf/projects/eaw/index.html
file://Tools//EAW//
http://www.7-zip.org/
ftp://sourceware.org/pub/pthreads-win32/dll-latest/lib/pthreadGC2.dll
http://www.mm-log.com/system/files/eaw-win32-bin.7z
http://www.mm-log.com/system/files/eaw-source.7z
http://www.mm-log.com/blog/2010-04-05/gimp-edge-avoiding-wavelets
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GREFFON SMART PRINT TOOL ( IMPRESSION)
Ce greffon permet de faire des impression d'images. Voici un extrait du site de Jean-Louis Hamel au sujet de 

ce greffon : Pour mon usage, j'ai créé ce paquetage qui contient une version corrigée de guash (sélecteur de  
fichiers image), un script permettant l'impression facile de plusieurs images par page directement à partir  
de GIMP et un système de correction de couleurs à l'impression.  
Auteur :   Jean-Louis Hamel.

Site :   http://jeanlouis.hamel.perso.neuf.fr/GIMP26/index.html                      

Téléchargement binaires compilées :  
http://jeanlouis.hamel.perso.neuf.fr/FILES/smartprint30_20100403.zip    

Installation :   Décompresser smartprint30_20100403.zip lire le fichier lisezmoi.txt et lancer setup.exe si vous 
avez une installation standard. Si vous utilisez notre archive ou un autre Gimp portable il faudra 
décompresser setup.exe avec l'utilitaire innounp (http://innounp.sourceforge.net/) disponible à partir de ce lien 
http://sourceforge.net/projects/innounp/files/innounp/innounp%200.31/innounp031.rar/download . 
Décompresser innounp031.rar dans le même répertoire que setup.exe avec 7-Zip pour obtenir l'utilitaire 
innounp.exe . À partir de l'Invite de commande, lancer la ligne de commande innounp.exe -x setup.exe . Voici 
l'arborescence obtenue après l'utilisation de innounp.exe :

│   innounp.exe
│   innounp.htm
│   innounp031.rar
│   install_script.iss
│   setup.exe
│
└───{%HOMEDRIVE}{%HOMEPATH}
    └───.gimp-2.6
        ├───brushes
        │       corner-ll-small55.gbr
        │       corner-lr-small55.gbr
        │       corner-ul-small55.gbr
        │       corner-ur-small55.gbr
        │
        ├───curves
        │       nullcrv.txt
        │
        ├───plug-ins
        │       guash.exe
        │       winprint.exe
        │
        └───scripts
                smartprint.scm

Il suffit de placer toute l'arborescence rouge dans le répertoire utilisateur de Gimp C:\Users\[utilisateur]\.gimp-2.6.

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

UTILISATION DE GUASH  (EXTRAIT  DU  SITE DE  JEAN-LOUIS  HAMEL)
Le sélecteur de fichiers guash a disparu depuis longtemps des versions officielles de GIMP, mais je le  
maintiens pour la circonstance. Les avantages de guash sont :
– Reconnaissance de la plupart des formats d'images connus de GIMP, y compris les fichiers  
comprimés, genre .xcf.gz.
– Possibilité de créer un fichier contenant la liste d'une sélection de plusieurs images à imprimer sur la  
même feuille par mon script smart-print-tool
Guash, qui fait partie de mon paquetage Smart print tool, est une application qui affiche les fichiers  
graphiques sous forme de miniatures. Il affiche également les icônes de répertoires.
Appeler Guash par <image>Fichier/Guash

http://sourceforge.net/projects/innounp/files/innounp/innounp%200.31/innounp031.rar/download
http://innounp.sourceforge.net/
http://jeanlouis.hamel.perso.neuf.fr/FILES/smartprint30_20100403.zip
http://jeanlouis.hamel.perso.neuf.fr/GIMP26/index.html
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Cliquer une fois sur un répertoire pour y aller.
Cliquer une fois sur un fichier pour le sélectionner.
Si la touche Maj est enfoncée, cliquer sur un fichier non sélectionné l'ajoute à la sélection, cliquer sur un  
fichier sélectionné le retire de la sélection.
Cliquer dans la sélection charge le ou les fichiers sélectionnés.

Remarque 1 : la première fois que guash est utilisé dans un répertoire de fichiers graphiques, il crée  
un dossier .xvpics dans ce répertoire, destiné à contenir les aperçus des images ; ceci prend un certain  
temps. Il est important que guash démarre dans un répertoire contenant les catalogues d'images, ce qui est  
le cas si l'on a pris soin d'indiquer ce répertoire dans les propriétés du raccourci de lancement de GIMP.

Remarque 2:les fonctions Copy et Move accessibles par menu contextuel (clic droit dans la sélection)  
sont utilisables.

Remarque 3: les précédentes versions de guash n'acceptaient pas les caractères spéciaux ou 
accentués dans les noms de fichier, mais c'est corrigé dans les dernières versions.

Appel de Gusah par Fichier > Guash ou par Filtres > Guash, sélectionner un répertoire par la bouton Jump > To 
puis  Valider. Sélectionner une image (ou des images en appuyant sur la touche Majuscule ou Shift) dans la 
fenêtre Guash, faire un second clic, elle s'ouvre dans Gimp. Appuyer sur le bouton Close pour fermer la 
fenêtre.
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IMPRESSION AVEC  SMART  PRINT  TOOL

REMARQUES  DE  JEAN-LOUIS  HAMEL

A cause d'une bogue dans le traitement des scripts, le système d'impression smart print tool ne fonctionne  
pas si le nom d'utilisateur comporte des caractères accentués, par exemple "invité". Si vous voulez l'utiliser,  
connectez -vous sous un nom d'utilisateur ne comportant pas de caractères spéciaux ou accentués.
Le script smart print tool est une interface avec le module d'impression de GIMP. Le nouveau module  
d'impression de GIMP étant bogué, j'ai recompilé l'ancien dans le nouvel environnement, et l'ai inclus dans  
le paquetagesmart print tool. Il n'entre pas en conflit avec les modules existants.

PARAMÉTRAGE

Le paramétrage se fait en éditant le fichier C:\Users\[utilisateur]\.gimp-2.6\scripts\smartprint.scm 
Il faut éditer les valeurs en rouge du fichier smartprint.scm     

SF-FILENAME "Color correction file"
string-append (car (gimp-gimprc-query "gimp_dir"))"/curves/nullcrv.txt")
SF-TOGGLE "Corrective method" TRUE
SF-VALUE "Resolution (ppi)" "300"
SF-VALUE "Printable width (mm)" "203.4"
SF-VALUE "Printable length (mm)" "290.4"
SF-VALUE "Columns" "2"
SF-VALUE "Rows" "2"
SF-VALUE "Margin width (%)" "5"
SF-TOGGLE "Markers" FALSE
SF-TOGGLE "Preserve aspect ratio" TRUE
SF-TOGGLE "Preserve orientation" FALSE
SF-TOGGLE "Repeat the same image" FALSE
SF-TOGGLE "Print thumbnails (3x6)" FALSE

Explication des paramètres , ici les valeurs sont pour un format Letter avec une marge de 5mm :
… )"/curves/nullcrv.txt") Emplacement du fichier des courbes (ne pas modifier).
SF-TOGGLE "Corrective method" TRUE Si TRUE, la correction effectuée est l'inverse de

celle fournie par les courbes. C'est le mode de correction normal, si l'on suit les
explications fournies plus loin.

SF-VALUE "Resolution (ppi)" "300" Résolution en PPI.
SF-VALUE "Printable width (mm)" "205.9" Largeur en mm de la zone imprimable.
SF-VALUE "Printable length (mm)" "269.4" Longueur en mm de la zone imprimable.
SF-VALUE "Columns" "2" Nombre de colonnes définissant l'assemblage des images.
SF-VALUE "Rows" "2" Nombre de lignes définissant l'assemblage des images.
SF-VALUE "Margin width (%)" "5" Si non nul, définit une marge en % de la taille d'image.
SF-TOGGLE "Markers" FALSE Si TRUE, imprime des marques aux angles des images.
SF-TOGGLE "Preserve aspect ratio" TRUE Si TRUE, préserve les proportions de l'image, sinon

coupe celle-ci pour remplir exactement sa case.
SF-TOGGLE "Preserve orientation" FALSE  Si TRUE pas de rotation de l'image.
SF-TOGGLE "Repeat the same image" FALSE  Si TRUE, imprime (colonnes x lignes) fois la 
première image de la sélection au lieu de plusieurs images.
SF-TOGGLE "Print thumbnails (3x6)" FALSE Imprime des miniatures avec le nom de fichier dans

un format fixe (3 colonnes x 6 lignes). Simule une "planche contact". Lorsque cette
option est validée, les autres options sont ignorées.

N'hésitez pas à consulter la page http://jeanlouis.hamel.perso.neuf.fr/GIMP26/index.html pour avoir plus 
d'explications.

http://jeanlouis.hamel.perso.neuf.fr/GIMP26/index.html
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IMPRESSION

Il faut activer Guash et sélectionner des images. Appuyer sur X avec la fenêtre Guash active pour écrire les 
noms de fichiers dans le script-fu  C:\Users\[utilisateur]\.gimp-2.6\scripts\guasch.scm 
Aller sur la fenêtre de Gimp et activer Script-Fu > Utils > Smart Print Tool

Paramétrer et appuyer sur Valider. Attendre la fin de l'exécution du script. Une fenêtre représentant 
l'assemblage des images s'affiche ainsi que la fenêtre de sélection d'imprimante.

Choisir une imprimante et paramétrer cette imprimante.

Valider par le bouton OK.
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Les images s'impriment. Résultat avec notre imprimante PDFCreator sur 4 images :

Fermer la fenêtre Guash quand tout est terminé.

MODIFIER  LE  RENDU  DES COULEURS  À  L ' IMPRESSION

Cette opération peut s'effectuer correctement à partir des anciennes versions de Gimp car, à partir de la 
version 2.6 les fichiers courbes sont différents. 

La procédure est expliquée à la page http://jeanlouis.hamel.perso.neuf.fr/GIMP24/index.html#Impression 

F ICHIERS SANS INSTALLATEUR  
Suite à une recherche, les exécutables compilés pour Windows sans installateur sont disponibles à la page 

avec les explications correspondantes :

http://jeanlouis.hamel.perso.neuf.fr/FILES/index.html 

http://jeanlouis.hamel.perso.neuf.fr/FILES/index.html
http://jeanlouis.hamel.perso.neuf.fr/GIMP24/index.html#Impression
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GREFFON GIMP MASK  (MASQUER UNE PARTIE D' IMAGE)
Ce greffon permet de masquer un endroit d'une image selon plusieurs algorithmes.

Auteur :   Copyright (c) 1998  Hirotsuna Mizuno

Modifications :  Modified for 1.2 and the Graphics Muse Tools CD by Michael J. Hammel01/2002
    Very minor modifications to make this work for GIMP 2.x by Anonymous 06 June 2010

Site :  http://registry.gimp.org/node/24496         

Téléchargement sources :  http://registry.gimp.org/files/gimpmask.c                

Téléchargement binaires compilées :     http://www.aljacom.com/~gimp/gimp_mask-06June2010-i686.zip 

Version :  06 June 2010                

Installation :   Décompresser gimp_mask-06June2010-i686.zip et placer gimpmask.exe dans le répertoire des 
greffons gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon : Sur l'image par  Filtres >  Misc > GIMP Mask...        

Exemple de masque : 

http://www.aljacom.com/~gimp/gimp_mask-06June2010-i686.zip
http://registry.gimp.org/node/24496


www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 311 / 391
 Greffon Image Mosaic (créer une mosaïque avec des images) 

GREFFON IMAGE MOSAIC (CRÉER UNE MOSAÏQUE AVEC DES IMAGES)
Voici un vieux greffon dont l'auteur, Peter Kirchgessner, a abandonné la distribution suite aux 

événements relatés à la page http://www.kirchgessner.net/photo-mosaic.html . En respectant le choix de 
l'auteur nous pouvons constater que la création du greffon (20 février 1999) est antérieure au dépôt de 
« patent » (24 octobre 2000) ! Heureusement, Internet n'oublie pas et on trouve des traces du travail de 
Peter Kirchgessner sur les pages suivantes :
– http://web.archive.org/web/20060515043630/www.kirchgessner.net/gimp.html  

Les paquets sont disponibles à :
– http://web.archive.org/web/20060515043630/http://www.kirchgessner.net/pub/gimp-  

2.2/pmosaic.1.22.Win.zip  (Windows)
– http://web.archive.org/web/20060515043630/http://www.kirchgessner.net/pub/gimp-  

2.2/pmosaic.1.22.Win.zip (Linux)
Version :  V 1.22, PK, 28-Dec-05                

Installation :   Décompresser pmosaic.1.22.Win.zip et placer pmosaic.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits (Windows 7 64bits)

Appel du greffon : Sur l'image par  Filtres >  Rendu > Image Mosaic...     
Voici l'aide fournie avec le greffon :
Image Mosaic Plug-In for The GIMP (v1.22)
Copyright (C) 1999 Peter Kirchgessner
This plug-in creates an image mosaic from an input image. An image mosaic is a composition of several 

small images (photos). But when viewed from a distance, it shows the input image again. To create an 
image mosaic, the input image is partitioned into small tiles. Each tile is then replaced by a small 
image, that has similar colours. The better the colours match the tile, the better the image mosaic 
matches the input image. To get good image mosaics, a large number of small images should be available to 
choose from. This collection of images also has to cover the complete range of colours.
To save computation time for choosing the best fitting small image, the plug-in uses a 'Mosaic Archive'. 

This keeps the colour information for all images in the archive and the images themself as small JPEG- or 
PPM-files. The colour informations are kept in a separate file (Mosaic Information Archive, MIA). The 
images are located in subdirectories. The MIA represents the archive. The archive images must not exceed 
a size of 4095*4095 pixels.
To create an image mosaic with the plug-in, three steps are required:
Step 1: Create collection of small images

Select the 'Images'-tab from the dialog.
Enter the source directory of your hard disc or CD-ROM which you want to scan for images. The 

plug-in will automatically scan all subdirectories for images.
Enter the destination directory on your hard disc which you want to use for the Mosaic Archive. 

The directory must already exist. With that file-select-dialog you can create directories. The plug-in 
creates a similar directory structure below the destination directory as it finds below the source 
directory.

Adjust the maximum size of the archive images. The larger the images, the better the quality. But 
also more disk space to use. Since an image mosaic is usually composed of a large number of images, the 
archive images need not to be very large. A size of 128*128 pixels should be quite enough.

Adjust the quality. This specifies the compression to use for writing the archive images. If a 
quality of 100 is given, the archive images are saved as PPM files without any compression.

Select 'Read JPEG/PPM only' if you only want to search for JPEG- or PPM-files. If this is not 
selected, all files recognized by GIMP are read.

Select 'Update files' if you previously had scanned the source directory tree and now just want to 
scan for new files.

http://web.archive.org/web/20060515043630/http://www.kirchgessner.net/pub/gimp-2.2/pmosaic.1.22.Win.zip
http://web.archive.org/web/20060515043630/http://www.kirchgessner.net/pub/gimp-2.2/pmosaic.1.22.Win.zip
http://web.archive.org/web/20060515043630/http://www.kirchgessner.net/pub/gimp-2.2/pmosaic.1.22.Win.zip
http://web.archive.org/web/20060515043630/http://www.kirchgessner.net/pub/gimp-2.2/pmosaic.1.22.Win.zip
http://web.archive.org/web/20060515043630/www.kirchgessner.net/gimp.html
http://www.kirchgessner.net/photo-mosaic.html
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Press 'Create' to start scanning for images, scaling them to the requested size and writing the 
archive images. You can run this step multiple times for different source directories and same 
destination directory (but beware of overwriting existing files).
Step 2: Create Mosaic Information Archive MIA

Select the 'Archive'-tab from the dialog.
Enter the name of the MIA to create. The name of the file should be <directory>/<somename>.mia . 

<directory> is a directory that has been used as a destination directory in step 1.
Press 'Create' to start scanning <directory> for the archive images placed in subdirectories and 

creating the MIA.
Now you are ready to create image mosaics.

Step 3: Create Image Mosaic
Select the 'Mosaic'-tab from the dialog.
Choose width and height of the output image in pixels.
Choose the number of tiles to use for the composition.
Enter the name of a *.mia-file created in step 2 to select from which set of images you want to 

create the image mosaic.
Select 'Keep aspect ratio' if you don't want to distort your image.
Select 'Exclude grey images' if you don't want to use archive images which are grey.
Select 'Multiple use of images' to allow an archive image to be used multiple times. If this is 

not selected, it could happen that no corresponding archive image is found and no replacement takes 
place.

Select 'Allow vertical mirroring' to enable vertical flipping of archive images to better replace 
a tile of the input image.

Adjust the minimum distance which should be between multiply used images.
0: neighbouring images allowed, 1: one image in between, ...

Press 'Create' to start the composition of the image mosaic.

En résumé, l'opération se déroule en 3 phases :
– Récupération, à partir de l'onglet Images, d'un maximum d'images avec une grande variété de couleurs 

(Source directory) à déposer dans un répertoire d'accueil (Destination Directory).
– À partir de l'onglet 

Archive créer un 
fichier archive ayant 
l'extension .mia 

– Création de la 
mosaïque à partir de 
l'onglet Mosaic en 
indiquant le lien où 
est située l'archive 
dans Mosaic archive.

– À chaque étape il 
faut valider en 
appuyant sur le 
bouton Create.

– L'aide est disponible 
via le bouton Help.

Exemple → 
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LES GREFFONS DE  G IMP-SHARP

Gimp-Sharp est un ensemble de greffons écrits en C# . 
Site : http://gimp-sharp.sourceforge.net/ 
Fichiers à télécharger : http://sourceforge.net/projects/gimp-sharp/files/ 
À ce jour, 15 juin 2010, la compilation de la version GIMP# 0.16 prévue pour Gimp 2.6.x n'est pas 

encore réalisée pour Windows. Il est tout de même possible de faire quelques essais avec la version 
prévue pour l'ancien Gimp 2.4 . Il faut télécharger l'installateur exe au format 7-Zip sur ce lien : 
http://sourceforge.net/projects/gimp-sharp/files/gimp-sharp-gimp_2_4-win/gimp-
sharp_setup_0_15_gimp_2.4.e_x_e/download et décompresser gimp-sharp_setup_0_15_gimp_2.4.e_x_e 
dans un répertoire prévu pour les tests avec 7-Zip (Télécharger 7-Zip à la page http://www.7-zip.org/)
Il faut ajouter ce répertoire de test aux préférences de Gimp dans le dossier des greffons et redémarrer 

Gimp.
Les greffons sont facilement identifiables par leurs icônes, par exemple :

Exemple de Pointillize (Filtres > Artistiques > Pointillize)  
 

http://www.7-zip.org/
http://sourceforge.net/projects/gimp-sharp/files/gimp-sharp-gimp_2_4-win/gimp-sharp_setup_0_15_gimp_2.4.e_x_e/download
http://sourceforge.net/projects/gimp-sharp/files/gimp-sharp-gimp_2_4-win/gimp-sharp_setup_0_15_gimp_2.4.e_x_e/download
http://sourceforge.net/projects/gimp-sharp/files/
http://gimp-sharp.sourceforge.net/
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GREFFON TEXTURETILER  (MOTIFS JUXTAPOSABLES)
Comme le greffon « Rendre raccordable », texturetiler permet de créer des motifs juxtaposables avec un 

rendu différent.

Auteurs :   Tim Rowley and Paul Harrison

Site :  http://www.logarithmic.net/pfh/textureops               

Téléchargement sources :  http://www.logarithmic.net/pfh-files/textureops/textureops-0.3.tar.gz                  

Téléchargement binaires compilées :  http://www.aljacom.com/~gimp/texturetiler-i686.zip  

Version :  0.3                

Installation :   Décompresser texturetiler-i686.zip et placer texturetiler.exe dans le répertoire des greffons 
gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.9 et Gimp 2.7.1 32 bits (Windows 7 64bits)

Appel du greffon : Sur l'image par  Filtres >  Mappage > Make Seamless Texture      
                Image source           Rendu du filtre texturetiler

Rendu du filtre texturetiler assemblé :

http://www.aljacom.com/~gimp/texturetiler-i686.zip
http://www.logarithmic.net/pfh-files/textureops/textureops-0.3.tar.gz
http://www.logarithmic.net/pfh/textureops
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CONTRÔLES MD5 DES GREFFONS COMPILÉS

Voici la liste des contrôles MD5 de quelques greffons compilés pour Gimp version Windows et disponibles 
sur notre site http://www.aljacom.com/~gimp (Chaque greffon est fourni avec les sources pour pouvoir être 
compilé sur Linux, etc.). Pour vérifier s'il existe des versions plus récentes sur Internet, consulter les sites des 
auteurs.
# MD5 checksums generated by MD5summer (http://www.md5summer.org)
# Generated 2010-06-06 16:35:48

ba8e53889aa31b3eeacc56002d46705b *area-gimp-2.2-i686.zip
4442b8be4ac56ad537ea8ea9d5e5758e *bascii_pre-alpha-i686.zip
9b2d4aa4c2f92702fed11ed70fb160f2 *Blend_Removal-i686.zip
dea49379a4e9c0eb250425fac7e2e870 *blendremoval-0.7-i686.zip
895077e93d0b4643ba2564472fa6f92e *CamoTruck-Net-i686.zip
2f8416bbf30b084dd120cc94ddaf29ac *colorspot-i686.zip
f8d31524a4b2b239a5e86e4049ee1c8d *colour-match-25novembre2009.zip
6d7bf94381e9712a4e3296450978895f *colour2grey-local-i686.zip
90405717256f2d00a268ae45b738e0fe *comment_ecrire_un_greffon_pour_gimp.zip
b003058117dc3ab43c5c68d9a062cdb2 *dbp-1.1.9-i686.zip
329e25fd3bd6141a0bee7bac70210e71 *degrain-i686.zip
dfbfb970217a18f4f1ef537a49db503b *elsamuko-depthmap-2009-10-26-i686.zip
1d4ba6567d9e7a24913f662148d2f1d4 *fileSeq-i686.zip
1e68062bd072f6b82c5c3ba612a14c10 *frame-scm_annulardenoise-i686.zip
656972bb7970ae7d2a62acbcc7b80ab2 *gimp-ace-0.6.7-i686.zip
853c5537298bdfaabe3be843d8a111e5 *gimp-plugin-userfilter-0.9.7-i686.zip
685e979c114db1d300758f421d8502e9 *gimp-save-for-web-0.28.6-i686.zip
d8b349e37cee2c317e0dc1a39bf9d7ef *gimp-save-for-web-0.29.0-i686.zip
62952d346436bb509a01b2f942f67339 *gimp_blp_plugin-1.0.0_i686.zip
d6bd667972d6042589fd48431da4b902 *gimp_mask-06June2010-i686.zip
fb051d19b137df4d05c05f59a15b20d8 *GP_Boundary_shrinker-i686.zip
4fbeed0c43e237675a08852d521e050e *greffons_en_python.zip
002c3fb01df968ccb9ee376767844288 *guillotine_into_layers-0.1.zip
643d7cfc7bbd54587028cae2040c80de *Image_Subtraction-i686.zip
cc773a6f69987189ca9ba22a34470f7c *impulse_localmode_gaussnr-i686.zip
43e7cb697065f3c168fb59ed16acbd86 *Isles-1.1-i686.zip
48a3adb245c1e0345ab57feca5e07ac1 *Kaleidoscope-i686.zip
e8a3669f5cf603009648a4ae37c6bce6 *l2height-0.7-i686.zip
cf83e9873e9b94a695c7a6dfb4eaae9b *magie-0.3-i686.zip
b534756d0d52bfabecfe219c4253fed3 *noise_generator-i686.zip
6df84df1ea624b144a80528a70a74343 *phymodmedia-0.5.1-i686.zip
26b3b41fe31f45e8f6040b5d679c37db *ps-pat-load_1-i686.zip
0fb4ad03d2e59ec0bca9b996196f2d7a *selfsom-1.1-i686.zip
58fc42496f55d5a7f5c2d25efdfb9aa4 *thin_line-2.0-i686.zip

http://www.aljacom.com/~gimp
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18113237d4b36a3b727882a4a8b66398 *tileably-shrink-1.3-i686.zip
d85918a2eb46ca47a321d533402c3609 *upside_20-10-2009.zip
f734f880943f6a9c5ffe699be5e58128 *vignetting-i686.zip
30bdd017e5d06e9931f8bc4c4589a7bb *wavelet-decompose-0.1-beta2-i686.zip
80985a5bb5d18bb0c360841d5577a662 *wavelet-denoise-0.3.1-i686.zip
f5a2eba13dce9b3b9ff0a92a8dba0ff7 *wavelet-sharpen-0.1.2-i686.zip
732596decc886cf1655eb899c4db94ba *waves-of-chaos-1.2-i686.zip
86f62fbf8bff7f4c688296ff5d412406 *wideangle-i686.zip
391ba3439ee39714a9013f34bf4439b9 *yuv-0.1.3-i686.zip
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LES GREFFONS W INDOWS QUI PEUVENT DONNER DES ERREURS OU QUI 
NE FONCTIONNENT PAS

Il ne faut pas utiliser l'ancienne version gimp 2.6.0 qui provoquait une erreur fatale avec certains greffons 
pour Windows lors de la consultation de l'aide.

Le « Greffon Color correction » (page 220) ne fonctionne pas.

Le Python-Fu convert_ASE_to_GPL.py , volume 5 361 octets, version 2008, disponible sur le site 
http://registry.gimp.org/node/10325 destiné à importer des palettes Adobe au format .ase  du site 
http://kuler.adobe.com/ ne fonctionne pas. Testé sous Gimp 2.6.1 version Windows, Python 2.5.2.

http://kuler.adobe.com/
http://registry.gimp.org/node/10325
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D IDACTICIEL, COMMENT ÉCRIRE UN GREFFON POUR G IMP

Voici le lien pour télécharger le didacticiel en anglais « How to write a GIMP plug-in »  écrit par Dave 
Neary : http://www.aljacom.com/~gimp/comment_ecrire_un_greffon_pour_gimp.zip   

Cette archive contient le didacticiel de Dave Neary en PDF, les sources en C et les greffons compilés pour 
Windows (Testés sous Gimp 2.6.2), le didacticiel de Kevin Turner au format HTML. 

Contenu du fichier lisez_moi.txt :
Auteur : Dave Neary
Document : How to write a GIMP plug-in.pdf
Licence : Creative Commons Attribution-NonCommercial-ShareAlike 2.5 License

http://creativecommons.org/licenses/by-nc-sa/2.5/ 
Pages du didacticiel :

http://www.linux.ie/articles/gimp-plugin/part1/index.php 
http://www.linux.ie/articles/gimp-plugin/part2/index.php 
http://www.linux.ie/articles/gimp-plugin/part3/index.php 

Fichiers, utilisation :
How to write a GIMP plug-in.pdf
lisez_moi.txt
hello.c  hello.exe Filtres > Misc > Hello world

myblur1.c myblur1.exe Filtres > Flou > My blur 1 (slow)

myblur2.c myblur2.exe Filtres > Flou > My blur 1 (fast)

myblur3.c myblur3.exe Filtres > Flou > My blur 1 (tiled)

myblur4.c myblur4.exe Filtres > Flou > My blur 1 (UI)

myblur5.c myblur5.exe Filtres > Flou > My blur 1 (preview)

Gimp API : http://developer.gimp.org/api/2.0/index.html 

http://developer.gimp.org/api/2.0/index.html
http://www.linux.ie/articles/gimp-plugin/part3/index.php
http://www.linux.ie/articles/gimp-plugin/part2/index.php
http://www.linux.ie/articles/gimp-plugin/part1/index.php
http://creativecommons.org/licenses/by-nc-sa/2.5/
http://www.aljacom.com/~gimp/comment_ecrire_un_greffon_pour_gimp.zip
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SCRIPT-FU SAUVEGARDER CHAQUE CALQUE EN IMAGE PNG
Sauvegarde chaque calque en image PNG dans le répertoire de l'image d'origine sous la forme : 

[nom du fichier d'origine][nom du calque].png

Si l'image n'est pas encore sauvegardée l'enregistrement se fera dans le répertoire temporaire défini dans les 
préférences à l'onglet « Dossiers » sous la forme : 

gimp-temp-[xxxxx].Sans titre[nom du calque].png

Auteur :  Niels Giesen.          

Installation :   Copier le code source bleu proposé plus bas, le coller dans un éditeur de texte, et l'enregistrer 
sous avec l'extension .scm (Saves_all_layers_to_separate_png_files.scm) dans le répertoire des scripts de 
Gimp (\gimp_2_6_x\share\gimp\2.0\scripts). Actualiser les Scripts-Fu par : Filtres > Script-Fu > Actualiser les 
scripts         

Testé avec : Gimp 2.6.1

Appel du script :  Sur l'image par Calque > Save all layers to a different png file

Ne pas demander de configurer les options 
de sauvegarde PNG pour chaque 
enregistrement de calque.

Ouvrir l'image de chaque calque.

Nota : Les noms de calques ne doivent pas contenir les caractères / \ * ? (Modifier attributs page 129)

Code source :
; Saves_all_layers_to_separate_png_files.scm
;
; origine http://groups.google.ca/group/comp.graphics.apps.gimp/browse_thread/thread/010e01bd0930438a#
;
; fonctionne  Gimp 2.6.1 Windows
;
(define (script-fu-save-layers-to-files image dont-ask display-images)
  (let ((basename (car (gimp-image-get-filename image))))
    (when (string=? basename "")
          (set! basename  (string-append
                           (car (gimp-temp-name ""))
                            (car (gimp-image-get-name image))))) 
    (let loop ((layers (vector->list (cadr (gimp-image-get-layers image)))))
      (unless (null? layers)
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              (gimp-edit-copy (car layers))
              (let ((img  (car (gimp-edit-paste-as-new)))
                    (new-name (string-append
                               basename
                               (car (gimp-drawable-get-name (car layers)))
                               ".png")))
                (file-png-save dont-ask
                               img
                               (aref (cadr (gimp-image-get-layers img)) 0)
                               new-name
                               new-name
                               TRUE 9 FALSE TRUE FALSE FALSE TRUE)
                (if (= FALSE display-images)
                    ;; clean up afterwards if we are not going to
                    ;; display the images anyway:
                    (gimp-image-delete img)
                    (gimp-display-new img)))
              (loop (cdr layers))))))

(script-fu-register "script-fu-save-layers-to-files"
; modif samj        _"Save all layers to a different file"
                    _"Save all layers to a different png file"
                    _"Saves all layers to separate .png files"
                    "Niels Giesen (niels.gie...@gmail.com)"
                    "Niels Giesen"
                    "2008-10-10"
                    ""
                    SF-IMAGE    "Image"       1
                    SF-TOGGLE   _"Don't ask options for each layer" TRUE
                    SF-TOGGLE   _"Display images?" FALSE)

(script-fu-menu-register "script-fu-save-layers-to-files"
; modif samj              _"<Image>/Filters/Generic") 
                          _"<Image>/Layer")
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SCRIPT-FU CRÉER UN DÉGRADÉ SUIVANT UN CHEMIN

Permet de créer un dégradé à partir d'un chemin.

Site : http://ffaat.pointclark.net/blog/archives/155-GIMP-Script-Sample-a-Gradient-along-a-Path.html 

Auteur :  Rob Antonishen.  

Téléchargement sources :  http://ffaat.pointclark.net/blog/plugin/dlfile_24               

Installation :   Enregistrer sample-gradient-along-path.scm dans le répertoire des scripts de Gimp 
(\gimp_2_6_x\share\gimp\2.0\scripts). Actualiser les Scripts-Fu par :  Filtres > Script-Fu > Actualiser les scripts 

Testé avec : Gimp 2.6.1

Appel du script :  Sur la fenêtre des dégradés par Menu des dégradés > Sample Gradient along a Path

Créer un chemin sur une image

Sur la fenêtre des dégradés faire Menu des dégradés > Sample Gradient along a Path et paramétrer.

http://ffaat.pointclark.net/blog/plugin/dlfile_24
http://ffaat.pointclark.net/blog/archives/155-GIMP-Script-Sample-a-Gradient-along-a-Path.html
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Résultat :

Exemple d'application du dégradé créé :

Code source du script sample-gradient-along-path.scm :
; sample-gradient-along-path.scm
; by Rob Antonishen
; http://ffaat.pointclark.net
; Version 1.0 (20081007)
; Description
;
; Script to create a gradient by sampling along a path
; Will appear in the Gradients Menu
;
; License:
;
; This program is free software; you can redistribute it and/or modify
; it under the terms of the GNU General Public License as published by
; the Free Software Foundation; either version 2 of the License, or
; (at your option) any later version.
;
; This program is distributed in the hope that it will be useful,
; but WITHOUT ANY WARRANTY; without even the implied warranty of
; MERCHANTABILITY or FITNESS FOR A PARTICULAR PURvarPosE.  See the
; GNU General Public License for more details.
;
; The GNU Public License is available at
; http://www.gnu.org/copyleft/gpl.html
(define (script-fu-sample-gradient-along-path img inLayer inPath inSamples inRadius inSmooth inName)
  (let* 
    (
(varSegments (truncate (- inSamples (if (= inSmooth TRUE) 1 0))))
(varGradient "")
(varFirstStroke (aref (cadr (gimp-vectors-get-strokes inPath)) 0))
(varPathLength (car (gimp-vectors-stroke-get-length inPath varFirstStroke 1)))
(varCheck (list-ref (gimp-vectors-stroke-get-point-at-dist inPath varFirstStroke varPathLength 1) 3))
(varCounter 0)
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(varPos 0)
(varNextPos 0)

)
; it begins here
(gimp-image-undo-group-start img)

    ;backtrack to get last good length
    (while (= varCheck FALSE)
      (set! varPathLength (- varPathLength 0.001))
      (set! varCheck (list-ref (gimp-vectors-stroke-get-point-at-dist inPath varFirstStroke 

varPathLength 1) 3))
    )
    ;create new gradient
    (set! varGradient (car (gimp-gradient-new inName)))
    (gimp-context-set-gradient varGradient)
    ;subdivide
    (gimp-gradient-segment-range-split-uniform varGradient 0 0 varSegments)
    (while (< varCounter varSegments)
      (set! varPos (gimp-vectors-stroke-get-point-at-dist inPath varFirstStroke (* varPathLength (/ 

varCounter varSegments)) 1))
      (set! varNextPos (gimp-vectors-stroke-get-point-at-dist inPath varFirstStroke (* varPathLength (/ 

(+ varCounter 1) varSegments)) 1))
      (gimp-gradient-segment-set-left-color varGradient varCounter (car (gimp-image-pick-color img 

inLayer (list-ref varPos 0) (list-ref varPos 1) TRUE TRUE inRadius)) 100)
      (if (= inSmooth TRUE) 
        (gimp-gradient-segment-set-right-color varGradient varCounter (car (gimp-image-pick-color img 

inLayer (list-ref varNextPos 0) (list-ref varNextPos 1) TRUE TRUE inRadius)) 100)
      ;else
        (gimp-gradient-segment-set-right-color varGradient varCounter (car (gimp-image-pick-color img 

inLayer (list-ref varPos 0) (list-ref varPos 1) TRUE TRUE inRadius)) 100)
      )  
      (set! varCounter (+ varCounter 1))

)
;done
(gimp-image-undo-group-end img)

  )
)
(script-fu-register "script-fu-sample-gradient-along-path"
            "<Gradients>/Sample Gradient along a _Path..."

                    "Create a gradient by sampling along the active path."
                    "Rob Antonishen"
                    "Rob Antonishen"
                    "Oct 2008"
                    ""
                    SF-IMAGE      "image"      0
                    SF-DRAWABLE   "drawable"   0
                    SF-VECTORS    "Path" -1
                    SF-ADJUSTMENT "Number of Samples" (list 25 2 256 1 10 0 SF-SLIDER)
                    SF-ADJUSTMENT "Sample Average Radius" (list 3 1 10 1 2 0 SF-SLIDER)
       SF-TOGGLE     "Smooth Gradient" TRUE
                    SF-STRING     "Gradient Name"  "Sampled Gradient"
)
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SCRIPT-FU CONTRAST BLENDING (EXPOSURE-BLEND-TINYSCHEME.SCM)
Créer des images façon HDR à partir de plusieurs images.

Site : http://tir.astro.utoledo.edu/jdsmith/exposure_blend.php                                   

Auteur :  J.D. Smith 

Version:  Version 1.3b (Mar, 2007)  

Téléchargement sources : Dans l'archive  http://www.aljacom.com/~gimp/images_gimp.7z  (Modification
       apportée pour l'appel du script).                     

Installation :   Placer exposure-blend-tinyscheme.scm dans le répertoire des scripts de Gimp 
(\gimp_2_6_x\share\gimp\2.0\scripts). Actualiser les Scripts-Fu par :  Filtres > Script-Fu > Actualiser les scripts 

Testé avec : Gimp 2.6.2

Appel du script :   Par : Fichier > Créer > Contrast blending 3 bracketed images > Exposure_Blend
       Sur l'image par Filtres > Photo >

Documentation en anglais : http://tir.astro.utoledo.edu/jdsmith/exposure_blend.php  

Exemples : http://flickr.com/search/?q=gimp%20exposure-blend.&w=all 

Voici un exemple réalisé avec l'image disponible à http://fr.wikipedia.org/wiki/Image:HDRI-Example.jpg. 
Dans cet exemple nous utilisons uniquement 3 images de la série de 6.

Dans Gimp faire : Fichier > Créer > 
Contrast blending 3 bracketed images > 
Exposure_Blend pour importer les 3 images 
(une claire, une normale et une foncée).

Valider

http://fr.wikipedia.org/wiki/Image:HDRI-Example.jpg
http://flickr.com/search/?q=gimp%20exposure-blend.&w=all
http://tir.astro.utoledo.edu/jdsmith/exposure_blend.php
http://www.aljacom.com/~gimp/images_gimp.7z
http://tir.astro.utoledo.edu/jdsmith/exposure_blend.php
http://fr.wikipedia.org/wiki/Imagerie_%C3%A0_grande_gamme_dynamique
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Résultat :

Les 3 images d'origine

L'effet du Script-Fu
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SCRIPT-FU L ISSAJOUS DRAWING

Dessiner des courbes de Lissajous.

Site : http://members.optusnet.com.au/~charles57/GIMP/lissajous.html                                 

Auteur :  Charles Cave.  

Téléchargement sources :  http://members.optusnet.com.au/~charles57/GIMP/lissajous.scm                       

Installation :   Enregistrer lissajous.scm dans le répertoire des scripts de Gimp 
(\gimp_2_6_x\share\gimp\2.0\scripts). Actualiser les Scripts-Fu par :  Filtres > Script-Fu > Actualiser les scripts 

Testé avec : Gimp 2.6.1

Appel du script :  Sur l'image par Filtres > Lissajous Drawing

Exemples : 

http://members.optusnet.com.au/~charles57/GIMP/lissajous.scm
http://members.optusnet.com.au/~charles57/GIMP/lissajous.html
http://fr.wikipedia.org/wiki/Courbe_de_Lissajous
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SCRIPT-FU RENDU 3D ANIMATION

Créer une animation 3D à partir d'une image.

Site : http://www.gimptalk.com/forum/animated-displace-script-my-first-script--t33775s50.html 

Auteur : greentunic    

Téléchargement sources :
      http://www.fileden.com/files/2007/7/19/1279673/AnimatedDisplaceScriptByGreentunic.scm 

Installation :   Enregistrer AnimatedDisplaceScriptByGreentunic.scm dans le répertoire des scripts de Gimp 
(\gimp_2_6_x\share\gimp\2.0\scripts). Actualiser les Scripts-Fu par :  Filtres > Script-Fu > Actualiser les scripts 

Testé avec : Gimp 2.6.2

Appel du script :  Sur l'image par Filtres > Animation > Animated Displace

Exemple : 

– Créer une nouvelle image de 100*100 pixels (Ctrl+N).

– Activer le filtre Plasma par : Filtre >Rendu > Nuages > Plasma

– Appel du script-fu par : Filtres > Animation > Animated Displace , paramétrer, Valider

– Sur la nouvelle image visualiser l'animation par :  Filtres > Animation > Rejouer l'animation, Lecture.

http://www.fileden.com/files/2007/7/19/1279673/AnimatedDisplaceScriptByGreentunic.scm
http://www.gimptalk.com/forum/animated-displace-script-my-first-script--t33775s50.html
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DOCUMENTATION TECHNIQUE SUR LES SCRIPT-FU

L IENS

Tiny-Fu  http://www.ve3syb.ca/software/gimp/tiny-fu.html 

Documentation Tiny-Fu  http://www.ve3syb.ca/wiki/doku.php?id=software:sf:start 

Documentation en pdf http://www.schemers.org/Documents/Standards/R5RS/r5rs.pdf 

Script-Fu in Gimp 2.4   http://www.gimp.org/docs/script-fu-update.html 

Tinyscheme http://tinyscheme.sourceforge.net/ 

Écrire un script-fu  http://abcdugimp.free.fr/gimp/apprendre/scheme/scheme.php 

Bases (Document déprécié)  http://www.gimp.org/tutorials/Basic_Scheme2/ 

PROCÉDURES

Accès aux procédures par Filtres > Script-Fu > Console , sur la fenêtre « Script-Fu Console » appuyer sur le 
bouton Parcourir.

Sous forme d'un fichier texte via maringouin par : Outils > Procédures de Gimp (Gimp ne doit pas être 
ouvert). Le document est dans \gimp_2_6_x\bin.

ARGUMENTS 
Extrait de :  http://manual.gimp.org/fr/gimp-using-script-fu-tutorial-first-script.html 

Type de paramètre Description Exemple
SF-IMAGE Si votre script opère sur une image ouverte, ceci doit être 

le premier paramètre après les paramètres requis. GIMP 
transmettra une référence à l'image dans ce paramètre.

3

SF-DRAWABLE Si votre script opère sur une image ouverte, ceci doit être 
le second paramètre, après le paramètre SF-IMAGE. Il se 
réfère au calque actif. GIMP transmettra une référence au 
calque actif dans ce paramètre.

17

SF-VALUE Accepte les nombres et les chaînes de caractères. Pour 
un texte, les guillemets doivent être précédés du caractère 
d'échappement \ , donc il vaut mieux dans ce cas utiliser 
SF-STRING.

42

SF-STRING Accepte les chaînes de caractères. "Un texte"
SF-COLOR Indique qu'une couleur est nécessaire pour ce paramètre. (0 102 255)

SF-TOGGLE Une boîte de saisie est affichée, pour entrer une valeur 
Booléenne.

TRUE ou FALSE (Vrai ou Faux)

http://manual.gimp.org/fr/gimp-using-script-fu-tutorial-first-script.html
http://www.gimp.org/tutorials/Basic_Scheme2/
http://abcdugimp.free.fr/gimp/apprendre/scheme/scheme.php
http://tinyscheme.sourceforge.net/
http://www.gimp.org/docs/script-fu-update.html
http://www.schemers.org/Documents/Standards/R5RS/r5rs.pdf
http://www.ve3syb.ca/wiki/doku.php?id=software:sf:start
http://www.ve3syb.ca/software/gimp/tiny-fu.html
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Type de paramètre Description
SF-ADJUSTMENT En mode interactif il crée une zone de dialogue dans la fenêtre de dialogue du script-fu.

SF-ADJUSTMENT "label" '(value lower upper step_inc page_inc digits type)
Liste d'arguments de boutons

Élément Description
"label" Texte affiché devant la zone de dialogue.

valeur value : Valeur affichée par défaut au départ.

lower / upper Valeurs mini / maxi (détermine la plage de choix).

step_inc Valeur pour incrémenter/décrémenter.

page_inc Valeur pour incrémenter/décrémenter utilisant les 
touches Page

chiffres Chiffres après le point (partie décimale)

type Un parmi: SF-SLIDER or 0 (glissière), SF-
SPINNER or 1 (bouton à flèche)

SF-COLOR Crée un bouton de choix de couleur.
SF-COLOR "label" '(red green blue)
ou
SF-COLOR "label" "color"
Liste d'arguments de boutons

Élément Description
"label" Texte affiché devant la zone de dialogue.

(red green blue) Liste de trois valeurs pour les composantes 
rouge, vert et bleu de la couleur par défaut.

"color" Un nom de couleur en notation CSS pour la 
couleur par défaut.

SF-FONT Crée une zone de sélection de fonte. Retourne le nom de la fonte sous la forme d'une chaîne de caractères. 
Il existe deux nouvelles procédures de type gimp-text pour utiliser facilement ce paramètre que retourne la 
fonction:
(gimp-text-fontname image drawable x-pos y-pos text border antialias size unit font)
(gimp-text-get-extents-fontname text size unit font)
dans lesquelles le paramètre "font" est le nom de la fonte que vous obtenez. La taille spécifiée dans 
fontname est ignorée. Elle est utilisée seulement dans le sélecteur de fonte. On vous demandera de donner 
une valeur utilisable (24 pixels est un choix correct).
SF-FONT "label" "fontname"
Liste d'arguments de boutons

Élément Description
"label" Texte affiché devant la zone de dialogue.

"fontname" Nom de la fonte par défaut.
SF-BRUSH Crée une zone de choix de brosse : prévisualisation de la brosse et à sa droite, bouton "Parcourir". Cliquer 

sur ce dernier fait apparaître la boite de dialogue des brosses avec possibilité de choisir une brosse ainsi que 
son espacement, son opacité et son mode.
SF-BRUSH "Brush" '("Circle (03)" 100 44 0)
Dans ce cas la brosse par défaut sera un Cercle (03) avec une opacité de 100, un espacement de 44 et en 
mode normal (0).
Si cette sélection reste inchangée la valeur passée à la fonction comme paramètre sera '("Circle (03)" 100 44 
0).
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Type de paramètre Description
SF-PATTERN Crée une zone de choix de motif : prévisualisation du motif et à sa droite, bouton "Parcourir". Cliquer sur ce 

dernier fait apparaître la boite de dialogue des motifs.
SF-PATTERN "Pattern" "Maple Leaves"
La valeur retournée quand le script est appelé est une chaîne de caractères contenant le nom du motif. Si la 
sélection par défaut ci-dessus n'est pas modifiée, la chaîne contiendra "Maple Leaves".

SF-GRADIENT Crée un bouton contenant une prévisualisation du dégradé.
Si on appuie sur le bouton, une fenêtre de sélection de palette apparaît.
SF-GRADIENT "Gradient" "Deep Sea"
La valeur retournée quand le script est appelé est une chaîne de caractères contenant le nom du dégradé. Si 
la sélection par défaut ci-dessus n'est pas modifiée, la chaîne contiendra "Deep Sea".

SF-PALETTE Crée un bouton contenant le nom de la palette sélectionnée.
Si on appuie sur le bouton, une fenêtre de sélection de palette apparaît.
SF-PALETTE "Palette" "Named Colors"
La valeur retournée quand le script est appelé est une chaîne de caractères contenant le nom de la palette. 
Si la sélection par défaut ci-dessus n'est pas modifiée, la chaîne contiendra "Named Colors".

SF-FILENAME Crée un bouton contenant le nom d'un fichier.
Cliquer sur celui-ci fait apparaître la boite de dialogue de sélection de fichiers.
SF-FILENAME "label" (string-append "" gimp-data-directory "/scripts/beavis.jpg")
La valeur retournée quand le script est appelé est une chaîne de caractères contenant le nom du fichier.

SF-DIRNAME Similaire à SF-FILENAME, mais permet de choisir un dossier.
SF-DIRNAME "label" "/var/tmp/images"
La valeur retournée quand le script est appelé est une chaîne de caractères contenant le nom du dossier.

SF-OPTION Crée une boîte de choix (combo-box) pour des options possibles.
La première option est l'option par défaut.
SF-OPTION "label" '("option1" "option2")
La valeur retournée quand le script est appelé est le numéro de l'option choisie (0 correspondant à la 1ère 
option...).

SF-ENUM Crée une boîte de choix (combo-box) montrant toutes les valeurs possibles pour un type donné. Le premier 
paramètre doit être un nom d'énumération de valeurs de GIMP, sans le préfixe "Gimp". Le second spécifie la 
valeur par défaut.
SF-ENUM "Interpolation" '("InterpolationType" "linear")
La valeur retournée quand le script est appelé est la valeur choisie de l'énumération.

Document technique en français sur les script-fu :

http://zigazou.wordpress.com/2009/05/19/decortiquons-un-script-fu-pour-gimp/  

http://zigazou.wordpress.com/2009/05/19/decortiquons-un-script-fu-pour-gimp/
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GREFFONS EN PYTHON

Voici le lien pour télécharger une archive remplie de greffons en Python :
http://www.aljacom.com/~gimp/greffons_en_python.zip 

Installation :   Décompresser l'archive greffons_en_python.zip et placer tous les fichiers .py dans le répertoire 
des greffons gimp_2_6_x\lib\gimp\2.0\plug-ins.  

L'utilisation de ces greffons testés avec Gimp 2.6.3 est indiquée dans les sous-paragraphes suivants.

De nombreux Python-Fu proviennent du site http://python-fu.sourceforge.net/index.html 

AQUABUTT-2.1.PY (CRÉER  DES BOUTONS « AQUA »)
Auteur : Werner Hartnagel  

Accès par : Filtres > Python-Fu > Web-Tools > Buttons > AquaButt2 (Attention car il y a deux Python-Fu).

Résultats sur fond noir avec police Arial :

BLACKINK1.PY (TRANSFORME  UNE IMAGE  EN DESSIN À L 'ENCRE NOIRE)
Auteur : Jerome Dumonteil  

Accès sur l'image par : Python-Fu > Black Ink1 

Résultat avec les paramètres par défaut :

Origine >>

Résultat

http://python-fu.sourceforge.net/index.html
http://www.aljacom.com/~gimp/greffons_en_python.zip
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BORDER_LAYER.PY (AJOUTER UNE BORDURE)
Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Create Layers > Border Layer 

Résultat avec les paramètres par défaut :

     Origine >    Effet >

COLORCONTOUR .PY (SOULIGNE LES CONTOURS)
Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Create Layers > Color Contour 

Résultats :

           Origine      Contour width = 1    Contour width = 3 

COLOROFFSET .PY

Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Effects > Color Offset 

Résultat avec les paramètres par défaut (Même origine que l'exemple précédent) :
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FISHEYE .PY (EFFET GRAND ANGLE)
Auteur : Werner Hartnagel  

Accès sur l'image par : 
Python-Fu > Create Layers > Grand Angle 

Créer une sélection elliptique :

Appeler le Python-Fu.

Résultat après Image > Ajuster le canevas aux calques
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KALEIDOSIX.PY (EFFET KALÉIDOSCOPE)
Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Patterns > Kaleidosix 

Résultat avec les paramètres par défaut sur une sélection :

              Origine (Sélection) >

Résultat
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LES TROIS GREFFONS MAGICMESH

Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Create Layers > Magicmesh
Python-Fu > Create Layers > Magicmesh2 (With Mask)
Python-Fu > Create Layers > Magicmesh3 (SVG) Export SVG

Résultats :

Effet Magicmesh sans le fond  >

Effet Magicmesh
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RANDOM_SHAPES .PY (CRÉER  UN MOTIF ET EXPORTER EN SVG)
Auteur : Werner Hartnagel  

Accès par : Filtres > Python-Fu > Patterns > Random Shapes (Attention car il y a deux Python-Fu).

Résultat à partir de la palette Bears :
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ROUND_COLORS2BW.PY (CRÉER  UNE IMAGE NOIR ET  BLANC)
Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Create Layers > Highpass-Lowpass Gray Values 

Résultat avec les paramètres au minimum :

ROUND_CORNERS.PY (ARRONDIR  LES COINS AVEC  UNE BROSSE)
Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Borders > Round Corners 

Résultat avec les paramètres par défaut:

>
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SCANLINE_LAYER .PY (CRÉER DES LIGNES)
Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Create Layers > Scanline Layer 

Résultat, paramètres par défaut avec l'image d'origine de l'exemple précédent :

W ATERPAINT .PY  (EFFET DE PEINTURE À L 'EAU)
Auteur : Werner Hartnagel  

Accès sur l'image par : Python-Fu > Effects > Water-Paint-Effect 

        Effet :
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GREFFON RESTAURATION  DIAPOSITIVES & VIEILLES PHOTOGRAPHIES 
(PYTHON)

Ce superbe greffon (en cours de tests) permet de restaurer de vieilles diapositives ainsi que de vieilles 
photographies dont les couleurs se sont détériorées avec le temps. 

L'algorithme de traitement créé par Geoff Daniell est disponible au format PDF à partir de ce lien :
 http://www.lionhouse.plus.com/photosoftware/restore/photorestore.pdf 

Des exemples sont disponibles sur http://www.lionhouse.plus.com/photosoftware/restore/ (images .jpg).

Site : http://www.lionhouse.plus.com/photosoftware/                                        

Auteur :  Geoff Daniell.  

Téléchargement greffon :   http://www.lionhouse.plus.com/photosoftware/gimp_plugins/restore.py 

Installation :   
Enregistrer restore.py dans le répertoire des greffons de Gimp : gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.5.

Appel du greffon :  Sur l'image par Restore > restore

Exemple de résultat : 

http://www.lionhouse.plus.com/photosoftware/gimp_plugins/restore.py
http://www.lionhouse.plus.com/photosoftware/
http://www.lionhouse.plus.com/photosoftware/restore/
http://www.lionhouse.plus.com/photosoftware/restore/photorestore.pdf
http://fr.wikipedia.org/wiki/Diapositive
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GREFFON SPIROGRAPH (PYTHON)

Spirograph permet de créer des courbes avec le pinceau sur l'image.

Site :  http://www.andyshelley.co.uk/gimpfarris/index.php                                        

Auteur :  Copyright 2010   Andy Shelley.  

Téléchargement greffon :  http://www.andyshelley.co.uk/gimpfarris/spirograph.py             

Installation :   
Enregistrer spirograph.py dans le répertoire des greffons de Gimp : gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits /Windows 7 64 bits

Appel du greffon :  Sur l'image par Filtres > Artistiques > Farris Curves...   

Pour tester, sur la boîte de paramétrage, positionner Show examples à Oui puis Valider. Voici 2 exemples :

http://www.andyshelley.co.uk/gimpfarris/spirograph.py
http://www.andyshelley.co.uk/gimpfarris/index.php
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PYTHON ET G IMP

Voici quelques liens pour trouver de la documentation sur Python :

– GIMP Python Documentation  http://www.gimp.org/docs/python/index.html

– La page Framasoft sur Python  http://www.framasoft.net/article1104.html 

– Le site officiel  http://python.org/ 

– Gimp-Python  http://www.jamesh.id.au/software/pygimp/ 

– GIMP Reference Manuals for the GIMP 2.0 API  http://developer.gimp.org/api/2.0/index.html

– Didacticiel en français : http://www.unixgarden.com/index.php/graphisme/le-gimp-et-le-python 

Pour installer Python voir page 3.

Dans Gimp, pour afficher la console faire : Filtres > Python-Fu > Console

 

http://www.unixgarden.com/index.php/graphisme/le-gimp-et-le-python
http://developer.gimp.org/api/2.0/index.html
http://www.jamesh.id.au/software/pygimp/
http://python.org/
http://www.framasoft.net/article1104.html
http://www.gimp.org/docs/python/index.html
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EXPORT AU  FORMAT SWF (FORMAT FLASH D'ADOBE)
Voici 2 greffons écrits en Python qui permettent d'exporter au format SWF.

Ce 2 greffons nécessitent les outils libres SWFTools disponibles à la page http://swftools.org/download.html . 
Pour nos exemples nous avons utilisé l'archive swftools-2010-05-16-1816.rar qu'il suffit de décompresser avec 
7-Zip. Ensuite il faut copier swfc.exe (pour le greffon de James Huang) et png2swf.exe (pour le greffon de 
Eckhard M. Jäger) dans le répertoire gimp_2_6_8\bin (celui où se trouve gimp-2.6.exe).

LE GREFFON DE JAMES  HUANG

Site :   http://www.gimptalk.com/forum/flash-swf-export-python--t41499.html                                     

Auteur :  James Huang 

Téléchargement greffon : http://www.box.net/shared/htf97ciy3r                      

Installation :   
Décompresser l'archive ExportSWFE.zip et placer ExportSWFE.py dans le répertoire des greffons de 

Gimp : gimp_2_6_x\lib\gimp\2.0\plug-ins.            

Testé avec : Gimp 2.6.8 32 bits / Windows 7 64 bits

  Appel du greffon :  Sur l'image par Fichier > Export SWF File ...

Exemple de paramétrage sur une image à plusieurs calques construite comme une animation avec l'ajout 
d'une musique mp3.

http://www.box.net/shared/htf97ciy3r
http://www.gimptalk.com/forum/flash-swf-export-python--t41499.html
http://swftools.org/download.html
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LE GREFFON DE ECKHARD M. JÄGER

Site :  http://my.opera.com/area42/blog/flash-swf-export-for-gimp                                           

Auteur :  Eckhard M. Jäger 

Téléchargement greffon : http://files.myopera.com/area42/files/flash-swf-export.py                        

Installation :   
Placer flash-swf-export.py dans le répertoire des greffons de Gimp : gimp_2_6_x\lib\gimp\2.0\plug-ins. 

Testé avec : Gimp 2.6.8 32 bits / Windows 7 64 bits

  Appel du greffon :  Sur l'image par Fichier > Flash SWF Export...

Exemple de paramétrage sur une image à plusieurs calques construite comme une animation.

Remarque : Ce greffon est beaucoup moins performant que celui de James Huang (manque le son, non 
respect des temporisations). 

SWFTOOLS

Ces outils offrent plus de possibilités que ces 2 greffons mais peuvent être moins souples à utiliser (emploi de 
lignes de commandes). Des didacticiels sont proposés à la page http://wiki.swftools.org/index.php/Main_Page 

Par exemple, utiliser swfc.exe :

– http://www.swftools.org/swfc/swfc.html    , http://www.swftools.org/swfc.html ,
      http://wiki.swftools.org/index.php/Sc_file_format  , http://wiki.swftools.org/index.php/SWF_Commands 

– http://www.indigorose.com/forums/archive/index.php/t-116.html    

http://www.indigorose.com/forums/archive/index.php/t-116.html
http://wiki.swftools.org/index.php/SWF_Commands
http://wiki.swftools.org/index.php/Sc_file_format
http://www.swftools.org/swfc.html
http://www.swftools.org/swfc/swfc.html
http://wiki.swftools.org/index.php/Main_Page
http://files.myopera.com/area42/files/flash-swf-export.py
http://my.opera.com/area42/blog/flash-swf-export-for-gimp
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GEGL
GEGL est une « librairie » ou « bibliothèque » que Gimp utilisera complètement dans ses futures versions. 

Le site de GEGL : http://gegl.org/ 

UTILISER  GEGL DANS LES TRAITEMENTS

Pour utiliser GEGL dans les traitements il faut valider l'option « Utiliser GEGL » dans le menu « Couleurs ».

FONCTIONS « ACTION GEGL »
Outils > Action GEGL

En ce moment elle est proposée avec Gimp 2.6 
pour réaliser quelques opérations.

La fenêtre de dialogue du flou :

http://gegl.org/
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RÉSULTATS DES EFFETS

Les effets sont accessibles sur l'image par : Outils > Action GEGL

Origine Bilateral-filter Box-blur Brightness-contrast C2G

Checkerboard Color Color-temperature Contrast-curve Difference-of-
gaussian

Fractal-explorer Gaussian-blur Grey * Invert Levels *



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 346 / 391
 GEGL 

Mblur Mono-mixer Perlin-noise Remap * Snn-mean

Stretch-contrast Threshold Tonemap * Unsharp-mask Value-invert

Whitebalance

*  : Signale un effet qui ne fonctionne pas (Testé avec Gimp 2.6.1).
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GEGL C2G (EFFET HDR)
Voici l'annonce de gimpfr.org (http://gimpfr.org/news_id.php?id=643) sur le filtre C2G (Color To Grey) : 

Dans les actions GEGL se cache un filtre au nom bizarre : C2G, c'est un acronyme pour Color 2 Grey. Ce  
filtre transforme donc une image couleur en une image en tons de gris mais avec un algorithme particulier,  
inspiré sur les mécanismes de l'oeil humain, pour obtenir une image plus contrastée. C2G permet d'obtenir  
des résultats très contrastés de conversion en noir-et-blanc. Mais le domaine d'application de C2G ne  
s'arrête pas là, avec un peu de manipulation dans Gimp on peut rapidement transformer aussi une image  
couleur normale en une image très contrastée. Un effet similaire au HDR (High Dynamic Range) en quelque  
sorte (http://fr.wikipedia.org/wiki/High_dynamic_range_imaging). C'est JanneMW, un membre du groupe  
Gimp sur le site de partage de photo FlickR qui nous en fait la démonstration dans le fil de discussion : Easy  
Overprocessing with c2g (http://www.flickr.com/groups/gimpusers/discuss/72157619079536887/)...
    * Copier le calque original

    * Lancer sur le calque copié le filtre C2G depuis le menu Outils > Actions GEGL > C2G

    * Augmenter l'échantillonnage de 3 (très bruité) à 10 (ou plus) , puis appliquer  C2G

    * Copier à nouveau le calque original

    * Déplacer le calque original copié tout en haut

    * Mettre le mode de calque à Couleur

Effet obtenu à partir de cette image de JanneM http://www.flickr.com/photos/jannem/3591010628/ (licence 
Creative Commons BY-NC-SA).

Origine :

http://www.flickr.com/photos/jannem/3591010628/
http://www.flickr.com/groups/gimpusers/discuss/72157619079536887/
http://fr.wikipedia.org/wiki/High_dynamic_range_imaging
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Résultat avec 200 itérations dans le filtre C2G (le traitement est relativement long) :

Testé sur Gimp 2.6.7
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THÈMES POUR G IMP À TÉLÉCHARGER

UTILISER  GTK+ PREFERENCE TOOL

Alexander Shaduri propose un sélecteur de thèmes pour GTK (et donc pour Gimp) à la page http://gtk-
win.sourceforge.net/home/index.php/Gtk2Prefs 

INSTALLATION

À partir de la page http://gtk-win.sourceforge.net/home/index.php/Downloads :

– Télécharger gtk2_prefs-0.4.1.bin-gtk2.10-win32.zip  http://downloads.sourceforge.net/gtk-win/gtk2_prefs-
0.4.1.bin-gtk2.10-win32.zip?download , décompresser l'archive et placer gtk2_prefs.exe dans le répertoire 
\gimp_2_6_x\bin où il y a gimp-2.6.exe .

– Télécharger gtk2-themes-2009-09-07-win32_bin.zip (archive avec beaucoup de thèmes) 
http://downloads.sourceforge.net/gtk-win/gtk2-themes-2009-09-07-win32_bin.zip?download , 
décompresser. Copier le répertoire lib et coller dans \gimp_2_6_x et répondre Oui .

– Copier le répertoire share et coller dans \gimp_2_6_x et répondre Oui . Les nouveaux thèmes seront dans 
\gimp_2_6_x\share\themes .

http://downloads.sourceforge.net/gtk-win/gtk2-themes-2009-09-07-win32_bin.zip?download
http://downloads.sourceforge.net/gtk-win/gtk2_prefs-0.4.1.bin-gtk2.10-win32.zip?download
http://downloads.sourceforge.net/gtk-win/gtk2_prefs-0.4.1.bin-gtk2.10-win32.zip?download
http://gtk-win.sourceforge.net/home/index.php/Downloads
http://gtk-win.sourceforge.net/home/index.php/Gtk2Prefs
http://gtk-win.sourceforge.net/home/index.php/Gtk2Prefs
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Voici les thèmes ajoutés (liste de répertoires) :
├───Amaranth
├───AnachronAna
├───Aurora
├───Bluecurve
├───Bluecurve-BerriesAndCream
├───Bluecurve-Gnome
├───Bluecurve-Grape
├───Bluecurve-Lime
├───Bluecurve-Slate
├───Bluecurve-Strawberry
├───Bluecurve-Tangerine
├───Blueprint
├───Blueprint-Green
├───Blueprint-Ice
├───Blueprint-no-color
├───Blueprint-Sand
├───Candido-Calm
├───Candido-Candy
├───Candido-DarkOrange
├───Candido-Hybrid
├───Candido-NeoGraphite
├───CleanIce
├───CleanIce-Dark
├───CleanIce-Debian
├───Clearlooks
├───ClearlooksClassic
├───ClearlooksTest
├───Crux
├───Darklooks
├───Default
├───Delightfully-Smooth
├───DyndynBlueGray
├───DyndynPinkGray
├───Emacs
├───G26
├───Glider
├───Glossy

├───Gorilla
├───HighContrast
├───HighContrastInverse
├───HighContrastLargePrint
├───HighContrastLargePrintInverse
├───Human
├───Industrial
├───Inverted
├───LargePrint
├───LighthouseBlue
├───LowContrast
├───LowContrastLargePrint
├───Lush
├───Metal
├───Mist
├───MS-Windows
├───MurrinaAquaIsh
├───MurrinaAzul
├───MurrinaBleu
├───MurrinaBlue
├───MurrinaCandido
├───MurrinaCandy
├───MurrinaCappuccino
├───MurrinaChrome
├───MurrinaCream
├───MurrinaEalm
├───MurrinaFancyCandy
├───MurrinaGilouche
├───MurrinaLoveGray
├───MurrinaNeoGraphite
├───MurrinaVerdeOlivo
├───Nimbus
├───Nimbus-Dark
├───Nimbus-Light
├───Nodoka
├───Nodoka-Aqua
├───Nodoka-Gilouche

├───Nodoka-Looks
├───Nodoka-Midnight
├───Nodoka-Rounded
├───Nodoka-Silver
├───Nodoka-Squared
├───Nuvola
├───Raleigh
├───Redmond
├───Rezlooks-candy
├───Rezlooks-dark
├───Rezlooks-Gilouche
├───Rezlooks-graphite
├───Rezlooks-Snow
├───Simple
├───Smooth-Funky-Monkey
├───Smooth-Line
├───Smooth-Okayish
├───Smooth-Sea-Ice
├───Smooth-Tangerine-Dream
├───Smooth-Winter
├───ThinIce
├───Unity
├───Wasp
├───Xcl-aqua
├───Xcl-aqua-dark
├───Xcl-bubblegum
├───Xcl-bubblegum-dark
├───Xcl-clarius
├───Xcl-clarius-dark
├───Xcl-flat
├───Xcl-flat-dark
├───Xcl-inverted
├───Xcl-inverted-dark
├───Xfce
├───Xfce-4.0
├───Xfce-4.2
└───Xfce-4.4

UTIL ISATION

Démarrer \gimp_2_6_x\bin\gtk2_prefs.exe et sélectionner un thème, par exemple ThinIce, appuyer sur le 
bouton Show preview, paramétrer selon vos souhaits, appuyer sur Valider  :
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Appuyer sur Oui.

Démarrer Gimp.

On peut ajouter le dossier \gimp_2_6_x\share\themes dans les préférences de Gimp et choisir ce thème 
ThinIce dans les préférences de Gimp.

Ici un exemple de modification de police de caractères (Times New Roman de 7) et le rendu dans Gimp.
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LOGICIEL PROPOSÉ PAR G IMPER

Gimper propose à la page http://gimp-tutorials.net/gimp-themes-for-windows un installateur pour Windows 
disponible directement à partir de ce lien http://gimp-tutorials.net/downloads/gimp-themes-v1-0.zip .

Il faut décompresser l'archive gimp-themes-v1-0.zip et activer l'installateur gimpthemes1.0.msi. Il installe par 
défaut les thèmes dans C:\Program Files (x86)\GIMP-2.0 . Si vous utilisez notre archive il faudra créer une 
archive du contenu de ce répertoire et la décompresser dans \gimp_2_6x où il y a maringouin.exe.

Il faut noter que les 14 thèmes de Gimper sont dans C:\Program Files (x86)\GIMP-2.0\share\themes ou 
\gimp_2_6x\share\themes si vous utilisez notre archive. Nous pouvons déclarer ce dossier dans les préférences 
de Gimp.

Pour modifier les thèmes de   GTK et  Gimp   utiliser   
l'utilitaire   \gimp_2_6_x\bin\  Gimpthemes-v1.0.exe   , 

choisir un thème et valider , ici Chocolate-Murrine =>

Voici la boîte à outils de Gimp suite à cette 
modification :

Pour désinstaller passer par le panneau de configuration et supprimer le fichier C:\Users\[Utilisateur]\.gtkrc-2.0

Remarque : Ce logiciel est identique à gtk2_prefs.exe décrit dans les pages précédentes.

http://gimp-tutorials.net/downloads/gimp-themes-v1-0.zip
http://gimp-tutorials.net/gimp-themes-for-windows
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AJOUT DE THÈMES DE GNOME  EN UTILISANT  LE LOGICIEL DE G IMPER

Le principal lieu pour télécharger des thèmes est le site de Gnome : http://art.gnome.org/themes/gtk2/ 

Sur ce site il y a une multitude de thèmes (76).

Nous faisons un exemple avec le thème Clearlooks-
DarkOrange  par Franco Gotusso (GNU GPL) 
http://art.gnome.org/download/themes/gtk2/1065/GTK2-
ClearlooksDarkOrange.tar.gz 

Il faut décompresser l'archive GTK2-
ClearlooksDarkOrange.tar.gz avec7-Zip. Placer le dossier 
Clearlooks-DarkOrange dans le répertoire des thèmes 
C:\Program Files (x86)\GIMP-2.0\share\themes ou 
\gimp_2_6x\share\themes et paramétrer via l'utilitaire 
\bin\Gimpthemes-v1.0.exe .

Voici la boîte à outils de Gimp suite à cette modification :

D'autres thèmes sont disponibles sur d'autres sites : http://my.opera.com/area42/blog/a-nice-gimp-theme , etc.

http://my.opera.com/area42/blog/a-nice-gimp-theme
http://art.gnome.org/download/themes/gtk2/1065/GTK2-ClearlooksDarkOrange.tar.gz
http://art.gnome.org/download/themes/gtk2/1065/GTK2-ClearlooksDarkOrange.tar.gz
http://art.gnome.org/download/themes/gtk2/1065/GTK2-ClearlooksDarkOrange.tar.gz
http://art.gnome.org/themes/gtk2/
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COMPILER G IMP OU DES GREFFONS SOUS W INDOWS

UTILISER  MSYS-M INGW
COMPILER  G IMP

Pour compiler Gimp sous Windows, le plus simple est d'installer l'environnement MSYS-MinGW 
disponible à http://www.mingw.org/ . 

Suivre les liens pour installer cet ensemble : 
http://www.mingw.org/wiki/MSYS 
http://www.mingw.org/wiki/HOWTO_Install_the_MinGW_GCC_Compiler_Suite  

Après avoir installé cet environnement il faut récupérer toutes les bibliothèques ( GTK, PNG, JPEG, TIFF, 
etc.). Tous ces paquets sont disponibles sur http://www.gtk.org/ à la page http://www.gtk.org/download-
windows.html où il faut installer « GTK+ individual packages » et « Third Party Dependencies » 
( « Binaries » et « Dev » ).

Ensuite il faut récupérer une version source de gimp ( http://www.gimp.org/downloads/ ), la décompresser et 
la compiler avec les 3 phases (./configure , make et make install).

Exemple de la boîte à outils de Gimp 2.6.7 compilé en 32 bits (i686) sous Windows 7 version 64 bits :

Il existe un ensemble de scripts qui automatise l'installation de MSYS-MinGW et la compilation de Gimp 
(ensemble non testé) sur le wiki de Gimp http://wiki.gimp.org/ . Si le Wiki est inaccessible voici un lien pour 
télécharger des exemples de scripts à adapter à la version de Gimp et des bibliothèques du jour :

http://www.aljacom.com/~gimp/compilation_gimp_2_6.zip 

COMPILER  UN  GREFFON

Il y a deux façons de compiler un greffon :

– Utiliser gimptool, exemple : gimptool-2.0.exe --build /mingw/mon_beau_greffon.c

– Le greffon est plus complexe et il faut le compiler avec les 3 phases (./configure , make et make install).

Dans ces 2 cas, Gimp ou GimpDev ( http://sourceforge.net/projects/gimp-win/files/  ) doit être installé 
dans l'environnement MSYS-MinGW.

http://sourceforge.net/projects/gimp-win/files/
http://www.aljacom.com/~gimp/compilation_gimp_2_6.zip
http://wiki.gimp.org/
http://www.gimp.org/downloads/
http://www.gtk.org/download-windows.html
http://www.gtk.org/download-windows.html
http://www.gtk.org/
http://www.mingw.org/wiki/HOWTO_Install_the_MinGW_GCC_Compiler_Suite
http://www.mingw.org/wiki/MSYS
http://www.mingw.org/
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UTILISER  CYGW IN

Cygwin est un environnement « Linux like » fonctionnant sous Windows : http://www.cygwin.com/ 

Comme sous Linux il faut installer les bibliothèques pour pouvoir compiler Gimp ou les greffons.

Jean-Louis Hamel propose de nombreuses informations pour compiler un greffon sous Cygwin :

http://jeanlouis.hamel.perso.neuf.fr/FILES/index.html#mozTocId742833 

UTILISER  LES COMPILATEURS  M ICROSOFT

Le projet de Pierre Barthe est abandonné : http://gimp-vs.sourceforge.net/ 

COMPILATION CROISÉE

La compilation croisée permet de générer un exécutable fonctionnant sous un système d'exploitation à partir 
d'un autre système d'exploitation. C'est le cas pour certains greffons fonctionnant sous Windows qui sont 
compilés sous Linux, par exemple gimp-image-reg.exe décrit page 301.

Voici un extrait du fichier README de ce greffon gimp-image-reg qui décrit la méthode :
(3.2.2) Building for Win32

--------------------------
Currently the binaries for Win32 are built by cross-compiling under Linux (using the same 
scripts as for building the Linux binaries).
For cross-compiling the sources, will need to get and install 
(a) 'Minimalist GNU win32 cross-compiler' (look for 'mingw32' in your package manager), and
(b) the Win32 development packages for Gimp and Gtk+.
The latter packages can be downloaded from:
http://sourceforge.net/projects/gimp-win/files/ (look for gimp-dev-2.6.4.zip or newer)
ftp://ftp.gnome.org/pub/gnome/binaries/win32/ (look for gtk+-bundle_2.18.7-20100213_win32.zip 
or newer)
Assuming that you unpack/install the development libraries into say '/opt/mingw32', the build 
steps are much like the 'normal' installation for Linux, namely:
(1) tar xvjf gimp-image-reg-0.5.4.tar.bz2
(2) mkdir build
(3) cd build
(4) ../gimp-image-reg-0.5.4/configure \
           --prefix=`pwd`/win32       \
           --with-prefix=/opt/mingw32 \
           --host=i586-mingw32msvc    \
           --target=i586-mingw32msvc  \
           --build=i386-linux
(5) make
(6) make install
This will create a directory 'win32' in your current directory and 'install' the package 
there. The contents of this directory will be:
win32/
|-- plug-ins
|   `-- gimp-image-reg.exe
`-- share
    |-- gimp-image-reg
    |   `-- help
    |       |-- css
    |       |   `-- image-reg.css
    |       |-- de
    |       |   |-- gimp-help.xml
    |       |   `-- index-de.html
    |       |-- en
    |       |   |-- gimp-help.xml
    |       |   `-- index-en.html

http://gimp-vs.sourceforge.net/
http://jeanlouis.hamel.perso.neuf.fr/FILES/index.html#mozTocId742833
http://www.cygwin.com/
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   |       `-- images
    |           |-- dialog-1-de.png
    |           |-- dialog-1-en.png
    |           `-- wilber.png
    `-- locale
        `-- de
            `-- LC_MESSAGES
                `-- gimp-image-reg.mo
For the actual installation of the plug-in, copy the contents of win32\...  into your 
*personal* gimp-2.6 directory, preserving the directory structure.
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G IMP EN BRETON

Une traduction de Gimp en breton est disponible à partir de la page :
http://www.drouizig.org/Galleg/Logiciels/divers-GIMP.html 

Lien direct : http://www.drouizig.org/Pellgargan/Meziantou/GIMP-2.6.3-bzh.zip  

INSTALLATION SUR NOTRE ARCHIVE

– Se placer dans le répertoire \gimp_2_6_9\share\locale\br\LC_MESSAGES

– Décompresser l'archive GIMP-2.6.3-bzh.zip dans ce répertoire.

– Supprimer l'archive GIMP-2.6.3-bzh.zip

– Résultat :

Avec un éditeur de texte, éditer le fichier maringouin_ahk.ini du répertoire \gimp_2_6_9 et modifier ces 3 
clefs comme indiqué :

demarrage_langue_6 = Démarrer en Breton
parametre_langue_6 = br
nom_fenetre_principale = Boestad binvioù

Démarrer maringouin.exe puis Démarrage Gimp > Démarrer en Breton

http://www.drouizig.org/Pellgargan/Meziantou/GIMP-2.6.3-bzh.zip
http://www.drouizig.org/Galleg/Logiciels/divers-GIMP.html
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PUBLICATIONS, LIENS INTERNET

PUBLICATIONS

Livres en français sur Gimp : http://gimpfr.org/litterature.php

Livre sur Gimp en anglais : http://gimpbook.com/ 

Programmation Python en français : http://python.developpez.com/livres/?page=tous 

L IENS

EN ANGLAIS

Le site de Gimp : http://gimp.org/ 

Chercher des greffons : http://registry.gimp.org/faceted_search/select/ 

Gimp developers : http://developer.gimp.org/ 

Liste Gimp users : http://lists.xcf.berkeley.edu/lists/gimp-user/ 

Liste Gimp developers : http://lists.xcf.berkeley.edu/lists/gimp-developer/ 

Les vidéos de « Libre Graphics Meeting 2008 » : http://www.river-valley.tv/conferences/lgm2008/ 

Aide au format CHM : http://www.aljacom.com/~gimp/doc_gimp.html 

Didacticiels : http://gimp-tutorials.net/ 

Comment dessiner en vidéo sur http://youtube.com : Mettre « Drawing ANIME art with the GIMP »
    dans « Search ».

EN FRANÇAIS

Portail francophone de Gimp : http://gimpfr.org 

Anneau francophone : http://raymond.ostertag.free.fr/html/webring.html 

Forum Linuxgraphic : http://www.linuxgraphic.org/forums/viewforum.php?f=4 

Forum Gimp-Attitude : http://www.gimp-attitude.org/forum/index.php 

Forum Absolut Photo : http://forum.absolut-photo.com/the-gimp-f30/ 

Forum Flickr : http://www.flickr.com/groups/gimp_francophone/ 

Forum Dessin.TheGimp :
 http://newsportal.zoo-logique.org/thread_frameset.php?group=dessin.TheGimp 

700 didacticiels :  http://www.gimpons.net    

RESSOURCES  
Gimpfr : http://gimpfr.org/ressource.php 

Gimp-Attitude : http://www.gimp-attitude.org/ressources.php 

D IVERS  
La photo numérique : du capteur à l'image : http://www.futura-sciences.com/fr/doc/t/technologie/d/la-photo-

numerique-du-capteur-a-limage_773/c3/221/p1/ 

Trouver une police de caractère via une image : http://www.myfonts.com/WhatTheFont/ 

http://www.myfonts.com/WhatTheFont/
http://www.futura-sciences.com/fr/doc/t/technologie/d/la-photo-numerique-du-capteur-a-limage_773/c3/221/p1/
http://www.futura-sciences.com/fr/doc/t/technologie/d/la-photo-numerique-du-capteur-a-limage_773/c3/221/p1/
http://www.gimp-attitude.org/ressources.php
http://gimpfr.org/ressource.php
http://www.gimpons.net/
http://newsportal.zoo-logique.org/thread_frameset.php?group=dessin.TheGimp
http://www.flickr.com/groups/gimp_francophone/
http://forum.absolut-photo.com/the-gimp-f30/
http://www.gimp-attitude.org/forum/index.php
http://www.linuxgraphic.org/forums/viewforum.php?f=4
http://raymond.ostertag.free.fr/html/webring.html
http://gimpfr.org/
http://youtube.com/
http://gimp-tutorials.net/
http://www.aljacom.com/~gimp/doc_gimp.html
http://www.river-valley.tv/conferences/lgm2008/
http://lists.xcf.berkeley.edu/lists/gimp-developer/
http://lists.xcf.berkeley.edu/lists/gimp-user/
http://developer.gimp.org/
http://registry.gimp.org/faceted_search/select/
http://gimp.org/
http://python.developpez.com/livres/?page=tous
http://gimpbook.com/
http://gimpfr.org/litterature.php
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V IRTUALBOX SOUS W INDOWS ET G IMP/UBUNTU

VirtualBox (http://www.virtualbox.org/) permet de faire fonctionner plusieurs systèmes d'exploitation 
simultanément par le procédé de virtualisation. Si nous utilisons Windows, nous pouvons avoir un Linux 
directement accessible dans une fenêtre. Cela peut être intéressant pour faire fonctionner Gimp dans son 
environnement natif afin d'avoir plus de possibilités (des greffons qui ne fonctionnent pas sous Windows), de 
tester d'autres environnements, etc. 
VirtualBox fonctionne sur tous les ordinateurs modernes (4Go de mémoire ou + , processeur à 2 cœurs ou +).

Dans cet exemple nous installons VirtualBox sous Windows 7 64 bits, puis une version de Linux Ubuntu 32 
bits version standard (ici la version d'avril 2010, Ubuntu 10.04 LTS « Lucid Lynx »).

INSTALLATION DE V IRTUALBOX

Se rendre à la page http://www.virtualbox.org/wiki/Downloads et télécharger la dernière version en cliquant 
sur le lien indiqué par VirtualBox xxx for Windows hosts → x86/amd64 (xxx = version de VirtualBox en cours). 
Lorsque le fichier est téléchargé, faire un double clic sur ce fichier VirtualBox-xxx-Win.exe pour démarrer 
l'installation en validant par Oui toutes les questions. 

Appuyer sur le bouton Next → 

← Valider I accept … Appuyer sur le bouton Next.

Appuyer sur le bouton Next →

← Appuyer sur le bouton Next.

http://www.virtualbox.org/wiki/Downloads
http://fr.wikipedia.org/wiki/Virtualisation
http://www.virtualbox.org/
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Appuyer sur le bouton Yes → 

← Appuyer sur le bouton Install.

L'installation commence → 

Répondre Oui ou Installer aux questions posées par Windows.

← L'installation est terminée, appuyer sur le bouton Finish.

Le logiciel s'ouvre → 

Nous pouvons télécharger Ubuntu.
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TÉLÉCHARGEMENT  UBUNTU

Se rendre à la page http://www.ubuntu-fr.org/telechargement et cliquer sur le bouton Télécharger

Ubuntu 10.04 LTS « Lucid Lynx » (32bits). 

Pour l'occasion nous créons un répertoire ...\virtualbox\images_iso ou nous plaçons l'image ISO d'Ubuntu.

INSTALLER  UBUNTU SOUS V IRTUALBOX

Dans le logiciel Virtualbox, créer une nouvelle machine par Machine > Nouvelle ou Ctrl+N. 

L'assistant s'ouvre, appuyer sur le bouton Suivant → 

← Définir un Nom, choisir le Système d'exploitation et la Version 
comme indiqué. Appuyer sur le bouton Suivant.

Allouer de la mémoire vive, ici 1024Mo. La valeur est 
fonction de la mémoire disponible sur votre ordinateur, par 
exemple ¼ de votre total. Appuyer sur le bouton Suivant→ 

← Paramétrer le disque dur virtuel. Appuyer sur le bouton 
Suivant. 

http://www.ubuntu-fr.org/telechargement
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L'assistant de disque Virtuel s'ouvre, appuyer sur le bouton 
Suivant → 

← Choisir un disque à taille variable, appuyer sur le bouton 
Suivant.

Choisir le volume max. du disque dur, ici 20Go, appuyer sur 
le bouton Suivant → 

← Noter l'emplacement du disque dur dans le répertoire 
utilisateur. Appuyer sur le bouton Terminer.

Appuyer sur le bouton Terminer → 

Nous pouvons passer à la création d'Ubuntu.

←  Appuyer sur le bouton Démarrer du programme VirtualBox. 

Si la fenêtre VirtualBox information s'affiche, paramétrez 
comme vous voulez, appuyez sur le bouton OK. 
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L'assistant du premier démarrage s'affiche. Appuyer sur le 
bouton Suivant → 

←  Nous allons indiquer le chemin vers l'image ISO d'Ubuntu en 
appuyant sur le symbole 

Appuyer sur le bouton Ajouter →

← Définir le chemin vers l'image ISO d'Ubuntu, appuyer sur le 
bouton Ouvrir.

 

Appuyer sur le bouton Choisir, l'image ISO est 
paramétrée dans VirtualBox → 

← Appuyer sur le bouton Suivant.
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Appuyer sur le bouton Terminer →

Si la fenêtre VirtualBox information s'affiche, paramétrez 
comme vous voulez, appuyez sur le bouton OK. 

L'installation d'Ubuntu commence sur notre disque dur virtuel 
ubuntu-10.04.vdi

Cette installation est classique, c'est le même principe que 
l'installation d'Ubuntu sur un ordinateur.

Le paramétrage d'Ubuntu commence.

←  Choisir Français comme langue.

←  Appuyer sur le bouton Installer Ubuntu [version]

Paramétrer votre emplacement géographique, 
appuyer sur le bouton Suivant → 

←  Choisir le type de votre clavier, ici CA-FR. Vérifier 
et appuyer sur le bouton Suivant.
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←  Appuyer sur le bouton Suivant.

Identifier l'installation, ici Ubuntu-VB et mot de 
passe roottoor puis appuyer sur le bouton Suivant → 

← Appuyer sur le bouton Installer.

Attendre, le temps d'installation est relativement 
long. Pendant l'installation des messages sur les 
possibilités d'Ubuntu défilent à l'écran.

L'installation se termine. Appuyer sur le bouton 
Redémarrer maintenant→  

Si la fenêtre se bloque faire Machine > 
Redémarrage. Sur la fenêtre Question appuyer sur le 
bouton Redémarrer.

Si la fenêtre VirtualBox information s'affiche, 
paramétrez comme vous voulez, appuyez sur le 
bouton OK. 
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←  Appuyer sur Ubuntu-VB.

Dans la fenêtre suivante, indiquer le mot de passe, ici roottoor et 
appuyer sur le bouton Se connecter.

Après quelques instants, Ubuntu démarre avec une petite musique.

Nous installons maintenant les Additions Invité de VirtualBox qui permettront d'ajuster la fenêtre Ubuntu, 
de partager des répertoires du disque dur, de partager le presse-papiers, par Périphériques > Installer les 
Additions invité... (menu de la fenêtre où apparaît Ubuntu). 

Dans Ubuntu faire Raccourcis > VBOXADDITIONS_[version] et clic. Attendre l'ouverture du navigateur de 
fichiers. Faire un double clic sur autorun.sh qui va démarrer l'utilitaire d'installation. Appuyer sur le bouton 
Lancer. Indiquer votre mot de passe roottoor et appuyer sur le bouton Valider. Le script d'installation s'exécute. 
À la fin de l'exécution appuyer sur la touche Entrée.

Maintenant, il faut redémarrer Ubuntu en appuyant sur le petit bouton en haut à droite et faire un clic sur 
Redémarrer.  Confirmer par Redémarrer. 

Ubuntu redémarre, valider le nom, entrer le mot de passe. Maintenant lorsque l'on redimensionne la fenêtre  
VirtualBox, Ubuntu se redimensionne automatiquement.

Ubuntu est maintenant opérationnel, pour l'utiliser il suffira de démarrer Virtualbox puis de démarrer cette 
distribution.

Un très bon document en français explique Ubuntu, il est disponible en livre ou PDF à cette adresse : 
http://www.framabook.org/ubuntu.html (passer l'installation qui est déjà réalisée).

INSTALLER  G IMP DANS  UBUNTU.
Depuis avril 2010, Gimp n'est pas fourni en standard sous Ubuntu. Pour l'installation nous devons avoir une 

connexion Internet active et passer par l'installateur de paquets Synaptic.

Activer ce gestionnaire par Système > Administration > Gestionnaire paquets Synaptic. Entrer le mot de passe 
roottoor et appuyer sur Valider. Dans l'espace Recherche rapide taper Gimp. Sélectionner le paquet Gimp, 
valider les dépendances. Appuyer sur Appliquer.

 

Appuyer sur Appliquer.

Attendre le téléchargement et l'installation, appuyer sur le bouton Fermer. Fermer Synaptic.

Gimp est disponible depuis Applications > Graphisme > Éditeur d'images Gimp. Même si nous sommes sous 
VirtualBox, Gimp est beaucoup plus rapide que sous Windows. Ce Gimp va nous permettre de tester et 
d'utiliser des greffons qui ne fonctionnent pas directement sous Windows. 

http://www.framabook.org/ubuntu.html
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CRÉER  UN PARTAGE DE DOSSIERS  DANS V IRTUALBOX

Il est utile de pouvoir partager des dossiers entre les 2 systèmes d'exploitation, voici la méthode pour réaliser  
ce partage :

– Dans Windows, à partir de la fenêtre VirtualBox créer un partage dans l'onglet Détails > Dossiers partagés 
et donner un nom, par exemple C_DRIVE

– Dans Ubuntu ouvrir le terminal et taper la ligne de commande sudo mount -t vboxsf C_DRIVE /mnt

– Puis ouvrir Nautilus à partir du terminal par sudo nautilus

– Les dossiers partagés sont dans /mnt



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 368 / 391
 Greffons de Gimp sous Ubuntu/VirtualBox 

GREFFONS DE G IMP SOUS UBUNTU/V IRTUALBOX

Les greffons qui suivent, à notre connaissance, ne sont pas disponibles pour fonctionner sous Windows 
(compilation problématique, etc.). Gimp doit être installé comme indiqué au paragraphe précédent.

GREFFON COLORIZE-GIMP

Ce greffon permet de colorier une image en nuances de gris. Le développement est abandonné par son 
auteur Christopher Lais. La page de ce greffon est http://zenthought.org/content/project/colorize et les sources 
sont disponibles sur ce lien http://zenthought.org/system/files/asset/2/colorize-gimp-20070930.tar.gz . 
L'auteur cherche un(e) volontaire pour maintenir le projet.

Des exemples sont disponibles à la page http://www.cs.huji.ac.il/~yweiss/Colorization/ 

Ce greffon utilise la bibliothèque SuiteSparse de l'université de Floride 
http://www.cise.ufl.edu/research/sparse/SuiteSparse/ . Il ne sera pas nécessaire de compiler cette bibliothèque 
dans Ubuntu car un paquet existe.

Nous allons installer ce greffon dans Ubuntu sans trop utiliser de ligne de commande (4 commandes) :

– Ouvrir Synaptic   par Système > Administration > Gestionnaire paquets Synaptic. Entrer le mot de passe 
roottoor et appuyer sur Valider.

– Nous allons commencer par récupérer gimptool qui permet d'installer les petits greffons de Gimp à partir 
des sources. Dans l'espace Recherche rapide taper gimptool. Sélectionner le paquet libgimp2.0-dev ( + 
dépendances). Valider l'installation par le bouton Appliquer. Appuyer sur Appliquer. Fermer lorsque 
l'installation est terminée.

– Dans l'espace Recherche rapide taper SuiteSparse. Sélectionner les paquets ( + dépendances) suivants :

– Valider l'installation par le bouton Appliquer. Appuyer sur Appliquer. Lorsque le chargement et 
l'installation sont terminés, fermer Synaptic.

– Télécharger les sources du greffon de Gimp en ouvrant Firefox et en collant le lien suivant :
 http://zenthought.org/system/files/asset/2/colorize-gimp-20070930.tar.gz 

– Enregistrer le fichier. Lorsque le fichier est enregistré, faire un clic droit et Ouvrir le dossier contenant le 
fichier. Fermer Firefox.

– Dans le navigateur de fichiers faire un double clic sur l'archive colorize-gimp-20070930.tar.gz .

– Dans la fenêtre « colorize-gimp-20070930.tar.gz » appuyer sur le bouton Extraire.

– Dans la fenêtre « Extraire » appuyer sur le bouton Extraire.

– Dans la fenêtre « Extraction des fichiers de l'archive » appuyer sur le bouton Afficher les fichiers. Faire un 
double clic sur le dossier colorize-gimp. Repérer l'emplacement des fichiers (Makefile, colorize.c , etc.) en 
faisant un clic droit sur un des fichiers et propriétés. 
Copier le chemin /home/ubuntu-vb/Téléchargements/colorize-gimp par Ctrl+C . 

– Ouvrir la console par Applications > Accessoires > Terminal.

– Dans le terminal taper cd, un espace et coller le contenu du presse-papiers qui contient le chemin pour se 
rendre dans le dossier où il y a Makefile par Édition > Coller , appuyer sur la touche Entrée.

– Taper make puis appuyer sur la touche Entrée.

http://zenthought.org/system/files/asset/2/colorize-gimp-20070930.tar.gz
http://www.cise.ufl.edu/research/sparse/SuiteSparse/
http://www.cs.huji.ac.il/~yweiss/Colorization/
http://zenthought.org/system/files/asset/2/colorize-gimp-20070930.tar.gz
http://zenthought.org/content/project/colorize
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– Taper make install puis appuyer sur la touche Entrée.

– L'installation est terminée. Taper exit dans le terminal puis appuyer sur la touche Entrée. Fermer toutes les 
fenêtres ouvertes.

– Démarrer Gimp par Applications > Graphisme > Éditeur d'images Gimp. 

– On trouve ce greffon dans Couleurs > Colorization.

Essai du greffon :

Pour l'essai on peut utiliser un des exemples de la page  http://www.cs.huji.ac.il/~yweiss/Colorization/ avec 
la photographie http://www.cs.huji.ac.il/~yweiss/Colorization/gray/gili_res.png .

– Dans Gimp faire Fichier > Ouvrir suivant l'emplacement. Coller le lien de l'image et appuyer sur Ouvrir.

– Désaturer cette image par Couleurs > Désaturer pour obtenir une image en nuances de gris.

– Ajouter un nouveau calque par Calque > Nouveau calque, Valider.

– Sur ce nouveau calque utiliser un pinceau fin pour peindre de petits traits comme indiqué dans l'exemple.

http://www.cs.huji.ac.il/~yweiss/Colorization/gray/gili_res.png
http://www.cs.huji.ac.il/~yweiss/Colorization/
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– Sélectionner le calque de fond « Arrière plan ».
– Activer le greffon par Couleurs > Colorization. Appuyer sur Valider et attendre la fin du traitement.

– Rendre invisible le calque avec les petits traits de couleurs.

– Résultat :

Ici le travail n'est pas trop soigné (l'application des petits traits a été très vite faite) mais nous voyons bien 
l'effet de ce greffon.

En conclusion ce greffon semble un très bon outil qui demande une certaine habitude.

GREFFON DJVU

Ce greffon permet de lire le format DjVu. Ce format est utilisé pour archiver les documents, voici un lien sur 
ses caractéristiques : http://djvu.org/resources/whatisdjvu.php . 

Sous Windows il existe DjVuSolo3.1-noncom.exe, un petit outil gratuit et assez ancien, qui permet de créer 
des fichiers au format DjVu : http://www.djvu.org/files/DjVuSolo3.1-noncom.exe . Cet outil est bien pratique 
pour scanner des pages manuscrites car il permet d'obtenir des rendus de très haute qualité avec des fichiers  
de petite taille. Nous allons utiliser cet utilitaire pour obtenir le fichier de test (test.djvu disponible à 
www.aljacom.com/~gimp/test.djvu 4 517 octets 627*479) que nous ouvrirons dans Gimp/Ubuntu.

Les sources de ce greffon sont disponibles sur http://registry.gimp.org/node/24251 . Il suffit de télécharger 
http://registry.gimp.org/files/djvu_plugin_sources.tar.gz et de le décompresser comme indiqué au paragraphe 
« Greffon colorize-gimp ».

Ce greffon utilise la bibliothèque DjVuLibre (http://djvu.sourceforge.net/) et ses dépendances. Via Synaptic, 
nous téléchargeons tout ce qui a un lien avec djvu (qui est le critère de recherche). 

http://djvu.sourceforge.net/
http://registry.gimp.org/files/djvu_plugin_sources.tar.gz
http://registry.gimp.org/node/24251
http://www.aljacom.com/~gimp/test.djvu
http://www.djvu.org/files/DjVuSolo3.1-noncom.exe
http://djvu.org/resources/whatisdjvu.php
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Ensuite nous compilons dans le terminal  (Applications > Accessoires > Terminal) :
– cd /home/ubuntu-vb/Téléchargements/djvu_plugin_sources

– ./configure

– sudo make entrer le mot de passe roottoor

– sudo make install entrer le mot de passe roottoor

– exit

L'installation est terminée. Il suffit d'ouvrir Gimp et de faire l'essai avec l'image de test 
(http://www.aljacom.com/~gimp/test.djvu) en ouverture de fichier ou en ouverture suivant l'emplacement.

http://www.aljacom.com/~gimp/test.djvu
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INSTALLER  DES GREFFONS EN PERL
Perl est un langage de programmation. Les greffons pour Gimp écrits en Perl se placent dans le répertoire 

des greffons. Voici comment installer ce langage sous Ubuntu 10.04 qu'il suffit d'adapter pour d'autres 
distributions (merci à Raymond pour son aide http://www.linuxgraphic.org/forums/viewtopic.php?
f=4&t=6371).

Nous commençons, via Synaptic, à installer les paquets GIT et extutils comme indiqué ci-dessous :

Ensuite, télécharger et décompresser l'archive http://downloads.sourceforge.net/gtk2-perl/Gtk2-1.222.tar.gz 
pour installer GTK Perl.

Dans le terminal exécuter les commandes suivantes :
cd /home/ubuntu-vb/Téléchargements/Gtk2-1.222
sudo perl Makefile.PL
sudo make
sudo make test
sudo make install

Installer Gimp Perl à partir de GIT par ces commandes :

sudo mkdir /git_gimp_perl (créer un répertoire /git_gimp_perl)
cd /git_gimp_perl (aller dans ce répertoire)
sudo git clone git://git.gnome.org/gimp-perl (télécharger git gimp-perl)
cd /git_gimp_perl/gimp-perl
sudo perl Makefile.PL
sudo make
sudo make test
sudo make install

L'installation est terminée. Nous pouvons tester via des greffons trouvés sur gimp registry ou autre : 
http://registry.gimp.org/search/node/perl , http://www.google.com/search?sourceid=chrome&ie=UTF-
8&q=gimp+perl+plugin  

http://www.google.com/search?sourceid=chrome&ie=UTF-8&q=gimp+perl+plugin
http://www.google.com/search?sourceid=chrome&ie=UTF-8&q=gimp+perl+plugin
http://registry.gimp.org/search/node/perl
http://downloads.sourceforge.net/gtk2-perl/Gtk2-1.222.tar.gz
http://www.linuxgraphic.org/forums/viewtopic.php?f=4&t=6371
http://www.linuxgraphic.org/forums/viewtopic.php?f=4&t=6371
http://fr.wikipedia.org/wiki/Perl_(langage)
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GREFFON  FLAG  W AVING

Ce greffon permet d'obtenir un effet de drapeau ondulant.

Lien de téléchargement : http://www.69b.org/web69/dl/gimp-animation-attributes.7z 

Il faut décompresser cette archive 7-Zip (installer les outils via Synaptic, mot clef 7-zip).

Installer flag-waving dans le répertoire des greffons 
/home/ubuntu-vb/.gimp-2.6/plug-ins et modifier ses propriétés 
d'exécution comme indiqué (le rendre exécutable)         →
ou par chmod (voir http://fr.wikipedia.org/wiki/Chmod).  

Dans Gimp, sur une image, activer le greffon par Filtres > 
Animation > Flag waving , paramétrer et Valider. Ne pas tenir 
compte des messages d'erreur.

Tester l'animation par Filtres > Animation > Rejouer l'animation :

http://fr.wikipedia.org/wiki/Chmod
http://www.69b.org/web69/dl/gimp-animation-attributes.7z
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AUTOMATISER DES ACTIONS AVEC AUTOHOTKEY

Dans ce chapitre nous expliquons une autre façon d'automatiser des actions répétitives de Gimp en 
utilisant un logiciel libre : AutoHotkey (http://www.autohotkey.com/).

AUTOHOTKEY

AutoHotkey est un langage de script sous licence GPL qui permet d'automatiser des actions en simulant des 
séquences de touches, des clics et déplacements de la souris. C'est aussi un langage de programmation pour 
l'environnement Windows qui permet de créer de petits programmes utilitaires (comme maringouin par 
exemple) avec des fonctions avancées comme appels de bibliothèques DLL, appels de fonctions, appels de 
sous-programmes, fonctions de tests, boucles, gestion de fichiers .ini , etc.

AutoHotkey est issu, suite à une mésentente entre développeurs, d'un autre célèbre langage de scripts pour 
Windows : Autoit (http://www.autoitscript.com/autoit3/). Les langages de ces deux logiciels sont assez 
semblables.

Ces 2 langages de script sont compilables et permettent de créer des fichiers exécutables .exe

INSTALLER  AUTOHOTKEY

Téléchargements : http://www.autohotkey.com/download/   (Par choix, nous utilisons l'archive zip) 

Forum : http://www.autohotkey.com/forum/ 

Editeurs :
AutoHotkey propose un lien vers Scite : http://www.autohotkey.net/~fincs/SciTE4AutoHotkey_2/web/  
Nous utilisons un autre éditeur Notepad++ : http://notepad-plus.sourceforge.net/fr/site.htm  qui contient la 
coloration syntaxique pour le langage AutiHotkey.

Installation : Si vous utilisez l'archive zip (au 4 décembre 2008 AutoHotkey104805.zip), il suffit de la 
décompresser dans le répertoire de votre choix dont le nom est, si possible sans accent et sans espace (par 
exemple C:\autohotkey).

Voici le contenu important du répertoire d'installation (fichiers en rouge) :
C:\AUTOHOTKEY
│   AU3_Spy.exe
│   AutoHotkey Website.url
│   AutoHotkey.chm  Fichier d'aide.
│   AutoHotkey.exe  Permet de lancer votre programme par simple glisser déposer du code source.
│   AutoHotkey104805.zip
│   license.txt
│
├───AutoScriptWriter
│       ASWHook.dll
│       AutoScriptWriter.exe
│
├───Compiler
│       Ahk2Exe.exe Permet de compiler le code source pour générer un exécutable .exe
│       AutoHotkeySC.bin
│       README.txt
│       upx.exe

http://notepad-plus.sourceforge.net/fr/site.htm
http://www.autohotkey.net/~fincs/SciTE4AutoHotkey_2/web/
http://www.autohotkey.com/forum/
http://www.autohotkey.com/download/
http://www.autoitscript.com/autoit3/
http://www.autohotkey.com/
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INSTALLER  L 'ÉDITEUR  NOTEPAD++
Téléchargements : http://sourceforge.net/project/showfiles.php?group_id=95717&package_id=102072 

     Choisir la dernière version avec l'installeur (au 4 décembre 2009 npp.5.6.Installer.exe). 

Installation : Lancer npp.5.6.Installer.exe et suivre le processus d'installation en validant.

A IDE  À  LA  PROGRAMMATI ON  EN  LANGAGE  AUTOHOTKEY

Il suffit de d'ouvrir le fichier d'aide AutoHotkey.chm ou de consulter le forum (voir page précédente). 
Malheureusement, sur Internet, nous ne trouvons pas beaucoup de documentation en français sur le sujet..

Voici un lien en français : http://autohotkey.free.fr/docs/Tutorial.htm  

EXEMPLE D 'UN PROGRAMME  ASSOCIÉ À G IMP

SCRIPTER  EN  AUTOHOTKEY POUR  G IMP  W INDOW S

Suite à une demande sur le site Gimp-Attitude http://www.gimp-attitude.org/forum/viewtopic.php?p=42429 
nous avons réalisé un petit script en langage AutoHotkey pour automatiser quelques tâches simples en 
appuyant simplement sur une combinaison de touches.

Ce script est testé sous Windows 7 - 64 bits , Gimp 2.6.7 - 32 bits et  AutoHotkey version 1.0.48.05. Lien 
pour le télécharger : http://www.aljacom.com/~gimp/Scripter_en_AutoHotkey_pour_Gimp_Windows.zip 

Pour tester ce script il suffit de décompresser l'archive zip et de lancer Exemple_Hotkey_avec_Gimp.exe

Le code source est le fichier Exemple_Hotkey_avec_Gimp.ahk

Utilisation :

– Démarrer Gimp

– Démarrer Exemple_Hotkey_avec_Gimp.exe

– Ouvrir une image dans Gimp

– Activer cette image et faire la combinaison de touches Win + i pour définir l'image source.

– Se positionner sur l'image et mettre le curseur de la souris à l'endroit voulu. Faire la combinaison de 
touches Win + a pour lancer le petit automatisme. À partir de ce moment la couleur sera récupérée avec la 
pipette à l'endroit du curseur de la souris, une sélection se fera avec la baguette, le contenu visible de cette 
sélection sera copié et collé dans une nouvelle image.

– Pour sortir du programme utiliser la combinaison de touches Win + q

Remarques :

– Les informations de fonctionnement sont dans une petite fenêtre en haut à gauche de l'écran.

– Les boîtes d'avertissement se ferment automatiquement, il n'est donc pas nécessaire d'appuyer sur le 
bouton OK.

– Vous pouvez adapter ce petit script à vos besoins qui est sous licence GPL.

– Toutes les lignes du code source sont commentées.

– La touche Win du clavier est celle avec le logo de Windows, placée sur la même ligne que la barre 
d'espacement. Il y a souvent deux touches Win, une de chaque côté de la barre d'espacement.

http://www.aljacom.com/~gimp/Scripter_en_AutoHotkey_pour_Gimp_Windows.zip
http://www.gimp-attitude.org/forum/viewtopic.php?p=42429
http://autohotkey.free.fr/docs/Tutorial.htm
http://sourceforge.net/project/showfiles.php?group_id=95717&package_id=102072
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ANALYSE  ET MODIFICATI ONS  DU  SCRIPT  EXEMPLE_HOTKEY_AVEC_G IMP .AHK

Ce script simule les touches du clavier et active les raccourcis de Gimp. Il simule aussi les actions de la  
souris. 

Voici la liste des commandes AutoHotkey qui permettent ces simulations :

– Envoyer des séquences de touches : Send , ControlSend , ControlSendRaw

– Envoyer des événements de la souris : Click , MouseClick , MouseClickDrag , MouseMove  

– L'utilisation est bien décrite dans l'aide AutoHotkey.chm  

----------

Le programme Exemple_Hotkey_avec_Gimp.ahk se décompose en 3 parties :

– Les déclarations de variables.

– Le programme principal.

– Les sous-programmes appelés par les séquences Win + une touche.

----------

Dans l'aide d'AutoHotkey, à la page Send, nous trouvons tous les équivalents des touches du clavier. 
Les raccourcis de Gimp sont accessibles par Édition > Préférences > Interface > Configurer les raccourcis 
clavier ou en intervenant directement sur le fichier C:\Users\[utilisateur]\.gimp-2.6\menurc (Windows 7). Il 
existe de raccourcis disponibles dans Gimp : de Ctrl+F1 à Ctrl+F12 et de Alt+F1 à Alt+F12

----------

Le programme n'est pas optimisé de façon à utiliser les fonctions de copier-coller. Par exemple, si nous 
voulons ajouter une fonction Effacer la sélection après Coller comme nouvelle image il suffit de copier les 
lignes 92 à 95 ...

WinActivate, %Var_Ref_Fenetre_Image% ; activer la fenêtre
WinShow, %Var_Ref_Fenetre_Image% ; afficher la fenêtre
Sleep, 200 ;Temporisation de 200 ms
Send, o ;Simuler l'outil pipette avec le raccourci O 

… de coller à la ligne 121 et de modifier comme suit (1ajout, 3 lignes de modifications en rouge) :
Sleep, 3000 ;Temporisation de 3 secondes pour le collage comme nouvelle image à ajuster 
WinActivateBottom, %Var_Ref_Fenetre_Image% ; activer la fenêtre d'origine au premier plan
WinShow, %Var_Ref_Fenetre_Image% ; afficher la fenêtre
Sleep, 200 ;Temporisation de 200 ms
Send, {Del} ;Simuler la touche Suppr

----------

Pour activer des menus déroulants, entrer de valeurs il sera nécessaire de bloquer des fenêtres à des endroits 
précis et à des dimensions précises en utilisant WinMove.

Exemple (attention aux 2 virgules qui se suivent) :
WinMove , %Var_Ref_Fenetre_Image%,, 0, 0, 900, 600 ; En haut à gauche, dimensions 900*600pixels

----------
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ANALYSE  DU  SCRIPT EXEMPLE_COULEURS_HOTKEY_AVEC_G IMP .AHK

Ce script est une modification du script de la page précédente. Des fonctions de couleurs sont ajoutées. 

Principe de fonctionnement :

– Les couleurs sont récupérées dans la fenêtre PP/AP de Gimp. Pour activer cette fenêtre un raccourci devra 
être créé dans Gimp par Édition > Préférences , Interface , appui sur le bouton Configurer les raccourcis clavier , 
Boîte de dialogue > Couleurs , clic sur la ligne Couleurs pour faire apparaître Nouveau raccourci, appuyer les 
touches Alt et F1 simultanément. Résultat :

– Les caractéristiques de la fenêtre PP/AP sont mémorisées dans un fichier .ini  . Pour cela il faut démarrer  
Gimp, puis le script AutoHotkey, activer la fenêtre PP/AP de Gimp par Alt+F1 et placer le curseur de la souris 
à la fin de la valeur de la couleur, faire un clic pour activer le curseur, ne plus bouger la souris et lancer le 
programme d'identification de la fenêtre par Win+P .

– 10 couleurs sont mémorisées dans le fichier .ini   par Win+C

– Pour ouvrir une image remplie d'une des 10 couleurs il suffira de faire Win+Touche de 0 à 9 du clavier 
numérique.
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Programmation :

– Deux fonctions sont ajoutées,  _Appliquer_une_valeur et _Recuperer_une_valeur . Cette dernière 
renvoie le contenu du presse-papiers. Ces deux fonctions peuvent être appelées par d'autres sous-programmes.

– Le fichier .ini est Exemple_Couleurs_Hotkey_avec_Gimp.ini . La lecture se fait par IniRead et l'écriture par 
IniWrite . 

Utilisation :

– Attribuer le raccourci Alt+F1 à Gimp pour activer la fenêtre PP/AP comme indiqué à la page précédente.

– Démarrer Gimp

– Démarrer Exemple_Couleurs_Hotkey_avec_Gimp.exe

– Faire un premier test avec Win+Touche 5 du clavier numérique, une image jaune devrait être créée.

– En cas de problème, faire l'apprentissage des caractéristiques de la fenêtre PP/AP , comme indiqué à la 
page précédente, par Win+P.

– Pour modifier une couleur mémorisée dans le fichier .ini , éditer ce fichier ou ouvrir la fenêtre PP/AP par 
le raccourci de Gimp Alt+F1 , choisir une couleur, activer Win+C .

Pour sortir du programme utiliser la combinaison de touches Win + q 

Modifications :

Vous pouvez modifier le fichier source Exemple_Couleurs_Hotkey_avec_Gimp.ahk selon vos besoins.

Utilisation de manettes de jeu comme interface :

Vous pouvez chercher le terme joystick dans le fichier d'aide AutoHotkey.chm ou sur le forum.
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FUTURE VERSION : G IMP 2.8.X

La prochaine version stable de Gimp sera  numérotée 2.8.x , sa date de sortie est estimée vers le milieu de 
l'année 2011. En attendant cette version stable, une version intermédiaire est proposée, c'est la version de 
développement Gimp 2.7.x 

Dans cette future version nous retrouverons quelques améliorations significatives :

– Avoir Gimp dans une fenêtre unique ou en fenêtres séparées.

– Regrouper des calques.

– Gros travail sur les brosses (rotation, ratios, brosses dynamiques).

– Écrire un texte directement à n'importe quelle position du canevas.

– Calculer directement dans les champs numériques de saisie.

– Nouveau dégradé.

– Nouveau système d'enregistrement et d'enregistrement sous pour les fichiers autres que xcf. 

– Export rapide pour les formats JPEG et PNG.

– Nouveau système d'exportation des palettes vers CSS, PHP, Java, Python ou fichiers texte.

– Support du format JPEG2000.

– Support du format RAW 16 bits en importation.

– Calques vectoriels.

– Plus forte intégration de GEGL au niveau des calculs sur les calques.

– Nouveaux raccourcis.

– Etc.

Voici un lien pour découvrir toutes ces nouveautés avec des illustrations :
 http://wiki.gimp-attitude.org/FonctionsFaqGimp28 

VERSION G IMP  2.7.X L INUX FONCTIONNANT  SOUS V IRTUALBOX

Nous proposons une version disponible à la page http://www.aljacom.com/~gimp/ 

Mot de passe root = roottoor
Voir installation « Importer Gimp Eval dans VirtualBox sous Windows » page suivante.

VERSION G IMP  2.7.X FONCTIONNANT  SOUS W INDOW S

Nous proposons une version de tests à la fin de la page http://www.aljacom.com/~gimp/download.html .

COMPILER  G IMP  2.7.X SOUS SNOW LEOPARD

http://clockwork.fr/how-to-compile-gimp-271-on-snow-leopard/  

COMPILER  G IMP  2.7 SOUS UBUNTU À PARTIR DE GIT
http://www.gimpusers.com/news/2009-10-14/compiling-gimp-27-git-ubuntu-904-910.html 

http://www.gimpusers.com/news/2009-10-14/compiling-gimp-27-git-ubuntu-904-910.html
http://clockwork.fr/how-to-compile-gimp-271-on-snow-leopard/
http://www.aljacom.com/~gimp/download.html
http://www.aljacom.com/~gimp/
http://wiki.gimp-attitude.org/FonctionsFaqGimp28
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IMPORTER  G IMP  EVAL DANS  V IRTUALBOX SOUS W INDOW S

Télécharger l'archive 7-Zip sur le lien indiqué à la page http://www.aljacom.com/~gimp/ et décompresser 
pour obtenir le fichier GimpEVAL-2.7.[version].vdi

– Ouvrir VirtualBox.

– Appuyer sur le bouton Nouvelle ou Ctrl+N, l'assistant s'ouvre.

– Donner un nom , Linux comme système d'exploitation, Linux 2.6 comme version.

– Mettre une quantité de mémoire de 1024Mo (ou plus selon votre ordi.).

– Valider Boot Hard Disk et indiquer l'emplacement du fichier GimpEVAL-2.7.[version].vdi dans Utiliser un 
disque dur existant via la fenêtre Gestionnaire de médias virtuels > bouton Ajouter.    

– Terminer.

Il ne reste plus qu'à démarrer GimpEval.

http://www.aljacom.com/~gimp/
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AMÉLIORER CETTE DOCUMENTATION

Communiquez vos remarques, erreurs constatées, ajouts, etc. à cette adresse courriel :

sylvie.alexandre@aljacom.com 

Il nous ferra plaisir de répondre à ces demandes.

Adresse pour nous écrire :

S. Alexandre

163 Principale

Sainte-Sabine (Québec)

G0R 4H0 Canada

mailto:sylvie.alexandre@aljacom.com
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MODIFICATIONS APPORTÉES À CETTE DOCUMENTATION

1er novembre 2008 Version d'origine.
V 002 Ajout GEGL Couleurs, ajout Image avec ICC.
V 003 Ajouts : JPEG 2000, les noms de calques ne doivent pas contenir les caractères / \ * ? sur

les scripts-fu adaptés de Niels Giesen, YUV, Astronomy.
V 004 Ajouts : .ani , AnimatedDisplaceScriptByGreentunic.scm
V 005 Modification :Photoshop Pattern 
V 006 Ajouts : Light to Height, Gimp-Ace, Area
V 007 Ajouts : Formulas, Film Degrain, exposure-blend-tinyscheme.scm, file sequencer.
V 008 Ajouts : Vignetting, Wideangle, Intelligum ,  GP Boundary Shrinker, Subtraction, 

Shapefs, Magie, PDS.
V 009 Ajout  :  User Filter.  Modifications de liens (Problèmes export OO.o en PDF)
V 010 Ajout  :  BASCII
V 011 Ajout  :  MSYS, Phymodmedia.
V 012 Ajout  :  Comment écrire un greffon pour Gimp.
V 013 Ajouts : colour2grey-local,  greffons de Lukas Hosek
V 014 Correction wsurface. Ajouts wavelet-decompose, annulardenoise, améliorer.
V 015 Ajouts : Greffons Python.
V 016 AVI VirtualDub, avertissement curseurs animés.
V 017 Gimp en breton.
V 018 Ajout  :  Greffon GMIC
V 019 Mise à jour GMIC & Wavelet decompose 0.1.2
V 020 Ajout  :  Greffon Blend Removal, mise à jour GMIC.
V 021 Ajouts  :  Greffons Wavelet Sharpen, Wavelet denoise, Noise generator.
V 022 Ajout  :  Greffon Focus Blur.
V 023 Mise à jour Normalmap, ajout du greffon RAWTex.
V 024 Ajout  :  Greffon Save for Web.
V 025 Ajout  :  Greffon Twist.
V 026 Ajouts  :  Greffons Tileably Shrink, Greffon Thin Line, Greffon Self-SOM.
V 027 Ajout  :  Greffon CamoTruck-Net.
V 028 Ajouts  :  Greffons Isles et DBP.
V 029 Ajouts  :  Greffons Waves of chaos. Contrôles MD5 greffons compilés SAMJ.
V 030 Ajout  : Lien YouTube.
V 031 Ajout  : bzip2.
V 032 Ajout  : G'MIC 1.3 
V 033 Ajout  : Greffon Restauration diapositives & vieilles photographies. MAJ Liquid 

Rescale 
V 034 Ajout  : Ouvrir avec URL. Modifications : Maringouin, Python. MàJ : GMIC, GAP. 
V 035 Mise à jour Script-Fu, Liens.
V 036 Ajout  : Color spotter.
V 037 Ajouts  : Greffons Kaleidoscope, smooth-path , iterative_save.exe.
V 038 Ajout  : Greffon Upsize.
V 039 Ajout  : Greffon  guillotine into layers.
V 040 Ajout  : GEGL C2G (effet HDR).
V 041 Corrections nouvelle version de maringouin.
V 042 Corrections nouvelle version de maringouin (suite) et modification masque de calque.
V 043 Déplacement masque de calque, icône maringouin sous Windows 7.
V 044 Compiler Gimp et greffons sous Windows.



www.aljacom/~gimp  -  Débuter avec Gimp 2.6  -  jeudi 26 août 2010  -  Page 383 / 391
 Modifications apportées à cette documentation 

V 045 Ajout des archives PSPI et Intelligum sur aljacom.com, MAJ Mathmap et Fourier. 
V 046 Correction liens PSPI. Ajout Colour Match.
V 047 Ajout fx-foundry.
V 048 Ajouts lien script-fu et Automatiser des actions avec AutoHotkey.
V 049 Ajout couleurs avec AutoHotkey.
V 050 Ajout lien didacticiel VirtualDub.
V 051 Remplacement de carte par « mappage ».
V 052 Ajout greffon elsamuko-depthmap.
V 053 Ajout et M.À.J. blendremoval-0.7-i686.zip
V 054 M.À.J. Save for web.
V 055 M.À.J. YUV, Contrôles MD5 des greffons compilés et ajout turing-pattern.
V 056 Ajout Animation le long d'un chemin (fp-script-fu-path-suite.scm).
V 057 Ajout fp-kaleidoscope-anim.scm
V 058 Ajout greffon Simple surface blur/bilateral (flou).
V 059 Ajout greffons Blizzard BLP importer et Enhance Details.
V 060 Ajout Traitement par lot avec gimp-console-2.6.exe.
V 061 Ajout Le format APNG (animation, image statique).
V 062 Ajout Future version : Gimp 2.8.x
V 063 Ajout Greffon Image registration  (Aligner 2 images).
V 064 Ajout Greffon Shape It (Texte selon un mappage).
V 065 Ajout Export au format SWF (Format Flash d'Adobe).
V 066 Ajouts Greffon edge-avoiding-wavelets (Netteté) & Thèmes pour Gimp à télécharger.
V 067 Ajouts compilation croisée & Greffon Smart Print Tool, correction courbes.
V 068 Ajout GTK+ Preference Tool.
V 069 Ajout greffon GIMP Mask + màj liste greffons compilés.
V 070 Ajout VirtualBox, Greffons sous Ubuntu/VirtualBox.
V 071 Ajouts greffons DJVU, Image Mosaic.
V 072 Ajouts Gimp-Sharp & Spirograph.
V 073 Ajouts partage dans VirtualBox, Gimp Perl, importer image VirtualBox.
V 074 Ajout greffon texturetiler.
V 075 Ajout remarque au chapitre batch.

http://www.aljacom.com/~gimp/
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